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1 - Introduction & Installation
Introduction
1 - Introduction & Installation

Introduction
Congratulations on your purchase of the Emulator X3 Streaming Sampling Synthe-
sizer—the most powerful and complete software instrument in the world, built on 
E-MU’s 35 years of synthesis experience. The Emulator X3 features the Xstream™ 
streaming sound engine with up to 192kHz sampling, and playback, an arsenal of 
automated sampling/beat analysis/editing tools and almost unlimited sound manipu-
lation.

Emulator X3 Features

Streaming

• Xstream™ 24-bit/192 kHz Streaming Engine, featuring E-MU’s patented pitch 
interpolation and precision 32-bit floating point processing for unmatched 
sound quality.

• 32-bit and native 64-bit applications included (32-bit: Windows XP and Vista; 
64-bit: Windows x64 and Vista)

• Optimized for Multi-core and Multi-Threaded processors to intelligently balance 
the processing load across all available resources for exceptional performance.

• Standalone (64 MIDI channels) or VSTi (16 MIDI channels per instantiation) 
operation.

Sampling

ASAP™ Automated Sampling and Placement
• Sample, Chop and Place
• Load, Chop and Place
• SynthSwipe™ automated hardware and software instrument sampling

Integrated Sample Editor
• Auto-Correlation Looping
• Crossfade Looping
• Comprehensive DSP Tools including Transform Multiply
• External Editor Link

Beat/Loop Tools
• Beat Analysis and Markup
• TwistaLoop™ non-destructive audio manipulator
• Xplode™ beat slicer with MIDI and Tempo Map Export
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Synthesizer

• Advanced Modular Synthesis and FX Engine (from your initial sample’s tempo 
through Emulator X3’s entire synthesis and FX architecture, all time-based 
parameters syncable to BPM clock).

• Over 50 types of Z-Plane™ Morphing Filters (2nd order to 12th order), 
including the Morph Filter Designer

• Multi-Function Generators/Arpeggiators (can be programmed to modulate 
pitch, filters, volume, retrigger samples, or LFOs, change tempo or trigger 
other events)

• Virtual PatchCord Modulation Matrix (over 100 modules)
• Integrated Modulation FX engine (23 core effects), including SP12ulator, 

Tremulator, Reverbs, Delays and many more

• Comprehensive sound format support, including EOS, EIII, GigaSampler, MP3, 
REX2, .AIFF, SoundFont 2.1, .WAV and more.

Before you Begin…
You should have a good working knowledge of your computer’s operating system. For 
example, you should know how to use the mouse, standard menus and commands. 
You should also know how to cut, copy, paste, open and close files.

Notes, Tips and Warnings
Items of special interest are presented in this document as notes, tips and warnings.

Tutorial List
 Tip:  Please refer to 

the “Index” for a 
complete list of all 
Emulator X tutorials.

Although this document is primarily intended as a reference manual, it does contain 
quite a few step-by-step tutorials that you may find helpful. A few are listed below.

Notes provide additional information related to the topic being discussed. Often, 
notes describe the interaction between the topic and some other aspect of the system.

Tips describe applications for the topic under discussion.

 Warnings are especially important, since they help you avoid activities that can 
cause damage to your files, your computer or yourself.

Tutorial Page Tutorial Page

Adding an Aux Effect 232 Function Generator 140

Adding an Effect to a Preset 233 Creating Sequencer Tempo Tracks 173

Building a Preset from Scratch 58 Layering Presets 124

Change Loops with a Controller 220 Looping 207

Conserving Polyphony 165 Morph Designer 150

Control FX Parameters via MIDI 242 Sampling 282

Create a Custom Bank 47 Program Change Commands 317

Creating ADSR Envelopes 133 Setting up your Controller Knobs 28

Crossfade between two Loops 227 SynthSwipe 290

Examine a voice or sample 52 VSTi 320
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Introduction
What’s New in X2
• Support for 64 MIDI channels (page 70)

• Three 64-stage Function Generators per voice (page 139)

• Morph Designer allows you to design custom morphing filters (page 149)

• TwistaLoop loop analysis and manipulation tools (page 209)

• User interface changes
• New Region Page (page 115)
• New Detail Page with Voices and Zones info (page 119)
• Improved Keyboard Display (page 99)
• Floating Keyboard (page 270)
• Tabs in Voice Editor (page 89)
• Envelope Mode Settings (page 132)
• Sample Display/Overview (page 169)
• Sample Root Note shown with Red Bar (page 99)

• Key CC Window Controls (page 108)

• Cycle Groups in CC Window provide more natural sound by cycling through 
different samples on repeated key presses. (page 111)

• Poly Key Groups allow you to limit polyphony per key (page 164)

• New modulation sources for patch cords: (page 156)
• Function Generator (+,~,<,) 
• Function Generator (gate, trigger)

• New modulation destinations for patch cords: (page 159)
• Function Generator Rates/Retrigger/Length/Direction
• Key Timer Rate
• Lag Rates 1 & 2
• Loop Select: Continuous/Jump
• Sample Retrigger (+, -)
• TwistaLoop Oscillator Speed

• New Effects
• Compressor (page 248)
• Limiter (page 259)
• Tremulator BPM (page 264)
• Flanger BPM (page 257)

• New Tuning Tables: al-Farabi 12, 22-Tone, 24-Tone, 36-Tone (page 83)

• More templates (XML based)

• Capture MIDI Controllers to preset initial settings (page 82)

• Voices and Zones can be sorted according to different criteria (page 121)

• New Preference Settings: Select edited preset for multisetup, Expand tree items 
when selected, Knob tracking (page 29)

• New MIDI Setting: Preset Tempo Channel (page 27)

• More Undo Levels and greater control over undo behavior (page 30)

• Effects Overhead dialog box (page 236)

New in X3
• Xstream™ 24-bit/129kHz Streaming Engine—32-bit and native 64-bit applications 

optimized for Multi-core and Multi-threaded processors. Vista compatible.

• Xplode Region can now create companion MIDI files (page 117)

• Export Tempo Map from Beat Analyzed samples (page 171)

• Xtractor tool selectively processes audio based on stereo position (page 196)

• Librarian improvements - Faster operation with large libraries (page 66)
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Minimum System Requirements
To use Emulator X you will need at least:

• Pentium IV 1.5 GHz or equivalent CPU (2.4 GHz or faster recommended)

• CD-ROM Drive

• 512 MB RAM (2 GB DDR or greater recommended)

• Windows XP, Windows x64, Windows Vista, or Windows Vista x64

• Onboard Sound or Audio Interface

 No Hardware 
Requirement: As of 
software version 3.0 
Emulator X3 no longer 
requires that a piece of 
E-MU hardware be 
connected to your 
computer system.

Software Installation

Programs installed:

• Emulator X3 Streaming Sampling Synthesizer application

• Emulator X VSTi

• Emulator X Factory Sound Banks

1. Insert the CD labeled “Emulator X3 - Software/Manual/Sounds Installation CD” 
into your CD-ROM drive.

If Windows AutoPlay mode is enabled for your CD-ROM drive, the CD starts 
running automatically. If not, navigate to the CD and double-click on Setup.exe.

2. Follow the instructions on the screen.

3. You will be asked to choose the Destination Folder for the program. The default 
location is: “Program Files\Creative Professional\Emulator X.”

4. You will be asked to choose the Destination Folder for the VST plugins. The default 
location is: “Program File\Steinberg\VstPlugins”

5. The program will be installed. Click Finish to complete the installation (when 
prompted) then remove the Emulator X application disk from the CD drive.

6. The included CDs contain the following Emulator X sound banks:

• X Producer.........E-MU General MIDI, Hip Hop Producer, Proteus X Composer, 
Saint Thomas Strings

• Studio Grand..... A stunning 1.4 GB grand piano bank

• Beat Shop 1 .......ATC, Buju, Head Nod, Homage, IDA, Modern Kit, Rock Kit, 
Seattle, Studio Kit

• Xperience...........Breakdown, Filters and Functions, Guitar Wah Bazaar, Jam 
Session, Jazz Drummer, Transform Tool Kit, Transformed, 
Twista Mania

• Xtreme Lead-1...The complete set of presents and samples from the Proteus 
Xtreme Lead-1 sound module

7. Follow the onscreen instructions to install the banks on your hard disk. The 
Factory Sound Banks are installed inside “Program Files\Creative Profes-
sional\Emulator X\Production Sound Banks” by default.

8. You may install the sound bank disks now or at a later time.
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Running the Application for the First Time
1. Launch the Emulator X program by double clicking the Emulator X icon on the 

desktop or by selecting the Emulator X item from the Start menu.

2. You will be asked to activate your copy of the software by entering the serial 
number included with your master CD-ROM.

3. Activation can be verified via the internet or by email. If your computer is 
connected to the internet, activation will be automatic.  

4. If you are NOT connected to the internet, you can register via email using another 
computer (such as a friend’s house, or public library). Click the “Activate by email 
via another computer” button. The following dialog box appears. 

5. Contact E-MU by email at: emu.support@customercare.creative.com. Be sure to 
include your Serial Number (from your Activation Card) and the Request Code in 
the email message. You will receive a return email with your authorization code.

6. When you receive the response code enter it in the box above and click “Activate”.

7. Continue on to “Setting Up Your Audio” on the following page.
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Setting up your Audio
Before you can start making music, you have to establish a connection between 
Emulator X and your audio output hardware. This is done by selecting a software driver 
that makes this connection between hardware and software.

1. In the Options menu of Emulator X, select Preferences. The following screen 
appears.

2. In the Audio section of the menu, select E-MU ASIO if using an E-MU Digital 
Audio System. Select ASIO E-MU USB|0202, ASIO USB|0404 or ASIO E-MU 
Tracker Pre|USB  if using an E-MU USB interface. If you’re using another brand of 
audio interface, select the appropriate driver.

3. You can verify that the Emulator X is producing audio by clicking on the   icon 
in the toolbar. This calls up the Floating Keyboard. Play the floating keyboard 
with your mouse and you should be hearing sound and seeing activity on the 
Emulator X main mix meters.

4. After running Emulator X, you may want to adjust the Audio Preferences for 
optimum performance on your computer system. 

5. If for some reason you want to use hardware that doesn’t support ASIO, select the 
DirectSound driver. For Emulator X to communicate with your sound card, you 
need to have Microsoft DirectSound installed on your computer and there must be 
a DirectSound driver installed for your audio hardware.

Please go to page 22 for complete explanations of the Audio Preferences.
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Setting up the Preferences
The preferences dialog box contains a variety of important controls used to configure 
Emulator X for your audio hardware and to customize the controls to suit the way you 
work.

To get the best possible performance from your computer, you’ll need to spend a little 
time adjusting the Audio Preferences such as Pre-roll, Sample Buffers, CPU Cap and 
ASIO Buffer latency. These parameters interact with each other and you may have to 
experiment to find the settings that work best on your unique computer system.

� To Access the Preferences Dialog Box

1. In the Options menu, select Preferences. The following screen appears.

2. The preferences dialog box is divided into four main groups. Click on the tab 
heading to select one of the four sets of controls.

Audio
Disk Streaming Controls, Sample Rate,  Audio Hardware Setup & 
Pitch Shift Algorithm Selection, Multiple Processor Support, ASIO 
Control Panel.

MIDI
MIDI Input Channels 1-64, IntelliEdit, and Receive/Ignore Program 
Changes, Internal/External Tempo Source select, Velocity Curve, 
Volume Curve, Volume Sensitivity, Preset Tempo Channel.

Controllers
This section allows you to set up the MIDI Continuous Controllers 
you want the Emulator X to receive.

Other

This group contains several miscellaneous controls: Load last bank at 
startup, Select preset on active channel when editing in multimode, 
Clear clip indicators after 10 seconds, Expand tree items when 
selected, Knob tracking, Recording Directory, External Audio Editor, 
Undo settings.
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Audio Preferences

Streaming
When you load an Emulator X bank (with Streaming on), you are not actually loading 
the sample files themselves into your computer’s RAM. Only the preset information 
and the first few seconds of each sample are loaded. The rest of the sample data is taken 
directly from the hard disk when needed.

This streaming technique makes fast loading times possible even when using huge 
banks that would clog a RAM-based sampler. Multi-layer, minute-long, stereo samples 
on each key are no problem for Emulator X. Sample streaming technology is not new. 
It was originally developed in the 1980’s for hard disk audio recorders so that fast 
punch-ins and punch-outs could be achieved.

You have the option to enable or disable streaming audio. If streaming is turned off, 
Emulator X loads (or attempts to load) the entire bank into RAM.

 Tip: If you get an 
error message when 
trying to open a file, the 
file may be too large to fit 
into RAM. Turn streaming 
on.

If streaming is so great, why would you ever want to turn it off? Well, if you’re using 
your computer as an audio workstation, performing multiple simultaneous functions, 
sooner or later, you’ll exceed your computer’s CPU, memory or disk access resources. 
Sample streaming makes very heavy demands on your hard disk. If you’re recording 
other audio tracks, using multiple software plug-ins and playing Emulator X with a lot 
of voices, you may run into a disk access bottleneck. By disabling streaming and 
loading the bank into your unneeded RAM, your hard disk can be reserved for more 
critical operations.

Pre-roll (seconds)
 Tip: Decrease Pre-roll 

time for fast load times 
when auditioning sounds 
and creating new banks.

Increase pre-roll time 
when you’re playing 
many notes or dense 
sequences.

This important control allows you to set how many seconds of each sample should be 
loaded into RAM when the bank is loaded. This setting greatly influences the perfor-
mance of Emulator X when streaming is on. The setting you choose depends on: the 
number of samples you want to use and the amount of RAM you want to dedicate to 
Emulator X. 

The smaller the pre-roll, the more disk access will be required for sustained sounds. 
Frequent disk access may overtax your computer system, depending on its speed and 
the number of other disk dependent applications you have running. Large pre-roll 
times improve polyphony and performance at the expense of system RAM and slower 
bank loading. If you set the pre-roll high enough, the entire bank will be loaded into 
RAM and no disk streaming will occur.
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Sample Buffers
 Tip: Adding RAM is a 

relatively cheap and easy 
way to improve EX3 
performance. With more 
RAM available, you can 
turn up the Pre-roll and 
Sample Buffers to reduce 
disk access.

This control allocates the amount of RAM that will be set aside for Emulator X (in other 
words, the number of the largest complete samples in the bank that can be kept in the 
RAM cache). As samples are played, they are streamed from the hard disk into RAM. If 
you play those samples again and they are already in RAM, they don’t have to be 
reloaded. This control sets the size of the RAM cache that will be kept and lowers disk 
access at the expense of RAM.

� Optimize the Performance and Polyphony of your System

The polyphony of the Emulator X is dependent on a variety of factors including:

• The Pre-roll setting (if streaming is enabled)

• The Sample Buffers setting (if streaming is enabled)

• The CPU Cap setting — the amount of CPU resources available to the Emulator X

• The bit depth of your samples —16 or 24 bits (24 bits = fewer voices)

• The sample rate of the audio hardware — 44.1kHz, 48kHz, 96kHz . 
Lower sample rates use fewer CPU resources.

• Ultra-High Precision Interpolation and the use of high-order filters can reduce 
polyphony.

• The speed of your computer — CPU speed, number of CPUs, speed and size of 
RAM, as well as hard disk access time

Synthesizer parameters also use CPU resources. When creating presets, feel free to use 
modulation cords as needed, but don’t leave cords half connected if you aren’t using 
them, since these patch settings waste CPU cycles. Turn off both the source and 
destination of unused cords.

Audio Setup
These controls let you set audio quality parameters related to Emulator X and your 
sound card.

Type
You have a choice to use either Direct Sound or ASIO audio drivers. If you have 
another high quality sound card installed in your system, it will be shown in this field.

ASIO (Audio Stream Input/Output) is a cross-platform, multi-channel audio transfer 
protocol. ASIO is fast and supports 16-bit and 24-bit data width. Select E-MU ASIO if 
using an E-MU Digital Audio System. Select ASIO E-MU USB|0202,  ASIO USB|0404 
or ASIO E-MU Tracker Pre|USB  if using an E-MU USB interface. If you’re using 
another brand of audio interface, select the appropriate driver.

Cost of Filters on Voice Count

No Filter No additional CPU load.

2nd Order Additional CPU load comparable to playing another 1/2 sample.

4th Order Additional CPU load comparable to playing another 3/4 sample.

6th Order Additional CPU load is comparable to playing 1 more sample.
(maximum polyphony is divided by 2)

12th Order Additional CPU load comparable to playing 2 more samples. 
(maximum polyphony is divided by 3)
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Selecting Direct Sound uses the audio output device specified in the control panel of 
your computer. In general, using Direct Sound is NOT RECOMMENDED because of 
low transfer rate and high latency issues.

Buffer Size
This control sets the number of sample periods between updates of the synthesizer 
parameters. The buffer size can be adjusted according to the speed of your computer’s 
CPU. A faster CPU can handle a lower buffer size.

An asterisk (*) next to a buffer size in the drop-down menu indicates the optimal 
buffer size for your ASIO Buffer Latency settings.

Use Optimal Buffer Size
When this box is checked, the Emulator X will choose the best buffer size based on the 
ASIO Buffer Latency setting (located in the ASIO control panel). You should normally 
leave this feature enabled for best audio performance. In certain rare cases you may 
want to manually set the buffer length to improve MIDI or synth performance.

Sample Rate
This control sets the output sample rate of the Emulator X, and will always match the 
sample rate of your sound card. The default setting is 44.1kHz.

CPU Cap
 Warning: Sounds 

with long release times 
will exhibit “voice 
stealing” more than short 
percussive sounds.

This control sets the maximum percentage of CPU resources that can be used by 
Emulator X and consequently the maximum number of samples that can be played at 
the same time. (Depending on the design of each preset, playing a single note on 
Emulator X  may cause multiple samples to play simultaneously.) The maximum 
setting is 80% CPU usage. If you hear notes being “stolen” in your sequence or as you 
play the keyboard, or if the disk meter readout at the bottom of the window frequently 
goes into the red, increase the value of this control. If you have other applications 
running, you may want to reduce the setting of this control to free up more CPU for 
them.

Headroom/Boost
Headroom is the amount of dynamic range remaining before clipping occurs.

The amount of headroom is adjustable from 12 dB to -30 dB in 1 dB increments. A 
headroom setting of 12dB provides the hottest output level, (and the highest signal to 
noise ratio) but may produce “clipping” if too many notes are played at once. The 
default headroom setting is -7 dB, which maintains an excellent signal to noise ratio 
while keeping a reasonable amount of headroom in reserve. If you hear the signal 
clipping or breaking up, make the headroom value more negative. In practice, you can 
think of this control as adjusting the control range of the Master Volume control.

Ultra-High Precision Interpolation
This button allows you to select between E-MU’s ultra-high precision pitch shifting 
algorithm or a lower quality pitch shifting scheme which uses fewer CPU resources. 

If you are using presets with a sample placed on every key, as is the case on many 
banks, you can switch high precision off to free up CPU with no penalty in audio 
quality. No pitch shifting is occurring anyway. High quality pitch interpolation is only 
needed when you are playing presets which have a few samples mapped across the 
entire keyboard. In this case, Emulator X shifts the pitch of the available samples to fill 
in the keyboard.
24 Emulator X3 Reference Manual



1 - Introduction & Installation
Setting up the Preferences
ASIO Control Panel
This button brings up the E-MU ASIO control panel which allows you to set the ASIO 
buffer latency in milliseconds. This important setting determines how fast notes will 
sound after you play them. If this time is too long, (>10mS) the keyboard response will 
feel slow and sluggish. If set too fast, however, you will hear the sound break up and 
crackle when you play too many notes. Experiment to find the setting that gives the 
best performance on your computer.

Use Multiple Processors
This option allows the processing load of the Emulator X to be divided among several 
CPUs or multi core processors. You can also set the Number of Processors (up to 4) to 
utilize the latest quad-core processors for significant performance gains. You can even 
use the 2 processor option if you have a hyper-threaded CPU since it can run 2 simula-
taneous threads.

 Tip: To find out how 
many logical processors 
your computer supports 
check the “Performance” 
tab in the Windows Task 
Manager (Ctrl-Alt-Delete 
or “Processors” in the 
Device Manager.

If your computer is also serving as your DAW, recording audio tracks and running VST 
plug-ins, simply assigning all your available processors to the Emulator X may not 
always be the best approach. Since your computer is running many other processes 
besides the Emulator X, you want to balance the workload between your available 
cores for most efficient results.

For example, if you have a screaming fast quad-core system you might assign the 
Emulator X to use 3 of the 4 available CPUs for a significant performance gain without 
crowding out your DAW. On the other hand, if you have a computer dedicated to the 
Emulator X you might want to give it all the available CPUs.

Balancing the workload between the available CPUs is the key to maximizing the 
performance of your system. If you have a multi core machine and Multiple Processor 
mode is OFF, you can probably turn up the CPU Cap (try 80%) for a performance gain, 
since the multiple CPUs are sharing the overall task load.

VST Output Buses
This control is only active in the Emulator X VSTi application. This setting allows you to 
add additional VST buses (stereo pairs). Emulator X channel outputs can be assigned to 
VST buses in the Multisetup, Output field. These outputs are sent to the VST Mixer in 
your recording application. You must restart the VSTi for the changes to take effect.

DAW
Software

Emulator
X2

CPUCPUCPUCPU

When running multiple audio software applications, it’s usually best to balance the workload 
between the available CPU cores. 
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MIDI
This group of preferences allows you to set up the MIDI inputs, adjust the master MIDI 
volume and velocity curves and turn the “IntelliEdit” feature on or off.

MIDI Inputs

Channels 1-16, 17-32, 33-48, 49-64
Emulator X can respond to 64 MIDI channels. Since there can be only 16 MIDI 
channels per MIDI cable (or input), four inputs are provided. Set the MIDI inputs to 
match up to four outputs from your MIDI interface or sequencer. If you don’t need 64 
channels you can turn any input off.

IntelliEdit
This control allows you to set the MIDI device for IntelliEdit. Selecting “None” disables 
the feature.

When editing sample key ranges or editing voices it is convenient to select the key 
position by simply playing your MIDI keyboard. IntelliEdit lets you selectively edit key 
ranges using the keyboard when you need to, but blocks keyboard editing when you 
may not want it, such as when your keyboard is playing in the background.

� To Use IntelliEdit:

1. Make sure IntelliEdit is set to the same MIDI port your keyboard is using.

2. In one of the Voices and Sample Zones screens such as “Key Window”, position 
the cursor inside one of the Key Range fields (Low or High).

3. Press and hold, Ctrl+Alt on your computer keyboard.

4. Play your MIDI keyboard. The key range will be edited.

5. In the Voice Edit window, holding Ctrl+Alt lets you select voices for editing. If 
more than one voice is assigned to the key, the voices will cycle around with 
repeated pressing of the same key.

6. To select multiple voices, you must use the Group feature. See Groups on page 93.
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Receive Program Changes
This check box selects whether or not MIDI Program Change messages from your MIDI 
controller or sequencer will be received or ignored by Emulator X. Place an X in the 
check box to receive program changes.

External Tempo Source
 Important! 

If External Tempo Source 
is set to external, the 
tempo control in the 
Voice Processing window 
will be “greyed-out” and 
non-functional.

This check box selects between internal tempo clock or MIDI clock as the tempo 
source. Emulator X uses a global master tempo for Tempo-based Envelopes, Tempo-
based LFOs, clock modulation and TwistaLoop. When this check box is selected, MIDI 
clock will be used for the global tempo and the tempo control in the Multisetup 
window will be disabled.

Preset Tempo Channel
The tempo of Emulator X can be specified in the preset so that selecting a preset on a 
specific MIDI channel changes the tempo. See Initial Tempo on page 82. This option 
selects the MIDI channel whose preset will be used for Tempo Control. This allows the 
proper tempo to be set when a Tempo-based or Twistaloop preset is selected.

For example, suppose you have this field set to channel 1 and the preset on MIDI 
channel 1 has its Tempo Control set to 122.22 BPM. When the bank is loaded, the 
Tempo will be set to 122.22 BPM. If you change the preset on channel 1, the tempo will 
change to follow the “Set Global Tempo” setting in the new preset.

If the preset on the Preset Tempo channel has its Tempo Control set to “Off”, (or if this 
option is set to “Off”) no tempo change occurs when the preset is selected.

MIDI Response
These controls allow you to customize the MIDI response of Emulator X to match your 
MIDI Controller or other instruments.

Velocity Curve
Incoming velocity values can be scaled by one of 24 curves to better adapt to your 
playing style or MIDI controller. Selecting “linear” leaves incoming velocity data 
unaltered. The shape of the selected curve is displayed in the window. Select the curve 
that works best for you.

Volume Curve
This is an adjustment to help match MIDI controller #7 volume response to other 
manufacturers’ equipment. Three curves are provided: Linear, Inverse Square or 
Logarithmic. The action of this control is displayed in the window.

Volume Sensitivity
This control allows you to modify the response curve for MIDI continuous controller 
#7 (Volume). This allows you to match Emulator X's response to other manufacturers’ 
equipment. Low numbers compress the volume control range, raising the volume level 
at lower controller #7 values. 
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Controllers
This is where you set up which MIDI Continuous Controllers Emulator X will receive. 
Match these controls to the MIDI continuous controller numbers that your keyboard 
or sequencer transmits. What the controllers actually do is programmable in each 
preset. See Modulation Cords on page 156.

As you can see, MIDI Continuous Controller numbers are assigned to letters (A-P) or 
labels (Pitch, Mod, Pressure, Pedal, etc.) in this screen. When programming a preset, 
these letter or name labels can be assigned to control various parameters such as filter 
frequency or attack time.

 For more information 
on MIDI Controllers...
See MIDI Channels & 
Real-time Controls on 
page 314.

The name labels such as pitch and mod wheels are so commonly used that they have 
their own assigned name, but these can also be freely assigned in any way you choose.

If you’re just getting started, it’s probably best to use the default settings. Press the 
“Use Default” button to restore the default settings shown above.

 

Preferences

Voice Processing Cords

(Options, Preferences Controllers)

MIDI Keyboard

Controller
Knob data

1. Select the CC 
numbers you 
wish to receive. 

2. Assign the controller 
letters to Synth 
destinations. 

Continuous controller numbers
are assigned Letters (A-P)
& Labels (mod wheel, etc.)

Controller Knob Assignment

The Controllers screen determines which CC numbers (knob controller data) the Emulator X will receive. What the knobs actually 
do to change the sound can be programmed differently for each preset (Voice Processing).
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Appearance Settings in Windows
Adjust the “Performance Options” in Windows to make the Preference buttons much 
easier to read and increase smoothness when dragging windows around the screen.

� To Improve the Appearance Settings:

1. Open the Windows Control Panel. (Start, Settings, Control Panel)

2. Select System.

3. Select the Advanced Settings tab.

4. Under Visual Effects, select Adjust for Best Performance.

5. Click OK.

Other Settings

Startup

• Load last bank - This feature automatically loads the last bank you had loaded 
whenever you start the Emulator X application.

Interface

• Select preset on active channel when editing in Multimode - When checked, 
selecting a preset for editing in the Tree selects that preset on the active channel 
in the multisetup. This is what you want if you’re editing a preset and playing a 
MIDI keyboard.

If you’re playing back a multi-timbral sequence and want to make a quick edit to 
a preset, you might want this feature Off so as not to alter your multisetup.

• Clear clip indicators after 10 seconds - This feature automatically clears the 
main output meter clip indicators. If this function is set to Off, the clip indicators 
will stay on until you manually click on them.

• Expand tree items when selected - If this option is checked, selecting presets 
from the Tree will automatically open the selected preset for editing. When 
unchecked, selecting presets from the Tree will select the preset for playing, but 
not open it for editing.

• Knob Tracking - This control allows the rotary knobs to be manipulated with 
either Rotary, Horizontal, or Vertical motion. The setting affects all rotary 
controls.
E-MU Systems 29



1 - Introduction & Installation
Setting up the Preferences
Paths

• Recording and temp file directory - This option allows you to choose the 
location where new samples will be stored when sampling.

• External audio editor - This option allows you to set the location of an external 
audio editor. The External Audio Editor is selected from the Sample Edit menu 
or the toolbar.  When the External Editor is selected, the current sample 
opens in the editing application you have selected. When you Save the edited 
sample in the external editing application, it is automatically transferred back to 
the Emulator X. You even have the option to Undo the external edit.

Undo

• History size - The maximum number of stored undo steps. 

• Clear history when saving - Clears all undo history when you save a bank. If 
you have this box unchecked, you can undo even when you save and re-open a 
bank.

• Clear now - Clears the undo history immediately.
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2 - Emulator Architecture

This chapter contains important background information about the organization of 
the various modules of Emulator X. Although this chapter doesn’t contain any hands-
on tutorials, this information is vital to your understanding of this ultra powerful 
instrument. Read This!

SSAMPLING

LOAD
& BROWSE
LIBRARIES

VOICES
& ZONES

VOICE
PROCESSING

PRESET
GLOBALS

MULTISETUP

OUTPUT

INTEGRATED
SAMPLE
EDITOR

SE

L

VZ

VP

PG

MS

ASAP

Load
Sample
SynthSwipe

Xplode
128 Layers
Crossfades
CC Windows
Key Switching
RT Windows
Cycle (flex)
Region Editor
Groups

PatchCords
Envelopes
LFOs
Function Gens
Morph Filters
Tuning/Amp
Templates
FX Sends

64 Chan Mixer
Aux FX
TwistaLoop
Tempo

Preset FX
Tuning Tables
Controller Setup

FILE-BASED
DSP

 Xtractor
Pitch Change
Reverse, etc.

BEAT
ANALYSIS

Sample Markup

Translator Tools
Librarian
Audition from Disk

LOOPING
TOOLS

Auto-Correlate
Crossfades
Multiple Loops

Organization of 
the Emulator X 

Modules
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A Modular System
You can think of Emulator X as a collection of sound organizing modules, all 
contained within the current bank. The following is a brief description of the five main 
elements of Emulator X’s hierarchy starting from the largest element, the Bank.

Bank
Before you can play Emulator X, you load a Bank of presets. The bank contains all the 
sounds you wish to use in a particular sequence or performance. If you need additional 
sounds, they can be added by simply dragging and dropping them into the bank from 
the system or library. Unneeded sounds can likewise be removed from the bank. When 
loading a bank, Emulator X only loads a small portion of the digital samples so bank 
load time is greatly reduced.

Saving
A bank’s data is retained only for as long you have the program open. Saving the bank 
to disk permanently stores the bank so you can access it next time you use the program.

IF YOU DO NOT SAVE A BANK, ANY CHANGES YOU HAVE MADE WILL BE LOST 
WHEN YOU OPEN A NEW BANK, OR CLOSE EMULATOR X!

 Whenever you have 
done enough work that 
you would hate to lose it, 
BACK IT UP! 

Use Save As… and 
rename the bank file to 
avoid losing valuable 
data.

Do not wait until the end of a session to save. Save your work periodically in case of 
power failure or some other unforeseen circumstance that might exit the program. 
Hard disks and computers are not infallible. All hard disk banks should be backed up 
periodically to another hard disk or other media. Should you improve the preset or 
sample later, you can always replace the original with the revised version. And if 
something goes wrong, the original will still be available to save you the ordeal of 
starting from scratch.

When you choose Save, (as opposed to Save As) only the edited presets, voices and 
samples will be written, saving time and memory.

When you choose Save As from the File menu, the entire bank—presets, voices and 
samples—are re-written to the hard disk as new files. This method, although somewhat 
wasteful of memory, ensures that all your samples remain bound with your bank.

When you save, you might be prompted with a dialog box telling you have unused 
samples. Choosing to delete the unused samples removes them from your hard drive, 
saving space and memory. This dialog occurs any time you have samples in your 
sample pool that are not assigned to any voices.

Undo/Redo
Almost every action you do with Emulator X can be undone. You can undo up to 500 
actions and this number is selectable under Preferences in the Options menu. See page 30.

Select Undo or Redo from the Edit menu or press Ctrl+Z (Undo) or Ctrl+Y (Redo) from 
the keyboard.
32 Emulator X3 Reference Manual



2 - Emulator Architecture
A Modular System
Emulator X Bank

Sample
01

Sample
02

Sample
03

Sample
04

Sample
05

Sample
06

Sample Filter Amp

S01S01

Filter Amp

S03

S02

S04 S06

Positional
Crossfade

Velocity Crossfade

S05

Single Sample
Voice

Multi

Preset

Voices

Samples

Voice

Voice

Multisample
VoiceVoice

Key Map

MIDI
Ch 1

Key Map Key Map

Velocity or
Realtime
Crossfade,
CC X-Switch

MIDI
Ch 2

MIDI
Ch 3

MIDI
Ch 4

MIDI
Ch 32

MIDI
Ch 64

Multi-
Setup

P
re

se
t

P
re

se
t

P
re

se
t

P
re

se
t

P
re

se
t

P
re

se
t

Multi-Sample Voice
(Multisample)
E-MU Systems 33



2 - Emulator Architecture
A Modular System
Multisetup
A Multisetup is like a map which assigns a preset, volume, pan position and output 
routing to each of the 64 MIDI channels. Aux FX and effect bypass controls are also 
included in a Multisetup. Multisetups can be saved and recalled for use with a 
particular song or sequence so that all the MIDI channels play the proper preset.

 A Preset is the same 
as a MIDI Program.

Preset
A Preset is one complete keyboard setup controlled by one MIDI channel. Presets are 
composed of multiple voices. The assignment of voices to keyboard keys is completely 
flexible.

Voice
A Voice is one complete sound, containing one or more samples with keyboard and 
velocity mappings and all programmable synthesizer parameters. Voices can be 
assigned to a single note on the keyboard, or transposed to cover a wider keyboard 
range.
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Sample
A Sample is an individual digital recording with a name, sample rate and looping 
information. 

Flexible Architecture 
Emulator X allows you great flexibility in the way you construct presets. Consider this 
— you can assign multiple samples to the keyboard inside a voice or assign single 
sample voices to the keyboard.

Unless you specify otherwise, only one sample is assigned per voice. In this case you 
would assign voices (and the single sample each one contains) to the keyboard and 
create presets. On the other hand, you may want to create multisample voices before 
you start designing presets and treat the voice as your finished sound. In this case, the 
Preset can crossfade, layer or switch between multiple complex voices.
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Preset Diagram
The diagram below illustrates the concepts of a preset and voice. 

Voices
A voice is a complete sound that can be assigned to a range of the keyboard. A sample 
is the part of a voice that generates the actual sound. You can think of a voice as a 
complete instrument consisting of one or more samples, which can then be used as a 
building block in constructing more complicated presets.

A voice consists of one or more samples, a dynamic filter, a dynamic amplifier, three 
6-stage envelope generators, three 64-stage function generators, two multi-wave 
LFOs and up to 36 modulation routings called “Cords” to connect everything 
together.

Preset A complete keyboard layout with unlimited voices.

Voice A complete synth sound containing a single sample or a Multisample.

Sample An individual digital recording with loop information.
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When you record a sample into the Emulator X, a new voice is typically created for each 
new sample. In this case, each sample will have its own complete set of synthesizer 
parameters.

Multisample Voices
 A voice can contain a 

single sample or multiple 
samples, whichever you 
prefer.

In another scenario, you might record several samples of an instrument (such as a 
piano), then place them into the same voice in order to share the same set of synthe-
sizer parameters. If a voice contains more than one sample, this multiple sample object 
is called a “Multisample.” A diagram of a multisample voice is shown below.

Normally these samples would be placed side by side on the keyboard as in the 
diagram above. You assign the sample to a range by setting the original key, (which is 
usually the original pitch of the sample) a high key and a low key. The number of 
samples needed for a realistic emulation varies with the instrument, but in general, 
“more is better.”

S27

Multisample Voice

S28

S29

S30 S32

Positional
Crossfade

Velocity Crossfade

S31

Each Sample:
Orig. Key
Tune
Volume
Pan
Key Range/Fades
Velo Range/Fades

Sample 28 Sample 30Sample 27
Loops, Samp Rate Loops, Samp Rate Loops, Samp Rate

Multisample voices are designed to arrange groups of samples into one manageable entity. 

The window below shows an opened multisample. The key range of the multisample 
can be used to limit the keyboard range of the samples contained within it. A multisampled 
voice is treated just like a single sample voice.
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When a sample is taken, it can be automatically placed into a voice with one sample. 
You could also manually place the voice (and its sample) on the keyboard if you wish. 
If more than one voice is assigned to the same range, then pressing a key in that range 
plays all the voices assigned to that range. Voices assigned to the keyboard can be cross-
faded by their position on the keyboard, or the key stroke velocity. Voices can also be 
switched or faded depending on the value of a realtime controller such as a 
modulation wheel, an LFO or an envelope generator.

The Sample
Loading in any sound, in mono or stereo, creates a sample, the raw material with which 
the Emulator X works.

The term sample commonly means two different things:

In this manual, we’ll assume sample means the complete recorded sound unless 
indicated otherwise.

You can modify a raw sample in several ways. A sample can be transposed up or down 
in pitch to cover a particular range of the keyboard making it unnecessary to record a 
sample for every key. Sample editing might consist of Looping a sample (allowing even 
short samples to play indefinitely), Truncating (cutting off unneeded parts of a sample), 
or any of a number of digital processes that actually change the raw sample data. 

The Original Key assignment determines the pitch at which the sample will be 
played back. Therefore it’s important to map your samples to the proper original key.

You can also name samples. It’s usually a good idea to include the original pitch in the 
name so that you can place it on the keyboard later at the proper pitch. 

You can have any number of samples in a bank. The number of possible samples is 
only limited by the size of your computer’s hard disk.

• A digital recording of a complete sound, or

• Each snapshot of the sound that makes up the complete sample. 

Original
Key

Low
Key

HighOrigLow HighOrigLow

High
Key

S02 Piano D3 S03 Piano D5S01 Piano A0

Sample Sample Sample
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TwistaLoop™
TwistaLoop is a tool that automatically analyzes a sample by dissecting it into its 
rhythmic components, making it easy to select multiple loop points and regions. Twist-
aLoop offers total control over tempo, using real-time audio time expansion/
compression.

You can play back analyzed samples at a custom speed, or in time with Emulator X’s 
clock (or an external clock source).

Once you create loops from an analyzed sample, you can use them in a variety of ways:

• Change the playback speed of any loop.

• Choose which loops are repeated when played back.

• Set up a continuous controller to change in real time which loop plays.

• Sync your loops to Emulator X’s master tempo, or to an external tempo source, 
such as a VST host.

• Play different beats or bars from the same sample.
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Exploring the Tree
In this section you’ll learn how to navigate around Emulator X using the Tree. Don’t 
worry if you don’t know what everything does just yet. Everything will be explained 
later on.

1. With the Emulator X application running, a bank is loaded by selecting Open from 
the File menu. Click on the Presets Folder in the Tree and a screen, similar to the 
one shown below, appears.

 E4/E3 CDs use a 
proprietary format and 
can only be read using 
SCSI/ATAPI drives. They 
cannot be read using 
firewire and USB drives.

The Tree is the section shown on the left of the screen. There are three tabs at the 
bottom of the Tree labeled Sampler, System and Library.

The
Tree

Sampler/System/Library Tabs

Sampler 
Bank

Presets 
Folder

Toolbars

Samples 
Folder

Multisetup 
Folder

Presets

Open 
Preset

List View

Sampler Allows you to see the contents of the current Emulator X bank.

System

This tab gives you access to your entire computer system: PC, hard disks, 
CD-ROM drives, network, etc. Presets, Samples and Multisetups can be 
browsed, then Merged into the current Bank. Load Emulator 4 
banks from this tab.

Library

The Library shows you all Emulator X and related files, wherever they 
may be located on hard disks, CD-ROM or network. Presets, Samples and 
Multisetups can be browsed in the Library, then Merged into the current 
Bank.
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Multisetup Page
The Multisetup is the top level of the Emulator hierarchy and is the place where you 
choose and assign presets to each of the MIDI channels.

 Note: When 
sequencing, you can also 
include program changes 
in the sequence rather 
than using a Multisetup. 
This is often best, since 
the program changes will 
then be part of the song.

A multisetup assigns a preset, volume, pan position and output routing to each of the 
64 MIDI channels. Multisetups can be saved and recalled for use with a particular song 
or sequence so that all the MIDI channels play the proper preset.

Click on the Emulator X icon to display the Multisetup page. 

There are five views of the Multisetup page. The Multisetup View buttons 
change the current view. The Single channel view is shown below.

• Single..................... Displays the preset for the currently selected MIDI channel.

• Channels 1-16....... Displays the preset, volume and pan for MIDI channels 1-16.

• Channels 17-32 .... Displays the preset, volume and pan for MIDI channels 17-32.

• Channels 33-48 .... Displays the preset, volume and pan for MIDI channels 33-48.

• Channels 49-64 .... Displays the preset, volume and pan for MIDI channels 49-64.

See page 69 for a complete description of the Multisetup screen.

Click
Here

MIDI
Controllers

Preroll
RAM Used

CPU & Disk 
Usage Meters

Samples
Playing

Master 
Volume

Aux FX 
Display 

Tabs

MIDI 
Mode
Select

Multisetup View 
Tabs

Single Channel View

Current 
Channel
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Changing Presets (from Single View) 
 Note that Single View 

only changes the display 
and does not affect the 
currently selected MIDI 
mode (i.e. Omni, Poly or 
Multi).

Single View is the default view when you first run Emulator X. This view is convenient 
for performing live or when you’re only playing one preset at a time. All the main 
parameters for the selected MIDI channel are displayed in Single View and a conve-
nient Category mode allows you to quickly select presets in a certain category. A close-
up of the current channel settings is shown below.

� To Select Presets by Number

1. Click on the Preset Increment/Decrement buttons to move up or down the presets 
by number.

2. Highlight the Preset Number field and type in the desired preset number.

� To Select Presets by Category

1. Click on the Select Category button. 
The pop-up dialog box at right 
appears.

2. Select the desired preset category, then 
press OK.

3. Choose Select By Category from the 
Single view screen above.

4. Use the Increment or Decrement 
buttons to select presets. Note that 
only presets of the selected category are 
selected.

 The Bank/Program 
Display shows the Bank 
and Program number 
you would use to select 
the preset from a 
sequencer.

Preset
Inc/Dec

Main Output 
Select

Select/View
Preset

Number

Channel
Volume

FXA/FXB
Enables

Aux Output 
Enable

Channel
Pan

Selected 
Category

Bank/
Program 
Display

Select All or Select 
by Category

MIDI Channel
Inc/Dec

Select
Category

Select/View
MIDI Channel

Preset
Name

Single View Close-up
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� Changing the Current MIDI Channel
The Current MIDI Channel is simply the MIDI channel you are currently working 
with. To change the current MIDI channel, simply increment or decrement the 
channel number using the buttons, or click on the channel number and type in the 
desired number. 

� To Find the Selected Preset in the Tree
In a huge bank like the Proteus X Composer, you can jump immediately to the 
preset by double-clicking in the Preset Name Display. The Tree expands to that 
preset, and the view switches to the Preset Globals view.

Multi Channel View

Press the Multisetup View 1-16 tab to view channels 1-16.
This page view is particularly useful when sequencing as you can see 16 MIDI channels 
at once. Note that the Output Display button is now active. Tabs 17-32, 33-48, 49-64 
are identical to this page and allow you to access these additional MIDI channels. See 
also “4 - Multisetup / Preset Globals” on page 69.
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Changing Presets (from the Multichannel view)
Play your MIDI keyboard and note that one of the MIDI activity LEDs comes on. This is 
the channel on which your MIDI keyboard is transmitting. If you don’t see MIDI 
activity, check your MIDI connection and make sure MIDI is set up properly in the 
Preferences menu. See page 28.

� To Audition and Select Presets

1. Click once on the Preset Select button on the channel used by your MIDI 
keyboard. The complete list of all presets in the bank appears.

2. Click once on a preset to audition it. Play your keyboard to hear it.

3. Try out a few more presets. When you find one you like, double-click on it to select 
it and return to the Multisetup screen.

4. Change the current channel by clicking on the number to the left of the preset. The 
number you selected turns red.

5. Play the floating keyboard (Select Keyboard from the View menu). Notice that the 
MIDI Activity LED of the current preset now plays along with whatever sound is 
selected for that channel. (Your MIDI keyboard still plays on the channel to which 
it is set.)

6. Change the channel on your MIDI keyboard then play it. Emulator X now plays the 
preset on that channel.

 Selecting “None” in 
the Preset field, disables 
the MIDI Channel.

� Selecting Presets from the Tree

1. When you click on a preset in the tree, you have just selected it for the current MIDI 
channel. This action also calls the Preset Global page.

2. To go back to the Multisetup page click the back arrow or click on the Emulator X 
icon at the top of the tree.

� Changing the Current MIDI Channel

1. The Current MIDI Channel is simply the MIDI channel you are currently working 
with.

2. To change the current MIDI channel, click on the channel number in the Multi-
setup page. The selected channel number turns red. Note also that the channel 
number at the bottom of the window changes to reflect the current channel.

Adjusting the Controllers
Each preset has a set of 16 continuous controllers (CC’s) which are used to adjust and 
control the sound as you play. Your MIDI keyboard may have several knobs or sliders 
that are transmitted over MIDI. These can be used to control Emulator X if you match 
the CC numbers your MIDI keyboard transmits to the same CC numbers on 
Emulator X. These global settings are located under Options, Preferences, Controllers. 
See page 28 and page 314 for additional information about MIDI controllers.

� To Modify the Sound using the Controllers

1. Play your MIDI keyboard as you adjust the controller knobs on the screen. Notice 
that the sound changes. If the sound doesn’t change, make sure the current preset 
(red number) is the same one that your keyboard is playing.

2. If you have controller knobs on your MIDI keyboard and have set up the 
Controllers (Options, Preferences, Controllers) to match your keyboard, you can 
use these knobs to modify the sound. Notice that the screen knob follows the 
movement of the hardware knob.
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3. Try changing the filter type. Click on the selector to the right of the filter name and 
select one of the 55 different filter types. 

4. Adjust the Tone and Presence controls while playing the keyboard to hear your 
changes.

5. Change the Volume and Pan controls for the MIDI channel you are using. These 
settings can be adjusted remotely using MIDI controller #7 (volume) and 
controller #10 (pan).

6. If you want to save the changes, you must set the Initial Controller Amounts in the 
Preset Globals page to match the settings you made in the Multisetup page, then 
save the bank.
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Create Your Own Custom Bank
It’s easy to create your own custom sound banks by simply “dragging and dropping” 
the presets or samples you want onto the Emulator X icon in the tree.

� To Create a New Custom Bank

Locate the Presets on your Computer

1. Select New from the File menu. This creates a new empty bank. (You can also 
merge presets or samples into an existing bank if you wish.)

2. Select the System Tab. The Desktop icon will appear in the tree.

3. Locate the presets you wish to include in your new bank. These will be located in 
the “Creative Professional” folder located in “Program Files”.

 The included CD-
ROMs contain several 
other great banks of 
sounds. Run the installer 
application on the library 
CDs to install these banks 
on your hard disk.

Audition the Presets

4. After you have located the Presets folder, click on the Emulator X icon in the Tree 
to view the Multisetup page.

5. Find a preset in the Tree and Right-click over it. A pop-up menu appears with two 
options, Audition and Merge.

 Tip: You can also 
audition samples or 
presets from the library.

6. Select Audition (or press “A” on your computer keyboard). Notice that the preset 
name is now flashing in the Multisetup screen.

7. Play your MIDI keyboard to audition the preset from the hard disk.

 Presets that reside in 
.E4B or .EXB disk files can 
be auditioned from disk.

8. Right-click again and select Stop Audition (or press “S” on your computer 
keyboard). The preset name stops flashing in the Multisetup screen.

9. Continue auditioning until you find a preset you like.

System Tab

Click to 
Open

Click to 
Open
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Merge the Preset

10. When you have found a preset you want to include, Right-click over it in the Tree 
and select Merge from the menu (or press “M” on your computer keyboard). The 
preset is added to the current bank. 

Another Method of Merging Presets

11. Simply click (left mouse button) and drag the preset over the Emulator X icon at 
the top of the tree. The cursor changes to a plus sign as you pass over the icon. 
Release the mouse button and a pop-up progress bar will inform you that the 
preset is being loaded.

12. If you change your mind and don’t want to merge the preset after all, choose Undo 
from the Edit menu to un-merge the preset.

Continue to Create the Bank

13. Continue to add presets to your new bank.

14. Save the bank when you are satisfied.

� Alternate Method using the Librarian to find Presets

1. Select the Library Tab instead of the System Tab in step 3 above.

2. If you haven’t done so already, Update the Library.

3. Choose presets from the Library, then drag and drop them on top of the Emulator 
X icon at the top of the tree.
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Load a New Bank
 Note: Emulator 4 

banks are accessed and 
loaded from the System 
Tab, rather than from the 
File menu.

Load up a new bank in preparation for the next few examples. Load the Proteus X 
Composer bank located in your Emulator X folder.

1. Select Open from the File menu, then locate Proteus X Composer and click Open.

Opening a Preset
A preset is a complete keyboard setup for one MIDI Channel. Think of a preset as one 
complete sound, which usually contains multiple voices and samples.

1. Click on the Preset Folder in the Tree to show all the presets in the bank.

2. Click the Show Details button. The details of the presets are now shown. The sort 
buttons allow you to sort the presets by name. ID number, bank/program number, 
or category. Click on the button again to sort in reverse order.

3. Clicking on the plus sign (+) next to the Preset folder or double-clicking on the 
folder itself opens the folder and displays the bank’s presets in the tree.

4. Clicking on the plus sign (+) next to one of the preset icons displays the sub-
modules of the preset: Voices & Presets, Links, Voice Processing.

Click 
Here
To Show All

Click on a 
preset icon to 
go to Preset 
Global.

Double-click 
to open the 
Folder.

Sort Buttons

Show Details 
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 Please refer to 
chapter  “2 - Emulator 
Architecture” on page 31 
for complete 
explanations of the sub-
modules.

5. Open the preset “And Voice” by clicking on the plus (+) sign next to the folder. 

6. Next, click on the Voices & Zones icon. The Key Window appears. The blue bars 
show that the two multisamples in this preset are mapped across the entire 
keyboard.

7. Click on the Mix/Tune tab at the top of the window.

8. There are two multisampled voices in this preset. Adjust the volume slider for each 
of the voices as you play. Now try playing with the pan position and transpose. 
Before you leave this window, turn up the volume controls on both voices.

� Exploring the Key and Velocity Windows

1. Click the Key Win tab again.

2. Click and drag the ends of the blue bars so they look something like the screen 
shown above. The settings don’t have to be exact.

3. Play the keyboard from the lowest key to the highest. Voice 1 plays at the low end 
of the keyboard and voice 2 plays on the high keys.

4. To return both voices to their original positions, select Edit, Undo from the 
toolbar. Select Undo again until both voices are assigned to the entire keyboard.

Velocity Switching and Crossfading

5. Click on the Vel Win tab. The following window appears:

Submodule Function

Voices & Zones Assign voices and multisamples to the keyboard, which can be 
switched or crossfaded by key position, velocity or controller setting.

Links Multiple presets can be layered, switched or crossfaded across the 
keyboard,

Voice Processing Synthesizer voice parameters including filters, LFOs, envelopes, 
function generators and cords.

Step 8. Alt-Click here.
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6. This page controls the voices using key velocity or how hard the keys are played. Set 
the bars something like the screen above.

7. Play the keyboard anywhere, but begin playing softly and gradually play harder. 
Notice that the choir (voice 2) plays with lower key velocity and switches to piano 
(voice 1) when you play hard. You’ve just created a velocity cross-switch.

8. Alt-click the end point of the bar in voice 1 and drag it to the left. The color 
intensity of the bar fades. The fade in color is analogous to volume. the darker the 
color, the louder the volume for a certain velocity.

9. Drag the fade points of the two voices so they look something like the window 
shown below.

10. Play the keyboard anywhere, but begin playing softly and gradually play harder. 
Notice that the choir plays with lower key velocity and fades into piano as you play 
harder. You’ve just created a velocity crossfade.

� Add a Voice

1. Select Preset, New Voice from the toolbar. A new, empty voice appears below voice 
two.

2. The label area of the new voice is blank. Click on the selection box to the right of 
the empty label area to bring up the entire list of samples in the bank.

3. Select sample 0350 SectionStringC3 by double-clicking on it. You’ve just assigned 
a sample to the voice you created.

4. Play the keyboard and now you have orchestral strings as well.

� Delete the Voice

1. Select the voice you just created by clicking once on the sample name or number 
to the left of the name. The number turns red.

2. Select Preset, Delete Voice from the toolbar. The voice has now been deleted.
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Examine a Voice
Each voice has its own synthesizer section (called Voice Processing) to process the raw 
samples. You can process each voice separately or select all voices to be processed in 
the same way.

1. Go to the Tree and click on preset P0015 Dana-him. Play the keyboard. You 
should be able to hear the preset.

2. Open the preset by clicking on the plus sign(+), then click on the Voice Processing 
icon.  The Voice Processing page shown below appears.

 See Groups on 
page 93 for detailed 
information on how to 
select groups of voices.

3. Near the top of the screen near the keyboard you’ll see the Group Selector. Set this 
to All, to select all voices in the preset.

4. Feel free to explore the synthesizer section. The filter section is probably a good 
place to begin. Change the filter type, then adjust the frequency and Q controls as 
you play the keyboard. Note that the filter response display changes as you change 
the filter settings.

Cords
One reason synthesizers are able to generate such complex sounds is because most, if 
not all, of their processes can be placed under automatic control. Here’s an example.

5. Tired of turning the filter frequency by hand? Let’s program one of the LFOs to do 
it. Choose Cord #8 and set the left selection box to LFO 1 ~.

6. You’ve just connected one end of a Cord. Like all cords, you’ve got to connect both 
ends for it to do anything. Connect the other end of the cord to Filter Frequency.

Step 3.
Select All

Step 5
Set to LFO 1 ~

Step 6
Set to Filter Frequency
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7. Each Cord has its own attenuator which controls “how much” signal goes through 
the cord. Turn the knob in the center of the cord all the way to the right (+100%).

8. Now set the filter frequency knob about 1/3 of the way up and play a note on the 
keyboard. You should hear the filter being turned up and down automatically. 

 Tip: Any control can 
be set to its default value 
by pressing Alt + left 
mouse click over the 
control.

9. Change filter types and adjust the filter frequency if you don’t hear the filter being 
modulated.

10.  Adjust the Frequency of LFO 1.

11. Change the Shape of LFO 1. (You’ll have to re-key to hear the new waveform.)

Modulating Cords
In Emulator X even the Cords themselves can be controlled by other modulation 
sources or controls. Let’s use your keyboard’s mod wheel to control the amount of LFO 
to filter modulation.

12. Cord 0 already has the Mod Wheel assigned as an input. Set the output of Cord 0 to 
go to Cord 8 Amount.

13. Turn up the amount of Cord 0 to 100%.

14. Set the amount of Cord 8 to 0% (off). (You’re going to turn it up with the mod wheel.)

15. Now play a note and move the Mod Wheel of your keyboard up. (Most keyboards 
have two wheels or controllers. One bends pitch and the other is the modulation wheel.)

Experiment

16. Try setting the output of Cord 11 to Pitch. Now try changing the LFO Shape. Now 
it’s much easier to hear the different LFO wave shapes.

Wipe the Slate
The preset might be a little messed up after your experiments. It’s good to know that as 
long as you don’t Save the bank, none of the original data is destroyed. If you want to 
get back to the original preset, simply load the bank again.

You can also Undo any changes you made by repeatedly clicking the back arrow
button (=).
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Examine the Samples
Samples are the digital recordings which are the basis of an Emulator X sound. As 
you’ve seen, samples can be layered and switched or treated by the Voice Processing 
functions to create entirely new sounds, but the actual samples can also be modified 
and sculpted.

A single preset may use over a hundred samples and a bank may contain thousands of 
individual samples. Let’s take a look.

1. Click on the plus sign (+) next to the Samples folder to open the folder and 
display the samples in the bank. (If the Preset folder is already open, you can click 
on the minus sign (-) next to the folder to close it and clean up the tree.)

2. Click on any sample to display its waveform.

3. The transport controls are located in the toolbar. If you don’t see them, right-click 
an empty area in the toolbar and select Sample Transport. Click the Play button  
to listen to the sample.

4. Press the Stop button  to stop playing.

5. Click on the larger magnifying glass of the Horizontal Zoom buttons. The time-
base of the waveform is magnified allowing you to see more detail. Continue 
clicking and eventually you’ll reach maximum magnification. The individual 
sample measurements are shown here as dots. If the sample rate is 44.1 kHz, there 
will be 44,100 of these dots per second of sound.

6. Click repeatedly on the smaller magnifying glass and the horizontal magnification 
decreases.

7. Click the Zoom All button, and the view zooms to show the entire sample.

8. The Vertical Zoom buttons allow you to zoom in or out on the vertical axis. None 
of the zoom buttons change the wave in any way. They’re just display controls.

Horizontal Zoom

Vertical Zoom

Zoom All
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Using DSP
There are a number of DSP or digital signal processing functions that you can perform 
on the raw samples. Samples can be spliced together, merged, time-stretched, reversed 
and on and on.

Time Compression/Expansion

1. Select sample Riff Trip Gb. Press Play on the transport controls to check it out.

2. Suppose you wanted to change the tempo to fit into your song. The time 
compression/expansion DSP tool can do this for you. Select Time Compress from 
the DSP toolbar.  The following dialog box appears.

 Note: The original 
tempo shown may not 
reflect the actual tempo 
of the sample. You have 
to set this value manually 
in order to have the new 
tempo accurately 
calculated.

3. Change the ratio. Ratios below 100% compress or shorten the time. Ratios above 
100% expand or lengthen the time. Note that the tempo and length fields change 
to show the new length and tempo.

4. Press OK to change the time scaling. Press Play again and note the change in tempo 
of the sample.

Loop Play

5. Turn on Loop Play  on the Transport toolbar. Now the sample will continue to 
loop until you press Stop.

Reverse

6. Select Reverse from the toolbar.  The sample is immediately reversed.

7. Press Play and hear the sample played backwards.

Copy and Paste

8. Select the entire sample by pressing the Select All button  on the DSP toolbar.

9. Choose Copy from the Edit menu. The sample is placed on the clipboard.

10. Click anywhere on the waveform display to deselect the sample, then position the 
cursor at the very end of the sample by pressing the Go To End button in the 
transport section of the toolbar. The flashing cursor line is now positioned at the 
end of the sample.
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11. Choose Paste from the Edit menu. The following dialog box appears.

12. Insert mode is already selected and it’s the mode we want. The clipboard contents 
will be inserted at the cursor location, extending the length of the sample. Press 
OK.

13. Now position the mouse pointer at the very end of the sample. Press the shift key 
down and click the left mouse button. The section of wave you just pasted is 
selected.

Step 13. 
Position 
pointer here.
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Pitch Shift

14. Select Pitch Shift from the DSP toolbar. The following dialog box appears.

15. Set the Tuning interval. 100 cents equals one semitone. Try a setting of 700 cents or 
a perfect fifth.

16. Select Constant Time. This setting changes the pitch but will leave the rhythm 
constant. Don’t change the algorithm. See page 192 for more information about 
the pitch change options.

17. Press OK to change the pitch.

18. Click on the Loop Start button in the Transport Controls to set the cursor to the 
beginning of the sample and press Play.

Experiment!
 All the DSP tools are 

calculated in 32-bit 
precision math.

Please feel free to try out all the other DSP processes such as Transform Multiplication. 
Be sure to read the Editing a Sample chapter (page 169) to learn all about these 
powerful tools, but you should actually try them out as you read.

Remember that nothing is made permanent until you save the bank, so experiment 
as much as you like without fear.

Samples can also be exported as WAVE or AIFF files using the Export function in the 
Sample Edit menu. This allows you to use other sound processors in your computer. Exter-
nally processed samples can be re-imported using the Import option in the File menu.

Save and Save As
When you choose “Save As” from the file menu, the entire bank—presets, voices and 
samples—are re-written to the hard disk. This method, although somewhat wasteful of 
memory, ensures that all your samples remain bound with your bank.

Be sure to rename your bank when using Save As… to save an edited bank, otherwise 
you may overwrite data you wanted to keep. When you choose Save, (instead of Save As) 
only the edited presets, voices and samples will be written, saving time and memory.

When you save, you might be prompted with a dialog box telling you have unused 
samples. Choosing to delete the unused samples removes them from your hard drive, 
saving space and memory. This dialog occurs any time you have samples in your 
sample pool that are not assigned to any voices.

Emulator X Bank Structure
Banks are comprised of two distinct entities which need to be kept in the same folder 
on your computer hard disk. The Sample Pool contains the raw sample data used. The 
Bank file contains all the voice, preset and multisample data that makes up the 
Emulator X bank.
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Building a Preset from the Ground Up
In this tutorial we’ll start with an empty bank and create a complete preset using some 
of the samples in your library. Along the way you’ll learn:

• How to locate samples from your library and load them into the bank

• How to place samples on the keyboard

• How to stretch samples across the keyboard

• How to apply various types of audio processing to the samples

� Locate Samples and Load them into the Bank

1. Make sure you have either the Proteus Composer or Proteus X Composer bank on 
your hard disk.

2. Let’s start with a clean slate. Select New from the File menu.

3. The easiest way to find samples is using the Library feature. Click the Library Tab at 
the bottom of the Tree.

 Important: If the 
Librarian doesn’t find the 
samples, select Update 
Library from the File 
menu. (You need to have 
Proteus X Composer bank 
in your System.)

4. Select Vocal as the Category, then type “aah” in the ‘Filter by Name’ box. Click 
Search.

5. Clicking on the Samples Folder in the Tree displays the expanded list in the main 
window.

 Tip: Select multiple 
continuous samples by 
pressing on the Shift key 
while selecting items. 
Select multiple non-
continuous samples by 
pressing the Ctrl key 
while selecting items.

6. The window should look something like the one shown above, although you may 
have more samples shown, depending on the size of your sample library.

7. Locate the following samples: Aahs A2, Aahs C3, Aahs C4, Aahs D#2, Aahs D#3, 
Aahs D#4, Aahs F#3, Aahs F6.

8. Select the samples listed above and while holding the mouse button, drag and drop 
them on top of the Emulator X icon above the Tree.

Library Tab
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9. Click the Sampler Tab at the bottom of the Tree, then double-click the Samples 
Folder to open it. You’ll notice that the samples have now been added to the Bank.

10. Click on one of the Sample icons in the Tree.  The Sample Editor appears with 
one of your Aah waves displayed.

11. The sample is of a fixed length. So that the sample will play for as long as you hold 
a keyboard key, the sample is looped. Notice (but don’t change) the Start and End 
Loop Markers.

12. Looping is a subject for another tutorial. At this point, let’s move on to the next 
step in building a Preset, and place the samples on the keyboard.

Time to Save?

13. It’s time to save whenever you have done enough work that you’d HATE to lose it. 
Now would probably be a good time.

14. Select Save As... from the File menu, choose a location where you can find it again 
(the desktop?), and press Save. Don’t you feel better?

Drag and Drop

Loop Start 
Marker

Loop End 
Marker
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� Placing the Samples on the Keyboard

1. Click on the Presets Folder in the Tree, then select New Preset (Ctrl+W) from the 
Presets menu. A new preset appears in the Tree.

2. Select Voices and Zones in the new preset. The Voices and Zones page appears.

3. Select Aahs A2 from the list in the Tree, then drag and drop it anywhere in the Key 
Win area as shown below.

4. A new voice named Aahs A2 appears in the window. A green bar appears across the 
entire keyboard range indicating that the sample is transposed across the entire 
keyboard. The red bar shows the original key. Because the original pitch of the 
sample (A2) is included in the name, Emulator X  is smart enough to place the 
original pitch on the proper key.
• Important: If the original key of a sample 

is on the wrong key, the sample will be 
out of tune. The original key selection 
field is always visible regardless of which 
tab is selected.

5. Play the keyboard. Since the sample is trans-
posed over the entire keyboard range you can play it polyphonically at any pitch. 
But as you play in the upper part of the keyboard, notice that the sound doesn’t 
sound so natural anymore. This is a result of the sample transposition. To 
overcome this problem we add more samples.

6. This time, let’s use a different method of assigning samples. This method is useful if 
the original pitch is NOT included in the sample name. Select Aahs D#2 from the 
list in the Tree, then drag and drop it over the D#2 key on the keyboard at the 
bottom of the window.

7. A new voice named Aahs D#2 appears in the window on note D#2.

8. Continue placing the rest of the samples. Practice using both methods.

9. Select the Key Win tab. This window graphically displays the current sample to 
keyboard mapping. Depending on the way you placed your samples, the display 
might look something like this. The red bars show the original keys.

Original Key Selection

Drag and Drop

Original Keys

Empty Voice
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10. Notice that the top voice has no sample. This empty voice was created when you 
created the Preset. We won’t need this voice and can get rid of it. Select the empty 
voice by clicking on it. It becomes highlighted in red. Press the Delete key on your 
keyboard to delete it.

11. Also notice that the original keys of our voices are all over the place. Let’s rearrange 
the voices by the position of the original keys. From the Preset menu, select Sort 
Voices, By Original Key.

12. Now the voices should be arranged like the screen below.

13. Next, we need to give each sample its own keyboard range. Click on the original 
key of Aahs D#2 and drag it all the way to the left.

14. You can also adjust the key range using the key range controls in the lower right 
corner of the window. Click the inc/dec buttons and note that the graphic display 
follows. The Key Range display shows the currently selected voice. The Key Range 
Controls allow you to select multiple voices and change them all to a single value if 
so desired.

15. Adjust the range of all your voices until the display looks like the one below. Make 
sure that none of the voices overlap each other and that all the keys are covered.

Click & Drag

Key Range
Controls

Inc/dec 
buttons
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16. Play the keyboard. The choir sounds much more realistic, especially in the middle 
range.

Time to Save?

17. It’s time to save again. This time just select Save (Ctrl+S) from the file menu.

� Apply Voice Processing
Now that we have our samples arranged, we can continue to refine our preset using the 
filters and amplifier.

1. Select the Voice Processing page by clicking the Voice Processing icon in the Tree. 

 The Voice Processing page appears.

2. In the Emulator X, each voice is a complete synthe-
sizer with its own set of parameters. In most cases, 
you’ll want to treat the voices as a single synthesizer. 
Select All voices from the Group box above the 
keyboard in lower part of the window. 

• Important! Selecting the proper voices to modify 
is a fundamental operation and it’s easy to get confused. If the synthesizer 
controls don’t seem to be working correctly, check to make sure you have the 
correct voices selected.

Select All

Amp
Envelope

Attack 1 Knob Release 1 Knob
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Amplifier Envelope

3. Our choir sounds pretty good, but the sound turns on abruptly like an organ. Let’s 
increase the Attack Time a little so that the voices swell up when we press the keys. 
The Amplifier has its own dedicated Envelope Generator and it’s already selected. 
Set the Attack 1 knob to about .5 seconds.

4. Much better! Let’s increase the Release Time so that the sound dies away slowly 
when the keys are released. Set the Release 1 Time to about 1 second. Heavenly!

Clear the Cords

5. Before we begin, take a look at the Cords section for 
a second. Cords are the virtual wires that connect 
everything together in the Emulator X. A bunch of 
Cords are already connected to their default connec-
tions. We don’t want or need these Cords, so let’s 
get rid of them.

6. Right-click anywhere inside the Cords section. A 
pop-up selection box appears. Select All Off to clear 
all the Cords. Poof!

Phaser Phun

7. Now let’s add a filter effect. Select Phaser 1 from 
the Filter Type menu. This filter simulates a tradi-
tional phase shifter by creating two deep notches 
in the frequency spectrum. Leave the Frequency 
and Resonance settings at 0.0 for now.

8. Let’s add a bit of movement to the filter by 
connecting an LFO to the Filter Frequency. An LFO 
or Low Frequency Oscillator is simply an oscil-
lator that repeats slowly. The LFOs have a range of  
.08 Hz (12.5 seconds per cycle) to 18 cycles per 
second.

9. Click on the fields to select source and 
destination for the cord. Set-up Cord 1 as 
shown at right with LFO 1+ as the source, 
Filter Frequency as the destination, and 
an amount of around +40.00.

10. A block diagram of the connection you 
just made is shown below.

11. Play the keyboard and you’ll hear the phaser filter sweeping the two notches across 
the frequency spectrum.

Freq.

40

Q

Filter

Cord

LFO

Phaser 1
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12. Let’s tweak the LFO a bit. Select the LFO/LAGS page by clicking on the LFO/Lags 
tab. Next, set the Frequency to about 0.9 Hz and change the Shape to Sine.

13. If you have trouble adjusting with the knob, try typing the value into the numeric 
field. One the numeric field “has the focus” you can use the up/down keys on your 
computer keyboard to increment or decrement values.

14. Now the effect is a lot more subtle. Increase the Filter Frequency to about 25 to 
“zero-in” on the main group of frequency components. Feel free to tune the filter 
to your own taste. You can also adjust the Cord Amount along with the Filter 
Frequency to get the effect you want.

15. The Resonance control (Res) adds resonant peaks and deepens the notches in the 
filter. Try it out.

16. Explore a little on your own. Go ahead and try out different LFO wave shapes, or 
different filter types. (Be careful. Some of the filters have extremely high gain at certain 
frequencies and they may distort with the harmonically-dense voice samples.)

� Load an Entire Preset
Now we’re going right back to where we started, but instead of loading individual 
samples, let’s load a complete Preset.

1. Select the Library Tab in the Tree.

2. Select Keyboard 1 as the “Filter Category” and type in piano in the “Filter by 
Name” box. Click the Search button.

3. Double-click on the Presets folder in the Tree to open it. You should see several 
piano presets there.

4. Select one of the piano presets then drag and drop it over the Emulator X icon 
above the filter selections.

5. Switch back to the Sampler Tab beneath the Tree and see your piano preset in the 
bank.

6. Select the piano preset and play the keyboard. That was easy!

7. Save the bank.

LFO/Lags

Shape

Frequency
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� To Audition and Merge Samples
Samples can also be auditioned and merged.

Locate the Samples Folder

1. Locate the Samples folder, just below the Presets folder.

2. Click on the Emulator X icon in the Tree to view the Multisetup page.

Audition

 Samples that reside in 
.E4B or .EXB disk files can 
be auditioned from disk.

3. Select a Sample from the Tree and press the Space Bar on your computer 
keyboard. The sample is auditioned from the hard disk.

4. Press the Space Bar again to Stop auditioning.

5. You can also audition samples by Right-clicking over the sample and selecting 
Audition. Right-click and select Stop Audition to silence audition.

 Vista Users: To 
Audition samples, you 
may need to download 
and install the Vista 
Codec Package 4.5.4. 

Merge the Samples

6. Right-click over the sample in the Tree and select Merge from the menu (or press 
“M” on your computer keyboard). The sample is added to the current bank. 

7. You can also drag and drop a sample over the Emulator X icon to merge it into the 
bank. These “free” samples will have to be assigned to voices in a preset before they 
can be played.

8. If you change your mind and don’t want to merge the sample after all, choose 
Undo from the Edit menu (or press Ctrl+Z) to un-merge the sample.

Signing Off
We’ve covered a lot in this lesson. Now you know how to create a preset from samples 
and how to create a custom bank from the presets in the library. This is a very ‘deep’ 
instrument, so don’t expect to learn it all in one day. Explore a little at a time and most 
of all don’t forget the music, because that’s what its all about. Have fun!

Emulator X Advanced Applications Guide
The Emulator X Advanced Applications Guide contains 43 more in-depth tutorials. The 
Advanced Application Guide begins with the fundamentals and walks you through 
nearly every facet of this amazing instrument. You can find this pdf document on your 
Emulator X3 CD or online at: www.emu.com. Check it out!
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The Librarian
As your sample library grows so does the problem of managing all your banks, presets 
and samples. As you’ve probably already discovered, a single bank can contain literally 
thousands of individual samples.

The Library is accessed by clicking the Library tab at the bottom of the Tree. To use the 
librarian, you first “Update” from the File menu. This creates a searchable database of 
all your samples, presets, banks and audio files which can be quickly searched. Audio 
files can be either WAVE or AIFF.

You can select which drives you wish to add to the catalog or manually “Add 
Locations” to narrow down the selection range to speed the update process. The Add 
Location button also allows you to specify network drives to catalog. Only the selected 
targets are overwritten with new data when the update process is performed. 
Unselected targets remain as they were. The “Clear Library” button erases the entire 
library so you can start from scratch.

 Cool Tip: Categorize 
multiple Presets:
1. Click the Sampler Tab 
in the Tree.
2. Click the Presets folder.
3. Select multiple presets.
4. Right-click and choose 
category.
5. Select category.

� Using the Librarian

Catalog your Disks

1. Select Update Library... from the File menu. A popup dialog box appears asking 
you to select the disks you wish to catalog.

2. Select any disk drives that contains the banks, presets and samples that were 
included when you installed the Emulator X application. Using the Add Location 
button, you can select network drives to add to the Library catalog. The Add 
Location button also allows you to select specific folders or locations for 
cataloging.

3. Click the Update button to begin cataloging. The display will read: “Updating”. 
This process may take a minute or two depending on how many files need to be 
cataloged.

Update
Updates the Library with the selected items, leaving non-checked 
targets intact.

Clear Library Erases Library database.

Add Location
Allows you to manually select targets to speed update time or select network 
drives to catalog.
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Find your Files

4. Select the Library tab at the bottom of the Tree and press Enter on your computer 
keyboard. All Emulator X Banks, Presets, or Samples can now be accessed here. 
(This can take a few seconds, especially with very large banks.)

5. Click on the Presets folder to view all the presets 
on your hard disks.

6. Selecting an item in the Category field returns any 
Banks, Presets or Samples in the selected category.

7. Type a search string in the Filter by Name field, 
then press the Search button to search the library. 

The 'Filter by Name' field is a subset of the 
Category search. Select <Any> in the Category 
field to search the entire library. 

8. Browse through the Bank, Preset, and Sample 
folders to find the sounds you want.

9. Right-click on a Preset or Sample to Audition the 
Preset or Sample from disk. You must play the 
keyboard while Auditioning to hear presets.

Load your Files

10. To add a file to the bank, Left-click and Drag the 
desired object in the Library over the Emulator X 
icon at the top of the tree and release the mouse 
button. The file is added to the bank.

11. Or… Select the object you want from the Library 
and Right-click. Then select Merge to merge the 
object into the current bank.
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4 - Multisetup / Preset Globals

The Multisetup
 The MIDI Controller 

settings and Filter 
Override are not stored 
with the Multisetup. 
These settings are stored 
with each Preset.

The Multisetup is the top level of the Emulator hierarchy and is the place where you 
choose and assign presets to each of the MIDI channels. All the control settings in this 
window are saved when you save the Multisetup.

A multisetup assigns a preset, volume, pan position and output routing to each of the 
64 MIDI channels. Multisetups can be saved and recalled for use with a particular song 
or sequence so that all the MIDI channels play the proper preset.

� To Select the Current Multisetup:

1. Click on the Emulator X icon at the top of the Tree. The current multisetup appears.

2. The Single Mode view is shown below. This view is convenient for performing live 
or when you’re only playing one preset at a time.

Click
Here

MIDI
Controllers

Pre-roll
RAM Used

CPU & Disk 
Usage Meters

Samples
Playing

Channel
Select

Current 
Channel

Effect
Bypass

Select
Effect

Channel
Pan

Preset 
Select

Channel
Volume

Master 
Volume

Limiter

Aux 
Output 
Select

Filter 
Override

Master 
Tempo

Aux FX 
Display 

Tabs

MIDI 
Mode
Select

Single View 
Tab

Single Channel View

Select All or 
by Category

Select 
Category

Bank & 
Preset 
Display

Preset 
Category 
Display

Main
Output

Select

FXA, FXB,
Aux Output

Enables

TwistaLoop 
Override

Master Tune 
Transpose
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There are five views of the Multisetup page. The Multisetup View buttons change the 
current view. The Single channel view is shown below.

• Single ..................... Displays the preset for the currently selected MIDI channel.

• Channels 1-16....... Displays the preset, volume and pan for MIDI channels 1-16.

• Channels 17-32 .... Displays the preset, volume and pan for MIDI channels 17-32.

• Channels 33-48 .... Displays the preset, volume and pan for MIDI channels 33-48.

• Channels 49-64 .... Displays the preset, volume and pan for MIDI channels 49-64.

Changing Presets (from Single View) 
 Note that Single View 

only changes the display 
and does not affect the 
currently selected MIDI 
mode (i.e. Omni, Poly or 
Multi).

Single View is the default view when you first run Emulator X. This view is convenient 
for performing live or when you’re only playing one preset at a time. All the main 
parameters for the selected MIDI channel are displayed in Single View and a conve-
nient Category mode allows you to quickly select presets in a certain category. A close-
up of the current channel settings is shown below.

� To Select Presets by Number
 Tip: You can also 

select a preset by 
dragging and dropping it 
from the tree into the 
single view screen.

1. Click on the Preset Increment/Decrement buttons to move up or down the presets 
by number.

2. Highlight the Preset Number field and type in the desired preset number.

 The Bank/Program 
Display shows the Bank 
and Program number 
you would use to select 
the preset from a 
sequencer.

Preset
Inc/Dec

Main Output 
Select

Select/View
Preset

Number

Channel
Volume

FXA/FXB
Enables

Aux Output 
Enable

Channel
Pan

Selected 
Category

Bank/
Program 
Display

Select All or Select 
by Category

MIDI Channel
Inc/Dec

Select
Category

Select/View
MIDI Channel

Preset
Name

Single View Close-up
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� To Select Presets by Category

1. Click on the Select Category button. The pop-
up dialog box at right appears.

2. Select the desired preset category, then press OK.

3. Choose Select By Category from the Single view 
screen above.

4. Use the Increment or Decrement buttons to 
select presets. Note that only presets of the 
selected category are selected.

� Changing the Current MIDI Channel
The Current MIDI Channel is simply the MIDI channel you are currently working 
with. To change the current MIDI channel, simply increment or decrement the 
channel number using the buttons, or click on the channel number and type in 
the desired number.

Multi Channel View
Press the 1-16 Multisetup View button to view 16 channels at once. This mode is useful 
for sequencing or when playing multiple MIDI channels.

Click
Here
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 Controllers

Preroll
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CPU & Disk 
Use Meters

No. Samples
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Channel

Aux Send 
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The Current MIDI Channel
Change the current channel by clicking anywhere on the desired horizontal channel 
strip. The red indicator displays the currently selected channel number. The MIDI 
Controllers change to show the settings of the currently selected MIDI channel.

� To Select a Preset:

1. Click on the Preset Select button for the desired MIDI channel. The Select Preset 
dialog box appears.

2. Click on the presets in the list to audition them. Presets can be viewed by large icon, 
small icon, by list, or by detailed list. Presets can also be sorted by name, ID, bank/
program number, or category when in Detail View mode.

3. To choose a preset, select it and press OK, or double-click on the preset in the list.

� To Select a Preset from the Tree:

1. Set the Current Channel by clicking anywhere on a horizontal channel strip in the 
Multisetup window.The channel number turns red, indicating that this is the 
current channel.

2. Choose the preset you want in the tree and Right-Click on its preset icon.

3. Choose Select on Current Channel. The preset is now selected for that channel.

4. You can also select a preset for the current channel by simply clicking the preset’s 
keyboard icon from the tree.

MIDI Channel
Each channel only responds to MIDI data on its particular channel. Use the floating 
keyboard (select Keyboard from the View menu) to audition presets on the currently 
selected channel. Select the current channel by clicking anywhere on the desired 
channel strip. The red indicator displays the currently selected channel number.

Preset Assignment
Assign presets to MIDI channels by clicking on the triangle selector button to the 
right of the preset field. A pop-up dialog box appears with the list of presets in the 
bank. Select a preset, then click OK to select.

Channel Volume
This control sets the relative volume of the MIDI channel. This is equivalent to MIDI 
controller #7 (channel volume) and changes made over MIDI will be shown here.

Channel Pan
This control sets the stereo position of the MIDI channel. This is equivalent to MIDI 
controller #10 (channel pan) and changes made over MIDI will be shown here.

Output Assignment
This control selects the Main Output assignment for the MIDI 
channel. 100% of the stereo output signal is sent to the selected 
output bus.

The number of outputs available in this field depends on the number of stereo 
channels your sound card provides. Add ASIO input strips in PatchMix DSP to increase 
the number of available outputs. Output destinations will be labeled according to the 
PatchMix DSP input strip scribble strip name. The EX session templates in PatchMix 
DSP are designed to be used with Emulator X.

 Important: The act of 
creating PatchMix DSP 
ASIO mixer strips makes 
them available for Emulator 
X. If they are not created in 
PatchMix DSP, you won’t 
see them in the Output 
Assignment field.
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Output View Button
This button allows you to view the Aux Send On/Off, Main Output Routing, and Preset 
FXA/FXB Bypass buttons when not in Single Mode. (The button is disabled in Single 
mode.)

You may want to bypass the Preset Effects on certain channels in order to free up CPU 
power or to hear the presets dry.

Aux FX View Buttons
The buttons above the TV display select which of the three possible Aux Effect is 
currently displayed. Note: The Output View button is disabled in Single mode.

Aux Send On/Off
 The Output View 

button is only available 
when any of the 
multimode views are 
selected. In Single mode 
you can only control the 
current channel.

These buttons enable (blue) or disable (grey) the inputs to the Aux Sends for each 
MIDI channel. When a factory FX template (such as Proteus X Composer) is used, these 
buttons serve to enable/disable the Aux FX for each channel. The Main Output is 
unaffected by these buttons.

These buttons disable the Aux Sends whether the Aux FX are being used or not. Please 
refer to the diagram on page 234 to see the exact location of this switch in the signal 
path.

Preset FX Enables
These two rows of buttons marked FXA and FXB, enable or disable the preset effects for 
each MIDI channel. These work differently than the Aux Send On/Off buttons in that 
they bypass the effects instead of turning them on or off. These buttons are useful to 
bypass any preset effects which may have been programmed in the preset.

Please refer to Chapter “9 - Effects” on page 231 for detailed information about the 
output and effects routing.

Select Effect
Click on the Effect Select icon at the top right corner of the Effects TV screen. A list 
of available effects drops down. See “Adding an Aux Effect in the Multisetup” on 
page 232 for complete details on how to add aux effects.

TwistaLoop Override
This three-way switch determines if the beat looping features 
are locked to Master Tempo. The three modes are as follows:

• On: Beats on the channel are locked to the Global 
Master Tempo. This control overrides the “Sync 
To Master Clock” setting in the preset.

• Off: Beats on the channel are NOT locked to the Global Master Tempo. This 
control overrides the “Sync To Master Clock” setting in the preset.

• Not Set: The “Sync To Master Clock” button in the Preset Globals page deter-
mines whether or not the Beats are locked to the Global Master Tempo.

Preset FX
Enable Buttons

Aux Send 
On/Off

Main Output 
Routing

Output View
Button

Aux Effect View Buttons
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Global Controls

Master Volume Control & VU Meter
This is the master volume control for Emulator X. This slider controls the output 
volume of all MIDI channels.The range of this control can be adjusted using the 
Headroom/Boost control in the preferences dialog box. See page 24.

The Master volume control responds to the Universal Real Time System Exclusive message for 
Master Volume. If your MIDI controller (e.g. an E-MU Xboard) sends such messages (such as 
from a master volume slider), the master volume in Emulator X changes accordingly.

The VU meter indicates the overall output level of the Emulator X Main Outputs. It serves 
as a handy indicator to show clipping or to troubleshoot audio output problems.

Tempo Control
This control and associated display sets the master tempo when Emulator X is chosen 
as the tempo source. Emulator X contains a global master clock which is used for 
Tempo-based Envelopes, Tempo-based LFOs, and clock modulation.

External Tempo Source” in the MIDI Preferences dialog must be Off for this control 
to operate.

When “External Tempo Source” in the preferences dialog box is On, and an external 
MIDI device or application is generating MIDI clock, the Emulator X tempo will lock to 
the MIDI clock tempo.

Master Tune
Master Tune adjusts the overall tuning of all presets so you can tune Emulator X to 
other instruments. The master tuning range is ±1 semitone in one cent steps (1/100th 
of a semitone). A master tune setting of 0¢ indicates that Emulator X is precisely tuned 
to concert pitch (A=440 Hz).

Master Transpose
The master transpose parameter transposes the key of all presets in semitone intervals. 
The transpose range is ±12 semi tones (1 octave).

Limiter
When playing Emulator X you may sometimes hear digital clipping. This clipping 
occurs in the digital hardware and is not caused by Emulator X, which uses high 
resolution floating point processing and has tremendous internal headroom.

To avoid the clipping, you could always lower the volume controls, but there’s a better 
way. The Limiter monitors the signal ahead of the output stage and automatically turns 
down the volume before clipping can occur.
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� To Use the Limiter

1. Press the Enable button, illuminating the button.

2. Set the Release knob to about 30% to start. Release controls how fast the limiter 
turns the volume back up after reducing it to avoid the clipping peaks.

3. Increase the release time if you hear obvious volume changes (pumping). Reduce 
the release time for percussive playing.

Aux Outputs
 See Chapter

“9 - Effects” on page 231 
for complete descriptions 
of the effects routing.

These three output assignments assign the Aux Routings selected in the Voices or 
Presets to pairs of ASIO channels or to DirectSound. Every Voice (page 36) has three 
effects sends with programmable amounts as well as a wet/dry mix to the Preset FX 
section. The three effect sends from all voices and Presets are summed into the three 
Aux Outputs where they are assigned to an ASIO pair. The Aux ASIO streams can be 
routed to the PatchMix DSP mixer or to other software devices running on your 
computer.

Using the Emulator Sessions in PatchMix DSP
The E-MU Digital Audio System contains special Sessions that can be used with the 
Emulator X factory banks. These Sessions connect the Aux Outputs to PatchMix DSP 
mixer input strips containing PatchMix DSP hardware effects.

If a factory bank has the Aux Outputs set as shown in the diagram above, it is designed 
to use the PatchMix hardware effects. If all the Aux Outputs are set to EX Main it most 
likely uses the built-in software effects. You can easily add PatchMix DSP hardware 
effects to a bank that uses Emulator X software effects by simply switching an Aux bus 
to a PatchMix strip with effects. 
See “Block Diagram of the Effects Routing” on page 234.

ASIO 3/4

ASIO 1/2

ASIO 5/6

ASIO 7/8

Emulator X Aux Bus Routing
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IMPORTANT
The act of creating PatchMix DSP ASIO mixer strips makes them available for 
Emulator X or any other application. You must create the ASIO mixer strips 
before Emulator X or any other application will see them.

� To Open the Emulator Sessions in PatchMix DSP

1. Open PatchMix DSP by clicking on the icon and select New Session.

2. Select Emulator X Studio.

3. Select Percussion EQ for use with the percussion banks on Disk 3. Select Emulator 
X Studio for all other banks.

4. The PatchMix DSP screen below shows the Main and Aux Output connections from 
Emulator X.

Main
Output Aux 1 Aux 2 Aux 3

Emulator X Studio Session

The routing options in the Emulator X Aux Output section take their names from the 
PatchMix DSP scribble strips. To route an Aux Send to a hardware effect, simply 
change the Aux Output routing to a PatchMix strip containing effects.
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Filter Override
The filter type of the first voice in the preset (on the currently selected channel) is 
shown in this display. If you change the filter type in this field, ALL the voices in the 
preset will change to the filter type you select. When the display reads, - Not Set - the 
filters programmed in each voice will be used. The filters may be set differently for each 
voice.

MIDI Controllers & Scribble Strips
Sixteen realtime MIDI Controllers are available to control the preset on the currently 
selected channel. These controllers are connected to MIDI sources as assigned in the 
Preferences dialog box (page 28) and changes made over MIDI will be reflected here.

The scribble strip names and the initial settings of the controller knobs are user 
programmable in the Preset Globals window. See page 80.

Pre-roll RAM Used
This display shows how much of your computer’s RAM is being used by pre-roll sound 
data. The amount of Pre-roll RAM can be adjusted in the preferences dialog box. When 
Sample Streaming is disabled this number shows the total RAM usage. See page 21.

CPU Meter
This display shows how much of your computer CPU power is being used by 
Emulator X. If the meter turns red, this indicates that there is not enough CPU 
bandwidth to properly process the audio in a timely manner, which may result in 
audible glitches or delayed notes.

Number of Samples Playing
This display shows you how many samples are currently being played. The maximum 
number of samples that can be played depends on a variety of factors such as: HD 
speed, RAM memory speed and CPU speed. See “Audio Setup” on page 23 for more 
information about performance.

Current Channel
This displays the currently selected MIDI channel. Change the current channel by 
clicking anywhere on the desired channel strip.

Filter OverrideMIDI Realtime Controllers & Scribble Strips

Pre-roll RAM CPU Meter Number of Samples Current Channel
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Working with Multisetups
A Multisetup is a “snapshot” of the current Emulator X settings. Multisetups store the 
preset, volume, pan position, and output bus routings for 64 MIDI channels along with 
the Global Tempo and the three Aux Send destinations.

Saving FX & Multisetups
It is important to realize what data is stored in a multisetup when saving banks. In 
addition to Volume, Pan, and Preset choices for each channel, the Initial Controllers, 
FX Aux 1, Aux 2, and Aux 3 are stored with the multisetup. The send level for each 
preset to each Aux bus is stored in the preset data. Remember to save the bank 
whenever you have made changes that you want to keep.

VSTi Multisetups
A multisetup for your VSTi is stored in your Cubase project and will be loaded when 
the project is opened. This multisetup overrides whatever default multisetup may have 
been saved if the bank was opened in standalone mode. If you wish to store extra 
multisetups you may do by using the Multisetup menu on the toolbar.

� To Store the Current Multisetup

1. Set up all the multisetup parameters the way you want them.

2. Select Store from the Multisetup window on the toolbar.

3. Choose a name and number for the multisetup. Changing the number allows you 
to place the Multisetup anywhere you want in the list.

4. Press OK to store the Multisetup.

5. Save the Bank, otherwise nothing will be saved.

� To Restore a Multisetup

1. Open the multisetup folder in the Tree. Any multisetups contained in the bank will 
be listed below the folder.

2. Left-click on the desired multisetup icon in the tree and drag it over the Emulator 
X icon above the tree. This multisetup will be restored.

3. Alternate Method - Right-click over the Multisetup icon in the Tree and choose 
Load.

� To Export the Multisetup as a New Bank
This feature lets you save only the presets and samples you need as a new bank. 

1. Set up all the multisetup parameters the way you want them.

2. Select Export from the Multisetup window on the toolbar. The popup “Save As” 
dialog box appears prompting you for the save location.

3. Choose the location for your new bank and click Save to save the bank, or click 
Cancel to cancel the operation.

� To Rename a Multisetup

1. Open the multisetup folder in the Tree. Any multisetups contained in the bank will 
be listed below the folder.

2. Right-click on the desired multisetup icon in the tree, then select Rename from the 
pop-up menu.

3. Type in a new name for the multisetup.
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� To Delete a Multisetup

1. Open the multisetup folder in the Tree. Any multisetups contained in the bank will 
be listed below the folder.

2. Right-click on the desired multisetup icon in the tree, then select Delete from the 
pop-up menu.

3. The Multisetup will be deleted.

� To Duplicate a Multisetup

1. Open the multisetup folder in the Tree. Any multisetups contained in the bank will 
be listed below the folder.

2. Right-click on the desired multisetup icon in the tree, then select Duplicate from 
the pop-up menu.

3. The Multisetup will be duplicated renamed “Copy of…XX” and placed in the first 
empty Multisetup location.

� To Rearrange the Order of Multisetups

1. Click once on the multisetup folder in the tree. The list of multisetups appears.

2. Select Details View from the view options in the toolbar and change the ID 
number.

3. If you try to save a Multisetup with a number that is already used, a popup dialog 
box will appear asking you if you want to use the next available ID number or enter 
a new ID.
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Preset Globals
The Preset Globals allow you to edit presets and their key maps. Samples can be 
arranged into single-sample or multi-sample voices with synthesizer processing 
applied. Then these complete voices can then be arranged anywhere on the keyboard.

The Preset Editor contains three sections. The first section, Voices & Zones, is used for 
arranging voices and samples on the keyboard and editing global preset parameters.

The Links section makes it easy to build new presets by combining other finished 
presets. Multiple presets can be crossfaded or cross-switched according to key position, 
key velocity, or by the position of MIDI continuous controllers.

The third section, Voice Processing, is used to perform more detailed editing of voices 
such as envelope shaping of amplitude and filters as well as modulation parameters. 
This is the synthesizer section of Emulator X containing E-MU’s legendary Z-plane 
filters and powerful matrix modulation.

� To Edit a Preset:

1. Select the Sampler tab from the Tree. The 
contents of the current Emulator X bank 
appears in the Tree.

2. Double-click on the Preset folder from the 
tree (or click once on the (+) symbol). The preset 
folder expands to display the presets 
contained within.

3. Click on one of the Preset icons in the Presets 
folder to view the Preset Globals window.

4. Double-click on the desired preset icon from 
the tree (or click once on the (+) symbol). The 
preset icon expands to display the subsections: 
Voices and Zones, Links, and Voice 
Processing levels.

5. Select the desired section: Voices & Zones, 
Links, or Voice Processing by clicking on the 
associated icon.

� To Select a Preset from the Tree:

1. Set the Current Channel to the one you’re 
using by clicking on the channel number in 
the Multisetup screen.

2. Choose the preset you want in the tree and 
Right-Click on its preset icon.

3. Choose Select on Current Channel. The 
preset is now selected for that channel.
80 Emulator X3 Reference Manual



4 - Multisetup / Preset Globals
Preset Globals
These parameters affect the entire preset and are saved with the bank.

 You can quickly access 
the Preset Globals 
window by clicking the 

 button in the toolbar.

Transpose & Volume
Transpose works by shifting the keyboard position. The actual samples are not retuned. 
In other words, if you have the same sound on each key, such as a piano, the piano will 
change key when you transpose. On the other hand, if you have a different drum 
assigned to each key, changing transpose will shift the position of the drums on the 
keyboard.

The volume control allows you to adjust the volume for the entire preset. This control 
is variable from -96 dB (off) to +10 dB.

Initial Controllers A-P
 Changing the initial 

controller settings is an 
easy way to customize a 
preset. Simply change the 
knobs and save the bank.

These set the initial value of MIDI controllers A-P for the preset. As soon as a MIDI 
controller is moved, it jumps immediately from this initial setting to the new setting of 
the control. The controllers A-P are assigned to MIDI continuous controller numbers in 
the Preferences dialog box.

Controllers A-P can be adjusted via MIDI or by turning the controller knob in the 
Multisetup.

The Label fields to the left of the initial controller knobs are user definable. These labels 
or “Scribble Strips” also appear in the Multisetup screen to show the function of the 
realtime controller knobs.

See “MIDI Channels & Real-time Controls” on page 314 for additional information 
about Controllers A-P.
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Capture MIDI Controllers
You can capture the state of all your MIDI input device’s MIDI controllers, and place 
the settings in the Initial Controllers section of the Preset. Essentially, this allows you to 
capture the Multisetup’s MIDI controller state, and store it in the preset.

� To Capture MIDI Controllers

1. Make any desired changes to any MIDI controllers on your MIDI input device, or 
in the Multisetup window.

2. Go to the Preset Globals window for the preset you want to apply your current 
MIDI state.

3. From the Preset menu, select Capture MIDI Controllers.

4. Notice that the initial controllers now reflect the state of your MIDI controllers. To 
keep these settings, you can save the Preset.

TwistaLoop Lock To Tempo
This control locks all analyzed beats in the preset to the global 
master tempo. When this function is on, all beats in the preset will 
lock to the master tempo unless “TwistaLoop Override” (page 73) 
is turned off.

This button works in combination with “TwistaLoop Override.” 
When TwistaLoop Override is “Not Set,” this button determines 
whether beats sync to the master tempo for the preset. 

When TwistaLoop Override is set to On or Off for the MIDI channel, this button has no 
effect. These two controls allow you to set the state of “Sync to Master Clock” by MIDI 
channel (TwistaLoop Override) or by Preset (this button).

Initial Tempo
This feature allows the master tempo to be programmed from 
presets that use tempo-based envelopes, LFOs or TwistaLoop.

The Initial Tempo works in combination with the “Preset Tempo 
Channel” option in the Preferences menu, which allows one 
specific MIDI channel to control the master tempo. See Preset 
Tempo Channel on page 27.

When the Initial Tempo is set to a tempo on the defined Preset 
Tempo Channel, the master tempo will follow this tempo setting when the preset is 
selected.

� To Set the Master Tempo from a Preset:

1. Turn Preset Tempo Channel on and set it to the desired MIDI control channel. 
(Options, Preferences, MIDI) “External Tempo Source” must be turned off.

2. Set the Initial Tempo (Preset Globals) to the desired tempo.

3. Turn on TwistaLoop - Lock To Tempo (Preset Globals) if you are using Twist-
aLoop.

4. Select the preset on the assigned preset tempo channel.
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Tuning Tables
In addition to the standard equally divided octave tuning, Emulator X contains twelve 
factory programmed tuning tables. The Keyboard Tuning parameter selects which 
tuning is used by the current preset.

The factory keyboard tuning tables are described in the following table.

Tuning Tables Description

Equal Temperament Standard Western tuning
12 equally spaced notes per octave.

Just C Just intonation. Based on small interval ratios. Sweet 
and pure, non-beating intervals.

Just C2 Allows you to play the following chords in the key of 
C: C, E, F, G, A, B, C#m, D#m, Em, F#m, G#m, Am, Bm

Just C-minor Allows you to play the following chords in the key of 
C: C, E, F, G, A, B, Em, Am, Bm, C#m, D#m, G#m

Just C3 Allows you to play the following chords in the key of 
C: C, D, F, Bb, C#m, Dm, Em, F#m, G#m, Am

Vallotti and Young Valotti & Young non-equal temperament. Similar to 12 
tone equal temperament. Each key has a different
character for a given scale.

19-Tone 19 tone equal temperament. 19 notes per octave.
Difficult to play, but works well with a sequencer.

Gamelan 5 tone Slendro and 7 tone Pelog. (Javanese.) Pelog are 
white keys, Slendro are black keys. Exotic tunings of 
Gamelan flavor.

Werkmeister A “well” temperament developed in the 17th century. 
Although you can play in all keys, each key sounds 
slightly different.

Kirnberger Another well temperament developed by Johann
Philipp Kirnberger where no pitch is more than 12 
cents off from equal temperament.

Scarlatti A variant of Meantone tuning which was used from 
the 15th to 18th centuries.

Repeating Octave Middle C octave is repeated up and down the 
keyboard. Link with a preset in equal temperament to 
form unusual inversions up and down the keyboard.

al-Farabi 12 A twelve-note reduction of an Arabic/Middle Eastern 
tuning system. The following scales are useful:
Diatonic: C Eb G G# A A# B c
Zalzal:     C Eb Gb G# A A# B c
Persian:  C Eb F  G# A A# B c

22-Tone 22 tone equal temperament. Good for minor 
harmonies.

24-Tone 24 tone equal temperament. These notes are quarter 
steps apart.

36-Tone 26 tone equal temperament. Difficult to play, but even 
better for minor harmonies.
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The Just C Tuning Tables
Well Tempered and Just were standard keyboard tunings up 
until the 20th-century when the current “equal tempered” 
scale became prevalent. In an equal tempered scale, the 
octave is equally divided into 12 parts. In Just or Well 
Tempered scales, the 12 notes are separately tuned to 
produce pure chords. However, in Just tunings you are 
limited to playing certain chords and if you play the wrong 
chord it may sound sour!

Tuning tables can be changed as you play using a program 
change (create several presets with the same sound and 
different tuning tables) or using a continuous controller 
(link 2 presets and crossfade between them using a 
controller).

The Just C2, Just C min, Just C3 Tuning Tables
Fully explaining the mysteries of just intonation is beyond the scope of this manual, 
but the subject is covered exhaustively in Hermann Helmholtz’s On the Sensations of 
Tone, available at most libraries and bookstores.

The four just intonation tables are called Just C2, Just C3, and Just C Minor. Try playing 
in the key of C/Cm using each table. You’ll quickly discover both the wonders and the 
frustrations of just intonation! In Just C, for example, you’ll find that the chords C, Em, 
F, G, and Am sound beautiful. If you hold one of these chords, you’ll hear no 
“beating”. After playing for a few minutes, switch back to Equal Temperament for a 
rude awakening!

At this point you might wonder why anyone would use Equal Temperament to begin 
with. For the answer to that question, play a D, Dmi, or Bb chord! The intervallic ratios 
that make the C & G chords sound so pure make the D chord sound horribly out of 
tune. That's why we had to include Just C3. In this tuning, D, Dmi and Bb sound in 
tune, but the G chord will sound wrong.

Each of the 4 tables allows you to play a different group of common chords in just 
intonation. Sadly, there is no single 12 note tuning that will allow all of the common 
chords to be in tune, and of course that's why they invented the equal temperament 
tuning system that we use today.

Just C
Play these chords: C, E, F, G, A, Cm, C#m, Em, F#m, Gm, Am

Just C2
Play these chords: C, E, F, G, A, B, C#m, D#m, Em, G#m, Am, Bm

Just C minor

Play these chords: C, Db, D, Eb, G, Ab, Cm, Em, Fm, Gm

Just C3
Play these chords: C, D, F, Bb, C#m, Dm, Em, F#m, G#m, Am

Equal Temperament Tunings 
For each of the equal temperament tunings except 19-tone, middle C (i.e., MIDI note 
60) is middle C as it would be in a standard 12-note tuning. The keyboard is then 
scaled up and down from middle C (C2). For example, using the 22-tone scale, one 
octave above middle C is 22 keys up the keyboard (A#3).
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Key CC Window
These controls work in conjunction with the “Keyboard - CC Window” function in the 
Voices and Zones. See “Continuous Controller Window Pages” on page 108.

Pressing the “Key CC Win” button and setting a Keyboard Range fields marks off a 
section of the keyboard to be used as control keys for the CC Window or a PatchCord 
source in the Voice Processing section. These keys will no longer trigger sounds. 
Instead, they are now used for selecting different voices in the CC Windows, or as a 
modulation source in the Cords. (See page 222.)

Preset Modulators
The Preset Modulators are special class of modulation sources in that they originate at 
the Preset Level, but their output is used in the Voice PatchCords. There are three types of 
preset modulation sources.

Channel Lag 1 & 2 Rate
Like the Layer Lag processors (described on page 138) the Channel Lag slows down 
rapid changes in the input signal. The output “lags” behind the input at a pre-
programmed rate.

Unlike the layer level lag processors, the Channel Lags 1 & 2 take effect as soon as the 
preset is selected. In contrast, the Voice level lag processors begin acting only after a 
keyboard key has been depressed. The Channel Lag also has a Lag Amount input which 
controls the lag time. Positive lag amounts increase the lag time. A MIDI controller 
(front panel knob) is commonly used to control lag amount.

The Channel Lags could be used to slowly increase or decrease the speed of an LFO 
which in turn controls some other effect, perhaps left/right panning, pitch, or the filter. 
When a MIDI footswitch is used as the input, the lag acts to slow down the instanta-
neous change of the switch. The slowly changing output value can then be routed using 
a patchcord to smoothly crossfade between voices or gradually change the speed of an 
LFO.

Preset Modulator Typical Uses

Channel Lags 1 & 2 “Leslie” speaker effects. Switch slowly increases/decreases LFO 
speed.

Poly Ramp (Timer) Controlling key-up layer volume based on the time a key is held.

Channel Ramp Ramps on First Note only. “Hammond” style organ percussion.

Channel
Lag

Lag Amount
(+ value = longer)

ex. footswitch
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Preset Globals
Poly Key Timer
This processor starts a timer which begins counting down whenever a key is pressed, 
and stops and outputs its value when the key is released. The value of this timer can be 
used on any voices after the key release. The Poly Key Timer is a special modulation 
source controlled by the key and not the voice.

The Poly Key Timer is commonly used on grand piano presets to reduce the pedal 
damper volume the longer the keys are held.

Channel Ramp
This processor generates a single negative going slope whenever the first key is 
depressed on the MIDI channel. This preset level processor was originally designed to 
simulate the percussion key click on Hammond organs, but you may find other uses.

The Channel Ramp instantly resets when all notes have been released and the next first 
key on the MIDI channel is pressed. The value of the ramp rate sets the increment. Large 
values produce fast ramps and small values produce slow ramps.

To use the Channel Ramp as a first-note decay envelope, patch the Channel Ramp out 
to Amp Volume and set the Amp Envelope for a fast attack and 100% sustain and short 
release.

Release
Layer
Voice

Poly Release
Trigger

Preset Global

Amp

Amp Vol

Poly Key
Timer

Note-On - Poly Key Timer begins counting down.
Note-Off - Poly Key Timer stops counting and outputs value.

Release layer 
voice becomes 
softer the 
longer the key 
is held.

Channel Ramp

d
ec

re
as

e

1st Note
Played

time
86 Emulator X3 Reference Manual



4 - Multisetup / Preset Globals
Preset Globals
Preset PatchCords
Preset PatchCords give you real-time control of the Preset Modulators. There are 16 
Preset PatchCords per preset with a source, a destination and an amount control. The 
amount can be set from -100 to +100.

Templates
For each different module in the Preset Globals window, you can save a library of your 
favorite settings. These Templates make it easy to create your own customized voices 
and presets. Templates are saved as an XML file within the Emulator X application 
directory so they’re always available for use. For more information on templates, 
See Templates on page 279.

Modulation Sources Modulation Destinations

Off Off

Pitch Wheel Channel Lag 1 In

Mod Wheel (Modulation Wheel) Channel Lag 1 Amount

Pressure (Channel Pressure) Channel Lag 2 In

Pedal Channel Lag 2 Amount

MIDI Volume (Controller 7) Channel Ramp Rate

MIDI Pan (Controller 10) Post-FX Main Send

Expression (Controller 11) Post-FX Aux 1 Send

MIDI A-P Post-FX Aux 2 Send

Footswitch 1 Post-FX Aux 3 Send

Flip-Flop Footswitch 1 (F’switch 1 FF) FX A Mod 1

Footswitch 2 FX A Mod 2

Flip-Flop Footswitch 2 (F’switch 2 FF) FX A Mod 3

Thumbswitch FX A Mod 4

Flip-Flop Thumbswitch (T’switch FF) FX B Mod 1

DC Offset FX B Mod 2

Channel Lag 1 & 2 FX B Mod 3

Channel Ramp FX B Mod 4
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5 - Voices & Sample Zones

Each preset contains voices. A voice houses a sample, or multiple samples, and can 
cover an individual key, or a range of keys.

The Voices and Zones window allows you full control over the parameters for each 
voice, including levels, tuning, keyboard range, crossfading, looping, region, and more. 
The Voices and Zones window is divided into tabs, each with its own set of controls. 
Certain controls, such as Volume and Pan appear in each window.

To access the Voices and Zones window, expand a preset in the tree, and click Voices 
and Zones.

Page Selection Tabs Voice Multisample Voice Sample Zone

Expand/Collapse 
Multisample

Selected 
Voice/Zone

Mute/Solo 
Voice or 

Zone

Overview 
Section

MIDI Controller RangeKey Range for 
Selected Voice(s)

Selected 
Voice(s)
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Voices and Zones Pages
The Voices and Zones Window is separated into tabbed pages:

 You can quickly access 
the Voices and Zones 
window for the current 
preset by clicking the  
button in the toolbar.

Mix/Tune
Adjust volume, pan, transpose, coarse tuning, and fine tuning for each voice. For more 
information, see “Mix/Tune Page” on page 99.

Key Win
Edit keyboard range assignments and place voices and multisamples wherever you 
want. For more informations, see “Key Window Page” on page 99.

Vel Win
Control the volume of a voice by key velocity. Crossfade or cross-switch between voices 
by key velocity. For more information, see “Velocity Window Page” on page 103.

RT Win
Control the volume of a voice using a real-time controller such as a modulation wheel, 
a pedal, an LFO or an envelope generator. For more information, see “Realtime 
Window Page” on page 105.

CC Win 1-5
Switch CC windows using specified keys on your MIDI controller. For more infor-
mation, see “Continuous Controller Window Pages” on page 108.

Region
Define which part of a sample plays. For more information, see “Region Page” on 
page 115.

Details
An overview of each voice that allows you to view and change Sample, Direction, Mix/
Tune, and Key Window information using numeric values. For more information, see 
“Details Page” on page 119.
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Voice Selection
Voice Selection
In each tabbed page, voices can be selected by clicking any part of the voice strip. 
Selection is shown by a red box around the voice strip.

1. Select the first voice in the “Voices & Zones” screen.

2. Hold the Shift key to select contiguous voices. Hold the Control key to select or 
deselect non-contiguous voices. Press Control-A to select all voices.

Manipulating Voices
Under each tabbed page, there are various controls that allow you to change a voice’s 
Group, Sample, Direction, Volume, Pan, etc. Some controls, such as Group or 
Direction, are selected from a drop-down menu. Others, such as Volume and Pan, are 
controlled by a slider or wheel. 

Most pages also contain parameters that can be adjusted 
using graphical sliders.

You edit a slider’s range or position by clicking the slider, and dragging your mouse left 
or right. Create a fade by holding the Alt key in conjunction with clicking and dragging 
your mouse. See the example below:

Working With Multiple Voices
If you select more than one voice, you can edit parameters for all selected voices simul-
taneously. To select more than one voice, hold the Ctrl key while clicking the voices 
with your mouse. To select contiguous voices, hold the Shift key while clicking.

It’s important to understand how changing parameters in the various tabbed pages 
differs from changing parameters in the Overview section that occupies the bottom 
half of the screen:

• In the tabbed pages, such as the Mix/Tune page, parameter changes work in a 
relative manner. This means if you select multiple voices and decrease the 
Volume of a voice by 10 dB, you decrease all voices’ volumes by 10 dB. 

• However, if you select multiple voices and change the volume knob in the 
Overview section, you change all selected voices’ absolute volumes.

• To set the high and low ranges, click and drag the end points of the graphic display 

• To move the whole range without resizing it, click and drag the middle of the range.

• To create a fade, hold Alt, and click and drag the end points. Once you create a fade 
point, you can click and drag the fade point to re-position it.

Alt-Click & Drag the 
End to set Fade

Click & Drag the 
Middle to Move

Click & Drag the 
End to Resize

Click & Drag Fade Point 
to Adjust Fade
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Note about multiple voice editing: If you open several voices for editing that have 
different voice parameter settings, the parameters in the different voices will remain as 
they were until you change them. That is, if you have three voices selected and you 
change the filter cutoff, all three voices will jump to the new cutoff setting, but all the 
other parameters will remain as they were.

Samples & Multisamples
The samples contained in the voice are displayed and can be edited. If the voice 
contains more than one sample, the word “Multisample” is displayed in the sample 
field. All the samples in a multisample share the same set of synthesizer parameters. 
However, the volume, fine tune and pan parameters can be adjusted separately for 
each sample in a multisample.

� To View & Edit the Samples in a Multisample

1. Click the + symbol to display the individual samples and key ranges which 
comprise the multisample.

2. Click the - symbol to collapse the multisample.

The multisample key range sets the overall key range limit for the samples in the multi-
sample. In the diagram above, the top sample won’t be played, because its key range is 
outside the limit of the Multisample key range.

Multisample Key Range Individual Sample Key Ranges

Multisamples allow you to place multiple samples under the same set of synthesizer voice 
parameters.

Expand/Collapse Multisample
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Groups
Voices can be categorized into Groups as a way to organize and select similar voices, 
say a layer of piano voices and a layer of string voices, into unified entities.

You can create a temporary group if you want to edit several voices. Grouping the 
voices and then selecting the group is faster and more dependable than manually 
selecting each voice when editing.

� To Place a Voice into a Group

1. Tag each voice you want to be in the group with the same group number. This can 
be done in the “Voices and Zones” window or from the “Voice Processing” 
window.

2. Whenever you select that group number in the Voice Processing window, all voices 
with that group number will be selected. You can define up to 99 groups, but a 
voice can only be in one group at a time.

� To Make a New Group from the Currently Selected Voices

1. Select the voices you want to be in the new Group from the “Voices & Zones” page.

2. Select New Group from the Preset menu. A new group will be created using the 
lowest available group number.

� To Select All Voices for Editing

� To Select a Group of Voices for Editing

Sorting Voices and Zones
You can sort Voices, and Zones using the following criteria:

• Sample Number

• Sample Name

• Low Key

• High Key

• Original Key

• Volume

• Pan

• Group (voices only)

� To Sort Voices or Zones

1. Right click any Voice or Zone number.

2.  Select Sort Voices or Sort Zones, and choose how you want to sort them.

• From the Voices & Sample Zones window, press Control-A.

• From the Voice Processing window, select All in the Group box.

• Method #1: Simply select the desired group number from the Voice 
Processing page. Once you have selected a group, you will be editing all 
the voices in this group.

• Method #2: Select any voice in the group, then select Select Group “N” 
from the Preset menu. All the voices in the group will be selected.
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The Keyboard Display
The keyboard display on the bottom of the screen gives you a visual representation of 
the Key Win range for the currently selected voice(s), and the Note range of your MIDI 
controller. 

Notes that fall within the currently selected voices’ key range appear in color.

You can also mask out notes that don’t fall within a range of keys that match your 
MIDI controller. Masked keys display in darker colors.

� To Choose What type of MIDI Controller to Display

• Right-click the keyboard and select the type of controller you are using. Choices 
are Full MIDI (no mask), Piano (88 keys), Three Octave, XBoard 61, XBoard 49, 
and XBoard 25.

 The Keyboard also 
appears in the Voice 
Processing screen.

The keyboard display is also useful for identifying notes and creating a new voice with 
a specific Original Key value Key Win range:

• When you hover your mouse over the keyboard, the name of the key is 
displayed.

• You can create new voices by dragging samples onto the keyboard in the Voices 
and Zones screen. See “Adding Samples and Voices” on page 97 for more infor-
mation.

MIDI Controller Range (Light)Mask (Dark) Mask (Dark)

Key Win Range for 
Selected Voice(s) (Color)
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Overview Section
Overview Section
 Tip: To set a control 

to its default setting, hold 
Alt while clicking the 
control, or right-click the 
control, and select 
Default.

The bottom portion of the page contains an overview that displays and allows you to 
control parameters for the selected voice(s).

These controls are available regardless of which tabbed page you select (except the 
Region page), and work per voice. When you modify a setting here, the corresponding 
setting changes in the Voice Processing window.

Note that the selected voices are indicated in the upper-left corner of the Overview. 
Changes to these controls only affect the indicated voice(s). If you select multiple 
voices and change a parameter in the Overview section, that parameter changes for all 
selected voices.

When you select multiple voices, it’s important to understand how changing param-
eters in the Overview differs from changing parameters in the various tabbed pages. In 
the Overview section, all changes are absolute values. This means if you select multiple 
voices and change the Volume knob to a value of 10, you change all selected voices to a 
volume of 10. However, if you select multiple voices and move the volume slider in the 
Mix/Tune page, you change all selected voices’ relative volumes.

 Muting and Soloing 
voices does not save 
polyphony! Muted voices 
still play; they are simply 
silenced.

Sample Controls

Sample
The sample assigned to the selected voice or zone. If you select multiple voices, this 
window appears blank.

Original Key
Sets the Original key of the selected voice or zone.

Group
Changes the group of the selected voice or zone.

Direction
Selects whether the sample plays forward, backward, forward loop, backward loop, or 
one-shot.

Selected Voice(s) CC Win Info Key, Realtime, and Velocity Window parameters

Mix/Tune Info

Sample Info
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Mix Tune Controls
These are the same controls found in the Mix/Tune page.

 Tip: To quickly 
remove all solos and 
mutes, select Clear All 
Solos and Mutes from 
the Preset menu.

Mute
Mutes the selected voice(s) or zone(s).

Solo
Mutes all voices but the selected voice(s) or zone(s).

Volume
Controls the volume for the selected voice(s) or zone(s). This control is also located in 
the Voice Processing window.

Pan
Controls the Pan for the selected voice(s) or zone(s). This control is also located in the 
Voice Processing window.

Fine Tune
Fine tunes the pitch of the selected voice(s) or zone(s) by cents. This control is also 
located in the Voice Processing window.

Coarse Tune
Tunes the pitch of the selected voice(s) by semi tones. This control is also located in the 
Voice Processing window. This control is NOT available for individual zones of multi-
sample voices.

 See page 129 to 
understand the 
difference between 
transpose and coarse 
tune. You can also set the 
group number from this 
page.

Transpose
Transposes the pitch of the selected voice(s) by semi tones. This control is also located 
in the Voice Processing window. This control is NOT available for individual zones of 
multisample voices.

Key Win, Velocity Win, RT Win, and CC Win Controls

Rather than using the graphical representation found in each corresponding tabbed 
page, you can change the Key Win, Velocity Win, Realtime Win, and CC Win values 
from any page (except the Region page). Remember, any changes you make only affect 
the selected voice(s).
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Direction
For each voice (or zone in the case of a multisample voice), you can choose direction 
settings. The Direction drop-down menu allows you to choose one of the following:

Adding Samples and Voices
You can create new voices and add samples to them from any of the tabbed pages in 
the Voices and Zones window.

� To Add a New Voice
There are several ways to add a new voice from the Voices and Zones window:

� To Change a Zone’s Sample

� To Add an Additional Sample to a Voice
This either adds to, or creates a Multisample voice. From the Voices and Zones 
window:

Forward The region plays from beginning to end while the note is 
held.

Backward The region plays in reverse from end to beginning while 
the note is held.

Forward Loop The region loops forwards from beginning to end as long 
as the note is held.

Backward Loop The region loops backwards from end to beginning as 
long as the note is held. 

One-Shot The region plays from beginning to end when a note on 
signal is received. If you release the note before the 
sample completes, the region still finishes playback.
Note: You may have to adjust the Amp Envelope settings 
in order to hear the sample. See “Envelope Complete” 
mode on page 126.

• Press Ctrl+W on your keyboard.

• From the Preset menu, select New Voice.

• Right-click an empty area and select New Voice.

• From the Sample column, click the Selector Button  next to the appro-
priate voice or zone. Select a sample from the Select Sample dialog box.

• Drag a Sample from the Tree to the zone’s strip.

• Drag and Drop a sample from the Samples tree (or from your Library) on 
the left into a voice in the Voices and Zones window.

• Explore your computer for an audio file (Wave, AIFF, MP3, REX 2). Drag and 
drop the file into a voice in the Voices and Zones window. This imports the 
sample and adds it to the voice.
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� To Add a Voice and a Sample Simultaneously
There are several ways to add a voice and a sample in the Voices and Zones window:

• Drag and Drop a sample from the Samples tree (or from your Library) on 
the left into the empty area just beneath the list of voices.
This creates a new voice containing the sample you selected. The new 
voice’s original key will be the sample’s original key (or C3 if this information 
is unavailable). The voice’s key range will be C-2 to G8.

• Explore your computer for an audio file (Wave, AIFF, MP3, REX 2). Drag and 
drop the file into any area in the Voices and Zones window.
This creates a new voice containing the audio file you selected. The new 
voice’s original key will be the audio file’s original key (or C3 if this infor-
mation is unavailable). The voice’s key range will be C-2 to G8.

• Drag and Drop a sample from the Samples tree, from your Library, or from 
your desktop onto a note on the keyboard at the bottom of the screen.
This creates a new voice containing the sample you selected. The new 
voice’s original key will be whichever note you dropped the sample onto. 
The voice’s high and low keys will also be whichever note you dropped the 
sample onto.
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Mix/Tune Page
Mix/Tune Page

 See page 129 to 
understand the 
difference between 
transpose and coarse 
tune. You can also set the 
group number from this 
page.

Volume, pan, direction, transpose, coarse tuning, and fine tuning can be adjusted 
separately for each voice. The Mix/Tune window allows you to see these settings for 
each voice at the same time, giving you an overview of your preset’s direction, volume, 
pan, tuning, and transpose settings for each voice. All of these controls are available in 
the other tabbed windows, but in this window, you can see the volume and pan for 
each channel.

Additionally, from this screen, you can easily select multiple voices and change their 
volumes with one adjustment. Select the voices whose Volume or Pan you want to 
change, and hold Shift while dragging the volume right or left.

Key Window Page

When a sample is recorded, it is automatically placed in a voice and assigned a 
keyboard range specified in the “Auto-Placement” parameters in the “Acquire” or 
Import Samples” options in the File menu. The Key Range Window allows you to edit 
these assignments and place the voices and samples wherever you want.

A voice containing only one sample takes the name of the sample. If a voice contains 
more than one sample, it is called a “Multisample” and the samples it contains are 
listed below it. The screen above shows two single sample voices. Voice 1 plays on the 
lower half of the keyboard and voice 2 plays on the upper half.

The Original Key determines the pitch of the sample. The original key need not be 
located between the high and low key ranges. Samples normally have the original key 

Sample Name

Selector 
Button

Mute/Solo Direction

Volume PanGroup

Transpose, Coarse Tune, Fine Tune

Original Key Graphic Display 
of Voice Position

Sample Name

Selector 
Button

DirectionMute/Solo

Group
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as part of the sample name. Imported samples with embedded original key infor-
mation can be auto-mapped to the correct location. See page 295.

The key position is edited by placing the cursor over the desired parameter and then 
playing the MIDI keyboard or adjusting the value using the keyboard. You can also 
simply drag the blue bar to the desired position with the mouse.

Voices and samples can be crossfaded according to key position by adjusting the low 
and high fade parameters. The fade is adjusted in “number of keys” and is graphically 
represented by a gradual decrease in the color intensity of the bars.

� To Manipulate the Bars:

• To Set the Length of the Bar: Left-click and drag from either endpoint.

• To Move the Entire Bar: Left-click and drag from somewhere in the middle of 
the bar.

• To Create a Fade: Left-click and drag inward while holding the Alt key.

� To Switch Voices According to Position
Assigning voices (samples or multisamples) adjacent to each other is the simplest and 
most common application of the Key Window. The voices in the screen below are each 
assigned a one octave range.

Another way of visualizing this assignment is shown below.

 Samples can be 
arranged in a 
multisample voice in 
exactly the same way that 
voices are arranged on 
the keyboard. They can 
be arranged side by side 
on the keyboard or 
stacked on top of each 
other to create layered 
sounds, all within a single 
voice.

The voice will gradually fade-out in volume below B2 as you play down the keyboard.

B2

VOICE 1 VOICE 2 VOICE 3 VOICE 4
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� To Layer Voices and Samples
The ranges of two or more voices may overlap, and all voices assigned to a key will 
sound.

Another way of visualizing this assignment is shown below.

 You may want to 
assign voices in different 
layers to different groups. 
This allows you to select 
all of the voices in each 
layer just by selecting the 
group number. You can 
edit the group number of 
a voice in any of the 
Voice screens.

� To Positionally Crossfade
This technique can help mask the point at which two sounds meet or can be used for 
crossfading sound effects. The fade parameters allow the volume of the voice or sample 
to be faded out as a function of key position. In the screen shown below, voices 1 and 2 
are being positionally crossfaded over a range of five notes.

As the voice boundaries are crossed playing up the keyboard, the lower voice gradually 
fades out as the upper voice fades in.

VOICE 1 VOICE 2 VOICE 3 VOICE 4

VOICE 1 VOICE 2 VOICE 3 VOICE 4
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Using Values to Define Key Window Parameters
As you use the graphical interface to change the Key Window parameters, you’ll notice 
that the values in the Overview section at the bottom of the screen change as well.

You can adjust the Key Window information here. Choices include High and Low 
notes, and High and Low fades.
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Velocity Window Page
The Velocity Window allows you to control the volume of a voice by the key velocity. 
Using this function, you can crossfade or cross-switch between voices by key velocity. 
Suppose you had several samples (voices) of the same piano note, one played soft, the 
next played medium hard, and the third played hard. Using this function, you could set 
the velocity at which each of the voices would sound, thus recreating the response of 
the actual instrument.

� To Velocity Switch Voices:

1. In order to velocity switch voices, they must first be assigned to the same key range. 
In the Key Window, set the high and low key range of the voices so that they 
completely overlap.

2. Select the Velocity Window button shown below. By default both voices will be 
assigned to the full 0-127 velocity range.

3. Set the velocity range so that each voice has its own velocity range.

(In the above example, a key velocity of 1-35 will play voice 1, a key velocity of 36-
80 will play voice 2, and a key velocity of 81 or above will play voice 3.)

� To Velocity Crossfade Voices:

1. In order to velocity crossfade voices, they must first be assigned to the same key 
range. In the Key Window, set the high and low key range of the voices so that they 
completely overlap.

2. Select the Velocity Window button shown above. By default both voices will be 
assigned to the full 0-127 velocity range.

3. Set the Fade parameter for each voice so that as one voice faces out the other fades 
in.

4. Play the keyboard and fine tune the crossfade points for the desired response.

Sample Name

Selector 
Button

DirectionMute/Solo

Group

Graphic Display of Velocity 
Switch/Fade
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Using Values to Define Velocity Window Parameters
As you use the graphical interface to change the Velocity Window parameters, you’ll 
notice that the values in the Overview section at the bottom of the screen change as 
well.

You can adjust the Velocity Window information here as well. Choices include High 
and Low notes, and High and Low fades.
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Realtime Window Page
The Realtime Window allows you to control the volume of a voice using a real-time 
controller such as a modulation wheel, a pedal, an LFO or an envelope generator. It 
works in a manner very similar to the velocity window except that a realtime controller 
is used to control the volume instead of key velocity.

Note: Realtime cross-switching/crossfading of voices is inherently wasteful of 
polyphony because voice channels must be assigned even if the volume of a voice is at 
0. (Since this is a Realtime control the volume can change at any time.) If you don’t 
need realtime volume changes, you might want to investigate the “Keyboard CC 
Window” on page 109.

� To Realtime Crossfade Two Voices:

 Warning: Make sure 
you understand how to 
select Voices and assign 
Cords before attempting 
to perform realtime 
crossfades.

1. In order to realtime crossfade voices, they must first be assigned to the same key 
range. In the Key Window, set the high and low key range of the voices so that they 
completely overlap.

Set up the Voices

2. Select the Realtime Window button shown above. By default both voices will be 
assigned to the full 0-127 range.

3. Set the Fade parameter for each voice so that as one voice faces out the other fades 
in. Voice 1 will be at full volume until the realtime controller reaches a value of 16. 
It will then begin fading out. Voice 2 will begin fading in immediately and be at full 
volume from 100 to 127.

Assign the Realtime Controller

4. Select one of the voices you want to crossfade by clicking anywhere on the strip. A 
red box forms around the voice to show that it’s selected.

5. Now hold the Crtl key and select the next voice you wish to crossfade by clicking 
on it. Both voices should be surrounded by red boxes.

6. With both voices selected, select Open Voices (Crtl+Enter) from the Preset menu. 
The Voice Processing window appears. Verify that the two voices are selected in the 
“Voice Selector” section of the window.

Sample Name

Selector 
Button

DirectionMute/Solo

Group

Graphic Display of Realtime 
Switch/Fade
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7. Assign a realtime controller to control the crossfade. Select Amp Crossfade as the 
destination. Select a modulation source that goes from 0-127 such as Aux 
Envelope+, LFO+ or MIDI A-P. Set the Cord Amount to +127.

8. You should now be hearing the realtime crossfade when you play a key. You may 
have to go back to the Realtime Crossfade page to adjust and fine tune the 
crossfade points. These settings will vary with the sounds that are being crossfaded.

� To Randomly Cross-switch or Crossfade Between Voices:

In certain situations, such as setting up drum kits, you may want to randomly switch 
between several voices. Crossfade Random is a modulation source specifically 
designed to handle this situation. Unlike the other random sources, Crossfade Random 
generates one random number for all voices that are assigned to the same key.

1. In order to realtime crossfade or cross-switch voices, they must first be assigned to 
the same key range. In the Key Window, set the high and low key range of the 
voices so that they completely overlap.

Set up the Voices

2. Select the Realtime Window button.

3. Set up a basic cross-switch in the Realtime Window as shown below. For this 
example, we’ll use two voices. This will cause voice 1 to sound whenever the 
random value is in the range of 0-63 and voice 2 to sound whenever the random 
value is in the range of 64-127.

Assign the Realtime Controller

 Tip: Random Cross-
Switch can be used in 
combination with 
Velocity Switching to play 
random voices when you 
play softly and a known 
voice when you play 
hard.

4. Select the first voice by clicking anywhere on the strip. A red box forms around the 
voice to show that it’s selected.

5. Hold the Ctrl key and select the next voice by clicking on it. Both voices should be 
surrounded by red boxes.

6. With both voices selected, select Open Voices (Crtl+Enter) from the Preset menu. 
The Voice Processing window appears. Verify that the two voices are selected in the 
“Voice Selector” section of the window.

7. Assign Crossfade Random as modulation source in the Cords section. Select Amp 
Crossfade as the destination. Set the Cord Amount to +127.

8. Voices 1 and 2 will now be randomly selected whenever you press a key.
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Using Values to Define Realtime Window Parameters
As you use the graphical interface to change the Realtime Window parameters, you’ll 
notice that the values in the Overview section at the bottom of the screen change as 
well.

You can adjust the Realtime Window information here as well. Choices include High 
and Low notes, and High and Low fades.
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Continuous Controller Window Pages
The CC Windows (1-5) offer additional voice switching and crossfading possibilities 
using MIDI Continuous Controller messages. Unlike the Realtime window, the CC 
crossfades and cross-switches occur only at Note-on time. They cannot be continu-
ously swept during the note. These controls are designed to be used to switch and fade 
voices during your performance. You can use the CC windows to switch between drum 
sets, or bring in accent samples.

The CC assignments are easy to use because you can complete the entire patch from 
this window. The list of control sources is accessed by clicking on the button  under 
the Source column. The following control sources are available: Mod Wheel, Pressure, 
Pedal, MIDI A-P, Footswitch 1 & 2, Flip-Flop Footswitch 1 & 2, Thumbswitch and Flip-
Flop Thumbswitch, Keyboard, Cycle 2-3-4 (Chan), Cycle 2-3-4 (Key), Random.

� To Cross-switch Two Voices:

1. In order to cross-switch voices, they must first be assigned to the same key range. In 
the Key Window, set the high and low key range of the voices so that they 
completely overlap.

2. Set up a basic cross-switch in one of the CC Windows as shown above. For this 
example, we’ll use two voices. This will cause voice 1 to sound whenever the CC 
value is in the range of 0-63 and voice 2 to sound whenever the CC value is in the 
range of 64-127.

3. Select one of the controllers from the list. Do this for each voice you wish to switch. 
In the example above, voice 1 will sound whenever the Mod Wheel is less than 
halfway up. Voice 2 will sound whenever the Mod Wheel is more than halfway up.

Sample Name

Selector 
Button

DirectionMute/Solo

Group

Graphic Display of CC 
Switch/Fade

List of Control Sources
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Keyboard CC Window
The keyboard CC window is a great performance feature, which allows you to switch 
CC windows using specified keys on your MIDI controller. For example, you can have 
three different voices assigned to the keyboard, such as piano, organ and a horn 
section, and select each of the three sounds using the lowest three keys on the 
controller. 

When you select the Keyboard option in the “CC Win” list, a section of the keyboard 
can be used to conditionally decide whether a voice is played (similar to the Key Win, 
Vel Win, and other CC Wins). 

The second part of the feature appears on the Preset Globals page. Pressing the “Key CC 
Win” button, and setting a Keyboard Range field marks off a section of the keyboard to 
be used as control keys for the CC Window. The keys in this range will not sound. 

Using the example in the first paragraph, you might mark off the three lowest keys on 
the controller as control keys, so they don’t sound notes when pressed. They are now 
used for selecting the different voices. 

Once you specify a Keyboard CC Value range, those values will not trigger note events 
on that channel. No voices (no sound) will be played when you play a key in the 
specified range. Once you press the key in the specified range, that key becomes the 
current Keyboard CC Win value. You don’t have to hold the note. A new Keyboard CC 
Win value is set when you press another key in the specified range. 

The Keyboard CC Win Key defaults to the lowest control key when the preset is 
selected. You don’t have to press a control key to hear sound.

When using the File Converter to convert Gigasampler files to EXB files, the “Keyboard 
Dimension” is converted to a Keyboard CC Win. The “Dimension Key Start” and 
“Dimension Key End” parameters in Gigasampler are translated to “Keyboard CC Win 
Key Start” and “Keyboard CC Win Key End”. These values appear in the dialog 
managing these values. Each Keyboard dimension split is mapped to one key when 
converting to a Keyboard CC Win.

� To Program a Preset using the Keyboard CC Window:
For this example we’ll use preset 000:010 And Voice from the Proteus X Composer 
bank. This preset has two different sounds, piano and voices, layered over the same 
keyboard range. You could also use any other preset that has layered voices.

1. Load the Proteus X Composer (or Proteus Composer) bank.

Reserve the Control Keys.

2. From the Tree select preset 000:010 And Voice. The Preset Globals page appears.

3. Click the Key CC Win button (located in the upper left corner of the screen).

4. Set the Low and High range keys to the lowest two white keys on your keyboard. 
(Hint: Select the key field. Press and hold Ctrl + Alt, then play the keyboard to set 
the key.)

Set the CC Window.

5. Open the Voices and Zones page of And Voice.

6. Click the CC Win 1 button.

7. For each voice, click the Assign button and select Keyboard.

8. Set the High and Low keys on voice one to the lowest key on your keyboard. 
(Don’t change the fade fields.)

9. Set the High and Low keys on voice two to the next-to-lowest white key.
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10. Play the keyboard. Pressing the lowest key on the keyboard selects the piano. 
Pressing the next white key selects voices.

11. Bonus Step: You can also make the black key between the white trigger keys play 
both voices. Extend the High CC range of voice one up 1/2 step. Extend the Low 
CC range of voice two up 1/2 step. Playing the sharp now plays both voices.
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Cycle Groups
The Cycle Group destinations apply rotational (or random) input controllers to the CC 
Window. Because the generated values are sources for the CC Windows, crossfades and 
complex cross-switching are possible.

This feature is very exciting because it allows for more realistic and natural-sounding 
presets than previously possible with a sampler. When you hear, for example, the same 
snare drum sample throughout a piece of music, it’s very obvious that you’re listening 
to a sampler, not a real drummer. But if you alternate between three or four similar, but 
not identical snare samples, the increase in realism is quite dramatic. Brass and string 
samples also benefit greatly from Cycle Groups.

In the simplest case, you can use this feature to alternate between two different voices 
each time you press a key (Cycle 2-Key). The first time a you press a key, a value of 0 is 
generated. The next time you press the same key, a value of 127 is generated, then 
0-127-0-127, etc. These values are used as control sources for the CC Window to 
determine which voice will sound. Cycle 3 and Cycle 4 groups sequence three and four 
values respectively.

Channel Cycle Groups. Rotate the value each time a note is played on the 
MIDI Channel.

Key Cycle Groups .......Rotate the value each time a note is played on the 
same Key.

• Random  . . . . . . . . . . . . At note on, per channel, a random value between 0 & 127 is 
generated as the source for the CC Window.

• Cycle 2 (Channel) . . . . A value of 0 or 127 is generated each time a note event 
occurs on the Channel. The two numbers alternate each 
time a note event occurs on the channel. This value is used 
as the source for the CC Window.

• Cycle 3 (Channel) . . . . A value of 0, 64 or 127 is generated each time a note event 
occurs on the Channel. The generated value cycles sequen-
tially through 0, 64 and 127 with each new note event on 
the channel. This value is used as the source for the CC 
Window.

• Cycle 4 (Channel) . . . . A value of 0, 42, 85 or 127 is generated each time a note 
event occurs on the Channel. The generated value cycles 
sequentially through 0, 42, 85 and 127 with each new note 
event on the channel. This value is used as the source for the 
CC Window.

• Cycle 2 (Key) . . . . . . . . A value of 0 or 127 is generated each time a note event 
occurs on the Key. The two numbers alternate each time a 
note event occurs on the key. This value is used as the source 
for the CC Window.

• Cycle 3 (Key) . . . . . . . . A value of 0, 64 or 127 is generated each time a note event 
occurs on the Key. The generated value cycles sequentially 
through 0, 64 and 127 with each new note event on the key. 
This value is used as the source for the CC Window.

• Cycle 4 (Key) . . . . . . . . A value of 0, 42, 85 or 127 is generated each time a note 
event occurs on the Key. The generated value cycles sequen-
tially through 0, 42, 85 and 127 with each new note event 
on the key. This value is used as the source for the CC 
Window.
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� Setting up the Cycle Groups
Here’s a simple example to show you how to set up the cycle groups. In preparation, 
load the Proteus X Composer bank, open the Presets folder, and select preset 000:035 
Fing&Harms from the tree.

1. Expand the preset in the tree by clicking the + symbol next to the keyboard icon.

2. Click Voices and Zones. The Key Window appears with two voices (HardFinger 
A#0 and BassHarm G4).

3. For each voice, extend the Key Range so it covers the entire keyboard.
(drag the bars)

4. Next, select new samples for each voice. (Click on the sample button and choose a 
new sample). It doesn’t matter which two samples you choose as long as they are 
clearly distinguishable from each other.

5. Click the CC Win1 button. The Continuous Controller Window 1 appears.

6. For each voice, click the Assign buttons and select Cycle 2(Key).

7. Set the CC Window range for voice 1 by dragging the right end of Voice 1’s bar to 
the left. It doesn’t matter how far you drag it, as long as it doesn’t include the value 
of 127.

8. Set the CC Window range for voice 2 by dragging the left end of Voice 2’s bar to the 
right. It doesn’t matter how far you drag it, as long as it doesn’t include the value of 0.

9. Play the keyboard. The voices alternate each time you play the same key.

10. For each voice, select Cycle 2(Channel). Now the voices alternate whenever you 
play a new key on the channel, regardless of which key you are playing.

Voice 1
Voice 2

0 127

0 - 127 - 0 - 127... CC Win Value  = 

The CC Range setting
determines which voice

will sound.

Cycle 2 (Key):
Generates alternating

values of 0 & 127
on each key press

The Cycle 2 (Key) Group allows you to alternate between 2 voices with each key press.

Cycle 2 (Key)
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Cycle 3 Crossfading
 Tip: Conserve 

polyphony by cross-
switching, rather than 
crossfading, voices.

This next example demonstrates the Cycle 3 mode as well as the crossfading abilities of 
the CC Window. Pressing a key will first play Voice 1. Pressing the key again will play a 
50-50 mix of both voices. Pressing the key a third time will play Voice 2. The next key 
press will play Voice 1 again and the cycle repeats.

11. Set both Voice 1 and Voice 2 to Cycle 3 (Key).

12. Create a fade in Voice 1 like the one shown in the diagram below. Alt-click on the 
right end of the bar and then dragging to the right, then all the way to the left.

13. Create a fade in Voice 2 so that it looks like the diagram below.

14. Repeatedly press a single key and listen to the voices rotate. The rotation order is 
retained for each key.

Cycle 3 (Channel)

15. Assign both voices to Cycle 3 (Channel).

16. Play the keyboard. Notice that the voices now rotate regardless of which key is 
played. Any key on the current MIDI channel will increment the rotation.

Random Mix

17. Assign both voices to Random.

18. Play the keyboard. Now the mix of the two voices is completely random.

19. You can “weight” the randomness by adjusting the crossfade points. For example, if 
you want Voice 1 to be dominant, adjust the fade of the voice so that most of the 
bar is solid. This way it has more chance of being played at full volume.

Voice 1
Voice 2

0 64 127

0 - 64 - 127 - 0 ... CC Win Value  = 

Cycle 3 (Key):
Generates rotating

values of 0 - 64 - 127
on each key press

1st key press = Voice 1
2nd key press = Voice 1 & 2

3rd key press = Voice 2
4th key press = Voice 1

(50-50 Mix)

Cycle 3 (Key)
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Using Values to Define CC Window Parameters
As you use the graphical interface to change the CC Window parameters, you’ll notice 
that the values in the Overview section at the bottom of the screen change as well.

You can adjust the CC Window information here as well. Choices include Source, High 
and Low notes, and High and Low fades.
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Region Page
The Region window allows you to define which part of a sample plays. In essence, it 
allows you to non-destructively crop the beginning and end of a sample.

• In its simplest use, you can re-define the start and end points of a sample.

• You can use the Region page to view sample information, such as bars, beats, 
and loops.

• You can define areas to loop forward or backward.

• You can Xplode a region, creating new voices from all visible note markers.

In the case of looping, you can view Beat, Note, and Loop markers, and snap to them. 
This way, you can loop portions of a sample in a similar way that you would with 
TwistaLoop. The difference here is that if you have multiple voices using the same 
sample, you can set up each voice to play a different section (such as a Loop) of the 
same sample.

When you select a voice, or a sample in a multisample voice, the sample shows up in 
the bottom of the screen. By default the entire sample is defined as a region. The 
selected region is defined in pink.

Current Sample

Selected RegionRegion Parameters

Sample Zoom and 
Scroll Controls

Sensitivity and Beats/
Percentage

Ruler
(in Bar:Beats Format)

Bar/Beat/Loop 
Markers

Selected Sample
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Creating or Editing a Region
 Tip: To select the 

whole region, hold Alt 
while clicking the Sample 
Region range bar. This 
restores the default 
setting, which is ALL. 

Creating or editing a region is very simple. There are three ways to do so:

• Click and drag in the display area.

• Use the selection bars next to each voice or sample zone.

• Enter the information manually in sample values.

Region View Controls

Sample Zoom and Scroll Controls
You can use the Zoom In and Zoom Out Buttons to take a closer look at the sample.

Use the Scroll Control to scroll backward and forward.

Sensitivity
The sensitivity setting determines the resolution of how Note Markers will be 
displayed. You can set the sensitivity in percentage from 0 to 100:

Or, if you click the Beats button, you can set the sensitivity ranging from eight-bar 
intervals (8/1) to sixteenth note intervals (1/16):

Click and drag.

Region Start and End (in samples)

Scroll Control Zoom In and Out
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For example, if you set the sensitivity to 1/8, Note Markers fall on note onsets that 
appear near eighth notes. Similarly, setting the sensitivity to 1/16 causes Note Markers 
to find onsets near sixteenth notes.

• A letter “t” next to a sensitivity setting indicates triplets.

• A letter “d” next to a sensitivity setting indicates duplets.

Snap Settings and Markers
When you use your mouse to define a region, the region start and end points snap to 
either samples, Loop Markers, or Beat and Note markers depending on your view 
settings.

If you do not view any markers, region selection does not snap. With markers present, 
region selection snaps to whatever markers are present.

You can also select a region using the Sample Region Bars to the right of each sample. 
This method of selection does not snap. Click and drag the right or left edge of the bar 
to change the start or end of the region. Click and drag the center of the bar to move the 
entire region forward or backward.

Region Xplode
This option creates new voices from the area between each visible note marker in the 
selected Region. The new voices are mapped either chromatically or on sequential 
white keys.

Optionally, you can create a MIDI file that maps the new regions to MIDI notes, which 
you can use in a sequencer to play back each region consecutively. 

You can only Xplode a single-sample zone, and the region you Xplode must contain 
note markers.

� To Xplode a Region

1. Select the voice whose region you 
want to Xplode.

2. Select the sensitivity you want. This 
determines the length of each segment 
into which the region is divided. 
Remember, the region is divided 
depending on how many note 
markers are visible.

3. From the Preset menu (or when you 
Right-click the Region), select Region 
Xplode. The following dialog box appears:

View Beat 
Markers

From the toolbar, click  to toggle Beat Markers. 
With this view enabled, region selection snaps to 
beat markers.

View Note 
Markers

From the toolbar, click  to view Note Markers. 
With this view enabled, region selection snaps to 
Note Markers.

View Loop 
Markers

From the toolbar, click  to toggle Loop 
Markers. With this view enabled, region selection 
snaps to Loop Markers.
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4. Select how you want the new voices to be mapped from the Placement drop-down 
menu:

• White Keys maps each voice sequentially to a white key, beginning at the key 
selected in the Start at field.

• Chromatic maps each voice sequentially chromatically, beginning at the key 
selected in the Start at field.

5. Under Start at, enter the lowermost note where you want placement to start.

6. Decide whether you want to export a MIDI file. If so, check Export MIDI File, and 
choose a location and tempo (by default, the tempo is filled in as the tempo of the 
first note, which is usually the best choice).

7. Click OK.

You should now have new voices, each using the same sample, but different regions. It 
might look something like this:

More About Regions
You should remember that if a sample contains loops, selecting a region does not 
override these loops; Selecting a region merely determines which portion of a sample is 
allowed to play.

However, if you select a region that excludes part of a loop, such as the start or end 
point, that loop will not repeat.

Warning: If a region contains only a part of the sample, DO NOT edit the sample in the 
Sample Editor (e.g. Time Stretch, Sample Rate Convert, etc.). Doing so will cause region 
information to become incorrect. This does not apply if a region contains the entire 
sample.

Since regions contain the entire sample by default, this is only a potential issue if you 
have created a region. To ensure a region contains an entire sample, you can always 
Alt-Click the sample region bar to restore the region to its default setting.
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Details Page

The Details page allows you to view, in rows, almost all of the Voices and Zones infor-
mation for all voices at once. For each voice, from left to right, you can view and edit 
Group, Sample, Direction, Key Win, Original Key, Volume, Pan, Transpose, Coarse 
Tune, And Fine Tune.

� Tips on using the Details Page:

• While the Mix/Tune, Key Window, and Velocity Window pages give you graphic 
displays of settings such as volume and pan, you can be very precise with your 
settings in the Details page.

• You can make very precise relative changes from the Details page. Try selecting 
multiple voices and using the  buttons to change a value. All selected voices’ 
values will change in a relative manner. You can get more granularity this way 
when making precise settings with multiple items selected.

Sample Name

Selector 
Button

DirectionMute/Solo

Group

Mix/Tune ParametersKey Win Parameters

Original Key
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Voice & Sample Zone Utilities
These utilities are invaluable when creating and modifying Emulator X voices. The 
voice and Sample Zone Utilities are located under the Preset menu.

Open Voices
This function opens the Voice Processing window for the 
currently selected voice(s).

Open Sample 
This function opens the Sample Editor for the currently 
selected sample.

New Voice
This function allows you to add a new empty voice to the 
preset. You’ll use this function when building new presets 
from scratch or to add a voice to an existing preset.

Delete Voices
This function deletes the selected voice, but does not erase 
the samples.

Duplicate Voices
This function makes a copy of the voice, but does not copy the samples.

Combine Voices
This function takes all selected voices and combines them into one multisampled 
voice. The synthesizer level programming of the first voice is used for the new voice. 
Any synthesizer level programming associated with the other voices is lost.

Voice 1 Voice 2 Voice 3 Voice 4

Sample 01

Sample 02

Sample 03

Sample 04

Voice 01

COMBINE

Before -

After -
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Expand Voice
This function takes apart the selected multisampled voice and makes an individual 
voice for each sample. The voice processing information of the “parent” voice is dupli-
cated for each newly created voice.

New Sample Zone
This function creates a new sample zone in the currently selected voice. If this 
operation is performed on a single sample voice, the voice is transformed into a multi-
sample.

Delete Sample Zones
This function deletes the currently selected sample zones from the voice.

Duplicate Sample Zones
This function makes a copy of the currently selected sample zones, but does not copy 
the samples.

Sort Voices
You can sort voices by Sample Number, Sample Name, Low Key, High Key, Original 
Key, Volume, Pan, or Group.

Sort Zones
You can sort a zone by Sample Number, Sample Name, Low Key, High Key, Original 
Key, Volume, or Pan.

New Group
Adds all selected voices to a new group.

Select Group
Selects all voices that share the same group number with the currently selected voice. 
For example, if the voice you selected is a member of group 3, the Select Group 3 
command selects all other voices in group 3. This command is unavailable if you have 
multiple voices from multiple groups selected.

Clear All Solos and Mutes
Un-mutes and un-solos all voices and zones.

Voice 1 Voice 2 Voice 3 Voice 4

Sample 01

Sample 02

Sample 03

Sample 04

Voice 01
EXPAND

Before -

After -
E-MU Systems 121



5 - Voices & Sample Zones
Edit Menu Utilities - Cut, Copy & Paste
Edit Menu Utilities - Cut, Copy & Paste

 Voices cannot be 
pasted onto the desktop 
or outside of a bank.

You can use the standard cut, copy & paste utilities when working with voices and 
sample zones. Single or multiple voices can be selected, then moved or rearranged 
within the bank or between banks. This makes it easy to create or modify custom 
presets and banks.

� To Copy and Paste Voice(s)

1. Select the voice(s) you wish to copy. (Hold Shift to select contiguous voices.)

2. Select Copy from the Edit menu.

3. Open a new preset if you want to paste between voices.

4. Select the Voices and Samples page.

5. Select Paste from the Edit menu. The following dialog box appears.

6. You have the option of pasting the voice(s) before the currently selected voice, after 
the currently selected voice or starting at a specified voice number. This feature 
allows you to rearrange your voices any way you want.

7. Press OK to paste the voice or Cancel to cancel the operation.
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Links
Links call up additional presets in the bank as a quick and easy way to create layering or 
keyboard splits. Linked presets are not altered by being linked to another preset, they 
are simply played.

One thing you need to be aware of when using links is that the Initial Controller 
settings (page 81) of the first preset are imposed on the linked preset. This may change 
the sound of the linked presets. Sometimes switching which preset is the Link will 
correct the problem. If this doesn’t work you will have to edit the Initial Controller 
settings until both presets sound the way you want.

 You can quickly access 
the Links page for the 
current preset by clicking 
the  button in the 
toolbar.

One way to create new presets is to simply link several other presets to an empty preset. 
Each linked preset can be customized with its own keyboard range, velocity range, 
continuous controller assignments, volume, pan position, and tuning.

� To Access the Link Windows:

1. Select the Sampler Tab in the Tree.

2. Open the Presets folder by clicking on the (+) sign next to the folder.

3. Select a Preset or Create a New Preset (Presets > New Preset).

4. Open the Preset by clicking on the (+) sign next to the preset icon.

5. You’ll see three sub-icons beneath the Preset icon. Click on the Links icon. The 
Links window opens.

6. Select Links > New to add a new link.

7. The Mix/Tune window appears. Click the tabs across the top of the window to 
select the various Link windows.

Preset #1

Preset #2

Layering Two Presets Using Links

Key Range

Key Range

Key Range
Preset #1

Preset #2

Creating a Split Keyboard with Links

Tip: You can also create a 
new Link by simply 
dragging and dropping a 
preset onto the preset field 
in the Link page.
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Link Utilities
These four controls are accessed from the main menu.

  If you link two or 
more presets, the Preset 
FX of the linked presets 
will be ignored. The 
linked presets will be 
routed through the 
effects of the main preset.

� To Create a Huge Stacked Preset the Easy Way:

1. Load any bank of presets.

2. From the Sampler Tab of the Tree, click on the Presets folder.

3. Select Preset > New Preset to create a new blank preset. “Blank Preset” will appear 
in the Tree. (Look at the bottom of the list.)

4. Rename your new preset and double-click on the plus sign to open it. The Voices 
& Zones, Links and Voice Processing branches appear.

5. Click on the Links icon. The Link window appears.

6. Select Links > New Link to create a new blank link.

7. Click on the Preset button to the right of the preset field. A pop-up menu appears. 

8. Select a preset.

9. Repeat steps 6 and 7 to add additional presets until the desired thickness is 
achieved.

Subsuming Links
If you want to add all the voices from your links to the current preset, use the Subsume 
Links command. This adds all voices from the linked presets to the current preset, and 
removes the links.

For single-sample voices, subsuming links only brings in voices that are located in the 
range defined in the Links Key Window. If a voice falls entirely out of the range defined 
in the Links Key Window, it is discarded when you subsume links.

For multisample voices any sample whose voice falls within the range defined in the 
Links Key Window is brought into the preset, even if the sample itself is mapped to a 
location that falls out of the Links Key Window range.

New Link Creates a new link.

Delete Links Deletes the selected link(s).

Duplicate Links Duplicates the selected link(s).

Subsume Links
Adds all voices from all links to the current preset 
and removes the link(s).
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Mix/Tune Window
This window allows you to set the volume, pan position, transpose and fine tuning for 
the linked preset.

Key Window
The key window works just like the key window in the Voices and Zones section 
(page 99) and allows you to set the keyboard range for each linked preset.

Velocity Window
The velocity window works just like the Velocity window in the Voices and Zones 
section (page 103) and allows you to set the velocity range for each linked preset. In 
the example below the presets are set to crossfade from Link 1 to 2 as the key velocity is 
increased.

Volume Adjusts the volume of the linked preset.

Pan Sets the stereo pan position of the linked preset.

Transpose
Transposes the linked preset by shifting the keyboard position. 
(See page 129.)

Fine Tune Allows you to detune the linked preset by ±100 cents. (1 semitone)

Key Position
Low & High Key, Crossfades

Graphic Display 
Keyboard Range

Selector 
Button

Linked Preset

Velocity Range
Low & High Velo, Crossfades

Graphic Display of 
Velocity Range

Selector
Button

Linked Presets
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5 - Voices & Sample Zones
Links
CC Window
The CC or continuous controller window works just like the CC window in the Voices 
and Zones section (page 108) and allows you to set the range for each linked preset 
using continuous controllers. In the example below the presets are set to switch from 
Link 1 to 2 as the Mod Wheel is turned past 63. The CC values are locked in at note-on 
time. 

CC Range
Low & High Range, Crossfades

Graphic Display of 
Controller Range

Selector
Button

Linked Presets

Continuous
Controller

Assignments
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6 - Voice Processing
Simplified Emulator X Signal Path
6 - Voice Processing

Voice Processing contains the traditional synthesizer controls such as envelope shaping 
of amplitude and filters as well as modulation parameters. When multiple voices are 
selected, parameter changes affect all selected voices (i.e. setting the filter cutoff to 50, 
sets it to 50 on all selected voices). The voice processing parameters are accessed by 
clicking on the Voice Processing icon in the Tree.

� To Select Multiple Voices:
 See Groups on 

page 93.
• Assign voices to Groups in the Voices and Zones page, then select the group.
• Select the desired voices from the Voices and Zones page.

 IntelliEdit is enabled in 
the MIDI Preferences 
dialog box. See page 26.

• Hold Crtl+Alt and play your MIDI keyboard to select voices (with IntelliEdit on).
• Press Ctrl-A to select all voices from the voice processing page.

Simplified Emulator X Signal Path
 You can quickly access 

the Voice Processing 
page for the current 
preset by clicking the  
button in the toolbar.

A single Emulator X voice is diagrammed below. The audio path includes one or more 
samples, a dynamically controlled filter, and a dynamically controlled amplifier with a 
panning network. Modulation parameters operate simultaneously on all samples 
contained in a voice. PatchCords with built-in amount controls connect modulation 
sources (LFOs, envelopes, knobs, etc.) to modulation destinations (sample pitch, filter, 
amp volume, etc.). Memorize this voice architecture diagram to better understand 
Emulator X and make programming much easier.
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6 - Voice Processing
Overview of the Voice Processing Window
Overview of the Voice Processing Window

The Voice Processing window displays all the synthesizer controls and PatchCord 
routings for the selected voice(s). Each module contains an independent synthesizer 
function.

Templates
For each different module in the Voice Processing window, you can save a library of 
your favorite settings. These Templates make it easy to create your own customized 
voices and presets. Templates are saved with the Emulator X application so they’re 
always available for use. For more information on templates, see “Templates” on 
page 279.
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6 - Voice Processing
Oscillator
Oscillator

Pitch Bend Range
These two sliders allow you to set the amount of pitch bend up or down when a MIDI 
pitch wheel message is received. Pitch wheel messages are automatically routed to pitch 
unless these controls are set to zero.

TwistaLoop Controls

Speed
Please refer to page 224 for detailed information about this control.

Loop (% or number)
Please refer to page 223 for detailed information about the “Loop %” control.

Please refer to page 217 for detailed information about the “Loop Number” control.

Start At Loop
Please refer to page 217 for detailed information about the “Start At Loop” control.

Tuning Controls

Transpose
This function allows you to transpose the key of the selected voice(s) in semitone 
intervals by shifting the keyboard position relative to middle C. The transpose range is 
-36 to +36 semi tones. You will normally use the transpose function to tune a voice to 
its keyboard location, or simply to transpose the voice.

This is the same Transpose control displayed on the Mix/Tune tab of Voices & Zones 
(page 99) and changes made to either page will appear in both places.

Coarse Tuning
This function allows you to change the tuning of the voice in semitone intervals. The 
coarse tuning range is -72 to +24 semi tones. Unlike the transpose function, coarse 
tuning stretches the pitch of the individual samples assigned to a key and may change 
the timbre of a voice.

This is the same Coarse Tuning control displayed on the Mix/Tune tab of Voices & 
Zones (page 96) and changes made to either page will appear in both places.

 Use Transpose 
when you want the 
voice's timbre to 
remain constant.

 Use Coarse 
Tuning when you 
want to change the 
timbre of the voice.

 Use the Coarse 
Tuning control to 
change the tuning of 
voices containing 
multiple drums.
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6 - Voice Processing
Oscillator
Fine Tuning
This function allows you to change the tuning of the voice in 1 cent intervals 
(100 cents = 1 semitone). The fine tuning range is ± 100 cents (± 1 semitone). Fine 
tuning can be used to slightly detune a voice, creating a “fatter” sound when it is 
combined with another voice.

This is the same Fine Tuning control displayed on the Mix/Tune tab of Voices & Zones 
(page 96) and changes made to either page will appear in both places.

Fixed Pitch Mode
This function turns keyboard transposition On or Off for the voice. With Fixed Pitch 
On, the keyboard will not control the pitch of the voice. This is a useful function for 
drones or “chiffs”, which you may not want to track the keyboard.

Chorus Amount
Chorus “thickens” the sound by doubling the sound in stereo and 
then detuning it. Chorus uses twice as many voices and twice as 
much of your CPU power when the Amount is set above zero.

Chorus amount and ITD can be modulated in the Cords section, although ITD can 
only be changed at the time of the key depression. When Chorus is on, a mono voice 
will use twice as many channels.

“Off” is different than “0” for chorus amount. With mono samples, chorus On effec-
tively turns a mono sample into a stereo sample with detuned L & R sides, with Chorus 
Amount being the detune amount. With chorus Off, no amount of modulation will 
turn the chorus on. With chorus On, modulation can drive the chorus (detune) 
amount to a minimum of 0, but not Off.

Tips for Using Chorus

Amount
The amount of detuning and is variable from 
Off to 100%.

Stereo Width
Controls the stereo spread. 0% reduces the 
chorus to mono and 100% gives the most
stereo separation.

Inter-Aural 
Time Delay 
(ITD)

Adjusts the delay of the left and right sounds. 
Positive values start the right channel early 
and the left late.

• Set chorus amount to 1% and use chorus width as a pan control which does not 
span the entire L/R spread.

• Set the chorus width to 0% and adjust the ITD to create a through-zero flange 
effect. With 100% width, a panning-chorus effect is obtained.

• To avoid L/R pitch drift, use “~” type of modulation in the cords selection box.

• Modulate the ITD to create “Hass-Effect” panning, (i.e. apparent location shift using 
slight delays in the L-R channels.)

• For a detuned analog oscillator sound, set stereo width to 100%. Route a free 
running LFO (~) to chorus position with amount set to about 25%.

 Chorus is 
automatically disabled 
on any voice that uses 
the TwistaLoop time 
modification feature 
(Lock to Tempo or 
TwistaLoop Speed). 
The Chorus controls 
can be set, but the 
effect will be disabled.
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Oscillator
Glide Rate & Curve
Glide is a smooth gliding between notes instead of the normal 
instantaneous change in pitch when a new key is pressed. The 
glide rate determines the time it takes to glide to the new pitch. 
The larger the value, the slower the glide rate. The rate is 
adjustable from 0 to 32.738 seconds. Zero seconds equals Off. 
The glide curve setting is adjustable between linear (large 
intervals result in longer glide time) and logarithmic (small or 
large intervals take roughly the same time). A logarithmic 
curve Glide is polyphonic, but can be monophonic when in 
Solo mode.

Key Controls

Delay
Delay varies the time between the arrival of a 
MIDI Note-On message and the onset of a note. 
The delay time is adjustable from 0 to 10,000 
milliseconds (0-10 seconds). Delay can be used 
to create echo effects or to thicken the sound 
when using layered voices.

Sample Offset
This function allows you to set where the voice's sample begins playing when you hit a 
key. A setting of 0 plays a sample from the beginning, higher values move the sample 
start point toward the end of the sound.

Important Note: If the Sample Start Offset is moved past the Pre-roll length, the sound 
will be cut off. If you are having Disk problems when using Sample Offset, increase the 
Pre-roll in the Preferences menu, or turn Streaming Off. See “Pre-roll (seconds)” on 
page 22.

Sample Start 
Offset
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Amplifier, Filter & Auxiliary Envelopes
Amplifier, Filter & Auxiliary Envelopes
Emulator X contains three envelope generators per voice. The Amplifier Envelope is 
“hard-wired” to control the Amp Volume and cannot go below the zero baseline 
(0-100). The Filter and Auxiliary Envelope generators are general purpose envelopes 
which must be patched to a destination using a PatchCord. The levels of the Filter and 
Auxiliary Envelopes can be programmed between the value range of -100 to +100.

Adjusting the Envelopes
There are four ways to adjust the envelope parameters:

The time values are calculated using time and the vertical distance to the next point. 

•  Adjust the Time/Level knobs.

• Grab one of the points on the Envelope Display and drag the envelope.

• Position the cursor in the Time or Level numeric fields and type in a time value.

• Position the cursor in the Time numeric field and type in the exact time.

At
k1

Atk2 D
cy1

Dcy2
Rls1

Rls2

Key
Down

Key
Released

Sustain

time

level

Holds here
until key release

Level Controls

Time ControlsTime / BPM SelectEnvelope Tabs Envelope Mode
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� To Setup the Volume Envelope as an ADSR
The classic synthesizer ADSR (Attack-Decay-Sustain-Release) envelope is easy to create 
using the six segment envelope generators. The trick is to only use segments: Attack1, 
Decay2, and Release1.

1. Set Atk2 level to 100.

2. Set all other levels to 0.

3. Set all times to 0.

Program the Atk1, Dcy2 and Rls1 time segments as you wish. Decay 2 level is the 
Sustain level. When programming controller knobs to the envelope times, you must 
use a negative cord amount in order to increase the time of an envelope segment.

Envelope Mode: Repeat
The filter and aux envelope generators can be made to repeat. When the envelope 
repeat function is On, the Attack (1&2) and Decay (1&2) stages will continue to repeat 
as long as the key is held. As soon as the key is released, the envelope continues 
through its normal Release stages (1 & 2).

 The Amp Envelope 
does not have the 
repeating feature.

The diagram above shows how the looping envelopes work. When the key is pressed 
the envelope goes through its regular Attack 1, Attack 2, Decay 1 and Decay 2 stages. In 
non-looping mode, the envelope would hold at the end of the Decay 2 stage until the 
key was released. In looping mode however, it jumps back to the Attack 1 stage and 
repeats the first four stages. It continues to loop through these four stages until the key 
is released where it immediately jumps to the Release 1 stage.
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Envelope Mode: Complete
In Complete mode, the envelope generator continues through all six stages when a key 
is pressed, ignoring the status of key sustain. This feature allows you to create long 
evolving soundscapes with a quick tap of the key (one-shot mode), since normally the 
envelope would jump into the release stages as soon as the key was released. This mode 
is also well suited for enveloping percussive sounds such as piano and drums, or 
plucked strings which decay. 

Complete mode can also be used to create more processor-efficient presets. On 
Emulator X, the voice stops playing when the Amp Envelope ends, and the computer 
resources used by that voice become available for other jobs. Because the envelope 
completes its cycle regardless of how long a key (or sustain pedal) is held, the 
computer resources are only used for a fixed amount of time, then returned. The 
performance increase can be dramatic!

Time-based and BPM Envelopes
Envelope times can be time-based or BPM-based. Time-based envelopes have an 
absolute time setting, such as 1 second. BPM-based envelope times are divided down 
from the Master Tempo setting on the Multisetup page. The Master Tempo scales the 
time of the BPM-based envelope segments.
BPM times are displayed in musical time intervals where possible. For example, if you 
set the attack time to be 1/16, the attack time will last exactly one sixteenth-note at the 
master tempo.

BPM Envelopes
 Note: The master 

tempo can be set 
internally using the 
tempo control in the 
Multisetup window, or 
controlled from an 
external MIDI clock. 
Internal/External clock 
selection is located in the 
Preferences dialog box.

BPM envelopes are controlled by the Master Tempo (located in the Multisetup 
window). The Master Tempo rate scales the time of all the BPM envelope segments. The 
Master Tempo can also be derived from an external MIDI clock to synchronize the 
envelope times with external sequencer or arpeggiator tempo changes. See note->.

 Tip: One-Shot mode. 
1. Select “Complete” mode.
2. Set the envelope controls 
as shown below.
3. Adjust Attack 2 time.
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The chart below lists all the displayed musical note divisions when the envelope is set 
to BPM. The “Master Tempo Clock Pulses” column shows the exact number of clocks 
used by each note division based on the MIDI standard of 24 pulses per quarter note. 
The envelope segments will last for the exact note division shown. You can also set 
envelope times between the standard note divisions. These are displayed as integer 
numbers.

BPM Tempo Chart

BPM Tempo Rates
(based on Master Tempo)

Displayed Note 
Division

Master Tempo Clock 
Pulses

16x whole note (quad long) 16/1 1536

8x dotted whole note 8/1d 1152

16x whole note triplet 16/17 1024

8x whole note (double long) 8/1 768

4x dotted whole note 4/1d 576

8x whole note triplet 8/1t 512

4x whole note (long) 4/1 384

2x dotted whole note 2/1d 288

4x whole note triplet 4/1t 256

2x whole note (breve) 2/1 192

dotted whole note 1/1d 144

2x whole note triplet 2/1t 128

whole note 1/1 96

dotted half note 1/2d 72

whole note triplet 1/1t 64

half note 1/2 48

dotted quarter note 1/4d 36

half note triplet 1/2t 32

quarter note 1/4 24

dotted 8th note 1/8d 18

quarter note triplet 1/4t 16

8th note 1/8 12

dotted 16th note 1/16d 9

8th note triplet 1/8t 8

16th note 1/16 6

dotted 32nd note 1/32d 4.5

16th note triplet 1/16t 4

32nd note 1/32 3

dotted 64nd note 1/64d 2.25

32nd note triplet 1/32t 2

64th note 1/64 1.5
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LFOs & Lags
A Low Frequency Oscillator or LFO is simply a wave 
which repeats at a slow rate. LFOs are used to add 
animation to a sound. Emulator X has two multi-wave 
LFOs for each voice, with 17 different waveforms 
which are diagrammed below.

Frequency
Sets the initial speed of the LFO. The frequency range 
is 0.08 Hz (12.5 seconds for one cycle) to 18.01 Hz.

Note: References to musical intervals in the pattern LFO shapes are with the LFO 
routed to pitch and a PatchCord amount of +37.5. 
See the Pitch Amount Chart on page 158.

Delay
Sets the amount of time between playing a key and the onset of modulation. This can 
be used to simulate an effect often used by acoustic instrument players, where the 
vibrato is brought in only after the initial note pitch has been established. The delay 
range is adjustable from 0 seconds to 20 seconds.

Shape
Sets the LFO waveshape which determines the effect of the LFO. There are 16 LFO 
waveforms and a random, sample & hold type of wave which outputs random levels at 
the LFO rate.

Variation
Sets the amount of random variation on the LFO frequency each time a key is pressed, 
which is useful for ensemble effects, where each note played has a slightly different 
modulation rate. The higher the number, the greater the note to note variation in the 
LFO rate.
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Sync
Key Sync or Free Running. With key sync selected, the LFO wave starts at the beginning 
of its cycle at each key depression. With Key Sync off, the LFO wave begins at a random 
point in its cycle on each key depression.

BPM
 The master tempo 

can be set internally 
using the tempo control 
in the Multisetup 
window, or controlled 
from an external MIDI 
clock. Internal/External 
clock selection is located 
in the Preferences dialog 
box.

The BPM button allows the LFO frequency to be controlled by the Master Tempo 
(located in the Multisetup window). The Master Tempo can also be derived from an 
external MIDI clock to synchronize the envelope times with external sequencer or 
arpeggiator tempo changes. The chart below lists all the displayed musical note 
divisions when the LFO is set to BPM. The “Master Tempo Clock Pulses” column shows 
the exact number of clocks used by each note division based on the MIDI standard of 
24 pulses per quarter note. The LFO cycle will last for the exact note division shown.

BPM Tempo Rates
(based on Master Tempo)

Displayed Note 
Division

Master Tempo Clock 
Pulses

8x whole note (double long) 8/1 768

4x dotted whole note 4/1d 576

8x whole note triplet 8/1t 512

4x whole note (long) 4/1 384

2x dotted whole note 2/1d 288

4x whole note triplet 4/1t 256

2x whole note (breve) 2/1 192

dotted whole note 1/1d 144

2x whole note triplet 2/1t 128

whole note 1/1 96

dotted half note 1/2d 72

whole note triplet 1/1t 64

half note 1/2 48

dotted quarter note 1/4d 36

half note triplet 1/2t 32

quarter note 1/4 24

dotted 8th note 1/8d 18

quarter note triplet 1/4t 16

8th note 1/8 12

dotted 16th note 1/16d 9

8th note triplet 1/8t 8

16th note 1/16 6

dotted 32nd note 1/32d 4.5

16th note triplet 1/16t 4

32nd note 1/32 3
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LFO Tricks & Tips:

Lag Processors 1 & 2

Lag processors can be inserted in a modulation patch to inhibit 
rapid changes in the modulation source or cause it to lag behind 
the input. The rate of lag is adjustable from 0 to 10 and can be 
modulated using a PatchCord. A setting of 0 will cause the least 
amount of lag. 10 is the slowest lag.

Extra Summing Amps

The Lag Processors can also be used as 2 additional 
summing amps. Summing amps are used to add several 
modulation sources together so the output can be 
controlled by a single Cord Amount. The output of Lag0 in 
and Lag1 modulation sources are equal to the sum of any 
cords connected to the Lag in destinations. The summing 
node is located before the lag processor as shown in the 
diagram.

• The Random LFO wave is truly random and is different for each voice and layer.

• The Pattern (Pat) waveforms will sound the same on different layers and voices.

• When the PatchCord amount for an LFO is a negative value, the LFO shape will be 
inverted. (A rising sawtooth turns into falling sawtooth.)

• Sine + Noise is very useful for simulating trumpet and flute vibrato.

• When routing Hemi-quaver to Pitch… 
+37.5 = major scale                        -37.5 = phrygian scale
+75 = whole tone scale                (+37.5) + (+75) = diminished scale (two cords)
odd amount = S+H sound.

• Try combining the Pattern LFOs, or controlling the amount of one with another, or 
combining them with the clock divisors.

• The Pitch Amount Chart on page 158 shows the exact cord amounts needed to get 
musical intervals when modulating pitch with the LFOs.

Lag processors are used to slow down and smooth rapid changes in 
control signals. In the example above, the instantaneous switch change 
becomes a smooth transition.

Lag
Processor

Foot
Switch

LFO

Cord Cord
Lag Slows

Rapid Change
of FootswitchSwitch

Instantly On

LFO Gradually
Speeds Up

Lag

Sum Node

Lag 0 in

Lag 0
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Function Generators
The function generator is a multi-function modulation source, fully capable as a 
complex LFO, a sequencer, an arpeggiator, or an envelope generator, depending on the 
way it is utilized. Because of its amazing flexibility, the function generator is certain to 
be one of your favorite new toys in your sound design toolbox. Because you can never 
have too much of a good thing, each voice has three independent function generators!

The function generator outputs a stepped (or smooth) sequence of values and a gate/
trigger for each step. Its most obvious function is a step-sequencer (when controlling 
pitch), or as a complex event generator for the filter or amplifier. Several key sync and 
direction modes allow you to create interesting variations and complex levels of 
control. The gate and trigger outputs can, trigger envelope generators, retrigger samples 
or LFOs, accent certain notes, change tempo, and trigger other events, which we’ll 
describe in detail later on.

Function Display and Grid
The function display is a bar graph, with an additional line of rectangular cells. The bar 
graph displays the function levels associated with each step, while the rectangles 
display a pattern used to generate Trigger and Gate modulation signals.

The display shows all 64 steps, with all steps to the left of the End Step drawn in color; 
the steps to the right of the End Step (if any) are drawn in gray.

You can edit the function either by dragging across the display, or by dragging 
individual steps. A pop-up tool tip shows the step number and value.

There are three key commands to make curve drawing easier. Hold the appropriate key 
while moving the cursor.

• Ctrl-key...... Constrains to vertical dragging only. Useful for setting levels.

• Shift-key .... All levels are set to the same value, resulting in a horizontal line. This 
also works for the trigger outputs, turning them on or off.

• Alt-key ....... Values are randomized when this key is held down while dragging. 
The trigger outputs, as well as the levels can be randomized. The 
values are interpolated when dragging quickly, which can result in 
interesting random curves.

The Single Step Controls allow you to precisely set the value and trigger status of each 
individual step. This method is useful for entering a prearranged composition.

The Grid controls determine the spacing of a set of vertical grid lines that are overlaid 
on the function display (see the following page).
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The grid options are listed below:

• None

• Semitone......... One line for each unit (semi tones).

• Octaves ........... One line for each 12 units.

• Major Triad..... Lines correspond to a major triad, repeated over the full range.

• Minor Triad .... Lines correspond to a minor triad, repeated over the full range.

• Major Scale ..... Lines correspond to a major scale, repeated over the full range.

• Minor Scale .... Lines correspond to a minor scale, repeated over the full range.

The musical intervals on the grid are helpful when the function generator is 
modulating Pitch and the Cord amount is set to 100%.

The Grid Button turns on Snap-to-Grid, which forces the function values to snap to the 
grid lines.

The Show All button allows you view all 64 steps (when on), or only shows the steps 
before the End Step. This feature is very useful with shorter sequences as it lets you 
“zoom in” to the area of interest.

� Using the Function Generator as a Sequencer / Arpeggiator
Using the Function Generator as a pitch controller is the most obvious application. It’s 
also lots of fun and the easiest way to explore the various controls.

Set up

1. Select P0017 New-Age Oohs from the Tree by clicking on 
the little keyboard. 

2. Next click on the (+) symbol to open the preset modules.

3. Click on the Voice Processing icon . The Voice 
Processing module appears.

4. Go to PatchCord #18 and patch “Func Gen 1 +” to “Pitch” 

with an amount of 100%. 

5. Now click the Func Gen 1 tab. The screen below appears.

6. Turn on “Snap to Grid” by pressing the Grid button.

7. Select Major Scale as the Grid Type.

2. 1.

3.

Trigger & Gate Grid LinesEnd Step
Single Step 
Controls

Snap to Grid Grid Type

Click & Drag Here
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Modify the Sequence & Play

8. Click in the graphic display and begin horizontally dragging the mouse. Notice 
how the bars snap to the Grid lines.

9. Play a key. Play a chord. Play an arpeggio. 

 Tip: Turn “Show All” 
off to zoom in and only 
display the steps in your 
sequence.

10. Go ahead and adjust the sequence until you get something you like. The function 
generator editing controls are described on page 139. They’re easy to use once you 
get the hang of it.

11. Click and drag the End Step line to shorten or lengthen the sequence.

12. Change the Step Rate to change the speed of the sequence. (The BPM button locks 
the step rate to a note division of the Master Tempo.)

13. Now change the Direction. There are six different direction options described on 
page 143.

14. Change the Grid Type and create a new sequence

15. Play around with the controls as much as you like. The function generators are a lot 
of fun and have many, many applications. You’ve just created a type of program-
mable arpeggiator. Later on, we’ll describe how to add rests, accents, change the 
timing of notes and do a few other tricks.

Function Generator Main Controls

Control Function

Step Rate
Sets the step frequency. This value controls the frequency at which 
individual steps occur, not the overall rate of pattern repetition. The 
frequency range for each step is 0.081 Hz to 18.147 Hz.

BPM
Changes the Frequency control to a clock divider control to change 
steps on quarter notes, eighth notes, etc. See the BPM chart on 
page 137 for the complete list of possible clock divisors.

End Step

This number sets the last played step from 1 to 64. This field can be 
modulated between 1 and 64. The end step can also be changed by 
simply dragging the end step line in the graphic display. A handy pop-
up tool tip shows the step number and the value.

Sync

There are three sync modes: Key, Freerun, and Channel. 

• Key Sync: The function generator begins at the first step for 
each new key played. Each key follows its own pattern.

• Freerun: The pattern begins at a random step for each new 
key played. Each key follows its own pattern.

• Channel Sync: The pattern begins with the first key down on 
the assigned MIDI channel and continues until no keys are held 
down on the MIDI channel. All keys on the channel follow the 
same pattern.

Smooth
When on, linear interpolation is applied between steps to provide a 
smooth output instead of a stepped function.
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Direction

This control determines the order in which the steps are played.

• Forward: Normal playback, loops back to the beginning when 
the end is reached.

• Reverse: Starts at the last step and counts back, looping from 
beginning to end.

• Pendulum (back and forth): Starts at the first step, precedes to 
the last, and then reverses. Each end point is played once.

• Random: The next step is chosen at random.

• Brownian: (“drunkards walk”) The next step is chosen at 
random, but it is always the next or previous step in the 
function. In other words, the next step is always adjacent to the 
current step, but the direction of motion is chosen at random. 
Motion will bounce off the endpoints; when an endpoint is 
reached, the next step is always the one that is inward in the 
function.

• One-shot: Forward, plays once and then stops at the end.

Function Generator Main Controls

Control Function
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Modulation Destinations
The following modulation destinations are available for each function generator: 

Function Generator Ideas

• Speed Control - You can slow down or speed up 
certain notes by routing the Function Generator 
Gate back to control its own Rate. Positive Cord 
values speed up the gated notes; negative Cord 
values slow down gated notes.

• Glide Control - Only notes that 
have the Gate turned on will glide 
using this patch. This technique 
works well for all kinds of music 
including synth bass lines and 
adds another element of interest 
to the sound.

Rate

Positive modulation increases the initial rate. 
Negative values decrease the initial rate.

• A modulation value of +1.0 (Cord: +100%) will result in the 
maximum step rate (18.147 Hz) from any initial setting.

• A modulation value of -1.0 (Cord: -100%) will result in the 
minimum step rate (0.081 Hz) from any initial setting.

Direction

Changes the direction (forward <-> backward). This is evaluated at 
each step. Modulation of direction is only valid when the initial 
direction type is set to forward or backward. A positive modulation 
value (>0.0) will result in a forward direction. A negative modulation 
value (<0.0) will result in a reverse direction.

Retrigger
Restarts the function generator when the modulation source crosses 
zero in the positive direction.

Length

Modulating the Length changes the end step as follows:

1. Modulation adds to the user specified end step.

• A mod value of +1.0 (Cord: +100%) adds 64 steps to the 
end step (clipped at 64).

• A mod of -1.0 (Cord: -100%) adds -64 steps to the end step 
(clipped at 1).

2. If the current step exceeds the sum of the End Step and the 
Modulation Amount, the function generator will:

• Return to the starting step for the single direction types such 
as forward, backward, etc. in a looping type fashion.

• Reverse direction in the case of the pendulum.

• Stop in the case of the one shot direction type.

Function
Generator

Gate
Out

Rate
In

Function
Generator

Lag
Processor Pitch

Gate
Out

8%

Initial Lag = 0
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• Rests and Accents - You can insert rests and accents onto specific notes using 
this simple patch. To make a rest, set the amp cord amount negative (turning the 
amp off). For an accented note, set the cord amount positive (making the amp 
louder). 

• Two-Speed Sequence - This sequence 
changes rate every other time it plays 
through. The flip-flop sets and resets 
every other time it is pulsed with the 
function generator gate. The Cord 
amount from the flip-flop controls 
the amount of speed variation.
(Note: The -DC Cord is necessary 
because the flip-flop input needs to go 
positive from a negative value.)

• Multi-Speed Sequence - If you want 
to control the timing for each step in a 
sequence, two function generators can 
be used. Function Generator 1 
controls the pitch and Function 
Generator 2 controls the length of 
each note.

Two function generators will remain 
in sync if their initial rate, length and 
direction are the same, and if the 
modulation is identical for both.

• Sample Re-triggering - The Trigger Out of the 
Function Generator is ideal for re-triggering 
samples. In fact, the trigger out can be used just 
for sample re-triggering without using any pitch 
control. 
Use Sample Retrigger (-) to trigger on the note. 
(Remember, samples to be retriggered must 
have a loop.)

Function
Generator

Samples Amp

Vol

Pitch

Gate

+ Out

Z-Plane
Filter

Negative Amount = Rest
Positive Amount = Accent

Function
Generator

Flip
Flop

Pitch

Gate
Out

Rate
In

DC
-1%

+10%

Adjust to Taste

Function
Generator

1

Function
Generator

2

Rate

Rate

Amounts
must be
Identical

Initial Rate,
Length & Direction
must be Identical

for both.

Function
Generator

Trigger

Sample
Retrigger (-)

Pitch
+ Out
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Filter Controls

You can choose from 55 different filter types or choose “No Filter”, which bypasses the 
filter section.

Most of the filters have two parameters: Frequency (or Morph) and Resonance (Q, 
Gain, Body Size). These two parameters can be continuously varied during the note 
(choose realtime resonance).

The frequency response curve of the filter is accurately shown in the display as you 
change the initial filter settings. Frequency is shown on the horizontal axis, with 
amplitude on the vertical axis.

High values of Q or resonance amplify frequencies near the cutoff or center frequency. 
In a swept EQ filter, gain controls the amount of boost or cut. In a phaser or flanger, 
resonance determines the depth of the effect. In the vocal filters, body size determines 
the apparent size of the mouth cavity.

You will notice an increase in voice count when the filters are bypassed as the filters 
steal cycles from your computer’s CPU. 12th order filters use more CPU and therefore 
decrease the maximum voice count.

Filter Descriptions

Filter Name Order Type Description

2-pole Lowpass 02 LPF Typical OB type low-pass filter with a shallow 
12 dB/octave slope.

4-pole Lowpass 04 LPF 4-pole low-pass filter, the standard filter on 
classic analog synths. 24 dB/octave rolloff.

6-pole Lowpass 06 LPF 6-pole low-pass filter which has a steeper 
slope than a 4-pole low-pass filter. 36 dB/
octave rolloff!

2-pole Highpass 02 HPF 2-pole high-pass filter. 12 dB/octave slope.

Filter Types

BPF Band-pass filter

EQ+ EQ boost filter

EQ- EQ cut filter

FLG Flanger filter

HPF High-pass filter

LPF Low-pass filter

PHA Phaser filter

PROG Programmable

REZ Highly Resonant

SFX Special Effect

VOW Vowel / formant

WOW Wah-Wah pedal
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4-pole 
Highpass

04 HPF Classic 4-pole high-pass filter. Cutoff sweep 
progressively cuts 4th Order High-pass.

2-pole 
Bandpass

02 BPF Band-pass filter with 6 dB/octave rolloff on 
either side of the passband and Q control.

4-pole 
Bandpass

04 BPF Band-pass filter with 12 dB/octave rolloff on 
either side of the passband and Q control.

Contrary
Band pass

06 BPF A novel band-pass filter where the frequency 
peaks and dips midway in the frequency 
range.

SweptEQ
1 octave

06 EQ+ Parametric filter with 24 dB of boost or cut 
and a one octave bandwidth.

Swept EQ
2->1 octave

06 EQ+ Parametric filter with 24 dB of boost or cut. 
The bandwidth of the filter is two octaves 
wide at the low end of the audio spectrum, 
gradually changing to one octave wide at the 
upper end.

Swept EQ
3->1octave

06 EQ+ Parametric filter with 24 dB of boost or cut. 
The bandwidth of the filter is three octaves 
wide at the low end of the audio spectrum, 
gradually changing to one octave wide at the 
upper end.

Phaser 1 06 PHA Recreates a comb filter effect typical of phase 
shifters. Frequency moves position of notches. 
Q varies the depth of the notches.

Phaser 2 06 PHA Comb filter with slightly different notch
frequency moving the frequency of notches.
Q varies the depth of the notches.

FlangerLite 06 FLG Contains three notches. Frequency moves 
frequency and spacing of notches.
Q increases flanging depth.

Vocal
Aah-Ay-Eeh

06 VOW Vowel formant filter which sweeps from “Ah” 
sound, through “Ay” sound to “Ee” sound at 
maximum frequency setting. Q varies the 
apparent size of the mouth cavity.

Vocal Ooh-Aah 06 VOW Vowel formant filter which sweeps from “Oo” 
sound, through “Oh” sound to “Ah” sound at 
maximum frequency setting. Q varies the 
apparent size of mouth cavity.

Dual EQ Morph 06 PROG Please refer to the detailed description on 
page 151.

Dual EQ +
Lowpass Morph

06 PROG Please refer to the detailed description on 
page 153.

Dual EQ Morph + 
Expression

06 PROG Please refer to the detailed description on 
page 152.

Peak/Shelf Morph 06 PROG Please refer to the detailed description on 
page 153.

Morph Designer 2 - 12 PROG Please refer to the detailed description on 
page 149.

Filter Name Order Type Description
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Ace of Bass 12 EQ+ Bass-boost to bass-cut morph

MegaSweepz 12 LPF “Loud” LPF with a hard Q. Tweeters beware!

EarlyRizer 12 LPF Classic analog sweeping with hot Q and
Low-end.

Millennium 12 LPF Aggressive low-pass filter. Q gives you a variety 
of spiky tonal peaks.

MeatyGizmo 12 REZ Filter inverts at mid-Q.

KlubKlassik 12 LPF Responsive low-pass filter sweep with a wide 
spectrum of Q sounds 

BassBox-303 12 LPF Pumped up lows with TB-like squelchy Q
factor.

FuzziFace 12 DST Nasty clipped distortion. Q functions as
mid-frequency tone control.

DeadRinger 12 REZ Permanent “Ringy” Q response.
Many Q variations.

TB-OrNot-TB 12 EQ+ Great Bassline “Processor.”

Ooh-To-Eee 12 VOW Oooh to Eeee formant morph.

BolandBass 12 EQ+ Constant bass boost with mid-tone Q control.

MultiQVox 12 VOW Multi-Formant, Map Q To velocity.

TalkingHedz 12 VOW “Oui” morphing filter. Q adds peaks.

ZoomPeaks 12 REZ High resonance nasal filter.

DJAlkaline 12 EQ+ Band accentuating filter, Q shifts “ring”
frequency.

BassTracer 12 EQ+ Low Q boosts bass. Try sawtooth or square 
waveform with Q set to 115.

RogueHertz 12 EQ+ Bass with mid-range boost and smooth Q. 
Sweep cutoff with Q at 127.

RazorBlades 12 EQ- Cuts a series of frequency bands.
Q selects different bands.

RadioCraze 12 EQ-  Band limited for a cheap radio-like EQ

Eeh-To-Aah 12 VOW “E” to “Ah” formant movement. Q accentuates 
“peakiness.”

UbuOrator 12 VOW Aah-Uuh vowel with no Q. Raise Q for throaty 
vocals.

DeepBouche 12 VOW French vowels! “Ou-Est” vowel at low Q.

FreakShifta 12 PHA Phasey movement. Try major 6 interval and 
maximum Q.

CruzPusher 12 PHA Accentuates harmonics at high Q. Try it with a 
sawtooth LFO.

AngelzHairz 12 FLG Smooth sweep flanger. Good with vox waves. 
e.g. I094, Q =60 

DreamWeava 12 FLG Directional Flanger. Poles shift down at low Q 
and up at high Q.

Filter Name Order Type Description
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AcidRavage 12 REZ Great analog Q response. Wide tonal range.
Try it with a sawtooth LFO.

BassOMatic 12 REZ Low boost for basslines. Q goes to distortion 
at the maximum level.

LucifersQ 12 REZ Violent mid Q filter! Take care with Q values 
40-90.

ToothComb 12 REZ Highly resonant harmonic peaks shift in
unison. Try mid Q.

EarBender  12 WAH Midway between wah & vowel. Strong
mid-boost. Nasty at high Q settings.

KlangKling 12 SFX Ringing Flange filter. Q “tunes” the ring
frequency.

Filter Name Order Type Description
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Programmable Morphing Filters
There are five user-programmable morphing filters which have the ability to change 
their response over time. You can design your own custom filters that morph between 
filter types.

Take the time to learn to use these powerful filters because they sound great. The 
frequency response graphs are especially helpful to understand the action of these 
complex filters since the control functions are slightly different for each filter.

Morph Designer
The Morph Designer is the ultimate in synthesizer 
filters with up to six completely programmable filter 
sections (lowpass, highpass or EQ) and the ability to 
morph between two completely different frame 
settings of the six sections.

Any of the six filter sections can be designated as 
either a lowpass, highpass, or EQ filter. You can set the 
filter frequency and Q (or Gain in the case of EQ) for 
both the low and high positions of the Morph control. 
When the Morph control is changed, all the filter 
controls interpolate between the settings you 
programmed. Twenty-four knobs have been reduced 
to just two extremely powerful controls, Morph and Gain (offset).

 Tip: Set the Gain/Q 
Wheel in the center 
while programming your 
Morph Designer filter, 
and use the Morph 
control to sweep the 
filter.

EQ Stage Gain Controls

• The small Gain knobs control Gain (-24dB to +24 dB)

• The big Gain Wheel is Gain Offset (-24dB to +24dB)

• For any given section, the two Gain controls add (clipping at 0 or 100%)

HP/LP Stage Gain Controls

• The small Gain knobs control Q (0 to 100%)

• The big Q Wheel is Q Offset (-50% to +50%)

• For any given section, the two Q controls add (clipping at 0 or 100%)

Morph Designer A supremely programmable filter with up to six filter sections.

Dual EQ Morph A 2-frame morphing filter with two EQ sections and controllable 
gain.

2EQ Morph + 
Expression

This filter contains two EQ sections and a separately controllable 
lowpass filter.

2EQ Morph + 
Lowpass Morph

This filter has two EQ sections and lowpass filter tied to the 
Morph parameter.

Peak/Shelf Morph This is a 2-frame morphing filter with independent control over 
frequency, shelving and peak for each filter frame.

Lo
Morph

Hi
Morph

1 2 3 4 5 6

LP EQ EQ EQ EQ HP

Filter Stages
E-MU Systems 149



6 - Voice Processing
Amplifier, Filter & Auxiliary Envelopes
� Explore the Morph Designer:
You can create great sounding filters with just a few filter sections.

1. Select any preset with lots of harmonic content.

2. Go into the Voice Processing window, select all Groups and select Morph Designer 
as the filter type.

3. Turn MIDI Controller A all the way down on your MIDI keyboard.

First Filter Section

4. Select LP as the shape for filter Stage 1.

5. Turn the Morph Wheel all the way down. (Select the Wheel, then press Home.)

6. Set the Gain Wheel to its center position. (Alt+click the mouse on the control.)

7. Set the Frequency and Gain controls of the Lo Morph all the way down.

8. Turn the Morph Wheel all the way up. (Select the Wheel, then press End.)

9. Set the Frequency and Gain controls of the Hi Morph to their maximum settings.

10. Now play the keyboard and turn the Morph wheel. You have just created the classic 
synthesizer lowpass filter response, but in this case the Q turns up automatically 
when you change the filter frequency. If you turn up the Q Wheel, you get even 
more Q. (The Q control adds to the Lo and Hi Q settings.)

Add Another Section

11. Select Stage 2 and this time choose EQ as the filter type.

12. Turn the Morph Wheel down (you can leave the Gain Wheel centered).

13. Set the Lo Morph Frequency to the minimum setting.

14. Set the Low Morph Gain to zero. (Alt+click the mouse on the control.)

15. Turn the Morph Wheel to the maximum setting.

16. Set the small Hi Morph controls so that another 
little resonance peak appears next to the one from 
the lowpass filter. The filter response display 
should look something like this:

17. Now play the keyboard and turn the Morph Wheel. The dual resonance peaks 
come in as the filter frequency (morph) is turned up, and they sound much more 
interesting than a simple lowpass.

18. Go ahead and adjust the controls some more, noting the interaction between the 
Lo/Hi Morph controls and the Morph Wheel. It’s really pretty simple. The Morph 
Wheel interpolates between the Lo and Hi settings of the filter section.

Add Another Section

19. When you’re ready go ahead and add yet another filter section. You’re on your 
own now so choose any filter type you want. Using just three of the six sections you 
can create some truly great sounding filters.
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Dual EQ Morph

This is a programmable 2-frame Morphing filter 
with two EQ sections. As the Morph value is 
increased, the filter interpolates from the low to 
high settings. The Gain of each section remains 
constant during the Morph, but can be scaled at 
note-on time by controlling the Initial Gain 
parameter.

This filter can be used to create your own vocal 
formant filters.
(Try the settings shown and modulate with the + 
filter envelope or +LFO.)

Morph Designer Controls

Control Function

Morph 
(Frequency)

The Morph control actually morphs between the Low Morph 
and High Morph Frames of the filter. The Morph control is a 
modulation destination.

Gain/Q 
(Resonance)

Increases or decreases the gain or Q of all filter sections simulta-
neously. This adds to the settings made in the Lo and Hi Morph 
controls. The Resonance control is a modulation destination.

Section Selects which filter section you are currently editing.

Shape Sets the filter shape for the current section being edited.
• Off...........Disables the filter section
• EQ........... Peak or Dip response
• Lowpass....Lowpass response with Q
• Highpass..Highpass response with Q

Lo Morph 
Frequency

Sets the center frequency of the current section when the Morph 
control is at minimum.

Lo Morph Gain/Q Sets the Gain (if EQ) or Q (if lowpass or highpass) of the current 
section when the Morph control is at minimum.

Hi Morph 
Frequency

Sets the center frequency of the current section when the Morph 
control is at maximum.

Hi Morph Gain/Q Sets the Gain (if EQ) or Q (if lowpass or highpass) of the current 
section when the Morph control is at maximum.
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Dual EQ Morph + Expression

This filter also has two EQ sections and a lowpass 
filter with independent control over the lowpass 
filter frequency (Expression). This allows you to 
use velocity (for example) to control expressive 
timbre via the lowpass filter, while the Morph 
parameter is modulated for another effect. As the 
Morph value is increased, the filter interpolates 
from the low to high settings. The gain parameter 
for each EQ section stays constant during the 
morph.

 Morph = Filt. Freq.
Expression = Filt. Res.

Frequency

A
m

p
li
tu

d
e

M
or

ph

Low EQ 1

High EQ 1
High EQ 2

Low EQ 2

Dual EQ &
2EQ Morph

Filters

As the Morph value is increased, the filter interpolates from the Low to High Frequency settin
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2EQ + Lowpass Morph

This unusual filter has two EQ sections and a 
lowpass filter whose Fc is also controlled by the 
Morph parameter. The Lowpass filter is 
completely open at a setting of 255. As the Morph 
value is increased, the filter interpolates from the 
low to high settings and the lowpass filter allows 
more high frequencies to pass. The Q of the 
lowpass filter has an initial setting and can also be 
modulated realtime using the Filter Resonance 
parameter. The gain parameter for each EQ 
section stays constant during the morph.

Peak/Shelf Morph

This 2-frame morphing filter offers independent 
control over frequency, shelving and peak for 
each of the two filter “frames”. The Peak 
parameter can also be modulated in realtime by 
controlling the Filter Resonance parameter.

When the Shelf parameter is negative, the filter 
will have a low shelving response. When the 
Shelf parameter is positive, the filter will assume 
a high shelving response. With Shelf at zero, the 
filter assumes a peak filter response.

Note that the three controls of the two morphing 
frames are grouped in this filter and all three 
controls are morphed.

 Fc/Morph = Filt. Freq.
 LPF Q = Filt. Res.

 Morph = Filt. Freq.
Peak = Filt. Resonance
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Amplifier Controls
These parameters set the overall volume and 
pan settings, as well as the output channels 
for the selected voice(s).

The voice effect sends allow you to route the 
voice output to the main and aux send 
busses.

The Classic Response button matches the 
amplifier response to that  of the Emulator 
IV.

Volume
Sets the initial volume of the voice from -96 dB (off) to +10 dB. This is the same 
volume control as shown on the Mix/Tune tab of Voices & Zones (page 96).

Lower the volume of the Amplifier when modulating Amp Volume. (You won’t hear 
any modulation if the volume is already turned all the way up.)

The default setting is 0 dB which allows a bit of headroom so that other modulators 
can be added in without clipping. Use this volume control to balance the voice output 
against others. If you hear clipping, reduce volume setting.

Panning
Sets the initial stereo pan position of the voice. Subsequent modulation is added to or 
subtracted from this value. This is the same pan control as shown on the Mix/Tune tab 
of Voices & Zones (page 96).

Amp Envelope Dynamic Range
Sets the maximum amount of attenuation from the amplifier envelope generator. 
Variable from -96 dB to -48 dB. With longer attack times, reducing the envelope depth 
(towards -48 dB) may provide a more natural-sounding volume envelope.

Response
Selects between the “Classic” amplitude response and “Emulator X” response. Choose 
Classic response ONLY if you’re authoring for hardware Emulators. This button should 
be Off if you’re creating sounds for the Emulator X.

FX Wet/Dry
This control sets the mixture of Wet/Dry signal that will be sent from the Voice Main 
output to the Preset FX processors. See the diagram at right. ->

A setting of 0 means that no signal from the Main output of the voice will be sent to the 
Preset FX. A setting of 100 means that all of the Main voice output will be sent through 
the Preset FX.

Voice
Output

Aux 1

To
Preset
FX

To
Aux
FX

Main

Wet/Dry

Aux 2

Aux 3

wet

dry
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Voice Effect Sends
Each voice has one Main Output level control which feeds a Wet/Dry mixer, and three 
Aux Send level controls. The Wet/Dry outputs from all voices in the preset are summed 
into the Preset FX. The output of the Preset FX section can be mixed into the Main and 
Aux 1-3 outputs. The Main Output of the Preset FX goes directly to the channel’s main 
stereo output. The Aux Outputs of the Preset FX are summed together with the Aux 
Output signals from all the voices.

All the Aux Sends 1-3 from all voices and channels are summed with Aux Outputs 1-3 
from the Preset FX and then feed the Aux FX processors located on the Multisetup page. 
See page 73. The outputs of the Aux FX processors (which may be bypassed) feed the 
Aux Output section, where they can be directed to any available ASIO output.

The Aux Output On/Off button to the right of each channel main output allows you to 
turn the Aux Sends on or off for that channel so you can hear the channel with or 
without effects.

The Voice Effect Send levels and the Wet/Dry mix can be controlled using the voice 
modulation cords. See “Send Aux 1-3” on page 159.

See also “Controlling the Preset Effect Amount from the Voice” on page 239.

Voices

per
VOICE

per PRESET

Aux 1

Main

Wet/Dry

Aux 2

Aux 3

MainMain

Aux 1

Aux Outputs

Aux 2

Aux 3

Aux 1

Aux 2

Aux 3

FX

FX

FX

FX Awet

dry

per MULTI

Aux
On/Off

Post FX
Sends

FX B

ASIO 1/2

ASIO 1/2

ASIO 3/4

ASIO 31/32

ASIO 1/2
ASIO 3/4

ASIO 31/32

ASIO 1/2
ASIO 3/4

ASIO 31/32
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Modulation Cords
Each voice contains 36 Cords which are used to route modulation sources to destina-
tions and control the amount of modulation. There are only three permanently 
connected modulation connections: amp envelope-to-amplifier, pitch wheel-to-pitch, 
and key-to-pitch. All other modulation routings must be connected with a Cord.

Modulation Sources

Source Description

Crossfade Random Generates the same random value for all voices in a preset. 
This source is intended to be used for crossfading voices.

Key (+, ~) Key Tracking - This value increases as you play up the keyboard.

Velocity (+, ~, <) Key Velocity - This value increases as the key is played harder.

Release Velocity This value increases the slower you release the key

Cord
Sources

Cord
Destinations

Modulation Amounts

Cord Page Select Buttons

Modulation
Source

LFO 1

Destination
Amount +/-

Amp
Volume

- +

Tremolo is created by routing an LFO to the Amp Volume using a Cord.
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Gate This value goes to full value as long as a key is depressed.

Pitch Wheel MIDI data from your keyboard’s pitch bender.

Mod Wheel MIDI data from your keyboard’s modulation wheel or lever.

Pressure Aftertouch MIDI data (channel pressure)

Pedal Footpedal MIDI data (normally controller #4)

MIDI A - P 16 assignable MIDI continuous controllers. See page 28.

Footswitch 1 & 2 MIDI footswitch data (normally controllers 64 & 65)

F-F Footswitch 1&2 MIDI footswitch inputs which latch on or off with each press.

T’switch MIDI “Thumb-switch” input. General switch controller.

T’switch FF MIDI flip-flop thumb-switch input. Latching switch controller.

MIDI Volume MIDI Continuous Controller data on channel #7

MIDI Pan MIDI Continuous Controller data on channel #10

Expression MIDI Expression Controller data (MSB) on channel #11

Key Glide A smoothly changing control source based on the Glide Rate 
and the interval between the last two notes played.

Key CC Window Keyboard keys output as a modulation source, used in 
conjunction with the “Key CC Window”. See page 85.

Amp Envelope Amplifier Envelope Generator (+, ~, <). See page 159.

Filter Envelope Filter Envelope Generator (+, ~, <). See page 159.

Aux Envelope Auxiliary Envelope Generator (+, ~, <). See page 159.

LFO 1 & 2 (+, ~) Low Frequency Oscillators 1 & 2 (+, ~,)

Func Generators 1-3 Function Generator 1, 2 & 3 outputs (+, ~, <). See page 139.

Func Gen Gate & 
Trig

Function Generator Gate and Trigger outputs. See page 143.

White Noise A continuously varying random control source for effects.

Pink Noise A lower frequency random control source.

KRandom 1 & 2 These sources generate different random values for each voice. 
The values are chosen at key-on time and remain constant.

Lag 0 & 1 in Lag Processors can also be used as summing amps. 
See page 138.

Lag Processor 1 & 2 Lag processors slow down rapid changes. See page 138.

Channel Lags 1 & 2 Lag processors that operate at the channel level. See page 85.

Channel Ramp Slope generator that is triggered by the first key pressed.
See page 86.

Poly Key Timer Outputs a value based on the time a key is held down.
See page 86.

Clock Divisors MIDI clock is divided to the specified value and used as a
modulation source. See page 304.

DC Offset A fixed value that can be scaled by the Cord to offset a value. 

Modulation Sources

Source Description
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Pitch Amount Chart
In order to obtain specific pitches when routing LFOs, envelopes and controllers 
through the PatchCords, use the following chart.

Summing Amp The Summing Amp is useful for mixing several modulation 
signals so they can be controlled from a single Cord amount. 
See page 307.

Switch The switch outputs full value (100) when the input is greater 
than 0. (The output value can be scaled by a Cord.) 
See page 307.

Absolute Value This processor inverts negative values and leaves positive values 
untouched so that only positive values are output.
See page 307.

Diode This processor allows only positive values to pass.
Negative values are blocked. See page 307.

Flip-Flop The output of this processor alternates between full value and 
zero each time the input goes positive from zero or a negative 
value. If an LFO were connected to the input, the output 
would be a square wave of half the input frequency.
See page 307.

Quantizer Smoothly changing signals are transformed into discrete steps. 
The value of the input Cord determines the number of steps. 
The value of the output Cord determines the size of the steps. 
(Hint: Gain 4x can increase number of steps or step size.) 
See page 307. 

Gain 4x This processor amplifies the modulation input by a factor of 4.

Semitone Cord Amt Semitone Cord Amt Semitone Cord Amt

1 3.125 9 28.125 17 53.125

2 6.25 10 31.25 18 56.25

3 9.375 11 34.375 19 59.375

4 12.5 12 37.5 10 62.50

5 15.625 13 40.625 21 65.625

6 18.75 14 43.75 22 68.75

7 21.875 15 46.875 23 71.875

8 25.00 16 50.00 24 75.00

Modulation Sources

Source Description
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Modulation Destinations

Destination Description

Key Sustain Holds the envelope generators at the sustain point as long as this value is above zero.

Fine Pitch Fine pitch modulation with a maximum range of 1 semitone.

Pitch Full range pitch modulation.

Glide Controls the portamento (glide) time.

Chorus Amount Controls the amount of voice chorus (doubling).

Chorus Position ITD Controls the Inter-aural Time Delay of voice chorus. See page 130.

Sample Start Controls the sample start offset point. See page 131.

Sample Loop Controls the sample loop length. See page 161.

Sample Retrigger (+) A positive-going, zero-crossing value retriggers the sample from the sample start.
Note: A sample must be looped in order to retrigger properly. For unlooped sounds, 
create a silent loop at the end of the sample. 

Sample Retrigger (-) A negative-going, zero-crossing value retriggers the sample from the sample start. 

Loop Select
(Continuous)

Loop selection that plays through to the next selected loop. Only backward jumping is 
allowed. See page 219.

Loop Select
(Jump)

Loop selection that jumps to the selected loop at the end of the currently playing loop. 
Forward and backward jumping is allowed. See page 221.

Filter Frequency Controls the frequency (or morph) of the filter.

Realtime Resonance Realtime control of filter resonance (Q, gain, body size).

‘Filter Resonance Filter resonance control which is set at note-on time only.

Amp Volume Controls the volume of the voice.

Amp Pan Controls the left/right positioning of the voice.

Amp Crossfade Controls the RT crossfade of voices so programmed. See page 105.

Send Main Controls the level of the voice sent to the Preset FX and the Main Output. See page 232.

Send Aux 1-3 Controls the level of the voice sent to the Aux Send 1, 2 or 3 FX processors. See page 232.

Wet/Dry Mix Controls the Wet/Dry mix sent to the Preset FX. See page 232.

Amp Envelope Rates Positive values decrease the rates of all amp envelope stages.

Amp Env. Attack Positive values decrease the attack rate of the amp envelope.

Amp Env. Decay Positive values decrease the decay rate of the amp envelope.

Amp Env. Release Positive values decrease the release rate of the amp envelope.

Filter Envelope Rates Positive values decrease the rates of all filter envelope stages.

Filt Env Atk, Dcy, Rel Same as for Amplifier. See above.

Filter Env. Trigger A positive-going, zero-crossing value retriggers the envelope. 

Aux. Envelope Rates Positive values decrease the rates of all Aux. envelope stages.

Aux Env Atk, Dcy, Rel Same as for Amplifier Envelope parameters. See above.

Aux Env. Trigger A positive-going, zero-crossing value retriggers the envelope. 

LFO Rate (1 & 2) Positive values increase the LFO rate.

LFO Trigger (1 & 2) A negative-going, zero-crossing value resets the LFO to zero.
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Modulation Source Polarity
On a few of the modulation sources you’ll see the following suffixes: +, ~, <. These 
designate the polarity of the modulation source. A plus (+) means that the source goes 
from zero to maximum value.

The (~) symbol indicates that the source is bidirectional. In the case of an LFO, the LFO 
would go both positive and negative, centering on the zero line.

The (<) symbol indicates that the source only subtracts from the initial value of a desti-
nation. This type of control is designed to be used for velocity-to-volume control where 
you want to keep as much headroom as possible.

The following chart shows the three types of polarity.

Lag Processor (1 & 2) Inputs for Lag Processors 1 & 2. See page 138.

Lag Rates (1 & 2) Rate control for Lag Processors 1 & 2. See page 138.

Summing Amp Input to the Summing Amp. See page 307.

Switch Input to the Switch processor. See page 307.

Absolute Value Input to the Absolute Value processor. See page 307.

Diode Input to the Diode processor. See page 307.

Flip-Flop Input to the Flip-Flop processor. See page 307.

Quantizer Input to the Quantizer. See page 307.

Gain 4x Input to the 4x Amplifier. See page 307.

Key Timer Rate Input rate control for the Poly Key TImer. See page 86.

Oscillator Speed Speed percentage modulation for TwistaLoop playback.

FuncGen Rate 1-3 Controls the rate between each step of function generators 1, 2 or 3. See page 143.

FuncGen Retrig 1-3 Restarts the function generator when the value crosses zero in the positive direction.

FuncGen Length 1-3 Modulates the End Step for function generators 1, 2 or 3. See page 143.

FuncGen Dir. 1-3 Changes the forward-backward direction for function generators 1, 2 or 3. See page 143.

Cord 1 - 36 Amount Controls the amount of PatchCords 1-36.

Modulation Destinations

Destination Description

+
~

+ modulation ADDS to the
    initial value. (Normal)

< modulation SUBTRACTS
    from the initial value

~ centers around Zero.
    (Use for LFOs, Filt. Freq.)

Control
Value

Control Value Applied

0 12763

0 12763

-63 +640

-127 0-63
<
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Summing Nodes
All the modulation inputs on Emulator X are summing nodes. This means that you can 
connect as many modulation sources as you want to an input (such as Pitch or 
AmpVol). Modulation sources are simply added algebraically — connecting two knobs 
one set to -100 and the other set to +100 yields a net value of zero.

PatchCord Lore

Sample Loop Modulation
The sample loop position can be modulated using a Cord. See “Modulation Destina-
tions” on page 159. The loop length remains constant as the loop is modulated. This 
feature can be used to implement pulse width modulation. Waveforms other than 
rectangular shapes can be used to implement wavetable scanning synthesis.

The basic idea of pulse-width modulation using the Emulator X is to start with a looped 
single-cycle wave, then dynamically move the loop location so that different portions 
of the waveforms are included. Changing the loop length will change the pitch of the 
sample, but this is easily corrected using the Transpose and Tuning controls in the 
Voice.

� To Pulse-width Modulate a Square Wave

1. Turn Streaming Off in the Options, Preferences menu. Pulse width modulation 
needs to have the entire sample loaded into RAM for proper operation.

2. Load the Proteus X Composer bank.

Copy the Sample

1. Select the Samples folder in the Tree.

2. Open the Samples folder by clicking on the
(+) symbol.

3. Locate sample S0766 - Square E3 in the

Tree, and select it. 

• Real-time events happen first on lower numbered Cords, so it is usually a good 
idea to put important functions on lower numbered cords and to place compo-
nents of complex modulations patches in the proper order in the Cords section.

• Negative Cord amounts invert envelopes and LFO waveforms.

• To invert the effect of a controller knob, set its Cord to -100 and add DC with a 
Cord value of +100.

S E

S E

Pulse-Width Modulation
The loop length is fixed, then the 
loop position is modulated with 
an LFO or Envelope so that it 
changes the duty cycle of the 
waveform.
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4. Select Copy from the Edit menu.

5. Select Paste from the Edit menu. The 
following dialog box appears.

6. Choose Pasting 1 sample 
“After the end of the selection.” 
Also choose “Move existing objects 
if necessary.”

7. A duplicate of Square E3 appears in 
sample location S0767. 

8. Right-click on S0767, then choose 
Rename (F2). 

9. Rename the sample to PWM E3.

Create a new Preset

10. Select the Preset folder in the Tree.

11. Select Presets, New Preset from the 
menu bar.

12. Open the Preset Folder by clicking
on the (+) symbol and scroll down to 
the bottom of the preset list. A new 
empty preset has been created at the bottom of the Tree (location P1026).

13. It’s always a good idea to rename your new preset to avoid confusion later. (Right-
click on the preset name, then choose Rename or press F2.)

Assign the Sample

14. Open the preset by clicking on the (+) symbol next to the little  icon.

15. Open the Voices and Zones module. The Key Window appears.

16. Select sample S0767 - PWM E3 (a pulse width modulation sample).

Adjust the Loop Markers

17. Double-click on the sample name to open the sample editor.

18. Move the Loop End Point by dragging the marker or by typing in a value into the 
End field. We have chosen a value of 69 samples for the loop length in the example 
above. The distance from the start point sets the initial pulse width and pitch of the 
sample. 

19. It’s easy to see how the loop will move if you click the Lock loop length button and 
then move the loop start point. Try this and note how the pulse width changes 
inside the loop markers. When you’re finished, move the loop start point back to 8 
samples and the end point to 77 samples (Loop Length = 69 samples).

Click the Sample Button to 
select a sample

Double-click here to 
open the sample editor
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Retune the Sample

20. Unfortunately, because we changed the loop length, the waveform is no longer 
tuned to E3. Fortunately, this is easy to fix. Click the Back Arrow  to jump back to 
the Key Window.

21. Select New Voice (Crtl+W) from the Preset menu. A new empty voice appears.

22. Click the button next to the voice and select sample S0766 - Square E3 (the original 
square wave sample).

23. Click the Mix/Tune  tab. The Voices and Zones page should look like this:

24. Play the keyboard. Both voices will sound and they will be horribly out of tune. 
Adjust the Transpose and Fine Tune controls on Voice 1 until they are in tune. 
Now the PWM E3 voice is back in pitch.

25. Select Voice 2 (S0766 - Square E3) and select Delete Voices from the Preset menu 
since it’s no longer needed.

Move
Loop End

Point
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Connect the Modulation Cords

26. Select the Voice Processing page from your 
new preset (P1025) in the Tree. The voice 
processing page appears.

27. Set up the Cords as shown at left. You only 
need to change two parameters. Set Cord 3’s 
destination to LFO~ to Sample Loop, and 
change the Amount of Cord 4 to -2.00.

28. Play the keyboard and turn up the Mod 
Wheel. You should now be hearing rich, 
luscious pulse width modulation.

29. You might want lower the frequency of LFO 1 
for a better chorale effect.

Assign Groups
 Note: “Output 

Channels” in this context 
is defined as channels of 
polyphony, or the 
number of sounds that 
can be simultaneously 
played.

The Assign Groups can be divided into two types:

• Output Assign Groups - Set the maximum number of output channels that a 
voice can use. These groups protect important parts, or cause intentional voice 
“stealing”.

• Poly Key Assign Groups- Limits the number of times a voice will sound when 
the same key is repeatedly pressed. Conserves available polyphony by limiting 
the number of output channels assigned to a single key.

Output Assign Groups
This function allows you to assign a certain number of output channels to each voice. 
By assigning all voices in the preset to assign groups, important parts can be protected 
from being “stolen” by more recently played keys. Or, a voice such as an open high hat 
can be assigned to a mono channel so it will be cancelled by a closed high hat. Voices 
will rotate within their assigned bin of channels not interfering with other bins. Poly 
All is the default mode. The modes are as follows:

Output Assign Groups

Poly All
Notes are played polyphonically with dynamic channel assignment, 
using all available polyphony.

Poly 16 A-B
Two bins of 16 channels each. Notes are played polyphonically with 
dynamic channel assignment, using no more than 16 channels.

Poly 8 A-D
Four bins of 8 channels each. Notes are played polyphonically with 
dynamic channel assignment, but using no more than 8 channels.

Poly 4 A-D
Four bins of 4 channels each. Notes are played polyphonically with 
dynamic channel assignment, but using no more than 4 channels.

Poly 2 A-D
Four bins of 2 channels each. Notes are played polyphonically with 
dynamic channel assignment, but using no more than 2 channels.

Mono A-I
Nine monophonic channels. Any voices assigned to the same letter 
interrupt each other, but do not affect other voices.
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Poly Key Assign Groups
The Poly Key Assign groups limit the number of times a voice will be duplicated when 
the same key is repeatedly pressed. The Poly Key Groups limit polyphony per key and 
allow you to make better use of the available polyphony of the instrument.

When using the default setting of “Poly All”, repeatedly playing a single key can eat up 
large numbers of voices, especially with pianos, cymbals, snares and other sounds 
where the envelope release parameter is used. The Poly Key Assign Groups allow you to 
impose a limit (1, 2, 3, 4, 5, 6 or 8) on the number of simultaneous notes that a single 
key will trigger.

The polyphony count is noted in the Poly Key item (8, 6, 5, 4, 3, 2, 1)—Poly Key 8 
limits the voice count to 8 voices per key (16 for stereo), Poly Key 4 limits the voice 
count to 4 voices per key (8 for stereo), Poly Key 2 limits the voice count to 2 voices per 
key (4 for stereo).

In addition, there are four different “bins” for each voice group labelled A, B, C, D. 
These four bins keep completely separate voice counts and allow complex control of 
polyphony. For example, if 3 voices are assigned to a single key, 1 voice could be 
assigned to a 1-voice group and the other 2 voices could be assigned to a 8-voice group. 
The 1-voice will retrigger itself on each key press, while the 2 voices assigned to the 8-
voice group will be allowed to ring out, producing a chorus effect.

As another example, suppose you had 4 voices assigned to a key and wanted to limit 
the polyphony of the key to 4 notes (4 x 4 = 16 voices max). By assigning each of the 
four voices to a different 4-voice bin, each voice on the key is allowed to play only four 
simultaneous notes.

� Conserving Polyphony Using the Poly Key Groups:

The Poly Key Group feature is designed for building more efficient presets from the 
ground up, but if you have an existing preset which seems to be consuming too much 
polyphony, you can try this quick fix which will work in many (but not all) cases:

1. Select the preset and Duplicate it.

2. Using the Copy, go to Voices and Zones and Select All.

3. Go to Voice Processing and set the Assign Group to Poly Key 2A (or Poly Key 1A).

4. Play the preset—if it sounds too dry— change the setting to Poly Key 3A.

Poly Key Assign Groups

Poly Key 8 (A-D)
Poly Key 8 limits the voice count to 8 voices per key 
(16 for stereo)

Poly Key 6 (A-D)
Poly Key 6 limits the voice count to 6 voices per key 
(12 for stereo)

Poly Key 5 (A-D)
Poly Key 5 limits the voice count to 5 voices per key 
(10 for stereo)

Poly Key 4 (A-D) Poly Key 4 limits the voice count to 4 voices per key (8 for stereo)

Poly Key 3 (A-D) Poly Key 3 limits the voice count to 3 voices per key (6 for stereo)

Poly Key 2 (A-D) Poly Key 2 limits the voice count to 2 voices per key (4 for stereo)

Poly Key 1 (A-D) Poly Key 1 limits the voice count to 1 voice per key (2 for stereo)
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5. Go to the original preset and play C3 over and over while watching the voice 
display at the bottom of the Emulator X screen.

6. Do the same with your new preset to see the polyphony savings and make sure that 
you haven’t altered the sound of the preset in a negative way. Experiment!

7. Save the Bank.

Keyboard Modes
The Keyboard mode controls how the voice will be triggered from the keyboard. Poly 
Normal mode is the default mode which allows you to play chords.

 Solo modes 
sometimes require extra 
Pre-roll (page 22) length 
to perform properly. If 
you are having problems 
with the solo modes, try 
increasing the Pre-roll.

The eight different solo modes provide the playing action of a monophonic 
instrument—only one note can be played at a time. Monophonic wind, brass and string 
instruments often sound more realistic with a single note playing. Synthesizer lead 
lines also require solo mode. There are solo modes provided which can be used with 
monophonic synthesizer sounds or to create other performance effects.

The Release modes trigger a voice when the key is released. Many acoustic instruments, 
such as a harpsichord, generate sounds when a key is released. To use this feature, 
create a special “Release Voice” and turn one of these modes on for that voice. 

Poly Normal Standard polyphonic mode. Any number of notes can be played.

Multiple 
Trigger

Last note priority. No key-up action. Retriggers envelopes and 
samples when a key is pressed.

Melody (last)

Last note priority. No key-up action.
First solo note: Envelopes start at Attack segment from zero. 
Samples start at the beginning.
If previous note is releasing: Envelopes start at Attack segment, 
but from current level. Samples start at the beginning.
When playing “Legato”: Envelopes continue from current 
segment and level. Samples start at the loop or the beginning if 
unlooped.

Melody (low)
Same as Melody (last), but with low-note priority. Newly played 
keys which are higher than the lowest solo key held will not 
sound.

Melody (high)
Same as Melody (last), but with high-note priority. Newly played 
keys which are lower than the highest solo key held will not 
sound.

Synth (last)

Similar to Melody (last) with key-up action. When currently 
sounding solo key is released while still holding other keys, the 
highest held solo key sounds in a Legato fashion (envelopes not 
retriggered).

Synth (low)
Same as Synth (last), but with low note priority. When the currently 
sounding solo key is released when other keys are still held, the 
lowest held solo key will sound in a Legato fashion. (MiniMoog).

Synth (high)
Same as Synth (last), but with high-note priority. When the 
currently sounding solo key is released when other keys are still 
held, the highest held solo key will sound in a Legato fashion.

Fingered Glide
Same as Synth (last), except that Glide is disabled when playing 
Staccato, enabled when playing Legato.

 You must let the 
note decay completely 
when changing 
envelope generator 
times in solo mode to 
hear the changes.
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Latch Mode
 Caution: Using 

Latch Modes together 
with the Solo Modes may 
cause unpredictable 
results.

When Latch mode is On, pressing a key once will latch the key on. Pressing the key 
again will unlatch the key. This mode was originally designed for doing sound effects 
work, but you can probably find many other uses for it, such as latching sampled 
grooves and beats. Any voices assigned to the same key as a latched voice will also 
latch.

Poly Release 
Trig Release 
Vel

Polyphonic action, but the voice triggers only when the key is 
released. The key velocity is determined by how fast the key is 
released.

Poly Release 
Trig Note-on 
Vel

Polyphonic action, but the voice triggers only when the key is 
released. The key velocity is determined by how fast the key is 
pressed

Solo Release 
Trig Release 
Vel

Monophonic action, but the voice triggers only when the key is 
released. The key velocity is determined by how fast the key is 
released

Solo Release 
Trig Note-on 
Vel

Monophonic action, but the voice triggers only when the key is 
released. The key velocity is determined by how fast the key is 
pressed
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Sample Editor Window
7 - Editing a Sample

Sample Editor Window
The Sample Editor allows you to modify the actual sample data in order to perform 
functions such as: sample looping, sample truncation and splicing, equalization, time 
compression, sample rate conversion and many others. In the Sample Editor module 
we are working with the most basic element of the Emulator hierarchy, the sample. It is 
important to note that every one of these functions except basic looping modifies the 
sample data.

Even though you can undo these operations, it’s a good idea to make a copy of the 
sample before modifying the original if you want to keep an original version of the 
sample.

 Note: 24-bit samples 
are shown as 32-bit 
because they are 
internally stored and 
processed as 32-bit 
numbers.

� To Get to the Sample Editor Window:

• Click on any sample in the tree to view that sample in the Sample Editor 
window. A stereo sample is shown above.

• Double-click on any sample in the “Voices and Sample Zones” window.

• You can also select samples by double-clicking on the sample name in the Voice 
Processing window, or by selecting a sample and choosing “Open Sample”from 
the Preset window.

� To Select an Area of a Sample for Editing (Mono):

1. Click anywhere on the sample display to place the cursor.

2. Click and drag the cursor to select an area of the sample for processing.

3. Or... press and hold the shift key after placing the cursor, then click again on the 
waveform to select the area between the two mouse clicks.

Selection Area Loop Markers
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� To Select Both Sides of a Stereo Sample

1. Place the cursor near the center of the display, as 
shown at right.

2. Click and drag the cursor to select an area of the 
sample for processing.

3. Or... press and hold the shift key after placing 
the cursor, then click again on the waveform to 
select the area between the two mouse clicks.

� To Select the Left Side of a Stereo Sample

1. Place the cursor in the upper 1/3 of the display, 
as shown at right. The letter L appears next to the 
cursor.

2. Click and drag the cursor to select an area of the 
sample for processing.

3. Or... press and hold the shift key after placing 
the cursor, then click again on the waveform to 
select the area between the two mouse clicks.

� To Select the Right Side of a Stereo 
Sample

1. Place the cursor in the lower 1/3 of the display, 
as shown at right. The letter R appears next to the 
cursor.

2. Click and drag the cursor to select an area of the 
sample for processing.

3. Or... press and hold the shift key after placing 
the cursor, then click again on the waveform to 
select the area between the two mouse clicks.
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Exporting & Importing Samples
The Export function allows samples in the bank to be exported as Wave or AIFF files. 
Samples can be imported using the import option in the File menu. You can also 
simply drop a WAVE, MP3, REX 2 or AIFF file over the Emulator X icon, onto the Multi-
setup screen or onto the Voices and Zones screen.

Exporting a Tempo Map
The Tempo Map of a “beat analyzed” sample (page 209) can be exported as a standard 
MIDI file (.mid). This file can then be imported along with the corresponding audio 
file to your sequencer in order to create a tempo that’s perfectly aligned to the audio 
file you analyzed.

Once imported, your sequencer’s bars and beats (and click track) will be perfectly 
aligned to the tempo of your audio file. This means your sequencer “grooves” with you 
(as opposed to you trying to groove to your sequencer’s rigid click track).

So give it a shot— analyze a drum beat, or a guitar track you recorded in Emulator X, 
run beat analysis and create a tempo map. Once you import the audio and MIDI info 
into your sequencer, your sequencer will play right along.

When you export a tempo map, the tempo map updates the tempo information at each 
Beat Marker. By setting the Tempo Granularity (page 214) of the Beat Analysis, you can 
adjust how closely the Tempo Map follows the source material.

� To Export a Tempo Map

1. Select a sample in the Sample Editor.

2. If you haven’t already, run Beat Analysis on the sample. See “Running Beat 
Analysis” on page 209 for more information.

� To Export a Sample from the Bank

• Right-click any sample in the Tree or List views.

• Select a sample, then select Export from the Sample Edit menu.

� To Import a Sample into the Bank

• Select Import Samples from the File menu. Audio files (Wave, MP3, AIFF, REX 2) can 
be auditioned from the import browser.

• Drop a Wave, AIFF, MP3, or REX 2 file over the Emulator X icon.

• Drop a Wave, AIFF, MP3, or REX 2 anywhere in the Voices and Zones screen. This 
creates a new voice with that sample with an original key at C3 and a Key Window 
range from C-2 to G8.

• Drop a Wave, AIFF, MP3, or REX 2 over the keyboard at the bottom of the Voices 
and Zones screen. This creates a new voice with the sample mapped (including 
original key) to the note where you drop it.

• Drop a Wave, AIFF, MP3, or REX 2 file over the Multisetup screen, or the Multisetup 
button (above the tree), bringing up the Import Samples dialog box.

• Drop a Wave, AIFF, MP3, or REX 2 file over the Samples folder in the tree. The 
sample imports at its original sample rate.

 To import other 
sample formats, see 
“Translator Emulator X 
Converter” on page 319.

 Vista Users: To 
Audition samples, you 
may need to download 
and install the Vista Codec 
Package 4.5.4. 

 64-bit Users:  
To Import REX files, you 
must use the 32-bit 
version of Emulator X3.
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3. In the sample edit window, select the beats you want included in your tempo map 
file. You should make sure your selection begins and ends on a beat marker.  If 
your sample has an area at the beginning with no assigned tempo, DO NOT select it.

4. Select Export Tempo Map... from the Sample Edit menu. A popup dialog box 
appears:

5. In the dialog box, select the number of times you want your tempo track to repeat.

6. Select a location for your Tempo Map and click Save.

Tips for Exporting Tempo Maps
If you’ve run beat analysis on an audio file, and exported a tempo track, you should be 
able to import the tempo track and the corresponding audio file to your favorite 
sequencer.

However, if the length of your audio file differs from the length of your exported 
tempo in any way, you’ll need to create a new audio file to import into your sequencer.

You must create a corresponding audio file if:

• Your exported tempo doesn’t cover the entire audio file. For example, you 
exported only a few measures of tempo data. You would then need to export the 
audio for the same few measures.

• The first beat begins after the beginning of the sample. 
This can happen if your sample has some silence at the 
beginning, or if beat analysis didn’t correctly analyze the 
sample, as illustrated to the right.

� To Create a Corresponding Audio File

1. Copy and paste the exact same portion of the sample you 
selected for exporting a tempo map. See “To Copy a Section” on page 181.

2. Paste the selected area as a new sample. See “To Paste as a New Sample” on 
page 183.

3. Export the audio using the Export... function in the Sample Edit menu. 
See “To Export a Sample from the Bank” on page 171.
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Importing a Tempo Track to a Sequencer
Most commercial sequencing applications should support MIDI tempo tracks. Here’s 
how to do it with Cubase or Sonar.

� To Import a Tempo to Steinberg Cubase

1. Launch Cubase and create a new project.

2. Import the audio file that corresponds with the tempo track you created. From the 
File menu, select Import, Audio File.... Make sure the audio file is aligned with the 
very beginning of the project (bar 1, beat1).

3. Import the MIDI tempo track you created. From the File menu, select Import, 
MIDI File....
While it may appear that nothing happened, in fact, you just created a tempo track. 
You’ll notice your timeline is now aligned with your imported audio file, and if 
you play back audio with the metronome on, it should be lined up perfectly.

4. You can view the tempo track by clicking the Project menu, and selecting Tempo 
Track.

� To Import a Tempo to Cakewalk Sonar

1. Launch Sonar.

2. If you see the Quickstart menu, click Open Project. Otherwise, select Open... from 
the File menu.

3. Open the .mid file you created as a tempo track. While it may appear that you 
created a blank new project, in fact, you just created a new project with a tempo 
track that uses the tempo information from the .mid file.

4. Import the audio file that corresponds with the tempo track you created. From the 
File menu, select Import, Audio.... Make sure the audio file is aligned with the very 
beginning of the project (bar 1, beat1).
Your timeline should be aligned with your imported audio file, and if you play 
back audio with the metronome on, it should be lined up perfectly.

5. You can view the tempo track by clicking the View menu, and selecting Tempo.

Important: If you want to save the Sonar project, you should choose Save As... rather 
than Save. From the Save as type drop-down menu, choose Normal. Otherwise, you’ll 
overwrite your .mid file.
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Display Menu Items
These options are available in the Display menu. If you Right-click in the vertical or 
horizontal units area of the waveform display a popup menu appears with the same 
options.

 Tip: You can also use 
the mouse wheel to 
zoom in and out.

Zoom In (Page Up)
Magnifies the horizontal scaling to show 
more detail in the waveform. You can also use 
the Zoom controls in the lower right corner of 
the waveform display to increase or decrease 
horizontal resolution.

Zoom Out (Page Down)
Reduces the horizontal scaling to show less 
detail but more of the entire waveform.

Zoom In (Ctrl +Page Up)
Magnifies the displayed height of the 
waveform to show more detail.

Zoom Out (Ctrl +Page Down)
Reduces the displayed height of the 
waveform.

Zoom To Selection (F10)
Automatically scales the display so that the 
selected area is visible.

Zoom To All (F11)

 Tip: You can also 
zoom to all by clicking 
the button in the 
bottom-right corner 
between the zoom 
sliders.

Automatically scales the display so that the entire waveform is visible.

Zoom To Sample (F12)
Automatically scales the display to the highest magnification.

 Display Time in Samples
Units are expressed in samples beginning from the start of the sample.

 Display Time in Seconds
Units are expressed in seconds beginning from the start of the sample.

 Display Time in Bar:Beats
Displays Bar and Beat Markers instead of samples or seconds.

 Display Level in Percent
Units are expressed in percentages with 100% equal to full code and 0% as the 
baseline.

 Display Level in Decimal
Units are expressed in decimal form with 1.0 equal to full code and 0 as the baseline.

 Display Level in dB
Units are expressed in decibels (headroom) with 0.0 equal to full code and infinite as 
the baseline.

100

1.0

1:1
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 Show Grid

Show or hide the vertical black grid lines across the waveform display.

 Autoscroll

Autoscroll, when on, keeps the cursor line in the center of the waveform display.

 Show Note Markers
Show or hide Note Onset Markers.

 Show Loop Markers
Show or hide Loop Markers.

Show Zero Crossing Threshold
 Tip: You can hold the 

Ctrl key while scrolling 
the mouse wheel to scroll 
right and left.

Shows or hides the Zero-crossing Threshold markers located near the zero vertical line 
on the waveform display. The zero-crossing threshold can be adjusted to accept sample 
points which are close to zero. See page 206 for additional information.

Vertical Units
If you right-click in the vertical units area of the waveform 
display the popup menu shown at left appears.

S

Z

Zoom In  
Double Click

Increases the Vertical magnification by 2 
times with each selection.

Zoom Out Decreases the Vertical magnification by 2 
times with each selection.
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Horizontal Units
If you right-click in the horizontal units area of the 
waveform display the popup menu shown at left appears.

 Show Beat Markers Show or hide Beat Markers.

Select Ctrl-Click Right-click on a Beat Marker, Note 
Onset, or Loop Marker to select.

Go To Moves the cursor to the selected 
region.

 Zoom In  
Double Click

Increases the horizontal magnifi-
cation by 2 times with each 
selection.

 Zoom Out Decreases the horizontal 
magnification by 2 times with 
each selection.

Add Loop Adds a pair of Loop Markers that 
you can place wherever you 
want.

Add Note Marker Adds a Note Onset Marker at the 
current cursor position. See 
page 212.

Add Beat Marker Adds a Beat Marker at the current 
cursor position. See page 212.

Delete (Note/Beat Marker) Deletes the selected note or beat 
marker.

Beat Parameters This function allows you to 
change the beat number, beats-
per-bar or tempo granularity. 
(Right-click on a Beat Marker to 
enable.)

Show Always Shows the selected marker 
regardless of view settings. Right-
click a marker to enable.
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Transport/Loop Controls

Play (from Cursor)
The sample plays from the cursor location and continues to play between the loop 
markers. This button latches on until the Stop button or Space bar is pressed. Press and 
hold the space bar to play the sample from the computer keyboard.

Play from Start
The sound plays from the start of the sample regardless of the cursor position.

Stop
Stops playback immediately. Press the Space bar to stop the sample from the keyboard.

Loop Play
Plays the sample repeatedly between the cursor line and the end of the sample when 
the Play button is pressed. See “How to Loop a Sample” on page 207. 
Plays the sample repeatedly between the start and the end of the sample when the Play 
from Start button is pressed.

Go to Sample Start
Positions the cursor at the start of the sample.

Go to Sample End
Positions the cursor at the end of the sample.

Go to Loop Start 
Positions the cursor at the loop start point.

Go to Loop End
Positions the cursor at the loop end position.

Move Start to Previous Zero
Moves the Loop Start Marker toward the beginning of the sample to the next zero-
crossing point. (Left Crtl + <-)

Play

Play 
from Start

Stop

Loop 
Play 

Go to 
Sample Start

Go to 
Sample End

Go to 
Loop Start

Go to 
Loop End

Go to Beginning 
of Selection

Go to End 
of Selection
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Move Start to Next Zero
Moves the Loop Start Marker toward the end of the sample to the next zero-crossing 
point. (Left Crtl + ->)

Move End to Previous Zero
Moves the Loop End Marker toward the beginning of the sample to the next zero-
crossing point. (Right Crtl + <-)

Move End to Previous/Next Zero
Moves the Loop End Marker toward the end of the sample to the next zero-crossing 
point. (Right Crtl + ->)

Autocorrelate Loop
The computer analyzes the waveform around the loop points you have specified and 
moves the start point to find a section of the wave that closely matches the section 
around the end point. Auto correlation can be use again and again, with the computer 
moving the analysis window slightly each time to zero in on the perfect loop.

For more information, see “How to Loop a Sample” on page 207.
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Cut, Copy, Paste & Delete
Imagine a printout of a sample. Now imagine that you have a pair of scissors capable 
of cutting a piece out of that sample (or a copy of that piece if you don’t want to affect 
the original), as well as a clipboard to neatly hold the cut or copied piece. Now imagine 
that you can either perfectly insert the clipboard contents at any given point in any 
sample, or mix the clipboard contents in with any sample, starting at any designated 
point. The Emulator X can do all this, and all electronically. Auto Correlation and 
Crossfade functions are also provided for seamless transitions between the cut, copied, 
and pasted parts.

Undo and Redo
During all sample edit operations, the sample being processed will automatically be 
backed up and stored on the hard disk. If you do not like the results of the processing, 
you can call up the Undo function, and restore the original sample. (Ah, if only life 
itself were so simple.) Best of all, the processed sample will now be backed up. Thus, if 
you decide you liked the processed version better after all, you can actually undo the 
undo. (Redo.) There are 100 levels of Undo.

Typical Applications
Typical cut/copy/paste applications would be to splice the beginning of one sample to 
the end of another, or to mix two samples together to conserve memory. (Do this by 
copying an entire sample, then pasting it at the beginning of the second sample using the mix 
option.) You can splice an attack transient on to a synthesizer waveform loop. Another 
possibility is, flanging and chorusing. Paste (mix) a sample to itself, offset from the 
beginning by a few hundred samples or so to thicken up the sound.

CLIPBOARD DATA. The clipboard will retain
data until replaced by other data to be
copied, cut, or backed up. This occurs with
several operations where you want to be able
to undo an action that doesn't work. 
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Cut Section
The Cut function removes a section of a sample, and stores the cut portion in a special 
part of memory called the clipboard. Portions of a sample can be cut, copied, and 
pasted to other samples or placed into a new sample. Cut can also be used to simply 
remove a section of the waveform.

� To Cut a Section

1. Click once on a sample icon in the Tree to select it for editing. The waveform 
display appears.

 Press the Play button 
to hear the sample as you 
adjust the selection area.

2. Magnify the waveform as desired using the Zoom button below the display. Press 
the “Go To Start” or “Go To End” buttons to quickly jump to the beginning or the 
end of the sample.

3. Select the section of the sample you wish to cut. See page 169.

4. Select Cut from the Edit menu or Toolbar. The selected section will be removed 
from the sample and placed onto the clipboard.

5. Use the Undo function (Ctrl+Z) in the Edit menu to if you don’t like the results of 
the cut.

Copy Section
The Copy function allows you to duplicate a section of a sample, and store that 
duplicate in a special part of memory called the clipboard.

Cut Start Cut End

Result of Cut
Cut Region is

Placed on Clipboard

Copy
Start

Copy
End

Length of Sample

Copied Region is placed
on the Clipboard
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� To Copy a Section

1. Click once on a sample icon in the Tree to select it for editing. The waveform 
display appears.

 Press the Play button 
to hear the sample as you 
adjust the selection area.

2. Magnify the waveform using the Zoom button below the display. Press the “Go To 
Start” or “Go To End” buttons to quickly jump to the beginning or the end of the 
sample.

3. Select the section of the sample you wish to copy. See page 169.

4. Select Copy from the Edit menu or Toolbar. The selected section will be duplicated 
and placed onto the clipboard.

5. Use the Undo function (Ctrl+Z) in the Edit menu to undo the copy process.

Paste Section
Paste takes the clipboard contents and either inserts them in a sample at a specified 
point, or mixes them with a sample starting at a specified point.

� To Paste a Section
 Select Zero Crossings 

in the waveform by using 
the Control keys. See 
page 206 for details.

1. Magnify the waveform as needed using the Zoom function.

2. Place the cursor at the point where you want to paste the clipboard contents.

3. Select Paste from the Edit menu or Toolbar. The following dialog box appears.

Paste Offset

Destination Sample

The sample on the clipboard is pasted
into the break in the destination sample…

…or crossfaded in and out of the break in the destination sample.

Crossfade
Size

Mode: Insert
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4. Choose the paste mode— Insert, Equal Power Mix or Linear Mix.

• Insert opens up a space in the sample into which the clipboard contents fit.

• Equal Power Mix and Linear Mix combine the clipboard contents with existing 
samples, starting at the point selected in step three. Normally, you will always 
use Equal Power. Use Linear Mix when the signals are very similar or when 
Equal Power causes a gain in amplitude.

5. If you choose Linear or Equal Power Mix, the Mix slider becomes active, giving you 
the option to select the level of the clipboard contents to be mixed. Select the 
crossfade length and type.

Please refer to the following diagrams.

After the start point, a section of the destination is replaced with the clipboard 
contents.

Cursor Location

This section will
be replaced

0.00 Sec. Crossfade

Paste Offset

Result

Destination Sample

Mode: Mix                             Source Amount: 100%
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6. Select OK to perform the Paste or Cancel to cancel the operation.

7. Use the Undo function (Ctrl+Z) in the Edit menu if you’re not happy with the 
results of the paste operation.

� To Paste as a New Sample
Suppose you wanted to copy a section of one sample and create a new sample from the 
clipboard contents. Here’s how.

1. Copy the desired section to the clipboard (Ctrl+C).

2. Select the Samples folder from the Tree.

3. Choose Paste from the Edit menu (Ctrl+V). The dialog box show below appears.

4. Choose the number in the list where you want the sample to be placed. If you 
choose an existing sample number and “Move existing objects if necessary” is 
selected, the existing samples in the back will be renumbered to accommodate 
your new sample.

5. Click OK.

The clipboard contents will be gradually mixed into the destination sample 
and will replace the destination when the fade reaches 100%.

Crossfade Size

Mode: Crossfade Mix             Source Amount: 100%

Crossfade Size

Mode: Crossfade Mix               Source Amount: 50%

The clipboard contents will be gradually mixed into the destination sample 
and reach a maximum of 50-50 mix.
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More Information about Paste

• You can cut, copy and paste multiple samples from the List View section of the 
screen.

• Pasting at the insertion point moves the sample after the insertion point and 
Inserts the clipboard contents.

• Pasting into a selected region Overwrites for the length of the clipboard 
contents.

• If you paste into a selected region which is shorter than the clipboard contents, 
only the selected region will be overwritten. The remainder of the clipboard 
sample will be Inserted after the selected region. (Data will not be modified out 
of the selected region.)

• Pasting a mono sample into one side of a stereo sample adds silence to the other 
side in order to preserve phase linearity.
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l 
Sample Edit Tools
The sample edit toolbar displays the most commonly used sample editing tools. These 
tools can also be accessed from the Sample menu under “Edit”. Select an area of the 
sample for processing using the mouse, then select the process you wish to perform.

MIDI Audition
MIDI Audition allows you to (monophonically) play the current sample using your 
MIDI keyboard. The sample can be transposed up or down from C4 which plays the  
original pitch. The transpose feature is useful when looping since sometimes a trans-
posed sample will reveal a tick or pop which was masked at original pitch.

A looped sample will continue to play inside the loop from the point where you 
released the key. An un-looped sample will play from the beginning as long as you play 
the entire sample. If you release the key before the end of the sample, the sample will 
begin at the release point the next time you press a key. This feature is useful to cue up 
extremely long samples.

• To play the entire sample from the beginning, select the entire waveform 
(double-click on the wave or use Select All), then play the keyboard.

• The sample will always play from the beginning of any selected region.
• To play from the beginning of a sample with no region selected, press the Ctrl 

key on the computer keyboard while you play your MIDI keyboard.
• Footswitch 1 (set in Preferences, Controllers) operates as a sustain pedal when 

MIDI audition is enabled.

� To MIDI Audition a Sample

1. Click once on a sample icon in the Tree to select it for editing. The waveform 
display appears.

 Important: 
IntelliEdit MUST be 
turned ON in the MIDI 
Preferences menu for 
MIDI Audition to work.

2. Turn on MIDI Audition by pressing the button on the toolbar or by selecting 
Audition from MIDI from the Sample Edit menu.

3. Play a key on your MIDI keyboard. The selected sample plays.

4. Play another key. Note that the sample begins playing from the point you released 
the key.

5. Press the Ctrl key while you play the MIDI keyboard to play from the beginning of 
the sample.

6. Select a region (or the entire sample) to audition only the selected region.

Truncate
Normalize

Reverse

Swap L-R

Bit
Reduction

Fade Adjust 
Gain

DC Filter

Convert 
Mono-Stereo

Time 
Compress

Select
Loop

Select
All

Pitch 
Shift

Sample Rate 
Convert

Autocorrelate 
Loop

Loop

Snap to
Zero-Crossing

MIDI 
Audition

Transform 
Multiply

No
Snap

Snap To 
Marker

Externa
Editor

Xtractor

Analyze 
Beats
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Truncate
  Truncate any silence 

off the beginning of your 
samples to avoid slow key 
response.

Truncation shortens a sample by keeping the selected area of the sample and 
trimming off the beginning and/or end. Truncation is most often used to remove 
unneeded portions of a sample, but it can also be used to change instrument character-
istics such as removing the attack from a plucked string note or isolating a particular 
section.

� To Truncate a Sample

1. Click once on a sample icon in the Tree to select it for editing. The waveform 
display appears.

2. Magnify the waveform using the Zoom button below the display. Press the “Go To 
Start” or “Go To End” buttons to quickly jump to the beginning or the end of the 
sample.

3. Select the area of the waveform you want to keep.

4. Press the Truncate button. Everything but the selected area will be discarded.

5. Use the Undo function (Ctrl+Z) in the Edit menu if you are not happy with the 
results.

Fade
Fade allows you to change the gain in a smooth curve, lets you create an artificial decay 
on percussion samples where the original decay is absent, create an artificial fast attack 
(such as bowed violin with a slow attack), or clean up background noise when editing 
dialog.

� To Fade a Sample

1. Click once on a sample icon in the Tree to select it for editing. The waveform 
display appears.

2. Magnify the waveform using the Zoom button below the display if necessary.

3. Select the area of the waveform you want to fade. Press the Play button to hear the 
sample as you adjust the selection area.

4. Press the Fade button. The following dialog box appears.

Exp 2Exp 3

Exp 1

Linear

Ex
p 

2Ex
p 

3

Ex
p 

1

Lin
ea

r

Attenuation Curves

Gain Curves
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5. The volume will fade between the selected (start & end) gain/attenuation amounts 
following the selected curve shape. Set the start and end amounts and curve.

6. If the sample is stereo you have the option to fade the right side only, left side only 
or both.

7. Select OK to perform the fade or Cancel to cancel the operation.

8. Use the Undo function (Ctrl+Z) in the Edit menu if you are not happy with the 
results.

Normalize
Normalize checks for the loudest peak in the selected section of the sample and raises 
the overall level of the section so that the loudest peak is at full level (0dB).

Stereo samples are normalized so that the gain is increased equally for both channels 
until one channel’s highest peak reaches 100%. If you wish to normalize each side of a 
stereo sample separately, use the normalize option in the Adjust Gain tool.

� To Normalize a Sample

1. Click once on a sample icon in the Tree to select it for editing. The waveform 
display appears.

2. Usually, you will normalize the entire sample. In this case you don’t have to select 
a specific area.

Selecting a specific region of the sample to normalize is not recommended as this 
can create a sudden thump or pop at the selection point from the sudden gain 
increase.

3. Press the Normalize button. The amplitude of the sample will be increased to the 
optimum level.

4. Use the Undo function (Ctrl+Z) in the Edit menu if you are not happy with the 
results.

Adjust Gain
Use this function to raise or lower the level of the selected section of the sample from 
-96 dB to +96 dB. There is also an option to normalize the section.

With a stereo file, you can choose to normalize each channel separately. This method 
boosts the volume differently on each channel without preserving the volume balance 
between the left and right channels.

� To Adjust the Gain of a Sample

1. Click once on a sample icon in the Tree to select it for editing. The waveform 
display appears.

2. Usually, you will adjust the gain of the entire sample. In this case you don’t have to 
select a specific area.

Selecting a specific region of the sample to gain change can create a sudden thump 
or pop at the selection point caused by the sudden gain increase or decrease. Use the 
Fade tool to gradually change the gain of a sample section.

3. Press the Adjust Gain button. The following dialog box appears.
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4. Select the amount of gain increase or decrease for the sample. Moving the slider 
all the way left (-inf) silences the sample.

5. If the sample is stereo you have the option to change the gain of the right side only, 
left side only or both. If you wish to Normalize the sample, check the normalize 
box. If the sample is stereo you have to option to normalize each channel 
separately.

6.  Select OK to perform the Gain Change or Cancel to cancel the operation.

7. Use the Undo function (Ctrl+Z) in the Edit menu if you are not happy with the 
results.

DC Filter
The DSP function removes the DC component from a sample, centering the waveform 
around the zero axis.

� To DC Filter a Sample

1. Click once on a sample icon in the Tree to select it for editing. The waveform 
display appears.

2. Usually, you will DC filter the entire sample. In this case you don’t have to select a 
specific area.

• Selecting a specific region of the sample to DC Filter is not recommended as this 
can create a sudden thump or pop at the selection point from the sudden change 
in the waveform.

3. Press the DC Filter button. The sample will be centered around the zero axis.

4. Use the Undo function in the Edit menu if you aren’t happy with the results.

0 0

+ +

- -

DC Offset Present DC Offset Removed
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Reverse
Reverse flips the selected portion of the sample so it plays backwards.

� To Reverse a Sample

1. Click once on a sample icon in the Tree to select it for editing. The waveform 
display appears.

2. Magnify the waveform using the Zoom button below the display.

 Press the Play button 
to hear the sample as you 
adjust the selection area.

3. Select the area of the waveform you want to reverse.

4. If the sample is stereo you will be given the option to reverse the right side only, 
left side only or both.

5. Press the Reverse button. The selected section of the sample will be reversed.

6. Use the Undo function (Ctrl+Z) in the Edit menu if you are not happy with the 
results.

Swap L-R Channels
Swaps sides of a stereo sample or moves a mono sample to the other side.

� To Swap the Left and Right Channels

1. Click once on a sample icon in the Tree to select it for editing. The waveform 
display appears.

2. Usually, you will select the entire sample. In this case you don’t have to select a 
specific area.

Selecting a specific region of the sample to Swap can create a sudden thump or pop 
at the selection point from a sudden gain increase or decrease.

3. Press the Swap L-R button. The left and right channels will be swapped.

4. Use the Undo function (Ctrl+Z) in the Edit menu if you are not happy with the 
results.
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Bit Reduction
This DSP tool takes your pristine samples and transforms them into any bit resolution 
you select. Ever wonder what a 2-bit sample sounds like? Find out using the bit 
reducer. Bit values above eight will generally result in increased noise without much 
other audible difference.

After Bit Reduction, a sample will be stored as a 16-bit linear sample. This allows the 
tool to be used to convert 24-bit samples to 16-bits, with a resulting 1/2 reduction in 
disk storage (24-bit samples are stored on disk using 32-bits).

� To Reduce the Number of Bits in a Sample

1. Click once on a sample icon in the Tree to select it for editing. The waveform 
display appears.

2. Magnify the waveform using the Zoom button below the display if necessary.

3. Select the area of the waveform you want to Bit Reduce. Press the Play button to 
hear the sample as you adjust the selection area.

4. Press the Bit Reduction button. The following dialog box appears.

5. Select the number of bits you want.

6. Select OK to perform the Bit Reduction or Cancel to cancel the operation.

7. Use the Undo function (Ctrl+Z) in the Edit menu if you aren’t happy with the 
results.

Time Compression
This DSP function allows you to change the length of a sample without changing the 
pitch. This can be extremely useful for fitting samples to the beat of a song or fitting 
dialog into a spot. Samples can be compressed or expanded in length from 50% to 
200% in steps of 1/10th of one percent. Stereo samples maintain phase accuracy when 
time compressed or expanded.

Large time compression ratios can produce undesirable artifacts in the sample. Stick 
with small ratios on critical audio parts. The artifacts produced by this processor can be 
used to create weird special effects. Try stretching-compressing-stretching-compressing, 
etc. if you want to really mess up a sample.

The tempo calculator makes it easy to change the tempo of sampled grooves.
Simply set the original tempo to the tempo of your groove, then adjust the ratio until 
the new tempo matches the desired tempo.

• Time Compression Ratios - 200% = Double the Length
 50% = Half the Length
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� To Time Compress a Sample

1. Click once on a sample icon in the Tree to select it for editing. The waveform 
display appears.

2. Magnify the waveform using the Zoom button below the display if necessary.

3. Select the area of the waveform you want to Time Compress. Press the Play button 
to hear the sample as you adjust the selection area.

4. Press the Time Compress button. The following dialog box appears.

5. Select the Time Compression/Expansion ratio. The calculator shows the original 
length and tempo as well as the new length and tempo after processing.

6. Choose the processing algorithm using the table below as a guide.

7. Select OK to perform the Time Compression/Expansion or Cancel to cancel the 
operation.

8. Use the Undo function (Ctrl+Z) in the Edit menu if you aren’t happy with the 
results. You may have to try a couple of algorithms before you get the best quality.

The following table lists the algorithm choices.

deep Predominant bass (to 20 Hz)

bass Predominant bass (to 20 Hz)

mid-1 Average source material

mid-2 Average source material (high-mids)

high Source material with high frequencies 

tight Maintains time accuracy - Drum loops

broad Low bass energy but critical highs

broad-smooth Both high & low freq. - Smooth output

difficult Inharmonic or broadband material

noisy Non-pitched - Sound Effects, etc.

tight-smooth Rhythmic accuracy - Use small ratios

x-smooth Rhythmic accuracy - Use small ratios
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Pitch Shift
Pitch Shift offers three different ways to change the original pitch of a sample.

• Nudge Sample Rate - Changes the sample rate to vary the pitch. The higher the 
pitch, the lower the sample rate.

• Gosset-Smith Tuning - A high-quality, constant sample rate interpolation 
method.

• Constant Time - These algorithms change the pitch, without changing the 
length of the sample. Constant time pitch change may introduce unwanted 
artifacts into the sample, especially when large intervals are selected.

The maximum pitch shift amount is: ±1200 cents (100 cents = 1 semitone).

� To Change the Pitch of a Sample

1. Click once on a sample icon in the Tree to select it for editing. The waveform 
display appears.

2. Magnify the waveform using the Zoom button below the display if necessary.

3. Select the area of the waveform you want to pitch shift. Press the Play button to 
hear the sample as you adjust the selection area.

4. Press the Pitch Shift button. The following dialog box appears.

5. Select the Tuning change in cents.

6. Select the type of pitch shift you want to perform: Nudge Sample Rate, Gosset-
Smith, or Constant Time. 

7. If you chose “Constant Time” pitch shift, select one of the processing algorithms 
using the table below as a guide. 

8. Select OK to perform the pitch shift or Cancel to cancel the operation.

9. Use the Undo function (Ctrl+Z) in the Edit menu if you aren’t happy with the 
results. You may have to try a couple of algorithms before you get the best quality.
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The following table lists the algorithms for constant time pitch shift.

Transform Multiply
This powerful synthesis tool multiplies two signals together in a way that the output 
signal contains the timbral and time elements of both inputs. This process, which is 
also known as Convolution, reinforces frequencies common to both sources and 
discards frequencies not present in both sources. Because of this characteristic, 
Transform Multiplication works best with sounds that are harmonically rich.

 The output of any 
filter is the convolution of 
the input signal with the 
filter’s impulse response.

Convolution has recently become popular as a way to model natural sounding rever-
beration from an actual room. You can experiment with this yourself by recording an 
impulse response in a reverberant space and then Transform Multiplying it with a 
sound of your choice. To create a simple impulse response, record a starter pistol or 
sharp percussive noise burst in your favorite room. If you’re interested in this subject, 
you’ll find information about convolution and free impulse responses on the Internet.

To use Transform Multiply, just copy a sample region to the clipboard, then choose 
another sample and Multiply!

Ideas for Using Transform Multiplication

• Reverb impulse responses will add their reverb signature to any sample.

 The E-MU Transform 
Tool Kit sound bank 
contains samples 
designed for use with 
Transform Multiplication.

• Percussion transients make good source material.

• A stereo impulse response can be T.M.’ed with a mono source to create a stereo 
output.

• Apply pitch shift or time compression to room impulse responses to change the 
resonance and decay time of the result.

• Reversing the impulse (clipboard sample) will reverse the attacks of transients in 
the main sample.

• Make your own impulses. Select a sample region, fade it, then copy to the 
clipboard and Transform Multiply

• Using speech as one of the sources, it is possible to “speak from within” another 
instrument (violins, bassoons, cymbals, etc.).

• Splicing silence to the beginning or ending of sounds will change the spectral 
characteristics of the result.

deep Predominant bass (to 20 Hz)

bass Predominant bass (to 20 Hz)

mid-1 Average source material

mid-2 Average source material (high-mids)

high Source material with high frequencies 

tight Maintains time accuracy - Drum loops

broad Low bass energy but critical highs

broad-smooth Both high & low freq. - Smooth output

difficult Inharmonic or broadband material

noisy Non-pitched - Sound Effects, etc.

tight-smooth Rhythmic accuracy - Use small ratios

x-smooth Rhythmic accuracy - Use small ratios
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� To Transform Multiply

1. Select a harmonically rich sample, or short region of a sample and copy it to the 
clipboard (Edit Menu, Copy or Ctrl+C).

2. Select another sample and highlight the region you wish to process.

3. Select Transform Multiply from the Sample Edit menu or by clicking the tool 
button.  The following pop up dialog box appears.

4. Intensity sets the ratio of effect to original sound. (In this case, the original sound is 
the second sample you chose, not the one on the clipboard.) For radical sound 
transformation set this value to 100%. To perform reverb convolution, choose a 
somewhat lower value such as 20-30%.

5. Press OK to Transform the two sounds.

Convert to Mono or Stereo
Converts a stereo sample to mono or a mono sample to stereo. Converting to stereo 
duplicates the sample on both sides and slightly detunes them.

� To Convert between Mono and Stereo

1. Click once on a sample icon in the Tree to select it for editing. The waveform 
display appears.

2. This function only operates on the entire sample so there is no need to select a 
region.

3. Press the Convert Mono-Stereo button. When converting mono to stereo, the 
sample is simply duplicated. When converting from stereo to mono, the following 
dialog box appears.

4. Adjust the mix of left and right signal in the new mono sample.

5. Select OK to perform the conversion or Cancel to cancel the operation.

6. Use the Undo function (Ctrl+Z) in the Edit menu if you aren’t happy with the 
results.
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Sample Rate Convert
Sample Rate Conversion digitally changes the sample rate from 8000 Hz to 100 kHz. 
Sample Rate Conversion can be used to match the sample rate for use in other applica-
tions or to decrease the memory size of a sample.

Sample Rate Conversion can also be used for exactly matching the sample rate to a 
multiple of the sound's frequency for perfect single cycle loops. Set the built-in sample 
calculator to the note you want to loop and it automatically calculates the number of 
samples in a single cycle loop. Next, adjust the sample rate until you get close to an 
integer value for the single cycle loop. Set the loop length to this value when you go to 
loop it.

� To Change the Sample Rate

1. Click once on a sample icon in the Tree to select it for editing. The waveform 
display appears.

2. You can only change the sample rate of the entire sample so there is no need to 
select a region.

3. Press the Sample Rate Convert button. The following dialog box appears.

4. Select the new sample rate. The sample’s new length is displayed.

• If you want to create a single cycle loop, set the calculator’s Key field to match 
the pitch of the sample and adjust the new sample rate until you get an integer 
number. Use this value as the loop length when you loop the sample.

5. Select OK to perform Sample Rate Conversion or Cancel to cancel the operation.

6. Use the Undo function (Ctrl+Z) in the Edit menu if you aren’t happy with the 
results.
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Xtractor
The Xtractor is a new audio manipulation tool that can cut or boost audio levels based 
on stereo position and frequency. If a song was mixed using stereo panning, this tool 
allows specific instruments or vocals to be removed, isolated, or pitch shifted. The 
Xtractor needs a stereo sample to work correctly since it uses the stereo position to 
isolate audio parts.

Applications

• Vocal elimination/vocal isolation

• Change the gain of specific instruments within a complex mix (remix a song)

• Correct out-of-tune vocal parts in a completed song

• Isolate a specific instrument or vocal for processing, then return it to the mix

• Mix analysis - find out how a song is mixed

• Unique special effects creation

� Using the Xtractor typically involves these easy steps:
1. Select an appropriate stereo sample (typically, complete songs with several instru-

ments or vocal parts panned across the stereo field.)

2. Audition using the Position and Frequency controls to determine the stereo 
position and frequency range of the element you wish to extract.

3. Use the Gain control to isolate, eliminate or change the gain, or use the Pitch 
control to shift the pitch of the selected element.

Gain

Brick Wall
Filters

Pitch
Shifter +/-L RStereo

Position
Selector

High
Cut

Pitch
Transpose

Low
Cut

Select Modify

Extract
Position

Focus
Width

Xtractor Block Diagram

The Xtractor allows you to select a stereo position and frequency range and then change 
the pitch or gain of this selected range.

R

Complete Audio Mix
High

Low

L

Sweep

Frequency

A flashlight sweeping across the stereo mix is a good analogy for what the Xtractor does. 
It highlights audio information based on stereo position and frequency.
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Frequency Select 
Controls

Gain 
Control

Position Select 
Controls

Pitch Shift 
Control

Prevents
Overload

Smoothes
Transitions

Sweeps the 
Pan Position

Use to “Tune” 
the Pan Position

Sets the beam width 
of the “Flashlight”

Xtractor Controls

Control Function

Position to 
Extract

This control selects the center point of the stereo position you wish to 
gain change. 0% = full Left; 50% = Center; 100% = full Right

Focus 
Width

This control sets the width of the Position to Extract region. The focus 
width is adjustable from 1% to 32%. With the Position to Extract set to 
50% and the width of 20%, the Extract Region would include instru-
ments panned from 40% to 60% around center.

Audition
Turn Audition on, set the Gain to 100%, then experiment with the 
Selection controls to find the audio you wish to extract.

Autoplay This feature automatically turns Audition on when Extract is first selected.

Filters
After the desired stereo position has been selected, the filters are used to 
zero in on the desired material. Frequencies BETWEEN the slider settings 
will be selected for gain adjustment.

Filter Low
This is an extremely steep highpass filter adjustable from 0 to 9999 Hz. 
Only the frequencies ABOVE this setting will be selected.

Filter High
This is an extremely steep lowpass filter adjustable from 0 to 20 kHz. 
Only the frequencies BELOW this setting will be selected.

Gain
This important control allows you to apply subtle or extreme gain 
changes in the selected stereo position and frequency range. A setting 
of +100dB extracts the selection; -100dB eliminates the selection.

Pitch
Change

This control allows you to change the pitch of the selected stereo 
position and frequency range. The range of the pitch shifter is ±1200 
cents (± 1 octave) in 1 cent steps.

Normalize
This feature prevents the sample from being clipped when extreme 
amounts of Gain are applied. When using small Gain amounts, you 
might want to turn this function off.

100 6018

Low High

Filter

Selected
Frequencies

Frequencies between 
the slider settings will 
be selected.
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Vocal or Instrument Isolation/Elimination
The Xtractor is the perfect tool if you want to isolate a particular instrument or vocal 
from the mix.

 You can also try to 
locate the audio you 
want to isolate by using 
attenuation (a negative 
gain value). Instead of 
listening for a boost, wait 
for the audio to 
disappear as you adjust 
the Width and Frequency 
controls.

First, you need to find out where the audio is located in stereo and frequency space. 
With Audition on and the Gain set to 100% adjust the Position, Width and 
Frequency controls until you hear the audio you want being isolated. (Make sure that 
the Sweep control is set to 0 - no sweep.) Because the Gain is set to +100 dB, the audio 
that falls within the parameters will be boosted higher than everything else.

• The Normalize On checkbox prevents the signal from clipping because of the 
extreme gain change.

• The Crossfade On checkbox smooths the transition between processed and unproc-
essed audio sections.

� To Isolate selected Audio from a Mix

1. If Autoplay is on you’ll hear audio as soon as the Xtractor window appears. 
If Autoplay is off, press the Audition button.

2. Set the Gain to 100dB and make sure Sweep is set to 0%.

3. Adjust the Position, Frequency and Focus Width controls for the best possible 
isolation of the instrument you want.

4.  To bring up the instrument in the mix, use less extreme Gain change settings 
(+6 dB to +12 dB). Turn off Normalize After for small gain changes.

5. Press OK and listen to the file.

6. Undo and try again if you’re not satisfied with the result.

Crossfade
A slight crossfade is normally applied at the edges of a processed section 
of audio to prevent abrupt tonal shifts. This box should normally be 
checked (on). When working with audio loops, turn crossfade off.

Sweep

This function is intended primarily as an analysis tool, but can also create 
unusual special effects. Sweep automatically adjusts the Position to 
Extract control over the course of the selected sample region.
For example, with the Position to Extract control set to 0% and with 
Sweep set to +100%, the Position to Extract will sweep from full left to 
full right as the sample plays.

Xtractor Controls

Control Function
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� To Eliminate selected Audio from a Mix

1. Follow the instructions above, except set the Gain to -100 dB.

2. To bring down the instrument in the mix, use less extreme Gain change 
(-6 dB to -12 dB). Turn off Normalize After for small gain changes.

� To Pitch Shift selected Audio in a Mix

 Tip: Changing the 
pitch by a few cents can 
create add chorus or 
flange effects to the 
selected instrument.

1. Follow the instructions for isolating audio, except change the pitch instead of 
changing the gain after you have isolated the desired audio part.

2. Turn Normalize Off. If the pitch shifted audio is lower in volume, you may want to 
boost the Gain (using the Gain control) by a few dB.

� To Process a Vocal and then Return it to the Mix

This trick allows you to completely remove a vocal (or other element of a mix), 
completely reprocess it, and then return it to the mix. This technique is perfect for 
Mash-ups and is loads of fun!

1. Make TWO copies (Duplicate) of your sample.

Start work on Duplicate #1 - Isolate the Vocal

2. Turn Normalize on.

3. Crank up the Gain to +100 dB.

4. Find the vocal using the Pan control (narrow the focus using Low and High Filter 
e.g. to avoid bass guitar / kick drum / cymbals).

5. Press OK to process, leaving only the vocal in #1.

Start work on Duplicate #2 - Remove the Vocal

6. Leave all the controls the same, except...

7. Turn down the Gain to -100 dB.

8. Press OK to process it, removing the vocal, leaving everything else in #2.

9. Modify the vocal in sample #1 to meet your liking.

Put it back together

10. Select All (of #1), and Copy to clipboard.

11. Go to sample #2.

12. Move cursor to start of sample.

13. Paste, using Mix Mode / Equal Power.
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A Visual Mix Analysis
A visual mix analysis allows you to visually plot the position of each instrument as the 
cursor sweeps across the sample section.

� To Analyze a Sample

1. Select a stereo sample in the Sample Edit window.

2. Magnify the waveform using the Zoom button below the display if necessary.

3. Select the region of the sample you wish to analyze. (Choose a short section for 
your initial experiments to shorten processing time.)

4. Press the Extract button. The Extract dialog box appears.

5. Set the controls as shown below and click OK to analyze the selected section.

6. Press Play (spacebar) and listen carefully as each instrument jumps out as the 
cursor sweeps across its position in the mix. Visualize the sample section as a 
diagram showing the stereo positions of each instrument. In the example below, 
the Vocal is positioned at about 92% to the right and its Focus Width is about 12%.

7. After you have identified the position of the instrument or vocal you want to 
process, press Undo (Ctrl+Z) to return the section back to normal.

Visual 
Analyze 
Mode 

Settings

Left Center Right
0% 10 20 30 40 60 70 80 90

Focus
Width

50 100%

VocalHi-HatKick

After analysis, playing the sample section allows you to see and hear the exact 
stereo position of each element of the mix.
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IMPORTANT NOTE about the Region Page and Editing Samples

If you’re using the Regions feature in the Voices and Zones window, you should keep 
the following in mind:

If a region contains only a part of the sample, DO NOT edit the sample in the Sample 
Editor (e.g. Time Stretch, Sample Rate Convert, etc.). Doing so will cause region infor-
mation to become incorrect. This does not apply if a region contains the entire sample.

Since regions contain the entire sample by default, this is only a potential issue if you 
have created a region. To ensure a region contains an entire sample, you can always Alt-
click the sample region bar to restore the region to its default setting.

For more information on regions, see “Region Page” on page 115.
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Batch Processing
You can run most of the sample edit tools on multiple samples at once. This includes 
Export and External Edit.

You can perform the following operations on multiple samples at once:

• Reverse

• Adjust Gain

• Convert to Mono/Stereo

• Normalize

• Swap Channels

• DC Filter

• Convert Sample Rate

• Time Compress/Expand

• Pitch Shift

• Bit Reduction

• Transform Multiply

• Beat Analysis

• Export

• External Edit

� To Batch Edit a Group of Samples

1. From the Sampler Tree on the left, click the Samples folder.

2. In the pane to the right, select the samples you want to process. Hold the Shift key 
while clicking to select contiguous samples, or hold the Ctrl key while clicking to 
select multiple non-contiguous samples.

3. Either:

• Click the operation in the toolbar that you want to perform on the selected 
samples.

• From the Samples menu, select the operation you want to perform on the 
selected samples.

• Right-click the selected samples, and select the operation you want to perform 
on the selected samples.

4. If the operation requires more information, the appropriate dialog appears. 
Whatever settings you choose affect all the selected samples. For more information 
on each operation, see “Sample Edit Tools” on page 185.
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Looping and Loop Processing
Looping is a technique that can extend a sound’s length indefinitely. It is based on the 
fact that many sounds start off with a complex attack transient, then settle down to a 
comparatively steady sound.

Although an Emulator X sample can have multiple loops, most sampled instrument 
presets only use a single loop. Multiple loops are generally used for special effects or 
for the TwistaLoop function as described on page 209.

For an aural example of how looping works, listen carefully to a plucked guitar string. 
The first part of the sound consists of a complex mixture of pick noise and several 
harmonics; then the string quickly decays down to a steady repetitive tone. Since the 
latter part of the waveform is repetitive, you can mark off a loop of the repetitive 
section, and play that looped section for as long as the key is held down. After playing 
to the end of the loop, the sound jumps back to the beginning of the loop and plays 
through the loop again. This process repeats until you release a key. If the “Loop-in-
Release” function is On, the sound continues to loop until the volume dies away.

At
ta
ck

Su
sta

in

Loop 
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Crossfade Looping
Crossfade Looping fades between the beginning and end of the loop so that as the end 
fades out, the beginning fades in. This virtually eliminates the clicks and pops that can 
occur with other types of looping. Sound data from around the loop start point is 
faded into the sound data around the loop end point so that the data at those loop 
points is identical.

The maximum allowable crossfade length is based on the distance from the start point 
of the sample. (Move the start point toward the end of the sample to allow a longer 
crossfade.) You can select linear crossfade or an equal power curve.

Truncate after Loop
Discards any information after the loop end point in order to conserve memory.

Loop Compression
The looped section of the sample can be compressed, which “evens out” any changes 
in amplitude. Changes in amplitude can cause “breathing” effects, thumping or clicks.

 Use larger crossfade 
loop sizes with complex 
sounds; shorter sizes 
when you simply want to 
mask a slight tick in the 
loop.

• Crossfade Size: (Crossfade Loop) This function smoothly crossfades between the 
waves on either side of the loop so that the waveform at the loop point is identical. 
Since Crossfade Looping alters the sound data, you may notice timbrel or amplitude 
variations. A size of 0.00 disables crossfade looping.

• Crossfade Type - Equal Power: This is a weighted crossfade that produces no 
apparent level shift, and is the commonly used mode.

• Crossfade Type - Linear: This provides a straight mathematical crossfade. Use 
linear mode with samples whose splice points are already close to optimum, 
such as a sample that has already been auto correlated.

Source Data faded in & out with this data

Loop Start Loop End

In the diagram above, a sine wave is crossfaded with silence to show the fade-in and 
fade-out. In an actual crossfade loop, both signals would be crossfaded together.

Amplitude Variations in Loop After Loop Compression
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Loop Settings
These controls allow you to turn looping On or Off, select whether the Loop in Release 
function is On or Off, select the current loop, lock the loop length, turn triplet playback 
On or Off and dial in the selection start and end points with sample accuracy. There is 
also an overall tempo display.

Loop Button
This button enables or disables looping. You’ll be happy to know that if you loop a 
sample and turn the loop off, the loop pointers remain exactly where you set them 
when the loop is turned back on (even after saving).

Loop in Release Button
With Loop in Release off, the sample stays in the loop as long as the key is held, and 
plays the sound data after the loop when the key is released. With Loop in Release on, 
the sample remains looping when the key is released.

Loop Select
This field selects the current loop when multiple loops are defined. For more infor-
mation about multiple loops see “Using Loops” on page 217.

Lock Button
The Lock button fixes the loop length at its current value. This is a handy feature when 
you have found the correct loop length and are looking for a better start point. The lock 
button is also very useful for creating groove loops and single cycle loops.

Select Loop
This tool automatically selects the region between the loop markers for the currently 
selected loop. Select Loop is available from the toolbar button or by selecting it 
from the Sample Edit pull-down menu.

Select All
This tool automatically selects the entire sample. Select All is available from the toolbar 
button or by selecting it from the Sample Edit pull-down menu.

No Snap
Selections made in the Sample Edit window will not snap to any boundaries when this 
option is active. No Snap can be enabled from the toolbar button or by selecting it 
from the Sample Edit pull-down menu.

Snap To Marker
Selections made in the Sample Edit window will snap to Loop Markers, Note-Onsets, 
or Beat Markers when this option is active. Snap To Marker can be enabled from the 
toolbar button or by selecting it from the Sample Edit pull-down menu.
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Snap To Zero-Crossings
When this function is on, sample selections made by dragging or clicking in the 
waveform display will automatically snap to the nearest zero-crossing points when the 
mouse button is released. For stereo samples, the zero-crossing is determined by the 
nearest zero-crossing on either channel. See also “Zero Crossing” on page 208.

Turn this function on, either by pressing the Toolbar button or by selecting it from 
the Sample Edit pull-down menu. 

Adjustments to the selection using the keyboard, and menu command selections are 
not affected by this switch. The switch holds its setting for each sample.

Background: Zero Crossing Threshold
The Zero Crossing Threshold determines 
how close to zero a sample has to be to 
qualify as a zero crossing. This allows more 
points to be selected as zero crossings.

To qualify as a zero crossing, the wave must 
have passed through the zero line since the 
last selected zero crossing and the sample 
must lie inside the zero crossing threshold.

In the example on the right, the samples 
marked in red will be selected as zero 
crossings. See also “Zero Crossing” on 
page 208.

� To Change the Zero Crossing 
Threshold

1. Enable “Show Zero Crossing Threshold” 
from the Display menu, or by pressing 
the toolbar button.

2. Press the Vertical Zoom button until 
you can see the Zero Crossing Threshold Markers on the left side of the waveform 
display.

3. Drag the markers apart to select more zero crossings. PLace them closer together to 
exclude more zero crossings.

Delete Unused Samples
 Caution: Delete 

Unused Samples erases 
the actual sample data. 
Make sure your original 
samples are backed-up 
before using this 
function.

When creating a custom bank, you may end up with a bunch of unused samples which 
are not used in any of the presets you created. This utility allows you to discard the 
unused samples from the bank.

� To Delete Unused Samples from the Bank

1. Right-click on the sample folder in the tree.

2. Select Delete Unused Samples.

3. Any samples not used in any preset will be erased from the bank.

Zero-Crossing 
Threshold 
Markers

Z
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How to Loop a Sample
 Note: Some sounds 

truly cannot be 
seamlessly looped. 
Percussion sounds and 
ensembles are 
notoriously hard to loop.

If you’re just learning to 
loop, practice with an 
easy sound such as your 
voice saying “Ahh”.

Looping has gained a reputation for being something of a black art. In actuality, it's 
really not that difficult to loop most sounds, especially with all the looping tools 
provided by the Emulator X.

The Attack portion of the sound is the beginning portion of the waveform. The attack is 
usually composed of changing harmonics and is difficult to loop. To get a smooth 
sounding loop, move the loop start and end points into a portion of the wave where 
the sample looks and sounds repetitive and is steady in amplitude. Changes in 
amplitude between the loop start and end points will be heard as sharp clicks or pops. 
You don’t want this.

1. Select a sample from the Tree by double-clicking on the sample name or icon.  
The Sample Editor window appears. You can also select samples by double-clicking 
on the sample name in the Voice Processing window, or by selecting a sample and 
choosing “Open Sample”from the Preset menu.

2. Press the Select Loop button to jump to any pre-existing loop.

3. Magnify the waveform using the Zoom button if necessary. Look for a region of 
the sample near the end where the wave looks repetitive.

Initial Settings

4. Place the Loop End marker near or at the end of the sample by dragging it into 
position. Position it at a zero crossing by holding the Right Control key and 
pressing the left or right arrow keys. (See page 206 for more information.)

 Looping is an art 
which takes a bit of 
practice to learn. Auto 
Correlate works best 
when you have already 
found a fairly good loop 
point by ear.

5. Use the Autocorrelate Loop (Ctrl + K) feature in the Sample Loop menu to get you 
into the ballpark.

Listen & Adjust the Start Point

6. Make sure Loop Play in the transport toolbar is turned off and select Play. The 
sample will play and continue playing within the loop boundaries.

7. While the sample is playing, slowly drag the Loop Start marker forward and back 
through the sample. Notice how the character and pitch of the sound changes. Try 
to match the pitch of the loop with the pitch of the sound. This will give you an 
idea of the proper loop length. Try to find a point where the loop sounds 
“smoother” with less “ticking”.

8. When you get just a soft “tick”, try holding the mouse over the increment and 
decrement buttons on the loop controls above the waveform display. This will 
move the loop one sample at a time.

9. Try Autocorrelation again. Autocorrelation only moves the Start point, so if it 
doesn’t find a good loop, move the Loop End point slightly and try it again.

Can’t find it?

10. Repeat step 7, moving the Loop End marker this time. Visually examine the end of 
the waveform and try to find an area that looks similar, then move the markers 
around in that area.
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� Crossfade Looping & Loop Compression
Use these tools when you have a loop that’s good, but not great. Since these tools work 
by changing the sample data, it’s best to use them only when necessary. Crossfade 
looping is a powerful tool in your arsenal, but like most things, it takes a bit of practice 
to master.

 Use a larger crossfade 
loop length with complex 
sounds and shorter 
lengths with when you 
just want to mask a slight 
tick in the loop.

1. With your loop points set as good as you can get them, select Loop Processing 
from the Sample Edit menu or from the toolbar. The following dialog box appears.

  Move the start point 
toward the end of the 
sample to allow a longer 
crossfade.

2. The maximum allowable crossfade length is based on the distance from the start 
point of the sample. What length should you use? It all depends on the sound. 
Begin with a long crossfade and use the Undo function (Ctrl + Z) if you don’t like 
what you’re hearing. Choose Equal Power. Truncate after Loop — On.

3. If you get a nice timbrel crossfade but still have amplitude variations in the loop, 
turn Compress Loop On.

Zero Crossing
 The left arrow moves 

the loop marker toward 
the sample start.

The right arrow moves 
the marker toward the 
sample end.

The term zero crossing refers to the point at which the positive slope of a waveform 
passes through zero. When looping it’s sometimes useful to locate zero crossings in 
order to make glitch-free loops. Both channels are used for zero-crossing selection 
when working with stereo samples.

� To Move the Loop Markers to Zero Crossings

1. Hold the Left Ctrl key and press either the left or right Arrow keys to move the 
Loop Start Point.

2. Hold the Right Ctrl key and press either the left or right Arrow keys to move the 
Loop End Point.
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Introduction
TwistaLoop™ is a tool that automatically analyzes any audio by dissecting it into its 
rhythmic components. This allows you create and edit multiple loop points and 
regions, and have total control over tempo using real-time audio time expansion/
compression.

You can playback analyzed samples at a custom speed, or in time with Emulator X’s 
clock (or an external clock source). Analyzing a sample with TwistaLoop™ consists of 
three easy steps: 

1. Run Beat Analysis on the sample.

2. Verify that you achieved the desired results, and make any fine adjustments to the 
analysis.

3. Create as many loops and regions from the analyzed sample as you want.

Once you create loops or regions from an analyzed sample, you can do the following:

• Change the playback speed of any loop.

• Choose which loops are repeated when played back.

• Set up a continuous controller to change in real time which loop plays.

• Sync your loops to Emulator X’s master tempo, or to an external tempo sources, 
such as a VST host.

• Play different beats or bars from the same sample.

Analyzing Beats In the Sample Edit Window
To run Beat Analysis on a sample, you’ll need to start in the Sample Edit Window.

 For more information 
on using the Sample Edit 
window, see Editing a 
Sample on page 169.

� To Get to the Sample Editor Window

• Click on any sample in the tree to view that sample in the Sample Editor 
window.

• Double-click on any sample in the “Voices and Sample Zones” window.

Running Beat Analysis
Beat Analysis looks at a sample and determines its rhythmic aspects. Once you analyze 
the sample, it’s easy to create loops based on the Beat and Note Markers that Beat 
Analysis produces. This process is easy, and produces great accuracy.

� To Run Beat Analysis:

1. Select the sample you want to analyze and click anywhere in the sample display.

2. From the Sample Edit menu, select Beats, Beat Analysis, or press Ctrl-b on your 
keyboard. The following dialog appears:
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Analyzing Beats In the Sample Edit Window
3. Enter the Tempo Range, Tempo Variation, Beats per Bar, and Meter.

4. Click Create note markers and Create beat markers.

5. Click OK.

When analyzing, it helps to have some idea of the sample’s original tempo and time 
signature. See below for a description of what these values mean.

Tempo Range (BPM)
This is the estimated tempo of the sample. You can enter values between 40 and 240 
BPM (Beats per Minute).

 Tip: 60 BPM is one 
beat per second, so if you 
have no idea what the 
original tempo is, you can 
at least use that as a 
guide.

Normally, beat Analysis correctly identifies a tempo. Beat Analysis is even more 
accurate if you have an idea of the sample’s original tempo. In most cases, a range of 
60 to 180 BPM is fine, but you can always narrow this value and re-analyze the sample. 

When narrowing the value, try to choose a tempo range that encompasses your 
estimated tempo, but leaves room on either side. For example, if you think the tempo 
of your sample is around 100 BPM, you might select a range of 90 to 110.

Tempo Variation
Some samples are more rigid in tempo than others. Set the Tempo Variation depending 
on how well-timed your sample sounds.

Beats per Bar
Sets the time number of beats per measure. You will probably want to use the number 
of beats per bar that the original sample used. However, you can achieve some inter-
esting loops if you change this.

Normal For samples with a small to moderate variation in tempo.

Fast Use for a sample that contains sudden or drastic changes in tempo.

Constant Use for short samples with rigid tempos.
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Meter
When analyzing a sample, shorter notes (or “pulses”) are recognized as either sixteenth note 
or triplet rhythms. The Meter setting determines how the analysis will treat these notes.

Create note markers
Creates Note Markers when Beat Analysis is performed.

Create beat markers
 Unless you are 

analyzing imported files, 
such as REX file, that 
already contain note 
onset markers, you 
should probably leave 
this box checked.

Creates Beat Markers when Beat Analysis is performed.

Viewing Your Analyzed Sample
After you run Beat Analysis on your sample, Beat Markers  and Note Markers  
appear on the ruler above the sample. The idea here is that Beat Analysis looks at your 
sample, and intelligently divides it into beats and notes. Each beat marker is assigned a 
bar number and beat number and depending on your tempo granularity settings, a 
tempo. The following diagram illustrates how this works:

Auto Automatically determines what type of rhythm the sample uses. If you analyze 
your sample and are dissatisfied with the results, try selecting Duple or Triple.

Duple Treats shorter notes as straight 16th notes. Use duple to guarantee that all 
short notes will be recognized as 16th notes.

Triple Treats shorter notes as part of a triplet. Use Triple for samples that have a 
shuffling rhythm.

Bar/Beat Tempo Beat Marker Note Marker Triplets On/Off

Sensitivity Beats/Percentage
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Try selecting an entire bar and playing it back. Make sure Snap to Marker  is 
selected. If you want to hear the bar loop, select Loop Play  from the toolbar or 
Transport menu.

If Beat Analysis was able to analyze your sample, you should hear a perfect loop of 
your sample. You you can then create a loop from this bar to use as a voice. If you’re 
unhappy with the way your sample was analyzed, you can run Beat Analyzer again, or 
you can fine tune the analysis manually.

Markers
After you analyze your sample, the horizontal ruler above the sample changes to the 
Bar:Beats scale. Beat Markers  and Note Markers  appear in the ruler, with the initial 

beat of each bar containing an orange center . You can turn the markers on or off by 
clicking the buttons in the toolbar, or by right-clicking the ruler, and selecting 
Show Note Markers or Show Beat Markers.

The Triplet Button
If your sample contains triplets and you want Emulator X to play them back as 
triplets when you change the tempo, click the Triplet button.

Sensitivity
 Tip: You can make 

specific Note Markers 
always appear, regardless 
of the sensitivity. Right-
click the Note Marker, 
and select Show 
Always. 

To reverse this setting, 
right-click the marker and 
uncheck Show Always.

The sensitivity setting determines the resolution of how Note Markers will be 
displayed. You can set the sensitivity in percentage from 0 to 100:

Or, if you click the Beats button, you can set the sensitivity ranging from eight bars 
intervals (8/1) to sixteenth note intervals (1/16):

For example, if you set the sensitivity to 1/8, Note Markers fall on note onsets that 
appear near eighth notes. Similarly, setting the sensitivity to 1/16 causes Note Markers 
to fall on note onsets near sixteenth notes.

• A letter “t” next to a sensitivity setting indicates triples.

• A letter “d” next to a sensitivity setting indicates duplets.

Beat Marker
Bar: 
Beat: 

Beat Markers determine the location of each beat. When you create 
loops, make sure your loops begin and end on Beat Markers. This way, 
your loops properly sync to your tempo source.

Note Marker Note markers appear on note onsets determined by Beat Analysis. They 
allow Emulator X to determine where Beat Markers should go, and they 
work in the background to adjust your loops to the tempo you are 
using.

Bar/Beat The Bar and Beat is shown next to each Beat Marker.

Tempo Beat Analysis calculates the original tempo of a group of beats (by 
default one bar). When you change the tempo of a loop, Emulator X 
uses this tempo to correctly synchronize the loop to your tempo.
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Fine-Tuning Your Analyzed Sample

You can make manual adjustments once you’ve run Beat Analysis:

• Move the beat and note markers by clicking and dragging them.

• Add new beat or note markers by right-clicking the horizontal ruler, and 
selecting Add Beat Marker or Add Note Marker.

• To delete a beat or note marker, right-click the marker you want to delete, and 
select Delete Beat Marker or Delete Note Marker.

Shifting the Beats
Sometimes when you analyze a sample, Beat Analysis might confuse the first beat of a 
bar, resulting in bar numbers that are a fraction of beat off to the right or left. This is 
most common if your sampled audio emphasizes off-beats

You can shift all beat markers left or right by quarter beats by using the menu or key 
commands:

• From the Sample Edit menu, select either Shift Beats 1/4 Beat Left or Shift 
Beats 1/4 Beat Right.

• On your keyboard, press Shift + to shift all beats right, or Shift +  to shift all 
beats to the left.

Beat Parameters
Using the Beat Parameter options, you can change the beat number, beats per bar, or 
tempo granularity.

To open the Beat Parameters dialog, 
right-click the beat where you want your 
change to begin.

When you open the Beat Parameters 
dialog, notice the affected bar and beat are 
listed in the dialog.

To keep track of a beat that has undergone 
manual changes, look for bar/beat 
indicators in boldface type.

1/16 Sensitivity1/8 Sensitivity
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Bar Numbering Changes
To change the bar number of a beat, check the box next to Bar numbering changes 
here, and enter a new Bar Number. This command will make the current beat the first 
beat of the bar number you enter. Click OK to apply the changes.

Bar Numbering Changes may be necessary if an analyzed sample has a pick-up note 
leading to the first full bar. If the pick-up note gets labeled as 1:1, you might want to 

shift bar1 beyond that first note.

Beats Per Bar Changes
To change the number of beats per bar, check the box next to Beats per bar changes 
here, and enter the number of beats per bar. This command changes the current bar 
and all subsequent bars to the length in beats that you enter. Click OK to apply the 
changes.

 Note: When you 
change the number of 
beats per bar, the 
currently selected bar 
becomes the first beat of 
that bar.

Tempo Granularity Changes
Tempo Granularity controls how often an original tempo is calculated. For example, a 
tempo granularity of 4 (the default setting for a 4-beat bar) means that an original 
tempo is calculated for every four beats. If you want the original tempo to be calculated 
on each beat, change the Tempo Granularity to 1. Lowering the Tempo Granularity can 
produce a tighter song, especially if you play multiple loops simultaneously. A higher 
Tempo Granularity, however, can produce a more realistic, less robotic sounding loop.

The tempo of a beat or bar also enables looped beats or bars to stay in synch with a 
tempo source. In order to synchronize a beat or bar, that beat or bar must have a 
tempo assigned to it. To assign a tempo to each beat, set the Tempo Granularity to 1.

Look at the examples below. The first example does not have a tempo established for 
beat 1:2. This is because the tempo assigned to beat 1:1 is the tempo for a longer period 
of time than one beat.

The second example shows two beats, each with its own tempo. When you select a 
region between Beat 1 and Beat 2, it will stay in synchronized.

Will not Sync to Tempo because a 
tempo is not set for each beat. 

(Tempo Granularity is greater than 1)

Will Sync to Tempo because a 
tempo is set for each beat. 

(Tempo Granularity is 1)

LOOP LOOP
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To change the Tempo Granularity, check the box next to Tempo granularity changes 
here, and set the granularity. This command sets the tempo granularity for the 
currently selected beat and all subsequent beats. Click OK to apply the changes.

Creating Loops from Your Analyzed Sample
 For more information 

on creating loops, see 
“Looping and Loop 
Processing” on page 203.

Once you’ve analyzed your sample, it’s very easy to create loops within your sample. 
You can create as many loops as you want and assign them to different voices, assign 
continuous controllers to cycle through them, etc.

� To Create a Loop Within an Analyzed Sample:

1. Make sure Snap to Marker  is selected (this turns on by default when you run 

Beat Analysis).

 Tip: Make sure that 
your loop begins and 
ends on a beat marker 
that has been assigned a 
bar and beat, and that 
the loop has a tempo.

2. Use your mouse to select the part of your sample you want to loop. For your loop 
to keep in sync with other loops, you must select an area between two Beat Markers 
that has a tempo.

3. From the Sample Loop menu, select Make Loop From Selection 
(or press Ctrl-Shift-L on your keyboard).

4. Click the Loop button to turn looping on (it should be on by default). 
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 The currently selected 
loop appears with gray 
markers. The rest of your 
loops appear with yellow 
markers.

Tips for Making Selections for Loops
If you want to select the area between two beats for looping, there are some tricks that 
make it a little easier:

• Make sure Snap to Marker  is selected.

• You can show/hide Note Markers by clicking the button in the toolbar, or by 
right-clicking the horizontal ruler, and selecting Show Note Markers.

• You can show/hide grid lines by clicking the  button in the toolbar, or by 
selecting Show Grid from the Display menu.

• If you want to select the length of a single beat (or a single measure if you’re 
zoomed out), hold Ctrl on your keyboard while clicking a beat marker. The 
region between the beat you clicked and the next beat is selected. You can also 
right-click a beat marker and choose Select to accomplish the same thing.

• If you want to select an entire measure, zoom out until the individual beat 
markers disappear and you can only see the markers for first beat of each 
measure (1:1,2:1, etc.), then hold Ctrl on your keyboard while clicking the Beat 

Marker .

You can make as many loops as you want and use them for several purposes (which 
will be explained in further detail later). Loops can overlap, or include the entire 
sample.

If you make more than one loop within a sample:

• Select loops using the Loop # box above the sample display. 
The currently selected loop displays yellow markers.

• You can view the markers associated with each loop by selecting the loop 
number from the toolbar.

• The loops are numbered in accordance to time, from left to right. This means 
Loop 1 always has the left-most start point. If you add a new loop before an 
existing loop, Loop numbers are re-aligned.

• To delete the currently selected loop, select Delete Current Loop from the 
Sample Loop menu.

• To delete all loops in the sample, select Delete All Loops from the Sample Loop 
menu.
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Using Loops
 Tip: If you want to 

trigger loops with your 
keyboard and have them 
continue playing without 
having to hold the note, 
set the voice to Latch in 
the Voice Processing 
window.

Once you create some loops in a sample, you can determine the way loops will behave 
when you assign that sample to a voice. For this, go to the Voice Processing page.

Playing Back Loops
Loop playback is very flexible, and you can assign continuous controllers, or even 
ranges of keys to determine which loop plays at any given time. When you assign each 
voice a sample containing one or more loops, by default, the loop behaves as follows:

 Tip: You can sustain 
loops by holding down a 
footswitch. When you 
want all sound to stop, 
release the footswitch.

• For each voice, you select which loop you want to repeat by using the Loop (n) 
knob in the Voice Processing window. The default loop is Loop 1.

• The Start At Loop button controls where playback begins. With Start 
At Loop turned on, playback begins at the beginning of the loop you 
selected using the Loop (n) knob. With it turned off, playback begins 
at the beginning of the sample.

• Once playback reaches the endpoint of the loop you selected in the Voice 
Processing window, it repeats that loop until you release the note.

For example, let’s say a sample has two loops, and you select Loop 1 in the Voice 
Processing window. When you play the note, the sample will begin at the beginning of 
the sample. When it reaches Loop 1’s end point, it will jump back to Loop 1’s start 
point. Loop 1 will repeat until you release the note.

Here is a visual representation:

Loop Select and Start At Loop

Loop 1 Loop 2
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Now, let’s say you select Loop 2 on the Loop (n) knob in the Voice Processing window. 
Rather than repeating Loop 1, your sample plays until it reaches the end of Loop 2, and 
then it repeats Loop 2 until you release the note.

Now, take the above example, and select the Start At Loop button. Playback begins at 
the start point of Loop 2, rather than at the beginning of the sample:

Loop 1 Loop 2

Loop 1 Loop 2
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Loop Speed and Tempo
 Note: You cannot 

use the Chorus settings 
on voices that have time-
stretching enabled. This 
includes syncing with 
tempo and loop speed 
changes.

The speed at which your loops play back is determined by whether you use the Twist-
aLoop Override/Lock To Tempo(page 73), the Preset/TwistaLoop Lock to Tempo 
(page 82), or TwistaLoop Speed settings (page 224). With all these settings turned off, 
your loops will play back at their original tempo. With any of these setting turned on, 
the speed of the loops is altered. However, the pitch does not change.

Changing Loops Using a Continuous Controller
There are two Cord destinations available for controlling which loop repeats:

• Loop Select (Continuous)

• Loop Select (Jump)

You can set up any source for these cords, but you’ll probably find a continuous 
controller to be the most useful.

When using the Loop Select cords, you should bear the following in mind:

• The Start At Loop button determines whether playback 
begins from the beginning of the sample, or from the start 
point of the loop.

• You should keep the Loop (n) knob set to 1 (or 0% in the 
case of multisamples). This allows you access to all your 
loops. Use the Cord’s Source to control the initial loop. 

You can do this by either using the source to determine the initial loop (e.g. 
moving your continuous controller) before you play a note, or by setting up the 
source’s Initial Controller amounts in the Preset window. For more information 
on Initial Controller Amounts, see “Initial Controllers A-P” on page 81.
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Loop Select (Continuous)
If you want to change which loop repeats while playing a note, without skipping any of 
the sample between the loops, you can set up the Loop Select (Continuous) cord to 
do so. This way, when playing back the sample, changing the CC value causes playback 
to move to the selected loop.

This example assumes your sample contains two loops. As you experiment with Twist-
aLoop™, you’re best off using distinct sounding loops with some space between them 
to be able to distinguish which loop is playing.

 If Loop 1 doesn’t fall 
at the very beginning of 
the sample, and you 
want playback to begin 
at the start point of Loop 
1 (rather than at the 
beginning of the sample), 
select Start At Loop.

� To Change Loops Using a Continuous Controller

1. In the Voice Processing window, select the group containing the 
voice you want to control.

2. Set the Loop (n) to 1. De-select Start At Loop.

3. Find an unused Cord, and set the Source to the continuous 
controller you want to use (e.g. Mod Wheel, MIDI A, etc.).

4. Set the Cord Amount to +100.

5. Set the Destination as Loop Select (Continuous). Your Cord 
should look like this:

Let’s say you chose MIDI A as the source. Now, when you play back the sample, 
looping behaves as follows:

a) If you don’t touch the MIDI A continuous controller, playback begins at the 
beginning of the sample. Once you reach the endpoint of Loop 1, Loop 1 repeats until 
you move MIDI A, or release the note.

b) While still playing the note, if you move MIDI A to 127, Loop 1 continues playing 
until it reaches its endpoint. Then, the rest of the sample plays until you reach the 
endpoint of Loop 2. Loop 2 then repeats.

c) While still playing the note, if you move MIDI A back to 0, Loop 2 continues playing 
until it reaches its endpoint. Then, playback jumps to the startpoint of Loop 1.

Loop 1 Loop 2

a) Mod Wheel at 0 b) Turn Mod Wheel to 127 c) Turn Mod Wheel to 0
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Loop Select (Jump)
If you want to jump from one loop to another without releasing a note, you can set up 
the Loop Select (Jump) Cord to do so. This way, changing a CC value causes playback 
to jump to the newly selected loop once it reaches the endpoint of the current loop.

� To Jump Loops Using a Continuous Controller
 If Loop 1 doesn’t fall 

at the very beginning of 
the sample, and you 
want the beginning of 
the sample to play first, 
don’t select START AT 
LOOP. This is useful for 
pickup notes, or 
introductions.

1. In the Voice Processing window, select the group containing the 
voice you want to control.

2. Set Loop (n) to 1. This time try selecting Start At Loop.

3. Find an unused Cord, and set the Source to the continuous 
controller you want to use (e.g. Mod Wheel, MIDI A, etc.).

4. Set the Cord Amount to +100.

5. Set the Destination as Loop Select (Jump). Your Cord should 
look like this:

Let’s say you chose MIDI A as the source. Now, when you play back the sample, 
looping behaves as follows:

a) If you don’t touch the MIDI A controller, playback begins at the startpoint of Loop 1. 
Once you reach the end of Loop 1, Loop 1 repeats until you move the MIDI A, or 
release the note.

b) While still playing the note, if you move MIDI A to 127, Loop 1 continues playing 
until it reaches its endpoint. Playback jumps to the startpoint of Loop 2. Loop 2 then 
repeats.

c) While still playing the note, if you move MIDI A back to 0, Loop 2 continues playing 
until it reaches its endpoint. Then, playback jumps to the startpoint of Loop 1.

Starting at a loop other than Loop 1 - Unless you have Start At Loop selected, if you 
use MIDI A to set an initial loop other than Loop 1, you cannot jump to a different loop 
until the current loop finishes. This means that your sample must play from the 
beginning of the sample to the end of the loop that you selected as the initial loop 
before jumping to another loop.

Loop 1 Loop 2

a) Mod Wheel at 0 b) Turn Mod Wheel to 127 c) Turn Mod Wheel to 0
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Other Ways to Change Loops
To change loops you can use any Cord source, such as Velocity or Pedal, in 
conjunction with the Loop Select Cords. One particularly useful source is the Key CC 
Win Cord.

The Key CC Win cord allows you to set up a range of keys on your controller to control 
a Cord destination. Here’s an example.

� To Select Loops Using the Key CC Win Cord

1. In the Voice Processing window, select the group containing the voice you want to 
control.

2. Set the Loop (n) to 1. Select Start At Loop if you want to start at the beginning of 
the selected loop.

3. Find an unused Cord, and set the Source to Key CC Win. 

4. Set the Cord Amount to +100.

5. Set the Destination to Loop Select (Continuous) or Loop Select (Jump). Your 
Cord should look something like this:

6. In the tree to the left, go to the Preset Screen by clicking the icon with the little 
keyboard  icon for the current preset.

7. In the Key CC Window area, click the On button to illuminate it in blue.

 Tip: Select a Key CC 
Win range that has the 
same number of notes, 
including black keys, as 
loops you’ve created in 
your sample. For 
example, if your sample 
has five loops, use a 
range of five notes, such 
as C0 to E0.

8. Select Low and High values. These will be the keys on 
your controller that you’ll use to select loops. Since they 
will no longer play any notes, you should select a range 
of keys that you don’t anticipate using for this preset.

Now, when you play back your sample, the notes on your 
keyboard that you assigned to the Key CC Window range will control the current loop. 
Try it! Play the looped voice on your keyboard. While still holding the note, change 
loops using one of your Key CC Window keys and hear the loop change.

Synchronizing Loops
Loops can synchronize to an internal clock source, a MIDI Clock, or a VST Host clock. 
For more information on clock sources, see “Tempo Control” on page 74.

 If you want beats to synchronize to a tempo:

• Make sure either Lock Oscillators To Tempo is selected in the Multisetup 
window, or that the preset is locked to a tempo channel. This will make your 
loops synch to whatever source you are using as a clock.

• Loops can be twisted (e.g. with TwistaLoop speed, or a tempo source) between 
50 and 200 percent of their original tempo.

• Loop with Start and End points must lie on beat/bar markers.

• Loops must have a tempo. This means that if you’re looping an individual beat, 
that beat MUST have a tempo assigned specifically to it. If you want a beat to 
have a tempo, change the Tempo Granularity. See “Tempo Granularity Changes” 
on page 214.
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Multisample Voices and Looping
You might wonder what happens if you want to use a multisample voice that contains 
samples with multiple loops. How do you select the initial loop if each sample 
contains a different number of loops?

When you use a multisample voice, the Loop (n) knob becomes the Loop 
(%) knob. When you create multiple loops in each sample, the knob is 
divided into percentages based upon the number of loops in each sample. 

For example, if one sample contains two loops, a setting of 0% to 49.99% 
selects the first sample. A setting of 50% to 100% selects the second sample.

If another sample contains three loops, a setting of 0% to 33.33% selects the first 
sample, 33.34% to 66.66% selects the second, and 66.67% to 100% selects the third.

So, if you use both these samples in a multisample voice, you’ll see why this setting is 
necessary. In the above example, with the two samples combined, the knob position 
determines which sample to select for both samples.

This diagram illustrates the concept:

Notice that a setting of 30% selects Loop 1 from both samples in the multisample 
voice. However, 40% selects Loop 1 from the first sample, and Loop 2 from the second.

Loop 1

Loop 1

Loop 2

Loop 2 Loop 3

Sample 1

Sample 2

10 20 30 40 50 60 70 80 90 100

LOOP (%)
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The Speed Knob
The TwistaLoop Speed knob in the Voice Processing window serves a special function. 
Unlike the Tempo knob, which controls the tempo of Emulator X, the Speed knob 
controls the speed of any loops for individual voices and groups.

Changing a Loop’s Speed
Use the Speed knob if you simply want to control the speed of loops on an individual 
basis. The Speed knob is most useful if you’re not trying to mix loops together in sync 
with each other,

� To Change a Loop’s Speed
 Note: For loops that 

are synched to a clock 
source, you are best off 
leaving the Speed set to 
Off, unless you want to 
be able to nudge the 
tempo.

1. For the current preset, click Voice Processing in the tree on the left.

2. From the Group drop-down menu, select the group that 
contains the voices you want to alter.

3. Turn the TwistaLoop™ Speed to the desired percentage. The loop’s original tempo 
is 100%. Reducing the percentage slows down the loop, and increasing the 
percentage speeds it up.

Nudging the Tempo
Nudging the tempo is particularly useful if you are using the multisetup and want to 
crossfade between two presets on different MIDI channels and keep them in sync with 
each other, and with your master tempo.

� To Nudge the Tempo With the Pitch Wheel

1. For the current preset, click Voice Processing in the tree on the left.

2. From the Group drop-down menu, select the group you want to be able to nudge. 
If you’re using a Multisetup, you’ll probably want to select All.

3. For the Bend settings, change both Up and Down to 0.
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4. Set the TwistaLoop Speed to 100%.

5. Find the Cord that uses Pitch Wheel as its source (Cord 2 by default).

6. Change the Destination to Osc Speed, and the Amount to 10. Your Cord should 
look like this:

Now, while you play back the preset, you can use the pitch wheel to change the tempo. 
Since you’re controlling the tempo with your pitch wheel, the tempo always snaps back 
to 100% when you let the pitch wheel go. This allows you to nudge the tempo far 
enough to synch it up with loops playing on other voices or channels.
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Using Regions of Analyzed Samples
Another way you can use a sample that contains bar, beat, and loop information, is 
with the Regions page in the Voices and Zones window. You can use the same sample 
for multiple voices, and select different beats or bars for each voice. This allows you to 
map different beats or bars from a single sample to different keys.

As with loops defined in the Sample Edit window, you can lock your region-based 
forward loops to a clock source and modulate them using Tempo knobs.

To define regions, first perform Beat Analysis on a sample. Then, using this sample, 
create a new preset and go to the Voices and Zones window.

For specific instructions on using the Region page, see “Region Page” on page 115.

� To Set Up Multiple Voices Using the Same Sample

1. Make a new preset by clicking the Presets folder in the Sampler tree to the left, and 
selecting New Preset from the Preset menu.

2. In the new preset, select Voices and Zones. There should be one voice already there.

3. Click the Region tab.

4. In the sampler tree to the left, expand the Samples folder (but don’t click any 
samples).

5. Click and hold a sample you’ve analyzed. While still holding down the mouse 
button, drag the sample to C3 on the keyboard at the bottom of the Voices and 
Zones window. This creates a new voice, with the sample you selected mapped to C3.

6. Repeat step 4, this time dragging the same sample to D3.

7. Delete the empty voice that was initially in the preset by right-clicking the voice and 
selecting Voice, Delete Voice.

� To Use Different Loops For Each Voice
8. For each voice, select Forward Loop from the Direction drop-down menu.

9. Select Voice 1 by clicking it.

 To select a region 
between beat markers, 
make sure the ruler 
format is Bars:Beats, 
and that Show Beat 
Markers is selected.

10. In the waveform display at the bottom of the window, use your mouse to select a 
portion of the sample. Select a region between two beat markers.

Select a region between two beat markers. Voice 1

Click and Drag
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11. Select the other voice and repeat step 9, only selecting a different region of the 
sample.

 Tip: To easily select an 
area between two beat 
markers, you can hide 
Note Markers by clicking 
the  button in the 
toolbar.

Now, when you play C3 on your controller, the region selected in Voice 1 loops. When 
you play D1 on your controller, the region selected in Voice 2 loops.

Play around, try making more voices and mapping different regions to them. You are 
not limited to selecting by beats; you can select an area between Note Markers or Loop 
points. Or, if you hide all markers, you can freely select any region of the sample.

 Note: You cannot 
lock backward-looped 
regions to a clock source. 

However, region-based loops will only lock to the master or preset tempo if your 
regions are defined between two beat markers AND set to forward looping. 

Using the RT Win With Regions
You can do some creative things with real-time crossfades and regions. For example, if 
you use a beat-analyzed sample, such as a drum beat, with multiple voices, you can set 
each voice to use a different region of the same sample. Then you can switch and 
crossfade between the two regions in real time. Using beat markers to define the 
regions, in conjunction with the Lock To Tempo feature ensures that all the voices stay 
in sync with each other.

� To Set up The RT Win to Crossfade Between Two Loops

1. Set up several voices, each using a different region of the same sample with forward 
looping.

2. Make sure that the voices are mapped to the same keyrange on your keyboard.

3. Use the RT Win page to set up a crossfade between the voices.

Select a different region.
Voice 2

Click and Drag

Map both voices to the same keyrange.
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4. Make sure that Lock To Tempo is turned on in the Multisetup or Preset window.

5. In the Voice Processing window, set up a Cord for both voices that controls Amp 
Crossfade with a continuous controller.

 Tip: If you want to 
sustain a looping voice 
without having to hold 
down the key, turn on 
Latch in the Voice 
Processing window. Make 
sure to select the right 
group from the Group 
drop-down menu. 

Now, you can use the continuous controller during playback to crossfade between two 
forward-looped regions. Since the crossfade works in real-time, you don’t need to re-
trigger the note-- just change the continuous controller with your finger still on the 
note. If you select Lock to Tempo in the Multisetup window, the voices will stay in sync 
with each other. For more information, see “Tempo Control” on page 74.

If you choose to lock looped regions to a tempo source, you MUST select a region with 
Start and End points that lie on beat/bar markers. In addition, the beat or bar MUST 
have a tempo. If you want a beat to have a tempo, change the Tempo Granularity. see 
Tempo Granularity Changes on page 214.

Troubleshooting
Having trouble getting TwistaLoop to do what you want? Check out these trouble-
shooting tips.

Beat Analysis Doesn’t Find the Right Beats
You analyzed a sample using Beat Analysis, but the Beat Markers do not fall in the 
correct places.

• In the Beat Analysis dialog, make sure you use an appropriate tempo range. Try 
to estimate the tempo as best you can. Also, make sure you select the correct 
Beats per Bar and Meter.

• In the Beat Analysis dialog, experiment with the Tempo Variation. If your sample 
changes tempo frequently, try using Fast. If the tempo is tight, and unchanging, 
try Constant.

• Use your ears and remove any extra beats from the beginning and/or end of the 
sample. To delete part of a sample, select the area you wish to truncate, and press 
the Del key on your keyboard. Now, re-analyze the sample.

Looping Doesn’t Occur
You’ve defined a loop’s start and endpoints and assigned the sample to a voice. Yet, the 
defined loop doesn’t seem to repeat.

• For the sample you’re trying to loop, make sure that the Loop button  is 
turned on in the Sample Edit window.

• Make sure you’re actually getting to the looped area during playback. 
Remember, if you have the Start At Loop button de-selected, playback begins at 
the start of the sample and doesn’t repeat the loop until it reaches the current 
loop’s end marker.

• Make sure you haven’t inadvertently selected Forward Loop in the Voices and 
Zones window. You cannot use both methods of looping simultaneously. If you 
want to use TwistaLoop with Loop Start and Loop End markers, all the voices 
that use that sample must have their direction set to Forward.
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Loops Don’t Synchronize to Tempo
You have one or more loops and you want them to stay in time with your clock source, 
but they do not modulate correctly, or they drift out of time.

• Make sure that your loop Start and End points occur on Beat Markers .

• Loops can be twisted (e.g. with TwistaLoop speed, or a tempo source) between 
50 and 200 percent of their original tempo. Make sure you aren’t exceeding this 
amount.

• If you’re looping regions, make sure that the regions begin and end on Beat 
Markers.

• Make sure you have the proper Tempo Granularity set. If you’re looping one 
beat, the Tempo Granularity must be set to 1. see Tempo Granularity Changes 
on page 214.

• Make sure that Lock To Tempo is turned on in either the Preset Globals window, 
or in the Multisetup.

• More things to check:

1. Click the MIDI tab in the Preferences dialog.

2. Make sure you have selected the correct Tempo Source information. If you 
want to lock to the Emulator X clock, or to a VST host, make sure External 
Tempo Source is unchecked.

• If you’re using the preset to control tempo, make sure that you select a Preset 
Tempo Channel. For more information on the Preset Tempo Channel, see 
“Preset Tempo Channel” on page 27.
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Overview
In addition to the hardware-based effects of PatchMix DSP, Emulator X offers software 
effects processors and a powerful effects routing scheme. The E-MU engineers have 
created a complete collection of top quality effects using 32-bit floating point precision 
for pristine sound quality. In addition, the effects algorithms have been designed for 
low CPU usage.

The Emulator X effect routing architecture is extremely flexible. Effects can be included 
as part of the preset or multisetup or both. Preset FX and Aux FX both use the same 
effects algorithms.

• Multisetup (Aux) Effects are designed to be used for your main effects such as 
reverb or delay. Aux effects can be applied to any or all of the 64 MIDI channels.

• Preset Effects are used when you want an effect to be included as part of a 
certain preset. For example, you might want to add chorus to a string pad or 
distortion to a guitar sound.

Each effect has a number of user-adjustable parameters and a wet/dry mix control. 
See page 28 to learn how to connect controllers.

When using effects as part of the preset, the wet/dry mix or effect amount is control-
lable on a per-voice basis. This means that you can create presets using effects as 
integral parts of the sound and control the effect amounts using LFOs, envelope gener-
ators, key velocity or any other PatchCord source. As an example, you could build a 
preset where the distortion amount increases the harder you hit the key.

Preset Effects in Series

Main

Aux 1

Aux 2

Aux 3

Amounts

Wet/DryWet/Dry

From
Voices

To
Aux FX
or Host

FXA FXB

Aux Effects in Sidechain

MAIN
Amounts

From
Voices

To
Host

Aux 1
Effect

Aux 1
Effect

Aux 1
Effect
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Adding an Aux Effect in the Multisetup
 PatchMix DSP 

hardware effects routings 
are already programmed 
into most Emulator X 
banks

Some banks (Proteus X Composer, for example) are already programmed to use 
Emulator X soft effects. These instructions explain how to add Aux Effects to an 
Emulator X bank which does not already have soft effects programmed.

The Aux Effects are designed to be used as sidechain effects applied on all presets in the 
bank. See the diagram on page 234 for a complete description of the effects routing.

�  How to Add an Aux Effect

1. Select the Emulator X Studio session in PatchMix DSP.

2. Close PatchMix DSP

3. Select the Multisetup Page by clicking the Emulator X icon at the top of the tree.

4. Locate the Aux Outputs section in the lower right part of the window and set all 
the Aux Outputs to EX Main (or the main output of Emulator X). This bypasses the 
PatchMix DSP hardware effects and sets up the Aux Outs to be used as sidechain 
effects.

5. Click on the Aux 1 button at the top right of the screen if it’s not already selected. 
The Aux 1 effect appears in the TV screen.

6. Click on the Effect Select Icon at the top right corner of the Effects TV screen. A 
list of available effects drops down.

Emulator X icon

Effect Select icon
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7. Select one of the Effects from the list.

 Emulator X factory 
banks have the FXA, FXB 
and FXC controllers 
already programmed. 
When creating your own 
presets and banks, we 
recommend you follow 
the FX routing model on 
page 237.

8. Turn up the FXA knob in the MIDI controllers section to hear the effect.
(FXA is usually located on Controller N.)

9. Change the effect parameters to suit your own taste, or change the entire effect for 
that matter. Keep in mind that the changes you make will affect ALL the presets in 
the bank.

10. Save the bank if you want to keep your changes.

�  How to Temporarily Disable the Aux Effects

 The Aux buttons turn 
all three Aux busses On 
or Off.

You might want to turn off the Aux effects to free 
up CPU or just to hear the dry mix.

1. Select the Multisetup Page by clicking the 
Emulator X icon at the top of the tree.

2. Click on the OUTS button near the top right 
part of the screen. The screen shown at the 
right appears.

3. The row of buttons marked AUX disable the 
Aux outputs for each channel.

4. Turn the buttons off (grey) for the channels 
on which you don’t want effects.

Adding an Effect to a Preset
Suppose you have a nice string sound, but you want to make it really thick and lush. 
The obvious solution is to add a chorus. Since you only want the chorus to affect the 
string sound, you’ll use a preset effect.

�  How to Add a Preset Effect

1. Select the preset you want in the tree by 
clicking on the keyboard  icon. The Preset 
Global page appears.

2. Click on the Effect Select Icon at the top 
right corner of the Effects TV screen. A list of 
available effects drops down.

3. Select Chorus (or whatever effect you wish) 
from the list. The Effect name is now listed 
above the TV screen and the effect parameters 
are shown in the TV screen.

 Remember that if a 
preset with effects is used 
on more than one MIDI 
channel, the CPU penalty 
multiplies each time the 
preset is used.

4. Play the keyboard. You should now hear the selected effect as part of your sound. 
If you don’t hear effects, make sure the FXA & FXB enable buttons are on for the 
MIDI channel you are using. See page 234.

5. Adjust the Wet/Dry mix to control the effect amount.

6. Adjust the effect parameters until you find the sound you want or select a 
Template. See page 279.

7. Save the bank if you want to keep your changes.

Aux 
Enables
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�  How to Temporarily Disable a Preset Effect

1. Select the Multisetup Page by clicking the 
Emulator X icon at the top of the tree.

2. Click on the OUTS button on the top left of 
the screen. The screen shown at the right 
appears:

3. The two rows of buttons marked FXA and FXB 
enable or disable the preset effects for each 
channel.

Turn the buttons off (grey) for the channels you 
are using if you don’t want to use the effects.

FX 
Enables

Two effects can be assigned per Preset. Three effects can be assigned per Multisetup. Effects amounts can be controlled a
the voice level or the preset level. Note that since the Main output and Aux 1, 2 & 3 are all connected to the same ASIO
output, they will be MIXED before being sent to the Host application or soundcard.

Block Diagram of the Effects Routing

Voices

per
VOICE

per PRESET

Aux 1

Main

Wet/Dry

Aux 2

Aux 3

MainMain

Aux 1

Aux Outputs

Aux 2

Aux 3

Aux 1

Aux 2

Aux 3

FX

FX

FX

FX Awet

dry

per MULTI

Aux
On/Off

Post FX
Sends

FX B

ASIO 1/2

ASIO 1/2

ASIO 3/4

ASIO 31/32

ASIO 1/2
ASIO 3/4

ASIO 31/32

ASIO 1/2
ASIO 3/4

ASIO 31/32
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FX Routing
Make sure that you are thoroughly familiar with the architecture of Emulator X 
(page 31), before delving into the effects section and it will make a lot more sense. 
Study the effect routing diagrams below and the preceding page. The effects archi-
tecture of Emulator X is very flexible and allows for a variety of different signal routing 
schemes.

ASIO 1/2

ASIO 1/2

ASIO 3/4

ASIO 5/6

This diagram shows the effects routing using the actual Emulator X screens in the Voice, Preset and Multisetup.
The Main output and the Aux 1 outputs are both routed to EX Main (ASIO 1/2) and will be combined into the ASIO 1/2 channels.

Preset Effects
A & B On/Off

Aux Effect
View

Aux Output 
On/Off

Aux Output 
ASIO Select

Main Output
ASIO Select

Block Diagram of the Effects Screens

Voice - Main Output Adjusts the amount of Voice signal to the Wet/Dry mix control.

Voice - Aux Outputs 1-3 Adjusts the amount of Voice signal sent to the Aux 1-3 Busses (and Effects)

Voice - Wet/Dry Mix Adjusts the Wet/Dry mix of the Voice main output sent to the Preset effects section.

Preset - Main Output Adjusts the amount of Preset effect signal that will be sent to the Main Output.

Preset - Aux Outputs 1-3 Adjusts the amount of Preset effect signal that will be sent to the Aux 1-3 busses.

Multi - Effects A & B On/Off These buttons enable or disable the Preset A & B effects for each MIDI channel.

Multi - Aux Effect View These buttons let you see the Main output screen or the Aux 1-3 effect screens.

Multi - Main Output ASIO This field allows you to select the ASIO channel pair for the Main Output. ASIO 
outputs appear in the list only after they have been created in PatchMix DSP.

Multi - Aux Output On/Off This button turns the Aux outputs on or off for each MIDI channel. In the factory 
presets, this button effectively enables or disables the global effects. 

Multi - Aux Output ASIO This field allows you to select the ASIO channel pair for Aux Outputs 1-3. ASIO 
outputs appear in the list only after they have been created in PatchMix DSP.
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You can place effects in three places:

• Multisetup - - - - - - -Effects placed in the Multisetup (Aux 1, Aux 2 or Aux 3) 
can be used by all Presets in the Bank.

 If a Preset containing 
an effect is used by more 
than one MIDI channel, 
more CPU resources are 
used.

• Preset  - - - - - - - - - - - Effects placed in the Preset (FXA or FXB) are used by one 
specific Preset.

• PatchMix DSP - - - - - Hardware effects can be applied in the PatchMix DSP 
mixer application. These effects use minimal CPU 
resources, but do not get saved with the Bank. You have to 
call up the appropriate PatchMix Session.

Effects Overhead
Each effect you select, whether it is located in a Preset or in the Multisetup, uses a 
percentage of your computer’s CPU. Extensive use of effects in every preset can easily 
bog down your computer. Effects begin running (and using CPU) as soon as they are 
selected.

The following dialog box appears if you try to add an effect to a preset which is used on 
multiple MIDI channels.

Typical Effects Usage
Because the software effects use precious CPU resources, you will generally use Aux 
effects in the Multisetup for your main effects, since these can be shared by all presets 
in the bank. You can still use Preset Effects as needed, keeping in mind that the more 
software effects you use, the fewer CPU resources will be available for polyphony, 
recording and other tasks.

ASIO Outputs
ASIO outputs appear in the list only after they have been created in PatchMix DSP. 
If you only have three ASIO input strips in PatchMix DSP, you will only see three 
choices in the Multisetup ASIO Selects. The ASIO Outputs take their names from the 
names of the Strips in PatchMix DSP.
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The Main Output window is accessed by clicking the Outs button. (This option is not 
available in “Single” mode.) This one window allows you to set the ASIO routing of the 
Main Output, enable the Preset Effects, and enable the Aux Outputs for each MIDI 
channel. This window is extremely handy for turning all your effects on or off.

The Preset Effect On/Off buttons are used to temporarily disable the selected A or B 
effect while passing the signal. These controls allow you to hear each preset with or 
without effects or to turn off all Preset Effects in order to gauge the CPU load incurred 
by the Preset Effects.

The Aux Output On/Off buttons work differently than the Preset Effect On/Off 
buttons and completely turn off the three Aux Sends for the selected channel. When 
using the factory presets, the Aux Output buttons are used to enable or disable the Aux 
Effects (because all outputs are connected to EX Main). If you were using the Aux 
busses to send signals to physical outputs, the Aux button could be used to turn these 
outputs on or off.

Output View Selects the Main Output Window.
(Note: This button is disabled in “Single” mode.)

Aux 1-3 Select Select between Aux 1, Aux 2, or Aux 3 FX in the TV view.

Preset Effects On/Off Turns the Preset A or B effects On or Off for each MIDI 
channel and passes the signal through.

Main Output Routing Selects the ASIO channel for the Main Output. See tip -->

Aux Output On/Off Turns the Aux Outputs On or Off for the selected channel. 
This turns all three Aux Outputs Off, rather than bypassing 
the effects. (This button functions as an FX Bypass when the 
standard Proteus X Composer template is used.)

Aux 1-3
Select

Preset 
Effects 
On/Off

Main Output 
Window

Aux 
Output 
On/Off

Output 
View

Main Output
Routing

 ASIO channels must be 
created in PatchMix or 
another Host application 
before they appear in this 
list.
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Proteus X Composer FX Template
This is the effects architecture we have chosen to use for the Proteus X Composer bank. 
We recommend that you use this scheme as a model for your own presets unless you 
have special requirements. Preset effects and global effects can be used simultaneously 
and you can use PatchMix DSP hardware effects by simply changing the Aux Output 
routing.

The main effects are located in the Multisetup so that they can be shared by all presets. 
This is the standard sidechain effects routing scheme found on all mixing boards.
Aux 1 = Reverb and Aux 2 = BPM Delay. MIDI controller K controls Reverb amount 
and MIDI controller L controls Delay amount through the Preset PatchCords. 

The diagram below shows the Proteus X Composer routing scheme.

Key Points

Voice
• Aux 1, 2, 3 are turned fully down and are not used.
• The Main Output is turned up full.
• The Wet/Dry Mix is turned to full wet.

Preset
• No effects are selected for Preset FXA/FXB. (To add a preset effect, just select one!)
• The Main Output is turned up full.
• Aux 1 and Aux 2 are initially turned down, but they are controlled by Preset Patch-

Cords connected to MIDI controllers K & L. 
• Aux 3 is turned down and is not used.

Multisetup
• Aux 1 is routed to Reverb.
• Aux 2 is routed to BPM Delay.
• Important: All the Aux Outputs are set to ASIO 1/2 and so they are mixed 

together before being sent to the Host computer.

Voices

VOICE

PRESET

Main

Wet/Dry

Main

Aux 1

Aux Outputs

Aux 2

Aux 3

Aux 1

Aux 2

Aux 3

Reverb

BPM
Delay

Not
Used

FX Awet

dry

MULTI

MIDI
Controllers

On/Off

Post FX
Sends

FX B
ASIO 1/2

ASIO 1/2 ASIO 1/2

100%

ASIO 1/2

Bypass

Off

Off

Off

Off

Off

Bypass

Aux 1

Aux 2

Aux 3

L

K

(Preset Cords)
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Controlling the Preset Effect Amount from the Voice
Emulator X allows you to control the Preset effects amount from the voice. 
This means that the amount is individually controllable for each key press. With this 
great feature you can create incredible effects such as:

• Velocity or pressure controlled distortion on guitars, organs or electric pianos
• Release velocity controlled echoes or reverb
• Chorus or Flanger amount controlled by an envelope generator or LFO. 
• Ring Modulator or Pitch Shifter effects that only occur during the attack.

Because the effect amounts are now controlled by your performance, this technique 
contains endless possibilities. Try it!

�  How to Control the Effect Amount from the Voice
For this example, let’s set up the keyboard so that echoes only occur with low velocity. 
When you hit the keys soft, you get echoes; when you play hard, you get no echoes.

1. Select the preset you want in the tree by clicking on the keyboard  icon. The 
Preset Global page appears. (Choose a sound with a fast release for this example.)

2. Click on the Effect Select icon at the top right corner of the Effects TV screen. 
A list of available effects drops down.

 Remember that if a 
preset with effects is used 
on more than one MIDI 
channel, the CPU penalty 
multiplies each time the 
preset is used.

3. Select Delay from the list. The Effect name is now listed above the TV screen and 
the effect parameters are shown in the TV screen.

4. Play the keyboard. You should now hear the echo. Adjust the parameters to taste.

5. Select Voice Processing from the Tree for the preset you are using. The Voice Page 
appears.

6. Find an unused Cord and Set it up like this:

7. Make sure the Wet/Dry Mix in the Amplifier 
section is set to 100 (all wet).

8. Play the keyboard soft and hard to check it out.

9. To reverse the action (hard = echo; soft = no 
echo), make the Cord amount +100 and set the 
Wet/Dry Mix to 0. (You may also want to reduce 
the Wet/Dry mix in the Echo effect itself to 
obtain the proper response.)

10. Now that you’ve got it all set up, try changing 
the Preset Effect. Try reverb, flanger, phaser and 
distortion effects.
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All effects have a wet/dry mix parameter to control the ratio of effected-to-plain signal, 
which is stored with the FX preset. The effect parameters vary with the type of effect.

Generally, when using the Aux Effects, the wet/dry mix in the effect should be set to 
100% wet since the Aux Send amount controls how much effect will be applied.

Aux FX Send Amounts
The Aux Send Amounts can be controlled either from the Preset Cords or from within 
each Voice. Please refer to the FX Routing Diagram on page 234. Aux Effect parameters, 
such as Delay Time, Feedback, etc., can not be externally controlled.

Effects List Click on the Effects List icon  to show the list of effects.

Aux 1-3 Select Select between Aux 1, Aux 2, or Aux3 FX in the TV view.

Output View Selects the Main Output Window. See Main Output 
Window. (Note: This button is disabled in “Single” mode.)

Wet/Dry Mix Control Adjusts the ratio of effected signal to un-effected signal.

Effect Bypass When this button is selected (Red), the effect is completely 
bypassed, allowing you to hear only the unaffected signal.

Effect Parameters Each effect has its own set of user adjustable controls.

Aux1-3
Select

Wet/Dry Mix
Control

Effect
Parameters

Effects List
Aux Effects

Effect 
Bypass

Output 
View
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All effects have a wet/dry mix parameter to control the ratio of effect-to-plain signal, 
which is stored with the FX preset. Each effect has its own set of control parameters. 
Turn up the Wet/Dry mix to hear more effect while you adjust the parameters, then 
turn the amount down to the desired effect amount.

�  To Get to the Preset FX Screen

1. Select the preset you want in the tree by 
clicking on the keyboard  icon. The 
Preset Global page appears.

2. Click on the Effect Select Icon at the top 
right corner of the Effects TV screen. A list of 
available effects drops down.

Effects List Click on the Effects List icon  to show the list of effects.

FXA / FXB Select Select between FXA or FXB in the TV view.

Wet/Dry Mix Control Adjusts the ratio of effected signal to un-effected signal.

Post FX Send Amounts Adjusts the amount of preset effect signal that will be sent 
to the Main and Aux Outputs.

Effect Parameters Each effect has its own set of controls.

FX A / FX B
Select

Wet/Dry Mix
Control

Effect
Parameters

Post FX
Send Amounts

Effects List

Preset Effects
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�  To Swap FXA and FXB
Effects can sound very different depending on their order in the chain. Here is a simple 
way to swap FXA and FXB.

1. Choose Swap Effects from the Preset pull-down menu.

2. The two effects will exchange positions.

Preset FX Modulation Parameters
Certain parameters in each Preset Effect can be controlled from the Preset Cords. Some 
effects (such as BPM delay) allow four controllable parameters, while other effects 
(such as Early Reflections) have only one controllable parameter. If an effect uses less 
than four parameters, the idle cords are listed as (unused). See below.

The Preset Cord value ADDS to the setting made in the Preset FX screen. For example, if 
the Wet/Dry Mix were set to 0% and you patched a MIDI Controller to Wet/Dry Mix 
with an amount of +100, the MIDI Controller would have a full range of control over 
Wet/Dry Mix. To invert the control, simply set the initial Wet/Dry Mix to 100% and set 
the Cord amount to -100.

�  How to Connect MIDI Controllers to FX Parameters

1. Select the preset you want in the tree by clicking on 
the keyboard  icon. The Preset Global page 
appears.

2. Assign FXA or FXB in the Preset FX screen.

3. Select the Destination field from the Preset Cords 
section. A list of all possible Preset Cord destinations 
appears.

4. The effect modulation parameters are at the bottom of 
the list. Select the parameter you wish to control.

5. Select the Modulation Source you wish to use.

6. Set the Cord Amount.

7. In the screen above MIDI Controller K is controlling 
the Reverb Decay Time.

See MIDI Channels & Real-time Controls to learn how MIDI controllers work in 
Emulator X.

See page 28 to learn how to assign MIDI controller numbers to Emulator X’s A-P 
reference letters. 

Creating and Deleting Templates
You can save a library of your favorite effects as Templates. Templates are saved in the 
Emulator X program files, so they’re always available for use. For more information on 
templates, see “Templates” on page 279.
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Effects Descriptions

Background: Reverb
This information applies to all the reverb algorithms.

Reverberation is a simulation of a natural space such as a room or hall. Pre-delay is the 
time before the reflections from the closest walls are heard. This parameter gives our 
ears important clues about the size of a room. As you might imagine, large halls have a 
longer pre-delay than small rooms.

Decay Time defines the time it takes for the reflected sound from the room to decay or 
die away. The diagram below shows a generalized reverberation envelope.

After a short pre-delay period, the echoes from the closest walls or ceiling are heard. 
The pattern of these first echoes, or Early Reflections, vary greatly depending on the 
type of room. Some time after the early reflection cluster ends, the actual Reverber-
ation 
(a dense cloud of complex wall reflections) begins and decays according to the time set 
by the Decay parameter.

Diffusion is the amount of scattering and density of the reverberation cloud. Rooms 
with many complex surfaces have more diffusion than bare rooms.

High frequency energy tends to fade away first as a sound is dissipated in a room. The 
High Frequency Damping parameter adjusts the time it takes for the high frequency 
energy to die away and thus changes the characteristics of the room. Rooms with 
smooth, hard surfaces are more reflective and have less high frequency damping. 
Rooms filled with sound absorbing materials, such as curtains or people, have more 
high frequency damping.

Reverb Delay (mono) Phaser

Early Reflections Reverb Early Reflections Pitch Shifter (mono)

Reverb Lite (mono) EQ - 1Band Parametric Ring Modulator

Chorus EQ - 4 Band SP12-ulator

Chorus / Delay (mono) Flanger Tremulator BPM

Compressor Flanger (BPM) Tube

Delay Growl Twin (mono)

Delay (BPM) Limiter

Time
Early ReflectionsPre-Delay

Initial Sound

Reverberation
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Reverb
The Reverb is a medium load reverb, designed to simulate various types of rooms, halls 
and plates.

Modulation Parameters
• Wet/Dry Mix
• Decay
• Diffusion

Early Reflections Reverb
The Early Reflections algorithm is the most resource-intensive reverb model and has 
the most adjustable parameters. This reverb is designed to simulate various halls, 
rooms and reverberation plates. See also “Background: Reverb” on page 243.

Parameter Description

Decay Sets the decay time of the entire effect.

Diffusion Sets the amount of scattering of the reverb cloud. Note that 
high diffusion settings will increase the overall decay time.

Room Size Changes the spacing of the reverb stages to simulate rooms of 
various shapes and sizes.

Early Reflections Sets the volume of the initial wall reflections.

Pre-Delay Sets the amount of time before any reflected sound is heard. 
Range:1millisecond to 200 milliseconds

High Freq. Damping Sets the rate at which high frequencies die away.

Low Freq. Damping Sets the rate at which low frequencies die away.

Stereo Mode Independent - In this mode, the left and right sides function 
as completely separate reverb units.
Figure Eight - This mode incorporates criss-cross feedback in 
which the left channel feeds the right and vice-versa.
Matrix - This mode utilizes multiple feedback paths to create a 
spacious, natural sound. 

Parameter Description

Pre-Delay Sets the amount of time before any reflected sound is heard. 

Early Reflection
Mode

Selects the pattern of the early reflections. Select between: Hall 1, 
Hall 2, Hall 3, Room, Spiral, 6 tap, 12 tap, 12 tap rising, 
or up & down.

Early Reflection 
Room Size

Scales the spacing of the early reflections to simulate rooms of 
different sizes.

Early Reflection 
L/R Spacing

Scales the spacing of left side reflections versus the right side, to 
create a more interesting stereo image.

Early Reflection / 
Tail Balance 

Allows you to balance the relative volumes of the early reflections 
and the reverberation cloud. 0% to 100%

HF Damping High Frequency Damping cuts the High Frequency content to 
simulate soft, absorbent surfaces such as draperies, wood or 
people.

 When using the 
Figure Eight or Matrix 
modes, pan position will 
be less focused and the 
stereo image will be 
somewhat blurred.
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Modulation Parameters
• Wet/Dry Mix
• Decay
• Diffusion

Reverb Lite (mono)
The Reverb Lite is a monophonic, slimmed down version of the Big Reverb. This effect 
only uses about 3/4 of the DSP resources of the Big Reverb, (and is smaller than even 
the Chorus effect) making it the perfect choice when you’re running low on CPU 
horsepower. See also “Background: Reverb” on page 243.

Modulation Parameters
• Wet/Dry Mix
• Decay
• Pan

LF Damping Low Frequency Damping cuts the Low Frequency content to 
simulate hard, reflective surfaces such as tiles or stone.

Tail Decay Sets the decay time of the reverberation cloud. (RT60)

Tail Diffusion Sets the amount of scattering of the reverb cloud. At low settings, 
discrete echoes are heard. At high settings a diffuse wash of 
sound is heard. High diffusion settings will increase the overall 
decay time.

Tail Room Size Changes the spread of the reverberation cloud echoes, 
simulating rooms of various sizes and shapes.

Tail Stereo Mode Independent - In this mode, the left and right sides function as 
completely separate reverb units.
Figure Eight - This mode incorporates criss-cross feedback in 
which the left channel feeds the right and vice-versa.
Matrix - This mode utilizes multiple feedback paths to create a 
spacious, natural sound.

Parameter Description

Pre-Delay Sets the amount of time before any reflected sound is heard.

Decay Sets the overall decay time of the reverberation effect.

Diffusion Sets the density of the echoes and scattering of the reverb cloud. 
At low settings discrete echoes will be heard, At high settings a 
dense wash of sound is produced. Note: High diffusion settings 
will increase the overall decay time.

Room Size Changes the spacing between the reverb stages to simulate 
rooms of various shapes and sizes. 

HF Damping High Frequency Damping sets the rate at which low frequencies 
die away. A setting of zero results in no damping.

Pan This parameter sets the position of the reverberant sound in the 
stereo field, in order to change the apparent source position.

Parameter Description

 When using the 
Figure Eight or Matrix 
modes, pan position will 
be less focused and the 
stereo image will be 
somewhat blurred.
E-MU Systems 245



9 - Effects
Effects Descriptions
Chorus

Background: Chorus
An audio delay in the range of 15-20 milliseconds is too short to be an echo, but is 
perceived by the ear as a distinctly separate sound. If we now vary the delay time in this 
range, an effect called chorus is created, which gives the illusion of multiple sound 
sources. A slight amount of feedback serves to increase the effect. Inverted feedback 
percentages add negative feedback which can change the tone of the chorus. A very 
slow LFO rate is usually best for a realistic effect, but a faster LFO rate can also be useful 
with minimal LFO depth (.2).

This effect is a true-stereo chorus with independent delay lines for the left and right 
channels. The left and right modulation waveforms are always 180° out of phase, so 
that left channel delay is increasing while the right channel delay is decreasing and 
vice-versa. This creates a richer and more animated chorus sound.

Modulation Parameters
• Wet/Dry Mix
• Rate (LFO)
• Feedback

Parameter Description

Initial Delay Sets the length of the delay. Range: 10ms to 50ms.

Modulation 
Depth

Controls the amount of LFO modulating the delay time. Increases the 
animation and amount of the chorus effect. Range: 0% to 100%

Modulation 
Rate

Sets the frequency of the low frequency oscillator.
Range: .01Hz to 15Hz

Feedback Sets the polarity and amount of delayed signal that will be recirculated 
through the delay lines. Range: -99% to +99%

LFO Waveform Selectable between Sine or Triangle wave.
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Chorus / Delay
This effect is a combination Chorus and Delay because the signal can be delayed up to 
a full second (1000 ms). Slightly modulating the delay time in the 15-20 millisecond 
range produces the familiar chorus effect. See “Background: Chorus” on page 246. 

 Very short delay times 
combined with a high 
feedback amount can be 
used to create monotone 
robotic-sounding effects.

When a longer delay is modulated, a kind of gliding pitch shift effect is produced. 
Vibrato effects can be easily created by adjusting the modulation rate and modulation 
depth parameters. When feedback is introduced to a long modulated delay, the sound 
tends to get scrambled up in unpredictable ways which might be just the thing to create 
that “swarming bees” effect you’ve been looking for.

Setting the feedback percentage in the negative range, inverts the feedback signal. 
Negative feedback has the effect of deepening the cancellation notches which are 
created when using short delays with feedback.

Modulation Parameters
• Wet/Dry Mix
• Rate (LFO)
• Feedback
• Pan

Parameter Description

Initial Delay Sets the length of the delay line. Range: 10ms to 1000ms.

Modulation 
Depth

Sets how much the LFO affects the delay time. Increases the amount 
of chorus effect and pitch shift animation. Range: 0% to 100%

Modulation 
Rate

Sets the frequency of the low frequency oscillator. 
Range: .01Hz to 15Hz

Feedback Sets the polarity and amount of delayed signal that will be recirculated 
through the delay line. Range: -99% to +99%

Pan This parameter moves the delayed sound left or right. This moves the 
apparent sound source left or right. Range: -99% to +99%

LFO -> Pan Sets the amount of panning that will occur at the Modulation Rate 
Range: -99% to +99%

Delay

LFO
Panning

L Out

R Out

Feedback

Initial
Delay

L In

R In
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Compressor
In its simplest form, an audio compressor is just an automatic gain control. When the 
volume gets too loud, the compressor automatically turns it down. Compressors are 
useful in musical applications because they smooth out dynamic volume changes and 
provide a louder average signal level.

Since the compressor turns down the gain of the signal, you might wonder how can it 
make the signal level stronger. An Output Gain control allows you to boost the output 
gain of the compressor in order to make up for the gain reduction. The overall level is 
higher and only turned down when the signal level gets too loud. The level at which the 
volume gets turned down is called the Threshold, which just happens to be the most 
important control on the compressor.

Basic Controls
The three main controls of a compressor are the Ratio control, the Threshold control 
and the Output Gain control.

If the signal falls below the Threshold level, no processing will take place. Signals 
exceeding the Threshold will have gain reduction applied as set by the ratio control. 
This important control allows you to dial in the range of amplitudes you want to tame. 
For example, if you’re trying to trim off just the loudest peaks, set the threshold high so 
that compression only occurs during these peaks. One of the biggest mistakes in 
using a compressor is having the threshold set too low. This adds noise as the 
compressor will always be reducing the volume.

0dB 1:1

1.5:1

2:1

10:1

Ratio

Threshold: -30dB
-30dB

-80dB

Signal Level

Threshold
Ratio Attack Release 

Output Gain

Signal path = Stereo
VCA

Level
Control

OutIn
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The Ratio control determines how strongly the compressor will affect the signal. The 
higher the ratio, the more reduction will be applied. If the ratio is high enough, (10:1) 
the signal will effectively be prevented from getting any louder. In this situation, the 
compressor will be acting as a Limiter, placing an upper limit on the signal level. In 
general, ratios from 2:1 to 6:1 are considered compression and higher ratios above 
10:1 are considered limiting.

The Output Gain control amplifies the signal after it has been compressed to bring it 
back up in volume. If you don’t increase the gain, the compressed signal will be much 
lower in volume.

Two other important controls are Attack and Release. Attack controls how quickly the 
gain is turned down after the signal exceeds the threshold. Release controls how fast 
the gain is returned to its normal setting after the signal has fallen below the threshold 
again. An attack setting of about 10 milliseconds will delay the onset of compression 
long enough to preserve the attack transients in guitar, bass or drums while allowing 
the sustain portion of the sound to be compressed. Longer release times are generally 
used to reduce the so called “pumping” effect as the compressor turns on and off. 
Don’t make the release time too long, however, or the compressor won’t have time to 
recover for the next pluck or hit. In general, the attack and release controls are used to 
smooth out the action of the compressor, but they can also be used to create special 
effects.

Modulation Parameters
• None

Parameter Description

Threshold Threshold sets the “trigger” level for compression. Signal levels above 
the threshold will be brought down in volume. Range: -50dB to +6dB

Ratio Sets the ratio of input signal level to output signal level, or “how much” 
compression will be applied. Range: 0.20:1 to 10:1

Output Gain Amplifies the signal after it has been compressed to bring up the 
volume. Range: -24dB to +12dB

Attack TIme Controls how quickly the gain is turned down after the signal exceeds 
the threshold. Range: 1 ms to 200 ms.

Release Time Controls how fast the gain is returned to its normal setting after the 
signal has fallen below the threshold. Range: 0.2 second to 1.0 second
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Delay

Background: Delay
A delay line makes a copy of the incoming audio, holds it in memory, then plays it 
back after a predetermined time.

Long delays produce echoes, short delays can be used for doubling or slapback effects. 
Very short delays can be used to produce resonant flanging and comb filter effects or 
create monotone robotic-sounding effects (Hint: use feedback). Stereo signals are 
summed together before entering a mono delay.

A feedback path recirculates the delayed audio back around through the delay line. 
When creating echo effects, the feedback controls how many echoes will be produced. 
With short delay settings, the feedback control acts as a resonance control, increasing 
the amount of comb filtering produced by the delay line. See “Flanger” on page 256.

A Tone control in the feedback path cuts some of the high frequency energy each time 
the audio goes through the delay line. This simulates the natural absorption of high 
frequencies in a room and can also be used to simulate tape-based echo units.

The Wet/Dry mix controls how loud the echoes are in relation to the original signal.

This Delay is a true stereo delay line with completely independent left and right 
channels right channels. This delay line features four different modes, which affect how 
the signals are routed and cross coupled.

Discrete stereo
Use this mode when you want to preserve the stereo image of the delayed signals. 
You can also create panning effects by setting one delay long and the other short.

Delay Mode:

Discrete stereo

The left and right 
channels are kept 
totally separate.

Left
Delay

Right
Delay

Left
In

Right
In

Left
Out

Right
Out

L Delay Time

R Delay Time

FeedbackHF Damping

HF
Damp

HF
Damp
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Ping Pong, stereo
This mode cross-couples the output of the left and right delay into the input of the 
opposite channel. This mode works best with true stereo program material or with 
completely different sounds on either channel.

Ping Pong, mono L->R
This mode creates echoes which bounce back and forth from left to right using either a 
mono or stereo source. This is the classic ping-pong echo effect.

Delay Mode:

Ping Pong, stereo

The output of the left 
and right channels are 
fed into the opposite 
channel.

Left
Delay

Right
Delay

Left
In

Right
In

Left
Out

Right
Out

L Delay Time

R Delay Time

FeedbackHF Damp

HF
Damp

HF
Damp

Left
Delay

Right
Delay

Left
Out

Right
Out

L Delay Time

R Delay Time

FeedbackHF Damp

L In

R In

HF
Damp

HF
Damp

Delay Mode:

Ping Pong, mono L->R

The input is summed to mono, 
then fed into the left channel. 
The output of the left channel is 
cross-coupled into the right 
channel. 

The right channel output
is cross-coupled into the left 
channel input. 
E-MU Systems 251



9 - Effects
Effects Descriptions
Modulation Parameters
• Wet/Dry Mix
• Feedback

Parameter Description

Left Delay Time Sets the length of the delay for the left channel in milliseconds.
Range: .01 millisecond to 2000 milliseconds
(.01ms. minimum increment between settings)

Right Delay Time Sets the length of the delay for the right channel in milliseconds.
Range: .01 millisecond to 2000 milliseconds
(.01ms. minimum increment between settings)

Mode Changes the signal routing of the delay. The four modes are:
Discrete stereo - signal paths remain completely separate.
Ping Pong, stereo - The feedback paths feed the opposite 
channel.
Ping Pong, mono L->R - The effected signal is summed to 
mono, then fed down the left channel whose feedback path feeds 
the right channel. The right channel feedback path feeds the left 
channel.
Ping Pong, mono R->L - This is the same as the previous 
algorithm except that the L-R channels are reversed.

Feedback Sets the amount of delayed signal that will be recirculated through 
both delay lines. Range: 0% to 100%

HF Damping High Frequency Damping cuts the high frequency content in the 
feedback paths. This causes the echoes to decay naturally away.
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Delay (BPM)
The BPM Delay is similar to the Stereo Delay except that the delay time is synchronized 
to the master (MIDI) clock in note divisions. This allows you to easily set up synchro-
nized echoes to your beats. Because the left and right channels are completely 
independent, you can set up different synchro-sonic patterns on each side. The four 
modes are the same as the stereo delay.

 See page 250 for full 
descriptions and 
diagrams. The BPM 
Tempo Chart on 
page 135 shows the 
number of master tempo 
clock pulses for each 
division.

Modulation Parameters
• Wet/Dry Mix
• Left Delay Division (Changes the division by a power of 2, up or down.)
• Right Delay Division (Changes the division by a power of 2, up or down.)
• Feedback 

Parameter Description

Left Delay
Division

Sets the length of the delay for the left channel.
Range: 4/1 note to 1/64 dotted-note

Right Delay
Division

Sets the length of the delay for the right channel.
Range: 4/1 note to 1/64 dotted-note

Mode Changes the signal routing of the delay. The four modes are:
Discrete stereo - signal paths remain completely separate.
Ping Pong, stereo - The feedback paths feed the opposite channel.
Ping Pong, mono L->R - The effected signal is summed to mono, 
then fed down the left channel whose feedback path feeds the right 
channel. The right channel feedback path feeds the left channel.
Ping Pong, mono R->L - This is the same as the previous algorithm 
except that the L-R channels are reversed.

Feedback Sets the amount of delayed signal that will be recirculated through 
both delay lines. Range: 0% to 100%

HF Damping High Frequency Damping cuts the high frequency content in the 
feedback paths. This causes the echoes to decay naturally away 

Delay Mode:

Discrete stereo

The left and right 
channels are kept 
totally separate.

Left
Delay

Right
Delay

Left
In

Right
In

Left
Out

Right
Out

L Delay Division

R Delay Division

FeedbackHF Damp

HF
Damp

HF
Damp
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Early Reflections
Early reflections are the initial echoes that you hear when listening to sound in an 
indoor space. The echoes are staggered because they are reflected off surfaces which are 
at various distances from your ear. Normally this effect would be part of a reverb 
algorithm, but we decided to include it as a separate effect because it creates useful and 
interesting sounds.

Modulation Parameters
• Wet/Dry Mix

1-Band Para EQ

This single band parametric equalizer is useful 
when you just want to boost or cut a single 
range of frequencies. For example, if you want 
to brighten up a vocal, this EQ is ideal. This EQ 
offers up to +15dB boost and -24dB of cut.

 Tip - EQ becomes a 
powerful performance 
tool when the 
modulation parameters 
are patched to MIDI 
Controllers.

Modulation Parameters
• Gain
• Frequency
• Bandwidth

Parameter Description

E.R. Mode Selects the pattern of the early reflections. Select between:
Hall 1, Hall 2, Hall 3, Room, Spiral, Multitap, 6 tap, 12 tap,
12 tap rising, up & down.

Room Size Changes the spacing of the early reflections characteristics of 
various room sizes and shapes.

L/R Offset Scales the spacing of left side reflections versus the right side, to 
create a more interesting stereo image. Range: -50% to +50%

Parameter Description

Gain Sets the amount of cut (-) or boost (+) of the selected frequency 
band. Range: -24dB to +15dB

Center Frequency Sets the range of frequencies to be cut or boosted with the Gain 
control. Range: 40Hz to 16kHz

Bandwidth Sets the width of the frequency range for the Center Frequency 
band that will be cut or boosted by the Gain control.
Range: .01 octave to 2 octaves

Center
Frequency

Boost

G
ai

n

Cut

-
+

+15dB

-15dB

Width
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4-Band EQ
This 4-band equalizer provides two shelving filters at the high and low ends of the 
frequency range and two fully parametric bands in the center. Up to +15 dB of boost 
and -24dB of cut is provided for each band.

 Note: The Wet/Dry 
Mix control on an 
equalizer should normally 
be set to 100% wet or 
unpredictable results may 
occur.

Modulation Parameters
• High Gain
• High Mid Gain
• Low Mid Gain
• Low Gain

Parameter Description

High Gain Sets the amount of cut (-) or boost (+) of the high frequency shelf.
Range: -24dB to +15dB

High
Frequency

Sets the corner frequency where the signal begins getting cut or 
boosted with the High Gain control. Range: 4kHz to 16kHz 

High Mid Gain Sets the amount of cut (-) or boost (+) of the High Mid Frequency 
band. Range: -24dB to +15dB

High Mid 
Frequency

Sets the range of frequencies to be cut or boosted with the High 
Mid Gain control. Range: 1kHz to 8kHz

High Mid 
Bandwidth

Sets the width of the frequency range for the High Mid Center 
Frequency band that will be cut or boosted by the High Mid Gain 
control. Range: .01 octave to 2 octaves

Low Mid Gain Sets the amount of cut (-) or boost (+) of the Mid 1 Frequency 
band. Range: -24dB to +15dB

Low Mid
Center Freq.

Sets the range of frequencies to be cut or boosted with the Mid 1 
Gain control. Range: 200Hz to 3kHz

Low Mid 
Bandwidth

Sets the width of the frequency range for the Low Mid Center 
Frequency band that will be cut or boosted by the Low Mid Gain 
control. Range: .01 octave to 2 octaves

Low Gain Sets the amount of cut (-) or boost (+) of the low frequency shelf.
Range: -24dB to +15dB

Low
Frequency

Sets the corner frequency where the signal begins getting cut or 
boosted with the Low Gain control. Range: 40Hz to 800Hz

Frequency

Low-Shelf
Low Mid

Band High-Shelf

Bo
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t

G
a
in

C
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Corner
Frequency

Corner
Frequency
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+ Width

 High Mid
Band

Width

Center
Frequency

Center
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 Tip: When using a 
MIDI controller to change 
the EQ gain, a value of
77 = 0dB.
E-MU Systems 255



9 - Effects
Effects Descriptions
Flanger
 In order to hear a rich 

flanging effect, the 
original signal must be 
mixed in with the flanged 
signal. This can be 
accomplished using the 
Wet/Dry Mix control or 
with the Main Send 
(when using Aux effects).

A flanger is a very short delay line whose output is mixed back together with the 
original sound. Mixing the original and delayed signals results in multiple frequency 
cancellations known as a comb filter. Since the flanger is a type of filter, it works best 
with harmonically rich sounds.

 

A low frequency oscillator is included to slowly change the delay time. This creates a 
rich, sweeping effect as the notches move up and down across the frequency range. The 
amount of feedback deepens the notches, intensifying the effect. You can invert the 
feedback signal by choosing a negative feedback value. Inverting the feedback signal 
creates peaks in the notch filter and deepens the effect.

Modulation Parameters
• Wet/Dry Mix
• Depth (Mod)
• Rate (Mod)
• Feedback

Parameter Description

Initial Delay Sets the initial delay of the flanger in .01 millisecond increments. 
This parameter allows you to “tune” the flanger to a specific 
frequency range. Range: .01ms to 4ms

Depth Sets how much the LFO affects the delay time. Increases the 
animation and amount of the flanging effect. Range: 05 to 100%

Rate Sets the speed of the low frequency oscillator which modulates the 
delay time of the flanger. Range: .01 Hz to 20Hz

Feedback Controls how much signal is recirculated through the delay line 
and increases resonance. Negative values can produce intense 
flanging with some signals. Range: -99% to +99%

Through Zero On - Adds a short delay to the original signal to simulate the 
classic “through-zero” flanger sound, which was originally created 
using two tape recorders.
On (out of phase) - Inverts the phase (180°) and adds a delay 
to the original signal producing additional phase cancellation.
If the feedback control is set to zero, complete cancellation occurs 
when the flanger goes through zero
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Flanger (BPM)
 In order to hear a rich 

flanging effect, the 
original signal must be 
mixed in with the flanged 
signal. This can be 
accomplished using the 
Wet/Dry Mix control or 
with the Main Send 
(when using Aux effects).

The BPM Flanger is similar to the previously described Flanger except that the delay 
time can be synchronized to the master (MIDI) clock in various note divisions. This 
feature makes it easy to synchronize sweeping flange effects to the beat of your song. In 
addition, the LFO sweep can be manually synchronized, using a continuous controller 
or switch in the Preset Cords, so that the top of the triangle waveform starts on a certain 
beat.

As the low frequency oscillator (LFO) varies the delay time, a rich, sweeping effect is 
created as the cancellation notches move up and down across the frequency range. The 
amount of feedback deepens the notches, intensifying the effect.

You can invert the feedback signal by choosing a negative feedback value. Inverting the 
feedback signal creates peaks in the notch filter and deepens the effect.

Modulation Parameters
• Wet/Dry Mix
• Sync
• Rate (Note Div)
• Feedback

Parameter Description

Initial Delay Sets the initial delay of the flanger in .01 millisecond increments. 
This parameter allows you to “tune” the flanger to a specific 
frequency range. Range: .01ms to 4ms

Depth Sets how much the LFO affects the delay time. Increases the 
animation and amount of the flanging effect. Range: .006 to 100%

LFO Note 
Division 

The speed of the LFO is locked to a note division of the master 
tempo.  Range: 4/1 note to 1/64 dotted-note

Feedback Controls how much signal is recirculated through the delay line and 
increases resonance. Negative values can produce intense flanging 
with some signals. Range: -99% to +99%

Through Zero On - Adds a short delay to the original signal to simulate the classic 
“through-zero” flanger sound, which was originally created using 
two tape recorders.
On (out of phase) - Inverts the phase (180°) and adds a delay to 
the original signal producing additional phase cancellation.
If the feedback control is set to zero, complete cancellation occurs 
when the flanger goes through zero.

Sync (LFO Phase) Re-syncs the LFO (to the peak of the triangle wave) whenever this 
button is pressed or whenever the sync modulation input goes from 
zero to a positive value.
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Growl
This is a new kind of self-modulation effect created especially for Emulator X. Growl 
excels at turning simple sounds into musically complex and interesting ones. 
Depending on the input wave and control settings, Growl can impart a horn-like 
quality, a warm tube distortion, or a harsh rasp.

Growl is easy to use. Just turn up the depth control and wet/dry mix, then adjust the 
Initial control until you find the right amount of “growl”. Then, back off the other 
controls and a fine tune all the other controls to taste. It’s Grrrreat!

Modulation Parameters
• Wet/Dry Mix
• Depth
• Color

Parameter Description

Initial This control “Tunes” the effect to a specific frequency range. 
Range: .01ms to 15ms

Depth Sets how much self modulation is applied. Range: 0% to 100%

Color Controls the tonal color of the effect. Range: -99% to +99%

Pre-Filter Anti-aliasing filter. Turn this filter up if you hear aliasing at high-
frequencies.
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Limiter
The Limiter sets a “maximum level” on the audio. Beyond this Threshold, any increase 
in gain is effectively prevented or limited, hence the name. A limiter works like a 
compressor with a very high ratio setting.

The limiter is particularly useful for taming the highly resonant peaks that can be 
produced by the Z-plane filters. Set a fast attack time to suppress transients and use the 
Release control to reduce “pumping” effects.

The Output Gain control amplifies the signal after it has been limited to bring it back up 
in volume. If you don’t increase the gain, the signal may be lower in volume.

Two other controls are Attack and Release. Attack controls how quickly the gain is 
turned down after the signal exceeds the threshold. Release controls how fast the gain 
is returned to its normal setting after the signal has fallen below the threshold again. 
Longer release times are generally used to reduce the so called “pumping” effect as the 
compressor turns on and off. Don’t make the release time too long, however, or the 
compressor won’t have time to recover for the next pluck or hit. In general, the attack 
and release controls are used to smooth out the action of the limiter, but they can also 
be used to create special effects.

Modulation Parameters
• None

Parameter Description

Threshold Threshold sets the “trigger” level for limiting. Signal levels above the 
threshold will be brought down in volume. Range: -50dB to +20dB

Output Gain Amplifies the signal after it has been compressed to bring up the 
volume. Range: -24dB to +12dB

Attack TIme Controls how quickly the gain is turned down after the signal exceeds 
the threshold. Range: 1 ms to 200 ms.

Release Time Controls how fast the gain is returned to its normal setting after the 
signal has fallen below the threshold. Range: 0.2 second to 1 second

0dB

Threshold: -10dB
-10dB

-80dB

Signals above the
Threshold level are
prevented from

getting any louder.
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Phaser
A Phaser (or phase shifter) produces a fixed number of peaks and notches in the audio 
spectrum which can be swept up and down in frequency with a low frequency oscil-
lator (LFO). This creates a swirly, ethereal sound with harmonically rich sound sources 
of a type of pitch shift with simpler sounds. The phase shifter was invented in the 
1970’s and the characteristic sound of this device evokes emotions of that musical era.

Modulation Parameters
• Wet/Dry Mix
• Depth (Modulation)
• Rate (Modulation)
• Feedback

Parameter Description

Depth Controls how much the Center Frequency is swept by the LFO.
Range: 0% to 100%

Rate Controls the sweep rate of the Low Frequency Oscillator.
Range: .01Hz to 20Hz

Feedback Increases the depth of the notches and height of the peaks.
Inverted values invert the feedback polarity.
Range: -100% to +100%. 

Stages Selects between: 3, 6, 9, or 12 phase shift stages and thus the 
number of peaks and notches in the frequency response.

LFO L/R Phase Offsets the LFO between the left and right phaser channels. 
(0°, 90°, or 180°). This adds extra animation to the sound.

Phaser
(stereo)

LFO

In

Out

Feedback

Depth Stages

Rate

Signal path = Stereo

L/R
Phase
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Pitch Shifter (mono)
The pitch shifter (also known as a “harmonizer”) shifts the pitch of the input up or 
down while preserving the time between events. (Unlike speeding up or slowing down 
a tape recorder or pitch shifting across the Emulator X keyboard.) The range of the 
pitch shifter is -36 semi tones down to +24 semi tones up in .01 semitone increments.

Small amounts of pitch shifting makes an effective type of chorus. Semitone shifts 
work especially well on the human voice for harmonization and for special effects. 
With the Feedback control turned up, the pitch shifted (and slightly delayed) signal 
will be recirculated through the pitch shifter and re-shifted further up or down.

Modulation Parameters
• Wet/Dry Mix
• Pitch
• Feedback
• Pan

Parameter Description

Pitch Shift This control selects the pitch shift interval.
Range: -36 semi tones to +24 semi tones

Feedback Controls how much signal is recirculated through the pitch shifter. 
Range: 0% to 100%

Pan This parameter moves the pitch shifted sound left or right. This 
moves the apparent sound source left or right.

Pitch
Shifter

Feedback

Pitch Shift
Pan

L Out

R Out

L In

R In
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Ring Modulator
A ring modulator takes two signals and multiplies them together to produce an output 
signal containing only the sum and difference frequencies of the two input waves. The 
original frequencies are not output. If complex waveforms are used, every partial of 
each signal multiplies every other according to its amplitude. Because ring modulation 
is a linear process, these new sum and difference frequencies are shifted from their 
normal exponential harmonic relationship. As a result, ring modulators tend to create 
clangorous, bell-like timbres.

In this ring modulator, each side of the stereo input source is multiplied by an internal 
sine wave oscillator. The internal oscillator can remain at a fixed pitch or it can be 
modulated by an envelope follower.

The envelope follower sweeps the pitch of the modulating oscillator up or down based 
on the amplitude of the input signal. Try adjusting the Emulator X attack and decay 
controls (amp) to hear the effect of the envelope follower. The envelope follower can 
sweep the modulating oscillator in either the positive or negative direction by setting 
the value positive or negative.

Parameter Description

Frequency This control sets the frequency of the modulation waveform
Range: 0 Hz to 5000 Hz

Envelope Follower Controls how much the amplitude envelope sweeps the 
modulating oscillator. Range: -10x to +10x

This diagram shows the result of Ring Modulating two sine waves with frequencies of 200 Hz & 
800 Hz. Only the Sum and Difference frequencies of 600 Hz and 1000 Hz will be output.
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Modulation Parameters
• Wet/Dry Mix
• Frequency
• Envelope Amount

SP12-ulator
The E-MU SP-12 Sampling Drum Machine was the most advanced beat box of its day 
and still remains a classic. The SP-12 used a gritty, “drop-sample” pitch shifting 
technique which contributed to its distinctive sound. The SP12-ulator effect is an 
homage to the venerable SP-12, and allows you to mangle sounds as your forefathers 
did many years ago.

Modulation Parameters
• Wet/Dry Mix
• Frequency
• Depth

Parameter Description

Frequency This parameter controls the number of samples that will be 
“dropped.” Range: 0 - 100

Depth This parameter controls the intensity of the resultant distortion. 
Range: 0% to 100%

Resolution The SP-12 is a 12-bit drum machine. The SP12-ulator allows you to 
reduce the bit depth to 12-bits, or all the way down to 1-bit 
resolution if you must. Range: Hi-Res (32 bit), 12-bit to 1-bit

Ring
Modulator

Modulating
Oscillator

Envelope
Follower

L OutL In

R OutR In

Freq.

In

Freq.
Depth

Resolution

Out

Signal path = Stereo

SP12-ulator
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Tremulator BPM
Tremolo is amplitude modulation and is also a standard guitar amp effect. The Tremu-
lator BPM is more like a tremolo on steroids! In addition to the standard rate and amount 
controls, the Tremulator lets you beat-sync the tremolo speed to the song tempo, has 
eight different modulation waveforms with adjustable lag, lets you autopan the stereo 
signal in several ways, and even includes a sweepable lowpass filter with five modes.

Parameter Description

Wet/Dry Controls the intensity (depth) of the tremolo effect.
Range: 0% to 100%

LFO Note Duration The speed of the LFO is locked to a note division of the master 
tempo. Range: 4/1 note to 1/64 dotted-note

LFO Waveshape Selects between the following modulation waveforms:
Sine, Triangle, Half Sine, Sawtooth Up, Sawtooth Down, Square, 
Pulse 25, Pulse 75

Lag Sets the slew rate of the LFO output. This is normally used to 
round the corners of the square waves, but can create interesting 
effects with the other waveforms as well. Range: 0% to 100%

L/R Phase Offsets the LFO phase between the left and right channels. 
(0°, 90°, 180°, 270°). 
0° - Both the left and right channels are the same.
180° - Creates a back and forth, “ping-pong” effect.
90°/270° - Creates a rotating effect.

Mode Six different modes are available:
�  Tremolo - Tremolo amplitude modulation
�  Tremolo + Filter 1 - Tremolo & 2-pole filter sweep, no Q
�  Tremolo + Filter 2 - Tremolo & 2-pole filter sweep, Mid Q
�  Filter 3 -  2-pole filter sweep, Low Q
�  Filter 4 -  2-pole filter sweep, Mid Q
�  Filter 5 -  2-pole filter sweep, High Q
Note: The initial filter frequency is set lower as the Q is increased.

Sync (LFO Phase) Re-syncs the LFO (to the peak of the wave) whenever this button 
is pressed or whenever the sync modulation input goes from zero 
to a positive value. You could connect a footswitch. 

LFO

Lag

In Out

Wave

Mode

Note
Duration

PhaseSync

Lag

LFc Q R

Stereo
TremFilter

Mode
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Modulation Parameters
• Wet/Dry Mix
• Rate (LFO Note Duration)
• Waveshape
• Sync

Triangle Sine Half
Sine

Sawtooth
Up

Sawtooth
Down

Square Pulse
75

Pulse
25

Tremulator Waveforms
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Tube
The Tube is a tube amplifier simulator based on “soft clipping”. An overdriven tube 
amplifier sounds good because it generates even harmonic distortion products. This 
digital tube gently rounds the waveform in a smooth, controlled manner much like a 
real vacuum tube. 

Set the amount of distortion using the Gain control, then adjust the tone using the 
Treble and Bias controls. The Compression control smooths out volume changes and 
the Output Level control sets the final volume of the effect.

Modulation Parameters
• Wet/Dry Mix
• Gain
• Output Level

Parameter Description

Gain This parameter controls the overdrive amount on the “tube” and 
thus, the amount of distortion generated. Range: 0.25 - 50.00

Output Level This parameter sets the output volume level and has no effect on 
the tone.

Presence This control sets the lowpass filter frequency at the output of the 
“tube”.

Compression Tubes have a certain amount of natural “soft” compression. This 
controls how much compression is applied.

Bias Bias controls at what point in the waveform clipping begins.

In

Compression
Bias

Output
Level

Out

Lowpass
Filter

Presence
Gain

Signal path = Stereo 8�6 �$�8 �6�$�
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Twin
The Twin utilizes two “tube” stages to simulate the overdrive response of a guitar 
amplifier. Separate gain controls allow you to precisely control the amount of soft 
clipping from each “tube” stage. A three-band tone control between the two stages and 
a presence control after the 2nd stage allow you to precisely contour the overdrive 
frequencies. 

Set the amount of distortion using the Volume and 2nd Stage Gain controls, then 
adjust the tone using the Treble, Mid and Bass controls. The Compression control 
smooths out the timbrel changes and the Output Level control sets the final volume of 
the effect.

Modulation Parameters
• Wet/Dry Mix
• Gains 1 & 2
• Master Volume
• Pan

Parameter Description

Volume This parameter controls the overdrive amount on the 1st “tube” 
and thus the amount of distortion generated.

Master Volume This parameter sets the output volume level and has no effect on 
the tone.

Treble Allows you to adjust the high frequency content between the two 
“tubes”.

Mid Allows you to adjust the mid frequency content between the two 
“tubes”.

Bass Allows you to adjust the low frequency content between the two 
“tubes”.

2nd Stage Gain This parameter controls the overdrive amount on the 2nd “tube” 
and thus, the amount of distortion generated.

Presence Allows you to adjust the mid frequency content at the output of 
the 2nd “tube”.

Pan Sets the left/right pan position of the processed sound.
Range: -100% to +100%

Compression Tubes have a certain amount of natural “soft” compression. This 
controls how much compression is applied by both tubes.

Compression
2nd 
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10 - Controls
The Toolbars
10 - Controls

This chapter describes how to work the controls Emulator X. There are certain tips and 
tricks to learn in becoming a power user, and a good number of them are in this 
chapter.

The Toolbars
The toolbars are located just beneath the menu bar at the top of the window. There is 
also a status bar at the bottom of the window. The toolbars provide handy single-click 
buttons for the most common operations. By holding the mouse pointer over the tool, 
a label will appear revealing the purpose of each tool.

The upper toolbars can be rearranged by simply clicking the Toolbar Handles (see 
below) and dragging them wherever you want.

The Status Toolbar is always located at the very bottom of the window and provides 
context sensitive information, such as the current MIDI channel, sample/preset name & 
number, as well as the number of samples currently playing.

Standard ToolbarMenu Bar

Sample Zoom 
Tools

Sample Edit 
Tools

Toolbar 
Handle

CPU Usage

Basic
MIDI Channel

Preset Name
& Number

Number of
Samples Playing

Status Bar

Pre-Roll Samples 
in RAM

Current Voice
& KYBD Range

Menu Toolbars

MIDI ModesHelp

Disk Usage
Meter

Sample 
Transport

Sample 
View

Floating Keyboard
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Drag & Drop
Viewing and Hiding the Toolbars
Select Toolbars from the View menu or Right-click when the cursor is over any toolbar 
to call up the Show/Hide Toolbar menu. Check the boxes of the toolbars you wish to 
view. “Flat Toolbars” removes the dividers and changes the look of the toolbars.

Drag & Drop
You can use simple “Drag & Drop” operations for many Emulator X functions. For 
example, to copy a voice to another preset, simply left-click on the voice icon, then drag 
it on top of another preset and release the mouse. To import WAVE, AIFF, REX2 or MP3 
files, simply drop them onto the Emulator X icon. Page 328 provides a complete listing 
of the drag & drop functions.

Floating Keyboard
You can call up a movable keyboard window by selecting  Keyboard from the View 
menu, pressing F9, or by pressing the  button on the toolbar. The keyboard and 
wheels always send data on the current Basic channel with a default velocity of 64. 
When the basic channel is changed, all active notes will be cleared. 

 Hold Ctrl and play 
the mini keyboard for a 
velocity of 10. Play the 
mini keyboard while 
holding Shift for a 
velocity of 127.

• Transpose: Shifts the keyboard up or down by up to 2 octaves. (No transpose 
on Piano and Full MIDI.)

• Latch: When latch mode is on, the note remains on when a key is pressed. 
Pressing the same key again turns the note off. Latched notes are displayed 
slightly darker.

• Pitch & Mod. Wheels: Send pitch bend and modulation wheel controls.

• Keyboard Range: Right-click anywhere on the keyboard to select the range. 
Choose the range that best matches your keyboard controller.

Select from the Menu Bar... ... or Right-click 
over the Toolbars

Modulation Wheel

Pitch WheelKey
Latch

Octave
Transpose

XBoard 25 -

Three Octave -

XBoard 49 -

Piano -

Full MIDI -

XBoard 61

Right-click the keyboard to 
select the keyboard type.
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Changing Settings

Entering Numeric Values
Numeric values are displayed in alphanumeric readouts with either an associated 
control knob or an up/down button adjoining the display. 

� Numeric values can be changed by:

� Move the Cursor from the Computer Keyboard

� Select the Knob or Slider and then:

• Turning the knob (if there is one).

• Pressing the Up/Down keys when the control has the focus.

• Typing the desired value into the field.

• Press the Tab key to move the cursor to the next field.

• Press Shift+Tab to move the cursor to the previous field.

• Hold the Alt key and click the knob or slider to set the default value.

• Use the Left/Right keys to increment or decrement the value by a small amount.

• Use the Page Up & Page Down keys increment or decrement by a larger 
amount.

• Use the Roller on a roller-type mouse to increment or decrement the value.

• Press the Home key to turn the control all the way down.

• Press the End key to turn the control all the way up.

• Press the 5 key in the numeric keypad to center the control. 
(Num Lock must be off)
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Adjusting Ranges & Fades
The Key Win, Vel Win, RT Win, CC Win, and Region tabs in the Voices and Zones 
screen all contain parameters that can be adjusted by both graphical sliders and alpha-
numeric values.

 Note: Fades are not 
available for the sliders in 
the Region tab.

You adjust a slider’s range or position clicking and dragging your mouse. To create and 
edit a fade range, hold Alt key in conjunction with clicking and dragging the endpoint 
with your mouse. See below:

� Editing Ranges using the Graphic Display

� Editing the Ranges Using the Alphanumeric Fields
Alphanumeric Fields for Key, Velocity, Realtime, and CC ranges appear in the Overview 
section at the bottom of the Voices and Zones screen.

Select the voices you want to change, place the cursor inside the alphanumeric field, 
and then:

• To set the high and low ranges, click and drag the end points of the graphic display 

• To move the whole range without resizing it, click and drag the middle of the range.

• To create a fade, hold Alt, and click and drag the end points. Once you create a fade 
point, you can click and drag the fade point to re-position it.

• Type in the desired value.

• Use the +/- keys to increment or decrement the value.

• Use the roller on a roller-type mouse to increment or decrement the value.

• Press and hold Ctrl, and press Alt. The word “MIDI” appears at the bottom of the 
window. Play your MIDI keyboard to set the key position.
(Note: Intelliedit must be turned on in the Preferences menu.)

Alt-Click & Drag the 
End to set Fade

Click & Drag the 
Middle to Move

Click & Drag the 
End to Resize

Click & Drag Fade Point 
to Adjust Fade
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Selecting Voices using your MIDI Keyboard
Before you begin: Make sure “IntelliEdit,” in the MIDI Preferences, is set to the same 
MIDI port as your keyboard.

Press Ctrl+Alt +MIDI Key to select voices from the Voice Processing page. You'll see the 
word MIDI appear in the status bar at the bottom of the window.

The first note played selects all voices that overlap that key. The second note played, if it 
is different, selects all voices that overlap the range between the two notes played. 

If the same key is pressed repeatedly, and if there are multiple voices assigned to that 
note, the selection will cycle through the voices whose ranges overlap that key.

You can see the selected range of keys displayed below the keyboard at the top of the 
Voice Processing window.
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Adjusting Envelopes
Envelope rates and levels can be adjusted using the knobs, numeric entry, or by simply 
dragging the break points to the desired positions. See also, “Amplifier, Filter & 
Auxiliary Envelopes” on page 132.

BPM Mode & Tempo
BPM mode allows the envelope times to follow the internal/MIDI clock rate. The 
master tempo is adjusted and displayed in the Multisetup page (page 74). This allows 
the synthesizer to adapt to the tempo of your music.

The tempo syncs to an external MIDI clock if “External Tempo Source” is enabled in 
the Preferences menu. (See “External Tempo Source” on page 27.) If “External Tempo 
Source” is NOT enabled, the internal clock will be used.

Cut, Copy & Paste
You can use cut, copy and paste commands for most Emulator X functions.

Page Uses

Sample Page • Cut, Copy and Paste samples between banks.
• Cut or Copy, then Paste into a new sample (List View)
• Rearrange the order of Samples in the list.

Voices & Zones • Cut, Copy and Paste voices between banks.
• Rearrange the order of voices in the list.

Voice Processing • Cut, Copy and Paste synth module settings (such as envelopes, 
LFO, Cords) between voices in the bank. You can also copy Amp 
envelope settings to the Filter envelope for example.
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View Menu
View Menu

Large Icons List

Small Icons DetailsShow Bank/Prog No.

Hide Object 
Numbers

Show Object 
Numbers Help

Toolbar View 
Selection

Keyboard
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View Menu
List Display View
When in the Tree, clicking on any folder shows the folder contents in the large window. 
The View Menu provides several display options for samples, presets and multisetups. 
The List Display view also allows you to cut, copy and paste multiple samples and 
presets. The view options are listed below:

Creating a Text List of Presets and Samples 
You can create a text file of all the presets and samples in the bank. This can be useful to 
organize your sound collection. The preset list shows: preset number, bank/program 
number and preset name. The sample listing shows: sample number, sample rate, size 
in bytes, and the sample name.

To create a text file of the presets and samples in a bank, load the bank and select 
Save Text Listing... from the File menu.

Large Icons Displays large icons useful for smaller banks

Small Icons Displays small icons (shown above) useful for large banks

List Displays Presets and Samples in a list view format (in numerical 
order).

Details
The Details view displays various details about the items. Clicking on 
the Column Header at the top of each column sorts the list by that 
category.

Category Buttons
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View Menu
Tree View
The Sample, Preset or Multisetup Tree items can also be viewed in several ways. The View 
Menu provides several display options for the tree. The view options are listed below:

Tree Navigation using the Keyboard

Cursor Keys
You can move quickly through the Tree using the Left-Right-Up-Down Cursor Keys. 

With the Presets folder selected as in the example above, pressing the right cursor will 
open the presets folder.

Pressing the Right Cursor key again opens the Preset.

The Left Cursor reverses the actions. The Up-Down Cursors move up and down 
within the list. The Enter key opens the item.

Show/Hide Object Numbers
Displays or hides the object number for the 
Sample, Preset or Multisetup.

Show Bank & Program 
Numbers

Presets can be displayed in the tree with Object 
numbers (P003) or with Bank and Program 
numbers (002:003).

Opens
Selected

Item

Closes
Selected

Item

Moves Down
in List

Moves Up
in List

Opens
Selected
Folder

Opens
the

Preset
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View Menu
Find Items
When the cursor is positioned in a list such as the tree, you can locate specific presets or 
samples by simply typing the name. Typing the first letter of a name finds the first 
preset or sample beginning with that letter. Repeatedly typing the same letter finds the 
next item beginning with that letter, and so on.

When “Show Object Numbers” is selected, you can type the preset or sample number 
(preceded by the letter P or S) to locate items by number.

Tree Navigation Using the Toolbar
You can use the buttons in the standard toolbar to navigate through the Tree.

Refresh (F5)
Sometimes the display does not reflect the state of the synthesizer or vice-versa. 
Pressing F5 or selecting Refresh from the View menu manually synchronizes the 
display and synth.

Context Sensitive Menus
The right mouse button brings up context-sensitive menus in many areas of Emulator 
X. Simply right-click over the field or area to bring up the menu for that function.

All Sound Off (Ctrl + Pause)
Activating this function immediately terminates all sound from the synthesizer and 
clears the effect processors of all sound data. The All Sound Off command is automati-
cally initiated when the sequencer transport Stop is pressed.

Navigates up one Tree level.

Jumps back to the previous tree location.

Jumps forward to the next tree location if you’ve clicked the back button. 

Jumps to the Global Presets page for the current preset.

Jumps to the Voices and Zones page for the current preset.

Jumps to the Links page for the current preset.

Jumps to the Voice Processing page for the current preset.
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Templates
Templates
For each module in the Voice Processing window, the Preset window, or for Effects, 
you can save a library of your favorite settings. These Templates make it easy to create 
your own customized voices and presets. Templates are saved with Emulator X appli-
cation so they’re always available for use. Here’s how they work:

Creating and Recalling Templates
You can create a template for a module, effects, all preset parameters, or all voice 
parameters to be recalled later. Templates are stored with Emulator X’s program files 
and therefore can be recalled from any bank.

� To Create a Template from a 
Module or Effects

1. Set the controls as desired for a particular 
module or effect.

2. Right-click with the mouse anywhere 
inside the module border or Effects TV 
screen. A pop-up menu appears.

3. Select Save Template… or press “S” while 
the popup dialog box is visible. The 
following popup dialog box appears.

4. Type in a name for your Template, and 
click OK. The Template is saved and 
ready to use when you open another 
bank.

� To Save All Voice Parameters as a Template

1. Go to the Voice Processing window.

2. From the Voice Processing menu, select Voice Processing Templates.

3. Choose Save Voice Processing Template... from the menu. A pop-up dialog 
appears asking you to name your new Template.

4. Name the template.

5. Press OK to save the Template or Cancel to cancel the operation.

� To Recall a Template

1. Right-click with the mouse anywhere inside the module 
border or Effects TV Screen. A pop-up menu appears.

2. Select the desired Template from the list. The Template 
will be selected. 

OR…

1. Select Organize Templates or press “O” while the popup 
list is visible. The Organize Templates dialog box appears.

2. Select the Template you want, and click OK.

 The menu only shows 
the first 20 templates; if 
there are more than 20, 
an item labeled More 
Templates appears, which 
will bring up a dialog for 
selecting a template.
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Organizing Templates
You can re-name, delete, re-order, and Explore 
your templates.

� To Rename or Delete a Template

1. Select the desired template from the 
Organize Templates dialog box.

2. Click Delete to permanently remove the 
Template.

3. Click Rename, then type in the new name to 
rename the Template.

4. Click OK to close the dialog box.

� To Re-Order Templates
This feature allows you to select which templates 
appear at the top of the list, which is important if there are more than 20 templates.

1. Click the template you want to move.

2. Click either Move Up or Move Down to change the order of your templates.

� To Explore Templates Folders

1. From the Organize Templates dialog box, click Explore.

2. Explore the templates on your computer.

Emulator X stores your templates as .xml files in the following folder:

\Program Files\Creative Professional\Emulator X Family\Templates\

When you click Explore, you are taken to this directory. From here, you can copy or 
restore existing templates for backup purposes. You can also modify the .xml files with 
an XML editor.

 Tip: Several templates 
can be deleted in one 
operation by selecting 
multiple templates and 
clicking Delete. This also 
applies to moving 
Templates Up or Down.
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Acquire (Sampling)
11 - From Sample to Preset

Acquire (Sampling)
Sampling has always been a bit of a chore to do because of all the housekeeping and 
organization involved. In Emulator X, we’ve invented a host of automatic tools to 
make sampling easier than ever before.

The chop function automatically extracts individual samples from a section of audio 
containing multiple notes. At the sample recording session, you set up your audio 
recorder and have the musician play each note separated by a short period of silence. 
You can make verbal cues on the tape if you wish. Later, when you’re ready to input 
your samples, the periods of silence allows Emulator X to automatically separate the 
samples for processing.

Select Acquire Samples... from the File menu. The following screen appears.

Input Controls

Record
Select this option if you want to sample audio from an ASIO or DirectSound 
input.

Load
This option allows you to load Wave, AIFF, MP3, or REX 2 sample files to run 
them through the gating and sample placement options. Sample gating 
chooses samples which are separated by periods of silence.

 To import other 
sample formats, see 
“Translator Emulator X 
Converter” on page 319.
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Acquire (Sampling)
Recording Audio (Sampling)
Choose “Record” if you want to sample from an ASIO source within your computer. 

�  To Set-up PatchMix DSP for Sampling into the Emulator X
Use these instructions if you are using PatchMix DSP. To sample from a PatchMix DSP 

input, an ASIO Send must be inserted on the desired PatchMix strip.

1. Open the PatchMix DSP mixer.

2. Add a mixer strip corresponding to the analog or digital input you are using. (i.e. If 
you have a microphone connected, add a mic/line strip.)

3. Insert an ASIO Insert Send into the mixer strip. You may also want to add a Peak 
Meter to make sure you’re getting a proper input level.

�  To Set-up Emulator X for Sampling
4. Open the Acquire Sample dialog from the file menu on Emulator X.

5. Select Record from the input section in the upper right corner. The Record Audio 
dialog box (shown below) appears.

6. Click on the Select Input box. The open ASIO inputs will be shown. Select the 
input you wish to use.

7. You should see activity on the Emulator X record meters with audio on your input.

8. That’s it!

Note: The Emulator X only records in stereo. To record monophonic samples, use a 
single input and convert the stereo sample to mono using the Mono<->Stereo sample 
edit tool. See “Convert to Mono or Stereo” on page 194. 

�  To Begin Sampling

1. Choose Acquire from the File menu. The Acquire/Chop Samples screen appears.

2. Press the Record… button. The following dialog box appears:

Select Input Monitor Source while Recording
(to ASIO 1&2 or DirectSound)

Input Level 
Meters

Record 
Time

Record Stop Play

Done 
Recording

Total Available 
Recording Time 

Click to Clear 
Red Clip Bars

Input Level 
Attenuator
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Record Audio Controls

3. Select the Input that you wish to record. The displayed input selections are based 
on which ASIO channels were free when the Record Audio dialog was opened.

• No Inputs? If no inputs are listed, make sure E-MU ASIO is selected in the 
Preferences dialog. If you’re using PatchMix DSP, make sure that the current  
Session contains at least one ASIO Send.

4. Set your input levels. With audio coming in, watch your meters. Adjust the input 
level using the Input Level Attenuator or by adjusting the volume level of the 
source. The signal peaks should illuminate the yellow area of the meter. The red bar 
at the very top of the meter indicates clipping and will stay on after clipping is 
detected. Left-click on either red bar to clear the clip indicator.

5. Press the Record button to begin recording. The Record Time display begins 
running and the Total Available Recording Time will begin to slowly decrease.

6. Press the Stop button (or hit the spacebar) when you’re finished recording.

7. Press Done to return to the Acquire/Chop dialog. (Pressing Record again without 
clicking OK discards the previous sample.)

8. After pressing Done, you’re ready to set up the automatic sampling features.

Level This control allows you to attenuate the input signal to avoid clipping.

Input
Choose the desired input source. An ASIO source must be open before an 
input will be listed here.

Monitor
When this button is depressed, you can monitor the input before, during 
and after the sampling process. The monitor outputs through ASIO 1&2 
(or DirectSound if selected). Monitor will normally be left On.

Record Press to initiate recording. Recording continues until you press stop

Stop Stops recording or playback of the sample.

Play
Plays back the recorded sample from the beginning.
(Pressing the Space Bar toggles between Play and Stop.)

Done
Closes the Record window and returns you to the Acquire/Chop dialog 
with the new recording in.

Meters
Stereo input signal level. The top red bars stay on after clipping. 
Click to clear them.
E-MU Systems 283



11 - From Sample to Preset
Acquire (Sampling)
Gating the Samples
The sample gating feature is designed for separating a series of samples separated by 
silence (SSSS). You can record or import one long sample containing many short 
samples and let the gating feature automatically separate them for you.

 Display Units
Right-click on the 
horizontal or vertical 
rulers to change the 
display units.

Horizontal units can 
be displayed in 
samples or seconds.

Vertical units can be 
displayed in percent, 
decimal, or dB.

Gate/Chop Controls

Level
Sets the level change that must occur before a gate is set. Adjust this control 
so that the gates conform to the signal. The gates should appear as in the 
diagram above.

Pre/Post
Sets the pre-sample and post-sample time. Increase this setting if the signal 
attacks and releases are being truncated.

Hold
Sets the minimum amount of time that must pass before another gate can 
be set. This control is useful to prevent too many gates from being set.

Apply
Sets the gate start and end points according the current Gate/Chop 
settings

Sample Overview

Display Zoom 
Controls

Gates

Gating Display Current View Bar
(move to change view)
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�  To Gate & Chop Samples
After recording or loading a section of audio, you’re ready to gate and chop.

 You can also adjust 
the Threshold Level 
settings by simply 
dragging the markers. 
Hint: Zoom in first.

Setup Parameters
1. Set the threshold Level using the numeric display or by 

setting the threshold markers in the waverform display. 
This setting affects the accuracy of the gating. For 
percussive samples like the ones shown above, set this 
setting at -40 dB or lower to start. Different signals 
require different settings.

2. Set the Level, Pre/Post and Hold settings to the settings 
shown at left as a starting point.

3. Press the Apply button. Gates now appear on the 
waveform display. You’ll also notice that numbered 
Region Names now appear in the Region List below the 
waveform display. We’ll get to these in a minute.

 Tip: Select a Region 
and hit the Space Bar to 
play it.

4. The gates should conform to the individual samples, similar to the screen shown 
on page 284. If not, simply change the Gate/Chop controls and Apply again.You 
will be asked if you want to “Delete the Existing Regions.” Click Yes.

Setting the gates may take a little practice to master, but it’s really very simple. In any 
case you can always set the gates manually if you wish. Read on.

• Decrease the Level setting (bigger negative number) if the regions are too 
large.

• Increase the Level setting (smaller negative number) if the regions are too 
small.

• Increase the Hold time if too many gates are being set.

Play 
Selected
Region

Region List Display

Play 
Entire

Recording

Stop
Playing Region Controls

Region
Name Field

Original
Key Field

Start
Sample

End
Sample

Click 
Headings 

to Sort

Region
Locks (off)
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Region List Controls

Refining the Selection

5. Try out the horizontal and vertical zoom controls in the lower right corner of the 
waveform display. Zooming in on the wave makes it a lot easier to see exactly what 
you’re doing.

6. Click on one of the numbered region names in the text area. Click on the word 
“Region” itself, not on the padlocks to the left of the names. The waveform display 
now automatically zooms in to show a close-up view of the selected region.

7. Press the Play button

8. Adjust the Start and End points of the gates manually so that they conform to the 
start and end points of the waveform. Just left-click and drag, to move them. Feel 
free to use the zoom controls if you need a closer look.

Manual Settings

9. The gates settings in the display below have a few problems. The end points have 
been set too far out and there is an extra Region without a sample.

Play - Plays the currently selected Region.

Play All - Plays the entire Sample (all the Regions)

Stop - Stops playing

Lock All Locks all Regions.

Lock None Unlocks all Regions

Select All Selects All Regions

Select 
None

De-selects all Regions

Name 
Field

Displays Region name, Type directly into this field or use “Set Names” 
button.

Original 
Key

Displays key number of region. Type directly into this field or use 
“Set Keys” button to generate key numbers using pitch detection.

Start Field Displays the Start point of the Region in samples.

End Field Displays the End point of the Region in samples.

Lock Icon
Locked Regions are protected against modification. Click to lock or 
unlock.

Set Keys Generates key numbers based on pitch detection of the region.

Set 
Names…

Allows you to enter a name for any selected Regions and automatically 
add the original key to the name if desired.

Delete
Removes the gates from the selected Regions and removes them from 
the list.
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10. Click on each of the Region names one at a time. In the example above, Region 8 is 
not gating a sample and needs to be deleted. With the Region name selected, click 
the Delete button to discard the gate. Poof!

11. In the example above, the End points can simply be dragged inward toward the 
Start point to remove the silence at the end of the sample. Press the Play button (or 
hit the Space bar) to listen to the gated area.

Labeling the Regions

12. Press the Set Keys… button in the Edit Section. The Emulator X analyzes each 
sample and labels it with the correct pitch. These key numbers can be used later for 
placing the sample on the keyboard.

13. If you know the pitch of the region, you can manually name the regions by clicking 
over the field and typing in the key number.

14. Click on the Name field in the Region List section. The selected section of the 
waveform is highlighted as you click on the name.

15. The Set Names… button allows you to name any selected samples. Shift-click or 
Ctrl-click to select multiple samples for naming. Use the Select All button to 
choose all regions. You can also include the original key in the sample name to 
make placement or identification easier.
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16. Press the headings in the labeling section to Sort each column. Press again to sort 
in reverse order.

17. You can Lock each region after you finish setting it up to prevent any accidental 
changes from being made. Click on the little lock icons to lock and unlock, or use 
the Lock All or Lock None buttons.

Saving your Samples

1. Once the gates and labels are set, you have several options. You can save the 
samples as WAVE or AIFF files, add them to the current bank or automatically 
create a new preset containing the samples.

2. Press the To Files… button to save the samples in WAVE or AIFF format. The 
following pop-up dialog box appears.

3. Choose a location for your samples.

4. From the Save files as: drop-down menu, select the file type you want to save as, 
and click OK to save, or Cancel to cancel the operation.

5. Press the To Sampler… button to add the samples to the current bank. The 
following pop-up dialog box appears.
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6. The save to sampler controls allow you to set up the automatic DSP and placement 
operations which will normalize your samples, loop them and even create a new 
preset with the samples placed on the keyboard if you choose.

Save to Sampler Controls

These features are described in detail in the next section. Please go to page 296 for 
more information.

Normalize
Boosts the gain of the samples to make them full-level. Please read 
“Sample Options” on page 296 for more information.

Auto-loop
This option allows you to choose the algorithm for setting the loop 
points of the imported samples. Please read “Sample Options” on 
page 296 for more information.

Build Preset
When checked, this option creates a new preset using your samples. 
Please read “Build Preset Options” on page 297 for more information.

Name This Build Preset option allows you to name your new preset.

Placement
This option lets you to specify how samples will be placed in your new 
preset. Please read “Build Preset Options” on page 297 for more 
information. 

Start At
This option allows you to specify which key will be the first key if you 
Place the regions on white keys, or chromatically. Please read “Build 
Preset Options” on page 297 for more information.

Stretch
These options let you control how the samples fill in the empty spaces 
on keyboard. Please read “Build Preset Options” on page 297 for more 
information.

Single 
Voice

If this box is checked, the samples will be placed inside a single Multi-
sample voice. See “Multisample Voices” on page 37 for more 
information.
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7. Click OK to perform the Sampler Options and Build the Preset (if enabled). If you 
chose not to build a preset, the samples will be added to the end of the sample list. 
If you did build a new preset, a new preset (with your chosen name) will also be 
added to the end of the preset list in the bank.

8. Open your new preset in the Voice Processing window and modify as desired to 
complete the preset.

9. Remember to SAVE THE BANK or all your work will be lost.

SynthSwipe™
Got an analog instrument with MIDI capabilities, such as a drum machine or a sampler 
keyboard? You can sample the entire instrument automatically using SynthSwipe.

All you need to do is: Connect your instrument’s analog outputs to your computer, 
connect your computer’s MIDI out to your instrument’s MIDI in, and run SynthSwipe.

Use the following steps to learn how.

�  To Set Up Your Connections

1. Connect the analog line out(s) to your sound card’s analog line in(s). Use stereo if 
possible.

2. Connect the MIDI output on your sound card to the MIDI input on your 
instrument. See the following diagram:

R L R L
IN OUT THRUOUTPUTS

MIDI
SUB 1 MAIN

EDI

In

1L 1R 2L 2R

3L 3R2L 2R
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1 2
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+ -
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3
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SEQUENCER
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RETURN
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�  To Set Up SynthSwipe
3. Select New from the File menu.

4. From the File menu, select Acquire Samples.... The Acquire / Chop Samples dialog 
appears:

 You can save and load 
Synthswipe settings as a 
template. Simply make 
your settings and click 
Save....The Templates 
dialog appears. See 
“Templates” on page 279.

5. Click the SynthSwipe... button. The SynthSwipe dialog appears.

6. Under Audio Parameters, select the analog input(s) that your instrument is 
plugged into. The displayed input selections are based on which ASIO channels are 
open when the Record Audio dialog was first opened.
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• If no inputs are listed, make sure E-MU ASIO is selected in the Preferences 
dialog, and that the current PatchMix DSP Session contains at least one ASIO 
Send.

7. Set your input levels using PatchMix DSP. While playing 
your instrument, watch your meters. Adjust the input level 
using PatchMix DSP. The signal peaks should illuminate the 
yellow area of the meter. The red bar at the very top of the 
meter indicates clipping and will stay on after clipping is 
detected. Left-click on either red bar to clear the clip 
indicator.

8. In the MIDI Parameters section, choose your MIDI output 
port and channel. The port should be whatever port you’re 
using to connect your computer to your MIDI input on 
your instrument. The channel must be whatever channel 
your instrument is currently using.

�  To set the Swipe Parameters
9. Set the Swipe parameters. The following table explains what each parameter means:

Notes

Low and High - set the range of notes that SynthSwipe will sample. To 
keep memory and disk usage low, only sample the range that you 
actually need.

Interval - sets the distance in semi tones between sampled notes. 
For example, setting the low note at C2 and the interval at 7 will 
sample C’s and G’s only (G is seven semi tones higher than C).

Velocities

Low and High - set the lowest and highest velocities SynthSwipe will 
record for each note.

Count - sets the number of different velocities at which each note will 
be played. Note: If you set the count at 1, the Low setting is grayed out 
and the High setting determines the velocity for each sample.
For example, if you set the low at 20, the high at 120, and the count at 
3, SynthSwipe would sample each note at a velocity of 20, 70, and 
120. 
You’ll probably want to select a Count value betwen 3 and 5.

Durations

Key Down - sets how long (in seconds) each note is played. 
SynthSwipe defines a region of the same length.

Key Up - sets how long (in seconds) an additional key up region will be 
recorded after the key down. This is useful if the instrument you are 
sampling has a tail that sounds after you release the key. SynthSwipe 
defines a separate region for key up and automatically utilizes this 
region when you add your newly recorded samples to a bank.

Pause - sets how long (in seconds) SynthSwipe waits between the end 
of the Key Down/Up and the beginning of the next Key Down.

Key Scale Durations - decreases the key up time as the pitch of the 
note increases. This is useful for creating a realistic effect when sampling 
an instrument that behaves this way, such as an electric piano. 
A piano’s higher notes have shorter sustain times than the lower notes. 
If you’re sampling a piano, checking this box makes the sampled 
instrument sound more realistic.
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10. To begin sampling your instrument, click the Record  button. You will hear 
the recording cycle through all the notes, one velocity at a time. Do not play your 
instrument during this time.

11. After the recording completes, if you’re satisifed with the results, click Done. If you 
want to try again, overwriting what you just recorded, click the Record button.

12. You will be prompted to save your bank. Click OK and choose a name and location 
for your new bank.

13. The Save Samples dialog appears. Choose your settings and click OK. See “Saving 
your Samples” on page 288.

Your new preset is ready to play with all the Key up, Key down, and velocities 
automatically set.

Tips for Saving SynthSwipe Recordings
• If you are swiping multiple velocities, turn Normalize off in order to preserve 

the relative volume relationships of the samples. 
• For pad-like sounds, choose Loop 1/2 + Xfade from the Auto-Loop drop-down 

menu.

Resampling
You can also sample the output of the Emulator X. Resampling allows you to include 
modulation, filters and effects in the sample, or you can record runs or chords, or a 
whole song for that matter. The basic idea of resampling is to make the EmulatorX 
output available as an ASIO input to the Record Audio dialog box. Using PatchMix 
DSP, this is a simple matter. (Resampling is also possible using other audio interfaces.)

�  To Resample the Emulator X using PatchMix DSP

1. Open EmulatorX in standalone mode (not as a VSTi), and select the preset you 
wish to resample.

2. Open PatchMix DSP by clicking on the EMU icon  in the Systray.

3. Play your MIDI keyboard and determine which input strip Emulator X is using by 
observing the peak meters. (You can right-click to add peak meters to the channels 
if there are none.)

4. Add an ASIO Send to the input channel used by the Emulator X.

5. Select Aquire Samples from the Emulator X File menu (Ctrl+Q).

6. Press the Record button from the “Acquire/Chop Samples” dialog box. The 
“Record Audio” dialog box appears.

Select 
EX Main

Monitor OFF 
(as shown)
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7. Select EX Main as the Input. If EX Main doesn’t appear, make sure you’ve loaded 
the default Emulator X template in PatchMix DSP. Make sure that the Monitor 
button is off (as shown) or you will hear annoying feedback as soon as you play 
the Emulator X.

8. Play your MIDI keyboard. You should hear it and see activity on the meters in the 
Record Audio dialog box above.

9. Press the red Record button,  then start playing.

10. Press the Stop button  when you’re finished resampling.

11. Continue to chop and process your samples. See page 284.

Importing Other Sample Formats
Emulator X can import sample formats such as Wave, AIFF, MP3, and REX 2. 
Emulator X  then automatically builds a preset for you, truncating, looping and placing 
the samples on the keyboard.

There are three ways to import samples:

• Select Import Samples from the File menu to call up the selection dialog box.

• Right-Click with the mouse over the Emulator X icon in the tree, then select 
“Import Samples” to call up the selection menu.

• Drag and Drop the sample files over the Emulator X icon in the tree.

�  To Import Samples into the Emulator X

1. When you select “Import Samples”, the following dialog box appears.

2. Locate and select the desired sample files on your computer, then press Open. The 
following dialog box appears showing the samples you just selected.

• You can audition a sample by highlighting it and clicking the button. To 
stop a sample from playing, click the button.

• If you want a sample to audition whenever you click it, check the Autoplay 
box.
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There are three groups of controls on the right side of this window.

Set Original Keys
The original key of a sample determines its pitch on the keyboard so it’s important that 
it be correctly placed. This group of controls allows you to select an automatic 
placement method for the currently selected samples.

The Set Keys button allows you to immediately process a key setting algorithm for a set 
of samples. The Original Key field in the sample area changes to show the new original 
key. You can then choose another algorithm for other samples. This allows you to try 
out the algorithms and set each sample to the proper original key before importing.

Set Original Keys Options which determine the pitch of each sample.

Sample Options Automatic sample trimming and looping options.

Build Preset Options These options determine the keyboard placement of each 
sample.

Original Key Algorithms

Embedded Info Keys are set according to key data embedded within the sample 
files themselves, if any.

File Name Keys are set by attempting to extract key names from the sample file 
names. (A#3, B2, etc.)

Pitch Detect Keys are set by algorithmically measuring the fundamental pitch of 
the sample file.

Auto Balance Keys are set by dividing the available key range equally among the 
selected sample files.

White Keys Keys are set on successive white keys beginning with the lowest key 
in the 88-key keyboard range (A-1).

Chromatic Samples will be placed within the preset on successive keys, 
beginning with the lowest key in the 88-key keyboard range (A-1).

Sort Buttons

Set Original Keys 
Options

Sample Options

Build Preset 
Options

Selected Samples

These update as 
Original Key 

options are set.
E-MU Systems 295



11 - From Sample to Preset
Importing Other Sample Formats
Sample Options
These sample options are applied to all selected samples.

The Normalize option allows you to specify how amplitude normalization should be 
applied to stereo samples.

 For additional 
information, see 
Normalize on page 187.

The Auto-Loop option allows you to choose the algorithm for setting the loop points 
of the imported samples. Auto Looping attempts to find the best loop point using auto-
correlation (See page 178). The auto-looping options are listed below.

 Warning: 
Crossfading permanently 
modifies the sample data. 
For additional 
information, see 
page 204.

Tips for using Auto Loop

Absolute Each side of the stereo sample is individually normalized without regard 
to the other channel.

Relative Each side of the stereo sample normalized by the same gain factor, so 
that the two channels maintain their relative volume.

Off No normalization processing will be performed.

Auto-loop Algorithms

Whole The loop points on each imported sample are set to enclose the 
entire sample.

1/2 The loop points on each imported sample are set to enclose the last 
half of the sample.

1/2 + Crossfade The loop points on each imported sample are set to enclose the last 
half of the sample, including an appended crossfade to the loop 
start.

1/3 The loop points enclose the last 1/3 of the sample.

1/3 + Crossfade The loop points enclose the last 1/3 of the sample, including an 
appended crossfade to the loop start.

1/4 The loop points enclose the last 1/4 of the sample.

1/4 + Crossfade The loop points enclose the last 1/4 of the sample, including an 
appended crossfade to the loop start.

1/8 The loop points enclose the last 1/8 of the sample.

1/8 + Crossfade The loop points enclose the last 1/8 of the sample, including an 
appended crossfade to the loop start.

• Use longer loops (1/2) and crossfade on harmonically complex samples such as 
piano and strings.

• Short loops work well on simpler waveforms such as brass, flutes, guitars, etc.

• Don’t choose crossfade if you plan to fine tune your sample loops later.
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Build Preset Options
These sample options allow you to specify if a new preset should be built using the 
imported samples.

When Build Preset is checked, a preset is created during import using all of the 
imported samples. Samples will be ordered within this preset identically to their 
ordering in the sample file list. The preset will be automatically named according to the 
first imported sample.

If “Build Preset” is unchecked, a preset will not be created during import, and the 
imported samples will simply be added to the instrument’s sample pool. The other 
controls in this group will be disabled (greyed-out) if “Build Preset” is unchecked.

Multisample Check Box - You have the option to build multiple voices (with one 
sample each) or a single multisample voice. See “Multisample Voices” on page 37. 
Check the checkbox to build one multisample voice.

The Placement option allows you to specify how samples will be placed in the 
constructed preset. (Note that this is a separate setting from the “Original Key” 
assignment. The former setting is a property of each sample and denotes where the 
sample may be placed so that it plays back at unity pitch. This setting relates to the 
actual per-sample assigned key range within a preset.) The Placement options are listed 
below.

The Start at options let you choose the first note for placement if you choose White 
Keys or Chromatic.

The Stretch options let you control how the samples fill in the empty spaces on the 
keyboard. If you’re only importing four samples, C1, C2, C3, and C4, you’ll probably 
want to stretch the voice range in order to fill in the missing keys. The Stretch options 
are listed below.

Sample Placement Algorithms

Original Key Samples will be placed within the preset according to their original key 
settings.

White Keys Samples will be placed within the preset on successive white keys, 
beginning with the key specified in the Start at drop-down menu.

Chromatic Samples will be placed within the preset on successive keys, 
beginning with the key specified in the Start at drop-down menu.

Up Only The assigned key range of each imported sample extends upward from 
the specified placement to the key immediately below the placement of 
the next imported sample. The key range of the last imported sample 
extends up to the highest note in the 88-key keyboard range (C7).

Voice 1 Voice 2 Voice 3 Voice 4

Sample
01

Sample
02

Sample
03

Sample
04

Up
Only
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Down Only The assigned key range of each imported sample extends downward 
from the specified placement to the key immediately above the 
placement of the previous imported sample. The key range of the first 
imported sample extends down to the lowest note in the 88-key 
keyboard range (A-1.)

Up & Down The assigned key range of each imported sample extends upward and 
downward from the specified placement, such that the available key 
range between imported samples is split evenly between them. If there 
are an uneven number of keys between placements of adjacent 
samples, the contested key will be assigned to the upper key range. 
The key range of the first imported sample shall extend down to the 
lowest note in the 88-key keyboard range (A-1), and the key range of 
the last imported sample shall extend up to the highest note in the 88-
key keyboard range (C7.)

     Off Each imported sample is only assigned to the placement key.

Voice 1 Voice 2 Voice 3 Voice 4
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Sample
04
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Voice 1 Voice 2 Voice 3
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12 - Synthesizer Basics

This chapter contains background information on the various programming aspects of 
synthesizers.

If you are new to synthesizers and electronic music, you may need more background 
information than this manual provides. There are many books dedicated to synthesizer 
basics and MIDI available through your local music dealer. Magazines such as 
Keyboard and Electronic Musician, available at most newsstands, contain current infor-
mation on the subject, as well as valuable programming tips. The internet is a also a 
rich source of information on this subject. Seek and you shall find.

Your initial involvement with Emulator X will most likely consist of using the existing 
banks and presets. While our factory banks and presets are very good, there are 
probably some things you would like to change, perhaps the LFO speed, the filter 
setting, or the attack time. Eventually, you’ll want to make your own custom presets 
using complex modulation routings.

Emulator X Advanced Applications Guide
The Emulator X Advanced Applications Guide is another valuable resource which 
contains 43 more in-depth tutorials. The Advanced Application Guide begins with the 
fundamentals and walks you through nearly every facet of this amazing instrument. 
You can find this pdf document on your Emulator X3 CD or online at: www.emu.com.

Editing Presets
It’s easy to create new presets by modifying existing presets. This is really the best way 
of getting acquainted with Emulator X. If you don't like the results, simply reload the 
preset or bank and you'll be back to the original sound. Changes are not made 
permanent until you SAVE a bank. Therefore, you can experiment all you want with 
presets, voices and samples without worrying about losing a sound.

We encourage you to actually try out the different functions as you read about them. 
Hearing what a control actually does will remove a lot of the mystery associated with it.

Emulator X contains an extensive modulation implementation using two multi-wave 
LFO’s (Low Frequency Oscillators), three envelope generators, and the ability to 
respond to multiple MIDI performance controllers. You can simultaneously route any 
combination of these control sources to multiple destinations.

Modulation
Modulation means to dynamically change a parameter, whether it be the volume 
(amplitude modulation), the pitch (frequency modulation), or whatever. Turning the 
volume control on your home stereo rapidly back and forth would be an example of 
amplitude modulation. To modulate something we need a modulation source and a 
modulation destination. The source is your hand turning the knob, and the destination 
is the volume control. If we had a device that would automatically turn the volume 
control, we would also call that device a modulation source.
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12 - Synthesizer Basics
Modulation
Turning the volume control back and forth on your home stereo is an example of Amplitude 
Modulation.

Emulator X is designed so that for each of the variable parameters, such as the volume, 
there is an initial setting which can be changed by a modulation source. Therefore in 
the case of volume, we have an initial volume and we can change or modulate that 
volume with a modulation source. Positive modulation Adds to the initial amount. 
Negative modulation Subtracts from the initial amount.

Modulation Sources
The main modulation sources are Envelope Generators, Performance Controllers and 
Low Frequency Oscillators. In the previous example, an envelope generator could be 
routed to automatically turn the volume control as programmed by the envelope, or, a 
low frequency oscillator could be routed to turn the volume control up and down in a 
repeating fashion. The main mod sources are listed below.

Keyboard Key
Which key is pressed.

Key Velocity
How fast the key is pressed.

Release Velocity
How fast the key is released.

Gate
High if the key is pressed, low when the key is released.

Key Glide
A smoothly changing control source based on the Glide Rate and the interval between 
the last two notes played.

Pitch and Mod Wheels
Keyboard pitch bend and modulation wheels.

Keyboard Pressure (mono aftertouch)
Key Pressure applied after the key is initially pressed.

Pedal
A continuously variable pedal controller connected to your MIDI keyboard.

Volume
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Modulation
Miscellaneous Controllers A-P
Any type of MIDI continuous controller data from your keyboard or other controller. 
MIDI continuous controller numbers are programmed in the Preferences dialog box 
(See page 28).

Low Frequency Oscillators (2 per voice)
Generate moving, repeating waves used to add interest and animation to the sound.

Envelope Generators (3 per voice)
Generate a programmable “contour” which changes over time when a key is pressed.

Function Generators (3 per voice)
A programmable, stepped modulation source which can be used as a complex LFO, a 
sequencer or an arpeggiator depending on how it is utilized.

Noise & Random Generators
Generate spectrums of noise and random signals to be used for modulation.

T-switch and Footswitches
Change a parameter when a MIDI switch is pressed. MIDI footswitch numbers are 
programmed in the Preferences dialog box (See page 28).

Modulation Cords
You use a Cord to connect a modulation Source to a Destination. (Patchcord – a 
holdover from the days when modules of an analog synthesizer were connected 
together with physical cords. Nowadays, we still need a way to connect modules 
together, but the cords are in software.)

You can connect the modulation sources in almost any possible way to the modulation 
destinations. You can even modulate other modulators. Each cord also has an amount 
parameter which determines “how much” modulation is applied to the destination. 
The modulation amount can be positive or negative and will either add or subtract 
from the initial value.

To use a modulation cord, you must connect a modulation Source to a modulation 
Destination. Think of modulation cords as if you are connecting an actual cord. You 
must connect both ends of the cord for the connection to be made. There are 36 
general purpose cords per voice.

Modulation
Source

LFO 1

Destination
Amount +/-

Amp
Volume

- +
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Envelope Generators
Envelope Generators
An envelope can be described as a “contour” which can be used to shape the sound in 
some way over time. There are three envelope generators per voice and all of them are 
the rate/level type.

 The EOS envelope 
generators are just like 
standard ADSR’s, except 
that they have two 
segments for each stage. 

To create a standard 
ADSR curve, set the 
“2” levels the same as the 
“1” levels and set all the 
“2” rates to 0.

This is how the rate/level envelopes work: When a key is pressed, envelope starts from 
zero and moves toward the Attack 1 Level at the Attack 1 Rate. As soon as it reaches this 
first stage, it immediately begins the Attack 2 phase and moves toward the Attack 2 
level at the Attack 2 rate. As long as the key is still held, the envelope continues on 
through the Decay 1 and Decay 2 stages. If the key is still held when the envelope 
reaches the end of Decay 2, it simply stops there waiting for you to release the key. 
When you release the key, the envelope continues through its Release 1 and Release 2 
stages, stopping at the end of the Release 2 stage. The rate/level envelopes give 
maximum flexibility to program both complex and simple envelopes.

The Amplifier Envelope generator controls the volume of the voice over time and has 6 
stages: Attack 1, Attack 2, Decay 1, Decay 2, Release 1 and Release 2. The Filter 
Envelope generator controls the filter morph and also has 6 stages. Unlike the amplifier 
envelope, however, the filter envelope has the ability to go negative as well as positive. 
There is also an Auxiliary Envelope generator which is a general purpose envelope. The 
auxiliary envelope is identical to the filter envelope and can go negative as well as 
positive. The time of each stage can be adjusted to create myriad envelope shapes, 
which in turn shape the sound over time.

 By routing the 
Auxiliary Envelope to 
control the pitch (Cords) 
you can easily hear the 
shape of the envelopes 
you are creating.

The way the volume of a sound changes over time determines how we perceive that 
sound. For example, a bell struck with a hammer is instantly at full volume, then slowly 
dies away. A bowed violin sound fades in more slowly and dies away slowly. Using the 
Amplifier Envelope, you can simulate different types of instrument volume envelopes 
by programming them appropriately.

Retriggering
The Filter and Auxiliary envelopes can be retriggered by an LFO or any other 
modulation source such as clock divisor. (See “Clock Modulation” on page 304.) 
Patch the desired modulation source (using a positive value) to Filter Env Trigger or 
Aux Env Trigger. Envelopes are triggered on a positive-going edge.

Complete Mode
In Complete mode, the envelope generator continues through all six stages when a key 
is pressed, ignoring the status of key sustain. This feature allows you to create long 
evolving soundscapes with a quick tap of the key, enveloping percussive sounds such 
as piano and drums, or plucked strings. This mode is also useful to conserve CPU 
resources, since the voice will turn off as soon as the amp envelope cycle completes.

At
k1

Atk2 D
cy1

Dcy2
Rls1

Rls2

Key
Down

Key
Released

Sustain

time

level

Holds here
until key release
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Low Frequency Oscillators (LFOs)
Low Frequency Oscillators (LFOs)
A Low Frequency Oscillator or LFO is simply a wave which repeats at a slow rate. 
Emulator has two multi-wave LFOs for each channel. The LFO waveforms are shown in 
the following illustration.

 Try combining the 
Pattern LFOs, or 
controlling the amount of 
one with another, or 
combining them with the 
clock divisors.

By examining the diagram of the LFO waveforms, you can see how the LFO will affect a 
modulation destination. Suppose we are modulating the pitch of an instrument. The 
sine wave looks smooth, and will smoothly change the pitch. The square wave changes 
abruptly, and will abruptly change the pitch from one pitch to another. The sawtooth 
wave smoothly decreases, then abruptly changes back up. The sound’s pitch will follow 
the same course. Controlling the pitch of an instrument is an easy way to hear the 
effects of the LFO waves.

Like the Auxiliary Envelope, the LFOs can be routed to control any realtime functions 
such as Pitch, Filter, Panning, or Volume. A common use for the LFO is to control the 
pitch of the sound (LFO -> Pitch). This effect is called vibrato and is an important 
performance parameter. Many presets use this routing with the modulation wheel 
controlling “how much” LFO modulation is applied. Another common effect, 
Tremolo, is created by controlling the volume of a sound with the LFO (LFO -> Amp 
Volume).

Another use for the LFOs might be to add a slight bit of animation to the sound by 
routing the LFO to control the filter. In this example, the Cord amount would be set 
low, for a subtle effect.

When the amount of an LFO is a negative value, the LFO shape will be inverted. For 
example, inverting the sawtooth wave produces a wave that smoothly increases, then 
instantly resets down. Since the inverted sawtooth wave is now negative, adding DC 
with a cord amount of +100 will make it positive again. See page 308 for information 
on how to use a DC Cord.
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Random Sources
Random Sources
Random modulation sources can be used when you want the timbre of the sound to be 
“animated” in a random or non-consistent manner.

Key Random 1 & 2 generate different random values for each voice which are selected 
at key-on time and do not change during the note.

The White & Pink Noise Generators produce varying random values. Both white and 
pink noise sources are low frequency noise designed for control purposes. Either noise 
source can be filtered even more by passing it through a lag processor.

The Crossfade Random function generates the same random value for all voices in a 
preset. This source is designed to be used for randomly crossfading voices, although 
you may find other uses.

The Function Generators have a random mode. This can be used to randomly pick 
from a set of pre-programmed values, such as the notes in a particular key.

Clock Modulation
The clock can also be used as a modulation source. It can be used to trigger the Filter or 
Auxiliary envelope generators, trigger sample start, synchronize the LFOs, or used 
directly as a square wave modulation source. Envelopes are triggered on the positive 
going edge of the clock. LFOs are triggered on the negative going edge.

 Envelopes are 
triggered on the positive 
going edge of the clock. 
LFOs are triggered on the 
negative going edge of 
the clock.

The Clock source is available in six divisions (double whole note, whole note, half 
note, quarter note, eighth note, sixteenth note). The different rates can be used 
separately or in conjunction to create complex rhythm patterns.

Using MIDI clocks, the internal clock can also be synchronized with an external MIDI 
device such as a drum machine or sequencer.

 The tempo of the 
master clock is set from 
the Multisetup page.

Clocks are routed exactly like the other modulations sources using the Cords. The Cord 
Amount MUST be positive (+) for the clock to pass. By modulating the Cord Amount, 
the divided clocks can be routed around using realtime controllers or other 
modulation sources.

Syncing an LFO to the Clock
When an LFO is triggered by a clock, the LFO wave resets to zero every time the clock 
wave goes low. To sync an LFO to the clock, patch a clock divisor to the LFO Trigger 
(Trg) in the Cords screen.

If the LFO rate is close to the clock rate, the LFO will synchronize with the clock. If the 
two rates are far apart, the waveform of the LFO will be mildly or radically altered (as 
shown by the diagram on the following page).

Inverted Sawtooth

Negative Amount

+-

Sawtooth
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Function Generators
The possibilities of clock modulation and retrigger are numerous. A repeating six 
segment curve of any shape can be created by triggering the Filter or Auxiliary Envelope 
generators with the clock. A few other possibilities are listed below.

Function Generators
The function generators are multi-function modulation sources and can be used as 
complex LFOs, sequencers, arpeggiators, or envelope generators. Each voice has three 
independent function generators. The function generator outputs a stepped (or 
smooth) sequence of values and a gate/trigger for each step.

Its most obvious function is as a step-sequencer/arpeggiator (when controlling pitch), 
or as a complex event generator for the filter or amplifier. Several key sync and 
direction modes allow you to create interesting variations and complex levels of 
control. The gate and trigger outputs can trigger envelope generators, retrigger samples 
or LFOs, accent certain notes, change tempo, and trigger other events. 

Please see “Function Generators” on page 139 for detailed information and examples 
of how to use this versatile modulation source.

• Turn different voice layers on and off using different clock divisors.

• Route the Clock through a Lag Processor to smooth the sharp edges or to create a 
global triangle LFO.

• Switch between Auxiliary and Filter Envelope retriggering using a slider or footswitch.

• Retrigger LFOs or Envelopes using noise or other LFOs to create random or semi 
random effects.

• Modulating the rate of triggered LFOs will alter the LFO waveform.

• Route multiple clocks with different divisors to the same destination (such as pitch) 
to create complex patterns. (Hint: Adjust the Cord Amounts.)

Quarter
Note

Eighth
Note

Added together in
equal amounts produces…

Quarter
Note

8th
Note

16th
Note Added together in

unequal amounts produces…
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Modulation Destinations
Modulation Destinations
The Cords section of the Preset Edit module is where you connect sources to destina-
tions. Each cord has an amount control associated with it to control how much 
modulation is applied.

The Cords screen and the diagram above show how modulation sources are connected 
to destinations. The modulation sources can control any of the destinations in the 
voice.

Note-on modulation sources, such as key, velocity and gate output a single value at 
note-on time. Realtime modulation sources such as LFOs, envelope generators and 
modulation wheels can be varied continuously.

The possible modulation routings are completely flexible as shown in the diagram 
above. Multiple sources can control the same destination, or a single source can control 
multiple destinations.
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Modulation Processors
Modulation Processors
Modulation processors are devices which can modify modulation sources such as LFOs 
and envelope generators before they are applied to a destination. The modulation 
processors allow you to create patches and do tricks which would not be possible 
otherwise. The following modulation processors are currently implemented:

SumDC

Switch
(above zero)

4x
Gain

Absolute
Value

Flip-Flopx y x y

Diode

Lag
Processor

Quantizer

# of
Steps

Size of
Steps

Summing Amp 
Allows you to add several 
modulation sources so the 
output can be controlled 
by a single Cord Amount.

Switch 
Outputs a full value (100) 
level whenever the input 
is greater than zero.  

Lag Processors
Slow down rapid changes 
in the input signal. The 
output "lags" behind the 
input. Rate is adjustable. 

Absolute Value 
Inverts negative values 
and leaves positive values 
untouched. Outputs only 
positive values.  

Diode
Blocks negative values 
and allows positive values 
to pass untouched.

Quantizer
With the input Cord set to 
100% the output is limited 
to 16 discrete steps.  

4x Gain 
This processor multiplies 
the input value by a factor 
of four. Used to amplify 
modulation sources.

Flip-Flop
Alternates between 1 and 
0 each time the input 
goes positive from a 
negative input.  

Rate
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Modulation Processors
Modulation Processor Examples
This example routes the Pink Noise generator through one of the Lag Processors in 
order to derive a smooth random function. A smooth random wave is useful in small 
amounts to add a degree of natural variation to timbre when routed to filter cutoff. 
Normal pink noise is low pass filtered audio frequency noise with a 3 dB/octave slope 
to give equal energy per octave. Our pink noise is actually more like very low frequency 
filtered (mauve?) noise, but it is perfect for use as a random control source.

The Quantizer can generate interesting whole-tone scales when envelope generators or 
LFOs are routed to the input. The quantizer turns a smoothly changing input signal 
into a series of steps. By routing the output of the quantizer to Pitch and adjusting the 
cord amounts, you can control both the number of steps and the pitch interval of each 
step.

The input cord amount limits the number of steps. A sawtooth wave (LFO+) feeding 
the input, and the cord amount set to 100% generates sixteen steps. The output cord 
amount controls the size (or interval) of the steps.

 Experiment with this 
patch by connecting 
other sources and 
destinations to the 
quantizer.

This patch generates an ascending arpeggio every time you press a key. The block 
diagram of the patch is shown below. The patch is very straightforward except for the 
DC offset which was added in to bring the pitch down into tune. (Sometimes you have 
to fix a problem, but thanks to the mod processors there's usually a way around it to 
achieve the desired result.)

You can probably start to see some of the possibilities (and there are many). Whenever 
you find yourself wishing for some esoteric type of control, take a minute and think if 
there is a way to achieve the desired result using the modulation processors.
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Dynamic Filters
Dynamic Filters
Following is a block diagram of the signal path.

Emulator X utilizes advanced Z-plane filters which can dramatically alter the sound of a 
sample.

To understand how a filter works, we need to understand what makes a sound wave. A 
sine wave is the simplest form of sound wave. Any waveform except a sine wave can be 
analyzed as a mixture of sine waves.

One way to represent complex waveforms is to use a chart with frequency on one axis 
and amplitude on the other. Each vertical line of the chart represents one sine wave at a 
specific amplitude and frequency.
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Dynamic Filters
What is a Filter? 
Most samples are complex waves containing many sine waves of various amplitudes 
and frequencies. A filter is a device which allows us to remove certain components of a 
sound depending on its frequency. For example, a Low Pass Filter lets the low 
frequencies pass and removes only the high frequencies.

A filter that lets only the high frequencies pass is called a high-pass filter.

A filter that only lets a certain band of frequencies pass is called a band-pass filter.

A Notch Filter is just the opposite of a bandpass filter and is used to eliminate a narrow 
band of frequencies.
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Dynamic Filters
Another control found on traditional filters is called Q or resonance. A lowpass filter 
with a high Q would emphasize the frequencies around the cutoff frequency. The 
following chart shows how different amounts of Q affect the low pass filter response. 
In terms of sound, frequencies around the cutoff tend to “ring” with high Q settings. If 
the filter is slowly swept back and forth, with a high Q, various overtones are “picked 
out” of the sound and amplified as the resonant peak sweeps over them. Bells and 
gongs are real world examples of sounds which have a high Q.

Another characteristic of a filter is the number of poles it contains. Traditional synthe-
sizer filters were usually either 2-pole or 4-pole filters. Emulator X has a selectable 2, 4 
or 6-pole low pass filter. The number of poles in a filter describes the steepness of its 
slope. The more poles, the steeper the filter's slope and the stronger the filtering action. 
The tone controls on your home stereo are probably one-pole or two-pole filters. 
Parametric equalizers are usually either two-pole or three-pole filters. In terms of 
vintage synthesizers, Moog and ARP synthesizers used 4-pole filters. Oberheim and 
E-mu synthesizers were famous for their 2-pole filter sound.

Using a filter, we now have a way to control the harmonic content of a sampled sound. 
As it turns out, even a simple low pass filter can simulate the response of many natural 
sounds.

For example, when a piano string is struck by its hammer, there are initially a lot of 
high frequencies present. If the same note is played softer, there will be fewer of the 
high frequencies generated by the string. We can simulate this effect by routing 
keyboard velocity to control the low pass filter. The result is expressive, natural control 
over the sound.

If an envelope generator is used to control the cutoff frequency of a filter, the frequency 
content can be varied dynamically over the course of the note. This can add animation 
to the sound as well as simulate the response of many natural instruments.
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Dynamic Filters
Parametric Filters
A more complex type of filter is called a parametric filter or Swept EQ. A parametric 
filter allows control over three basic parameters of the filter. The three parameters are: 
Frequency, Bandwidth, and Gain. The Frequency parameter allows you to select a range 
of frequencies to be boosted or cut, the Bandwidth parameter allows you to select the 
width of the range, and the Gain parameter either boosts or cuts the frequencies within 
the selected band by a specified amount. Frequencies not included in the selected band 
are left unaltered. This is different from a band pass filter which attenuates (reduces) 
frequencies outside the selected band.

Another parameter sometimes used on a parametric filter is Shelving. Shelving simply 
widens the passband so that it extends to the limit of the upper or lower frequency 
range.

The parametric filter is quite flexible. Any range of frequencies can be either amplified 
or attenuated. Several parametric sections are often cascaded in order to create complex 
filter response curves.

If four parametric filter sections were cascaded, it would be possible to create the 
following complex filter response.

Many natural instruments have complex resonances which are based on their sound-
board or tube size. The resonance shown above would be impossible to create using a 
normal synthesizer filter.

Boost

Cut

Freq.

0 dB

+18 dB

-18 dB

Bandwidth

Frequency

A
m

p
li
tu

d
e Parametric

Filter

10

Linear Frequency - Hertz

d
B

 M
a
g
n

it
u
d
e

-5

0

5

15

20

500 10,000 15,000 20,000

4 Parametric Equalizers
312 Emulator X3 Reference Manual



12 - Synthesizer Basics
Dynamic Filters
The Z-Plane Filter
A Z-plane filter is a filter which can change its function over time. In a Z-plane filter, we 
start with two complex filter types and interpolate between them using a single 
parameter. Refer to the diagram below.

Filters A and B represent two different complex filters or “frames”. By changing a single 
parameter, the Morph, many complex filter parameters can now be changed simulta-
neously. Following along the Morph axis you can see that the filter response smoothly 
interpolates between the two filters. This is the essence of the Z-plane filter. Through 
the use of interpolation, many complex parameters are condensed down into one 
manageable entity.

Consider, as an example, the human vocal tract, which is a type of complex filter or 
resonator. There are dozens of different muscles controlling the shape of the vocal 
tract. When speaking, however, we don't think of the muscles, we just remember how it 
feels to form the vowels. A vowel is really a configuration of many muscles, but we 
consider it a single object. In changing from one vowel to another, we don't need to 
consider the frequencies of the resonant peaks! You remember the shape of your 
mouth for each sound and interpolate between them. This is similar to what the 
Z-plane filter does.

This Z-plane filter sweep can be controlled by an envelope generator, an LFO, 
modulation wheels or pedals, keyboard velocity, key pressure, etc. In fact, any of the 
modulation sources can control the Z-plane filter.
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The Z-plane filter has the unique ability to change its function over time.
E-MU Systems 313



12 - Synthesizer Basics
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MIDI Channels & Real-time Controls
The MIDI real-time controllers may seem confusing at first, but they are really very 
simple once you understand them. You probably already know that there are 16 MIDI 
channels per MIDI cable. Each MIDI channel uses three basic types of messages; note 
on/off, preset changes, and continuous controller messages.Your MIDI keyboard, in 
addition to telling Emulator X which note was played, can also send aftertouch real-
time control information, which simply means control occurring in real-time or “live.” 
(You may be using a MIDI device other than a keyboard, but for simplicity's sake we'll 
presume that you are using a keyboard.) Real-time control sources include such things 
as controller knobs, pitch wheels or touchstrips, modulation wheels, control pedals 
and aftertouch. These are used to add more expression or control.

The front panel control knobs send out real-time controller information on separate 
continuous controller numbers. There is a set of 95 continuous controller numbers for 
each MIDI channel. Some continuous controllers, such as modulation wheel, volume, 
and pan have standardized numbers. For example, volume is usually sent on 
continuous controller #7. The front panel control knobs are programmed to specific 
MIDI controls.

Any MIDI controller can be routed to any modulation destination. First, you have to 
know which controller numbers your keyboard transmits. Most modern MIDI 
keyboards let you select a controller number for each control on the keyboard. For 
example, it may let you select a number from 0-31 for the data slider. The realtime 
controller numbers that the keyboard transmits must match the numbers Emulator X is 
receiving, otherwise nothing will happen when you move the controls.

Suppose you wanted to send the four data sliders on your master keyboard. Emulator X 
can handle up to 16 MIDI controllers (A-P) of your choosing. “MIDI A-P” are simply 
names for the internal connections that link external MIDI continuous controllers to 
the Cords page. There are two parts to the connection. First, MIDI controller numbers 
are assigned to the letters A-P in the Controllers dialog box. Next, the letters A-P are 
connected to synthesizer control parameters in the PatchCord section of the Preset Edit 
window. The Cord Amount scales the amount of each controller by a positive or 
negative value.

Most factory presets have the MIDI A-P controls connected to standard synthesizer 
functions (labelled in the Multisetup page). By choosing any four of the 16 standard 
functions, the four sliders on your keyboard will work the same on every preset. The 
chart on the following page shows how this might work if your keyboard transmitted 
the slider settings on MIDI controllers 21-24.

MIDI
Channel 1

Note
On/Off

Program
Change

Continuous
Controllers

MIDI
Channel 2

Note
On/Off

Program
Change

Continuous
Controllers

MIDI
Channel 3

Note
On/Off

Program
Change

Continuous
Controllers

MIDI
Channel 16

Note
On/Off

Program
Change

Continuous
Controllers
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MIDI A-P are internal connections which carry MIDI continuous controller data. Assign a MIDI 
Continuous Controller numbers to a letter A-P in the Preferences menu, then assign the same letter 
to a modulation destination in the Voice Processing window.

Control MIDI Controller # Routing Letter Standard Function

Slider 1 21 A Controls Filter Frequency

Slider 2 22 B Controls Filter Resonance

Slider 3 23 C Controls Filter Attack

Slider 4 24 D Controls Filter Decay

Cord Destinations16 Control
Knobs

Preferences
Menu

Voice Edit
Page

A

B

C

P

MIDI

Amount

+-

+-

+-

A

B

C

P

C
o
rd

C
o
rd

C
o
rd

C
o
rd

Key Sustain
Fine Pitch
Pitch
Glide
Chorus Amount
Sample Start
Sample Loop
Sample Retrigger
Filter Frequency
Filter Q
Amplifier Volume
Amplifier Pan
Amplifier Crossfade
Volume Envelope Rates
Volume Envelope Attack
Volume Envelope Decay
Volume Envelope Release
Filter Envelope Rates
Filter Envelope Attack
Filter Envelope Decay
Filter Envelope Release
Aux. Envelope Rates
Aux. Envelope Attack
Aux. Envelope Decay
Aux. Envelope Release
LFO 1 & 2 Rates
LFO 1 & 2 Trigger
Lag Processor
Summing Amp
Switch
Absolute Value
Diode
Quantizer
4x Gain
Cord 1-36 Amount

Channel Lag
Channel Lag Rate
Preset Lag In
Preset Lag Amount
Preset Ramp Rate 

Preset
Cords

0
1
2 MIDI

Controller
A

31

95

64

0
1
2 MIDI

Controller
P

31

95

64

0
1
2 MIDI

Controller
C

31

95

64

0
1
2 MIDI

Controller
B

31

95

64

+-
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EMULATOR

PRESET

SAMPLE

SEQUENCER

PAGE

LEVEL

PRESET SELECT

REAL TIME CONTROLLERS
ASSIGNABLE KEYS

ENTER EXIT

RETURN

0. 9 8 7 6 5 4 3 2 1

R L R L
IN OUT THRUOUTPUTS

MIDI
SUB 1 MAIN

(Keyboard)
MIDI Device

Controller
Knobs

Continuous controller numbers
are assigned Letters (A-P) 
& Labels (mod wheel, etc.)

Select the CC numbers
you wish to receive. 

Assign the controller letters
to Synth destinations. 

Assign the controller letters
to Preset destinations or...

Preferences

Voice Processing Cords

Preset Global Cords

or

(Options, Preferences Controllers)

Assigning MIDI Controller Knobs
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MIDI Program Change Commands
Emulator X receives MIDI Program Change commands on each of its 64 MIDI 
channels. MIDI program changes select Emulator X presets. The “Receive Program 
Changes” button must be turned on (depressed) in the Preferences dialog box in order 
to receive program changes or bank select commands.

MIDI Bank Select Commands
Emulator X accepts MIDI bank select commands using MIDI continuous controller 
numbers. Continuous Controller (CC) 0 is the MSB (most significant byte) and CC 64 
is the LSB (least significant byte). Normally you send both the MSB and LSB controllers 
to implement a bank change.

 Tip: Select “Show 
Bank and Program 
Numbers” in the toolbar 
to view program and 
bank numbers in the 
preset list. 

Bank and Program 
numbers are displayed in 
Single Preset mode 
screen.

Emulator X remembers the MSB and the LSB that were last sent (or last changed from 
the front panel). For example, if you have already set the Bank MSB to 04, you need 
only send the LSB to change banks within the bank.

The selected bank remains selected until you change it (either via MIDI or by changing 
the bank from the front panel). Standard MIDI Program Change commands select 
from 128 presets within the selected bank.

Background: Bank Select Commands
When the original MIDI specification was developed, no commercially available 
synthesizer had more than about 100 preset locations. At that time being able to select 
up to 128 presets didn’t seem like much of a limitation. So it was that the original MIDI 
specification provided for the selection of up to 128 presets.

As synthesizers came to have even more presets the MIDI specification was later 
amended to include Bank Select Commands. It was decided that Bank Select Commands 
would use Continuous Controllers 0 and 32 to allow the selection of up to 16,384 
banks of 128 presets (over two million presets).

Because Bank Selects are implemented using Continuous Controllers, the Bank Selec-
tions can be made per channel. (This is getting better and better.) For each MIDI 
channel, you can select any of 16,384 banks and then one of the 128 presets in the 
bank. Of course no synthesizer has 16,384 banks (yet), but hey, it’s nice to know it’s 
possible (for that really BIG project).

MIDI Modes
There are three MIDI modes used by Emulator X. Multi Mode is the default mode. 
Select MIDI Modes from the toolbar buttons or from the Taskbar, Options menu.

 The general term for 
“Preset” in MIDI-speak is 
“Program”. Same thing.

• Omni Mode: Voice messages are received on any and all MIDI channels and 
played on the basic channel. This mode is the lowest common denominator of 
MIDI. It is designed so that you always hear something. Also called “Mode 1”.

• Poly Mode: Voice messages are received only on one MIDI channel (the basic 
MIDI channel). Also called “Mode 3”.

• Multi Mode: Voice messages on each MIDI channel play on the preset 
assigned to that channel. Emulator X has the ability to play a different preset 
on each of 64 MIDI channels (using two MIDI ports of 16 channels each).

The Basic MIDI Channel can be identified by the red channel number in the Multi 
page. Click on any channel number to make it the basic channel.

Multi Poly Omni
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13 - Appendix

Translator Emulator X Converter
The Translator Emulator X Converter by Chicken Systems, Inc. is a special application 
that enables you to convert most popular sampler formats into the Emulator X’s .exb 
file format, for use in Emulator X. Any source media may be used, such as CD-ROM’s, 
fixed hard drives, ZipDisks, all removable media, magneto-optical drives, and all 
others. Exception: floppy media is not supported, however, see notes on possible 
workarounds.

Supported File Types
The Translator Emulator X Converter can convert the following types of files into 
Emulator X format:

• Akai S-1000/3000
• Akai MPC
• Emu EIII/ESi/Emax
• Tascam GigaStudio 1 + 2
• SoundFont
• Native Instruments Kontakt 1 + 2
• Steinberg HALion I and II

If you don’t have sounds for any of these products, you won’t need to use Translator. 
Keep the application installed in case you ever want to convert file formats.

� To Use Translator for Emulator X:

1. Install the Translator Emulator X application. This application is available from 
Chicken Systems, Inc. (www.chickensys.com) if it wasn’t included in your  E-MU 
software bundle.

2. Follow the instructions provided with the Translator application.

� IMPORTANT: You don’t have to convert Emulator IV banks, WAVE, 
AIFF Mp3 or REX files! 

1. Simply locate the desired EIV bank using the System Tab, then Open or Merge the 
bank. 

2. Drag and drop REX 2 (.rx2, Recycle Export) .wav, .aiff, or mp3 files over the 
Emulator X icon to merge them into the bank. You can also Import them using the 
File, Import Samples... menu item.

� Note about EOS Banks Saved on DOS Floppies
Some EOS banks saved onto DOS floppies may end up with their 16-bit byte-swapped, 
LSB for MSB. The samples in these banks, when loaded into Emulator X, will typically 
sound like white noise. Emulator X provides a method by which to repair the data as it 
is loaded. To do this, simply rename the bank file so that the extension reads, “.b4e”.
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Emulator X VSTi

Launching the VSTi Application
The following instructions apply to Cubase LE 4. Other host applications will have 
their own unique methods for launching a VSTi application. If you are using a host 
application other than Cubase LE, consult the documentation that came with your host 
application. Also see the Emulator X Advanced Applications Guide at: www.emu.com.

 Tip: When running 
multiple VSTis, distribute 
the CPU % among the 
VSTis. Example: If one 
VSTi does not glitch at 
60%, set the CPU% of 
two VSTis so they add up 
to 60%.

1 - Setting up Cubase LE4
Follow these instructions carefully to ensure that Cubase LE 4 runs smoothly the first 
time. Cubase LE 4 will remember these settings, so you’ll only have to do this once.

1. Open Cubase LE 4 from the Start menu. 
An ASIO multimedia driver test dialog 
box will pop up to ask if you want to run 
the ASIO test. Choose No, because you 
won’t be using the driver anyway.

2. Select New Project from the File menu.

3. Select Empty and click OK.

4. A Select Directory pop-up dialog box will 
appear. Choose a location on your hard 
disk where you want to store your audio 
files, then click OK.

5. The Cubase LE 4 Project window appears.

6. Select Device Setup… from the Devices 
menu.

7. Select VST Audio System from the left pane.
 DO NOT select the 

“ASIO Multimedia Driver” 
or the “ASIO Direct X Full 
Duplex Driver.”

8. Select the ASIO Driver. Choose your E-MU interface from the list. Choose:
E-MU ASIO (0404, 1212, 1820, 1616 Digital Audio Systems), ASIO E-MU 
0404|USB, ASIO E-MU 0202|USB, or ASIO E-MU TRACKER Pre|USB.

9. A pop up dialog box asks you if you want to keep or switch the ASIO driver. Select 
Switch.

 If you have two or 
more hard disks, it’s 
better to store audio 
files on a disk that isn’t 
running your OS.

Step 10: 
VST 

Audio
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Buffer Latency Setting

10. Click on the name of your E-MU interface that appears immediately below VST 
Audio System in the Devices pane. Refer to the following screen.

11. Click the Control Panel button. The 
pop-up dialog box shown at right 
appears.

12. Set the ASIO Buffer Latency as low as 
your computer will allow and click OK.
(10ms is a good starting point.)
A low latency setting is important to 
assure fast response when using virtual 
instruments and to minimize delay when 
monitoring through Cubase. If you hear 
crackles or other audio problems, try 
increasing the Buffer Size.

13. Close the Device Setup screen by clicking OK.

Setting up a New Project

14. Select New Project from File menu in Cubase LE 4. A pop-up Template selection 
dialog box appears. Select Empty, then click OK.

15. Another pop-up dialog box appears asking you to select the directory in which your 
audio files will be stored. Choose a location to store your audio files and click OK.

 If the Cubase LE 4 
application crashes for 
any reason, it is 
recommended that you 
re-boot the computer.

16. Select Project Setup (Shift +S) from the Project 
menu. This is where you set the Sample Rate and 
Record Format (bit depth), among other things. 
Set the Record Format to 24 Bit and the Sample 
Rate to 44.100 kHz.

Optional - Add Additional Input Busses
If you are using an audio interface that has more 
than two inputs (0404 USB, 0404, 1212, 1616, 
1820), the following instructions will allow you to 
select these extra inputs to feed your audio tracks.

17. Select VST Connections (F4) from the Devices 
menu.

Step 11 
Control 
Panel

Step 10
VST 

Audio

 E-MU 0202 Control 
Panel is shown at left. The 
Bit Depth field does not 
appear with 0404PCI, 
1212, 1820 or 1616.
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 You can also Rename 
your Input Busses here to 
avoid confusion when 
assigning Inputs to tracks.

18. Select the Inputs Tab, revealing the window shown above.

19. Click the Add Bus button. The pop-up dialog 
box shown at right appears.

20. Select the number of mono or stereo input 
busses you want, then click OK.

21. Additional mono or stereo busses appear in the 
list. Note that the actual PatchMix input label 
appears in the Device Port field.

22. Close the window by clicking the close 
box. The inputs you added will now be available for selection in the Track Input 
field of the Inspector pane.

2- Recording a MIDI Track using Emulator X3
 Emulator X3 can also 

run as a standalone 
application.

You’ll need a MIDI interface and a MIDI keyboard (or other MIDI input device) for 
this tutorial. 

Make the Connections

1. Connect the MIDI out of your MIDI keyboard to the MIDI input of your MIDI 
interface.

2. From the Project menu, select Add Track, Instrument.

Step 
18

Step 
19

PatchMix Inputs
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  Selecting a Count of 
2 or more, instantiates 
multiple copies of 
Emulator X3, which 
results in very inefficient 
usage of your CPU. (See 
the note on page 325.)

3. A pop-up dialog box appears asking you to select a VST Instrument. Select 
Emulator X3. Select a Count of 1. Click OK.

After a short delay, the Cubase Project Window should now look more or less like 
the one below with one Instrument track:

Open VX & Load a Bank

4. Since Emulator X3 uses samples as the basis of 
its sound, you need to load a bank of samples 
before it can be played. The Edit Instrument 
button, located in the Inspector section of the 
window, allows you to edit the virtual 
instrument.

Instrument 
Track

Th
e 

In
sp

ec
to

r

Edit Instrument Button
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5. Click the Edit Instrument button. The Emulator X3 main window appears.

6. Now we can load the Proteus X Composer bank. Select Proteus X Composer from 
the File menu. The bank is installed here: “Program Files\Creative Professional\E-
MU Sound Central\Proteus X Composer.” Loading takes a few seconds.

7. Change the Preset using the Inc/Dec keys. You also have to select a preset before 
you can hear anything. There are 1024 different presets (sounds) in this huge bank.

8. Bring up the mini keyboard by clicking the icon on Emulator X3 and play a few 
notes. You should be hearing sound.

 Increase the 
headroom setting (more 
positive) to increase the 
volume and decrease the 
amount of available 
headroom.

• If the sound volume is very low, you can decrease the Headroom of Emulator 
X3. (Options, Preferences, Headroom/Boost) Keep in mind that with less 
headroom, the Emulator X3 will be more prone to clipping when multiple 
channels are played.

9. Play your MIDI controller and verify that it plays Emulator X3. If not, check to 
make sure your MIDI keyboard is set to the same MIDI channel number as 
Emulator X3 (probably channel 1).

10. Try out the MIDI Controller knobs on your MIDI keyboard. In order for these to 
work, the continuous controller numbers of your keyboard knobs must match 
those on Emulator X3. (Options, Preferences, Controllers tab).

11. Feel free to play around for awhile and don’t worry about losing anything. Nothing 
is made permanent until you Save the bank, so have fun.

MIDI Channel SelectionPreset Inc/Dec Keys

MIDI Channel
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To Record a MIDI Track

12. Make sure the Record Enable button on the MIDI track is on (it should be on by 
default).

13. Click Record on the Cubase LE Transport control and start playing your MIDI 
controller.

14. Press Stop when you’re finished recording the first track.

15. Press the Go To Start button. 

16. Press Play  on the Cubase Transport to play back your track.

To Record a MIDI Track on another MIDI Channel

NOTE: Emulator X3 VSTi can play back up to 16 MIDI tracks at once, however, the LE 
version of Cubase 4 only supports a single MIDI channel per VSTi. You could load 
another instance of the Emulator X3 for each channel, but this is a very inefficient 
usage of your CPU resources and is NOT recommended. The full version of Cubase 4 
does support multiple MIDI channels on a single VSTi.

Program Changes
Cubase LE 4 allows you to insert MIDI Program Change messages in the MIDI 
sequence. (Key Editor, List Editor, Insert Program Change) This trick makes it possible 
to use more than one Emulator X3 preset in a song.

On Your Own
Cubase LE 4 and Emulator X3 include excellent documentation and help files. Don’t 
overlook the Emulator X Advanced Application Guide, (located at www.emu.com) 
which contains 43 in-depth tutorials on all aspects of the Emulator X. Take the time to 
learn all the features of these powerful programs so you can expand your musical 
boundaries.

Multisetup is Saved in the Recording Application
The current Multisetup is automatically saved when you save your song in your 
recording application such as Cubase or Sonar. 

Simply set up the Multisetup the way you want it, or select one from the Tree, then save 
your song. The Multisetup will be saved along with your song.

Record Enable

Record
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Checklist for Launching Emulator X VSTi

Cubase LE
Choose the following settings in the Options menu.

• Options, Audio Setup, System

Audio I/O..........................................E-MU ASIO or E-MU USB 

• Options, MIDI Setup, System
MIDI Input .....................................Select the MIDI port your KYBD is using

If you’re using PatchMix DSP...
Make sure you have an ASIO 1 & 2 input strip in the mixer.
326 Emulator X3 Reference Manual



13 - Appendix
Keyboard Shortcuts
Keyboard Shortcuts

File Menu
New....................................................  Ctrl + N

Open ..................................................  Ctrl + O

Merge .................................................  Ctrl + M

Save .....................................................  Ctrl + S

Acquire Samples ..................................  Ctrl + Q

Edit Menu
Undo....................................................  Ctrl + Z

Redo ....................................................  Ctrl + Y

Cut.......................................................  Ctrl + X

Cut........................................................ Ctrl + X

Copy .....................................................Ctrl + C

Paste .....................................................Ctrl + V

Duplicate.............................................. Ctrl + U

Delete ........................................................  Del

Select All...............................................  Ctrl + A

Sample Edit Menu
Select Loop...........................................  Ctrl + L

Select All...............................................  Ctrl + A

External Edit .........................................  Ctrl + E

Beat Analysis ......................................... Ctrl + B

Shift Beats Right ................................  Shift + 

Shift Beats Left ..................................  Shift + 

Transport Menu
Play from Cursor .....................................  Space

Play from Start ...............................  Ctrl + Space

Go To Start .............................................  Home

Go To End .................................................  End

Go To Loop Start............................ Ctrl + Home

Go To Loop End ...............................  Ctrl + End

Go To Beginning of Selection..........................  [

Go To End of Selection..................................... ]

Tree
Expand Folder or Node ....................... Ctrl + 

Collapse Folder or Node ...................... Ctrl + 

Move Up Through Items ...............................  

Move Down Through Items ..........................  

Zoom
Zoom In .............................................  Page Up

Zoom Out .....................................  Page Down

Zoom In Vertically ......................  Ctrl + Page Up

Zoom Out Vertically ..............  Ctrl + Page Down

Zoom to Selection......................................  F10

Zoom to All................................................  F11

Zoom to Sample ........................................  F12

Sample Loop Menu
Make Loop From Selection ...........Ctrl + Shift + L

Duplicate Loop ...........................Ctrl + Shift + D

Move Start To Previous Zero ..........  Left Ctrl + 

Move Start To Next Zero................  Left Ctrl + 

Move End To Previous Zero ......... Right Ctrl + 

Move End To Next Zero .............. Right Ctrl + 

Autocorrelate Loop ...............................  Ctrl + K

Options
All Sound Off .................................. Ctrl + Pause

Window
Close .................................................... Alt + F4

Presets
New Preset ...........................................Ctrl + W

Open Voices ....................................Ctrl + Enter

Open Sample...................................  Alt + Enter

New Voice............................................Ctrl + W

New Sample Zone ................................. Alt + W

Links
New Link..............................................Ctrl + W

View
Refresh ........................................................  F5

Keyboard...................................................... F9

Knobs, Sliders, and Wheels
(Place the cursor over the knob, slider or wheel)

Center Control (Pan, etc.)..................  Alt + Click
(Number key 5 also centers control when Num 
Lock is off)

Minimum Setting ....................................  Home

Maximum Setting.......................................  End
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Drag & Drop
You can use simple “Drag & Drop” operations for many Emulator X functions.

Drag & Drop Operations

From Drag & Drop To… Action

Bank File in Windows Emulator X Icon Load or Merge Bank

Bank File in Windows Emu-X System Folder Copy Move Bank

Audio File in Windows Instrument Import

Audio File in Windows Samples Folder Import

Audio File in Windows Keyboard Key in Voices 
and Zones window

Import

Audio File in Windows Keyboard Display in 
Emulator X

Import to New Voice Mapped 
to Key

Audio File in Windows Samples folder in the 
Tree.

Import

Emulator X Bank File Emulator X Icon Load/Merge

Emulator X Bank File Folder in Windows Copy/Move

Emulator X Bank File Emu-X System Folder Copy/Move

Emulator X Bank Preset Emulator X Icon Merge

Emulator X Bank Preset Presets Folder Merge

Emulator X Bank Preset Multisetup Slot Merge & place

Emulator X Bank Preset Emu-X System Folder Export as Bank

Emulator X Bank Preset Link Merge & Replace Link

Emulator X Bank Preset Link (null space) Merge & Add Link

Emulator X Bank Sample Samples Folder Import

Emulator X Bank Sample Preset Voice Merge & add to Voice

Emulator X Bank Sample Emu-X System Folder Export as Bank/Wave/AIFF

Emulator X Bank Sample Preset Zone Replace Zone

Emulator X Bank Sample Preset Voice (null 
space)

Add Voice

Emulator X Bank Multisetup Emulator X Icon Merge

Emulator X Bank Multisetup Multisetup Folder Merge

Preset Multisetup Preset Slot Place

Preset Emu-X System Folder Export as Bank

Preset Link Replace Link
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Preset Link (null space) Add Link

Sample Preset Voice Add Zone to Voice

Sample Preset Voice (null 
space)

Add Voice

Sample Preset Zone Replace Zone

Sample Emu-X System Folder Export as Bank/Wave/AIFF

Sample Keyboard Key in Voices 
and Zones window

Add Voice

Multisetup Instrument Load

Instrument Multisetup Folder Save

Instrument Multisetup Replace

E4 Bank File Instrument Load/Merge

E4 Bank File Emu-X System Folder Copy/Move

E4 Bank Preset Instrument Merge

E4 Bank Preset Presets Folder Merge

E4 Bank Preset Multisetup Preset Slot Merge & Place

E4 Bank Preset Folder in Windows Load/Merge

E4 Bank Preset Emu-X System Folder Export as Bank

E4 Bank Preset Link Merge & Replace Link

E4 Bank Preset Link (null space) Merge & Add Link

E4 Bank Sample Instrument Merge

E4 Bank Sample Samples Folder Merge

E4 Bank Sample Emu-X System Folder Export as Bank/Wave/AIFF

E4 Bank Sample Preset Zone Replace Zone

E4 Bank Sample Preset Voice 
(null space)

Add Voice

E4 Bank Multisetup Instrument Merge

E4 Bank Multisetup Multisetup Folder Merge

E4 Bank File (CD) Instrument Load/Move

E4 Bank File (CD) Emu-X System Folder Copy/Move

Drag & Drop Operations

From Drag & Drop To… Action
E-MU Systems 329



13 - Appendix
Drag & Drop
E4 Bank Preset (CD) Instrument Merge

E4 Bank Preset (CD) Presets Folder Merge

E4 Bank Preset (CD) Multisetup Preset Slot Merge & Place

E4 Bank Preset (CD) Emu-X System Folder Export

E4 Bank Preset (CD) Link Merge & Replace Link

E4 Bank Preset (CD) Link (null space) Merge & Add Link

E4 Bank Sample (CD) Instrument Merge

E4 Bank Sample (CD) Samples Folder Merge

E4 Bank Sample (CD) Preset Voice Merge & Add to Voice

E4 Bank Sample (CD) Emu-X System Folder Export as Bank/Wave/AIFF

E4 Bank Multisetup Instrument Merge

E4 Bank Multisetup Multisetup Folder Merge

Drag & Drop Operations

From Drag & Drop To… Action
330 Emulator X3 Reference Manual



13 - Appendix
Toolbar Functions
Toolbar Functions

Standard
Back

Forward

New Bank

Open Bank

Save Bank

Cut

Copy
Undo

Redo
Up

Status Bar

CPU Usage

Basic
MIDI Channel

Preset Name
& Number

Number of
Samples Playing

Samples In RAM
Current Voice
& KYBD Range

Fade

Normalize

Adjust
Gain

Reverse

Loop
Processing

Truncate DC
Filter

Swap
Channels

Bit
Reduction

Time
Compress

Pitch Shift

Mono to 
Stereo

Sample
Rate Convert

Auto-
correlate

Select 
Loop

Select 
All

Sample Edit

Horizontal 
Zoom In

Horizontal 
Zoom Out

Vertical 
Zoom In

Zoom to All

Zoom to 
Selection

Vertical 
Zoom Out

Disk Usage

Multi
Mode

Poly
Mode

Omni
Mode

MIDI Mode

MIDI 
Audition

Transform 
Multiply

No 
Snap

Snap to 
Zero 

Crossings

Snap to 
Marker

External 
Edit

Stereo to 
Mono

Beat 
Analysis

Zoom to 
Sample

Preset 
Globals

Voices 
& Zones

LInks

Voice 
Processing

Extract

Show Name 
Only

Show Object 
Number

Show Bank 
& Prog No.

Large Icons

Small Icons

List View

Details
Help

Keyboard

Sample Zoom 

Show Loops

Show
Notes

Percent

Show Grid

Auto-Scroll

Bars & Beats

Show Beats

Show
Zero-Crossing 

Threshold Seconds
dB

Samples Decimal

Sample View 

Paste

Play from 
Cursor

Play from 
Start

Stop

Go to 
End

Go to 
Start

Loop 
Play

Go to 
Loop Start

Sample Transport

Go to 
Loop End

Go to 
Selection 

End

Go to 
Selection 

End
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MIDI Key Number to Note Chart

0 1 2 3 4 5 6 7 8 9

1’s C-2 C#-2 D-2 D#-2 E-2 F-2 F#-2 G-2 G#-2

10’s A-2 A#-2 B-2 C-1 C#-1 D-1 D#-1 E-1 F-1 F#-1

20’s G-1 G#-1 A-1 A#-1 B-1 C-0 C#0 D0 D#0 E0

30’s F0 G0 G#0 A0 A#0 B0 C1 C#1 D1 D#1

40’s E1 F1 F#1 G1 G#1 A1 A#1 B1 C2 C#2

50’s D2 D#2 E2 F2 F#2 G2 G#2 A2 A#2 B2

60’s C3 C#3 D3 D#3 E3 F3 F#3 G3 G#3 A3

70’s A#3 B3 C4 C#4 D4 D#4 E4 F4 F#4 G4

80’s G#4 A4 A#4 B4 C5 C#5 D5 D#5 E5 F5

90’s F#5 G5 G#5 A5 A#5 B5 C6 C#6 D6 D#6

100’s E6 F6 F#6 G6 G#6 A6 A#6 B6 C7 C#7

110’s D7 D#7 E7 F7 F#7 G7 G#7 A7 A#7 B7

120’s C8 C#8 D8 D#8 E8 F8 F#8 G8
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Frequency Range of Common Instruments

500 1000 2000 4000 8000 16k2501256231Hz

Piano

Violin

Flute

Trombone

Trumpet

Hi-Hat/Cymbals

Bass Guitar

Female Vocal

Male Vocal

Guitar

Fundamental

Kick Drum

Snare Drum

Harmonics Attack Transients

 E4/E3 Library CDs use 
a proprietary format and 
can only be read using 
SCSI/ATAPI drives.
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MIDI Implementation Chart
MIDI Information Transmitted Recognized Remarks

MIDI Channels No 1-16, 17-32, 
33-48, 49-64

64 MIDI Channels on 4 MIDI 
ports

Note Numbers No 0-127

Program Change No 0-127

Bank Select Response? No Yes MSB + LSB

Modes: Omni (Mode 1)
            Mono (Mode 2)
            Poly (Mode 3)
            Mode 4 (Y/N)
            Multi (Mode 5)

No
No
No
No
No

No
No
No
No
No

Responds to all MIDI 
channels

Note On Velocity No Yes

Note Off Velocity No Yes

Channel Aftertouch No Yes

Poly (Key) Aftertouch No No

Pitch Bend No Yes

Active Sensing No No

System Reset No No

Tune Request No No

System Exclusive
Sample Dump Standard
File Dump
MIDI Tuning
Master Volume
Master Balance
Notation Information
Turn GM1 System On
Turn GM2 System On
Turn GM1 System Off
Other (See Remarks)

No
No
No
No
No
No
No
No
No
No
No

No
No
No
No
Yes
No
No
No
No
No
No

NRPNs No No

RPN 00 (Pitch Bend Sensi.)
RPN 01 (Chan. Fine Tune)
RPN 02 (Chan Coar. Tune)
RPN 03 (Tuning Prog Sel.)
RPN 04 (Tuning Bank Sel.)
RPN 05 (Mod Depth Rang)

No
No
No
No
No
No

No
No
No
No
No
No

MIDI Timing & Sync No No

MIDI Clock Yes Yes

Song Position Pointer No No

Song Select No No

Start
Continue
Stop

No
No
No

No
No
No

MIDI Time Code No No

MIDI Machine Control No No

MIDI Show Control No No

General MIDI Compat?
Is GM default mode?

No
No

No
No

DLS compatible?
Import DLS Files?
Export DLS Files?

No
No
No

No
No
No

Import Std MIDI files
Export Std MIDI files

No
No

No
No
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MIDI Implementation Chart (part 2 - Controllers)

Control # Function Transmitted Recognized Remarks

0 Bank Select MSB No Yes See Note

1 Mod Wheel MSB No Yes *

2 Breath Cntl MSB No No *

3 No * 

4 Foot Cntl MSB No No * 

5 Portamento MSB No No * 

6 Data Entry MSB No No * 

7 Chan Volume MSB No Yes *

8 Balance MSB No No *

9 *

10 Pan MSB No Yes *

11 Expression MSB No Yes *

12 Effect Cntl 1 MSB No No *

13 Effect Cntl 2 MSB No No *

14 *

15 *

16 GenPur Ctrl 1 MSB *

17 GenPur Ctrl 2 MSB *

18 GenPur Ctrl 3 MSB *

19 GenPur Ctrl 4 MSB *

20 *

21 *

22 *

23 * 

24 *

25 * 

26 * 

27 *

28 *

29 *

30 *

31 *

32 Bank Select LSB *

33 Mod Wheel LSB *

34 Breath Cntl LSB *

35 *

36 Foot Cntrlr LSB *

37 Portamento LSB *
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38 Data Entry LSB *

39 Chan Volume LSB *

40 Balance LSB *

41 *

42 Pan LSB *

43 Expression LSB *

44 Effect Cntl 1 LSB *

45 Effect Cntl 2 LSB *

46 *

47 *

48 Gen Pur Ctrl 1 LSB *

49 Gen Pur Ctrl 2 LSB *

50 Gen Pur Ctrl 3 LSB *

51 Gen Pur Ctrl 4 LSB *

52 *

53 *

54 *

55 *

56 *

57 *

58 *

59 *

60 *

61 * 

62 *

63 *

64 Sustain Pedal No Yes *

65 Portamento on/off No No *

66 Sostenuto No No *

67 Soft Pedal *

68 Legato Footswitch *

69 Hold 2 *

70 Variation *

71 Timbre/Har Inten Yes Yes *

72 Release Time Yes *

73 Attack Time Yes *

74 Brightness Yes *

75 Sound Control 6 Yes Yes * 

76 Sound Control 7 *

MIDI Implementation Chart (part 2 - Controllers)

Control # Function Transmitted Recognized Remarks
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77 Sound Control 8 Yes Yes * 

78 Sound Control 9 Yes Yes *

79 Sound Control 10 Yes Yes *

80 Gen Purp Control 5 Yes Yes *

81 Gen Purp Control 6 *

82 Gen Pur Control 7 Yes Yes * 

83 Gen Pur Control 8 Yes Yes *

84 Portamento Cntrl *

85      *

86 *

87 *

88 *

89 *

90 *

91 Effects 1 Depth Yes *

92 Effects 2 Depth *

93 Effects 3 Depth Yes *

94 Effects 4 Depth *

95 Effects 5 Depth *

96 Data Increment

97 Data Decrement

98 NRPN (LSB)

99 NRPN (MSB)

100 RPN (LSB)

101 RPN (MSB)

102

103

104

105

106

107

108

109

110

111

112

113

114

115

MIDI Implementation Chart (part 2 - Controllers)

Control # Function Transmitted Recognized Remarks
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116

117

118

119

120 All Sound Off No Yes  See note �

121 Reset All Controllers No Yes

122 Local Cntrl on/off No No

123 All Notes Off No Yes

124 Omni Mode Off No No

125 Omni Mode On No No

126 Poly Mode Off No No

127 Poly Mode On No No Poly mode is 
always on.

NOTES:     * Emulator X can receive ANY continuous controller number from 1 to 
95. Because of Emulator X’s powerful synth engine, many of the standard 
MIDI controllers can be user programmed to provide the desired function. 
A “Yes” response in this chart means that a controller is programmed by 
default in Emulator X.

 �  Terminates all sound from the synthesizer and clears the effect processors of all 
sound data. The All Sound Off command is automatically initiated when the sequencer 
transport Stop is pressed. It can also be manually invoked from the Options menu or by 
pressing Ctrl+Pause on the computer keyboard. 
                        Other: Pan: -64 = hard left, +63 = hard right 

MIDI Implementation Chart (part 2 - Controllers)

Control # Function Transmitted Recognized Remarks
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Received Channel Commands
Channels number (n) = 0-15. Message bytes are represented in hex. All other numbers 
are decimal. Running Status is supported.

Special Notes:

Command Message Comments

Note Off 8n kk vv

Note On 9n kk vv velocity 0 = note off

Key Aftertouch An kk vv kk = 0-127  vv = 0-127

Program Change Cn vv 0-127

Channel Aftertouch Dn vv 0-127

Pitch Bend En ll  mm l = lsb, m = msb

Real-time Controller Bn cc vv cc = 00-31, 64-95

Footswitch Bn cc vv cc = 64-79, vv Š 64 = on

Volume Bn 07 vv 0-127

Pan Bn 0A vv 0=left, 127=right, 64=center

All Sound Off Bn 78 00 turns all sound off

Reset All Controllers Bn 79 00 ignored in omni mode

All Notes Off Bn 7B 00 ignored in omni mode

Omni Mode Off* Bn 7C 00 forces all notes & controls off

Omni Mode On* Bn 7D 00 forces all notes & controls off

Mono Mode On (Poly Off)* Bn 7E 00 forces all notes & controls off

Poly Mode On (Mono Off)* Bn 7F 00 forces all notes & controls off

Bank Select MSB Bn 00 bb bb = bank MSB  Go There!

Bank Select LSB Bn 20 bb bb = bank LSB  Go There!

• From Omni Mode Omni Off turns Poly On.

• From Poly Mode Omni On turns Omni On; Mono On turns Mono On.

• From Mono Mode Mono Off turns Poly On; Omni On turns Omni On.

• From Multi Mode
Omni On turns Omni On; Omni Off or Mono Off turns Poly 
On; Mono On turns Mono On.

All other changes have no effect
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Optimizing Your Computer for Emulator X
The following suggestions can help you configure your Windows machine for optimal 
performance. Since systems vary, we recommend that you note the original settings of 
any system parameters you alter so that you can restore them in the event that 
unexpected problems occur as you seek to optimize your system for Emulator X:

• Seriously consider dedicating a computer as your audio workstation. This 
computer can be optimized for best audio performance.

• If possible, avoid assigning slower devices to the IDE or serial ATA controller 
used by your audio drive.

• Get the fastest hard disk drive you can afford, as this is the single most important 
component affecting Emulator X performance. Many drives now offer 8 or 16 
MB data buffers, which can also improve performance. 

• Defragment your hard drive often.

• Perform a “clean” install of your operating system with only the minimum 
components and programs installed. 

• Use System Restore or other restoration program such as “Ghost® to keep your 
system uncluttered and fast. 

SCSI and IDE Drive Tips and Considerations
 E4/E3 CDs use a 

proprietary format and 
can only be read using 
SCSI/ATAPI drives.

When considering the purchase of a new hard disk drive for use with Emulator X, make 
sure that the new drive supports a sustained data transfer rate of at least 2 megabytes 
per second. While it is impossible to reliably calculate the needs of your computer's 
operating system — which must be considered in addition to Emulator X’s require-
ments — you can get an approximate idea of the necessary speed of your hard disk 
drive based on the bit depth and number of voices you need.

• Regularly check your hard drive for fragmentation and de-fragment the drive 
when necessary. Your drive will operate most efficiently when it’s not 
fragmented.

• If possible, use a two-drive system: one for audio, one for your system.

Data Transfer Rate Chart

16 bits 44.1 k sample rate 86.2 k per Channel per second

48 k sample rate 93.8 k per Channel per second

24 bits 44.1 k sample rate 138 k per Channel per second

48 k sample rate 150 k per Channel per second
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Index

Symbols
~, +, - modulation source polarity  160

Numerics
1-Band Para EQ  254
22-Tone Tuning  83
24-Tone Tuning  83
2nd Stage Gain  267
36-Tone Tuning  83
4-Band EQ  255
4x Gain  307

A
Absolute Value  307
Acquire Samples  281
Activate, software  19
Add  97

a sample to a voice  60,  97
a voice and sample  98
preset  327

Add Input Busses, to Cubase LE  321
Add Track, Cubase LE  322
Adjust Gain, sample  187
ADSR Envelopes  133
Advanced Applications Guide  65,  299
Advanced Preference Settings  25
Aftertouch, Mono  300
AIFF, import  171
Akai, converting files to Emulator X  319
al-Farabi 12, tuning  83
All Sound Off  278,  327

MIDI command  338
Alternate Tunings  83
Amount, patchcord  314
Amp Envelope Depth  154
Amplifier

controls  154
envelope tutorial  63
pan  154
volume  154

Analog Oscillator Sound  130
Analyzing Beats  209

Architecture, description  35
Arpeggiator, using function generator as  140
ASIO

audio drivers  23
inputs for sampling  282
outputs  236

ASIO Buffer Latency  321
Assign Group, voice  164
Audio Setup  23
Audition

audio file from the import browser  171
MIDI  185
preset or sample from library  67
presets  45,  47
sample from disk  65
under Vista  171

Auto Balance, sample placement  295
Autocorrelate Loop  178
Auto-Loop  296
Auto-Normalize  296
Aux FX  231

adding  232
bus routing diagram  75
enable/disable  233
select  240
send amounts  240
view buttons  73

Aux Output  75
enable/disable  155,  237
on/off  237
select  237

Aux Sends 1-3  155
on/off  73

B
Backward

playing samples  189
region play mode  97

Band-Pass Filter  146,  310
Bank

& preset display  69
create new from current multisetup  78
create new using librarian  67
description  32
structure  57

Bank Select, MIDI  317
Bar/Beat  212
Basic MIDI Channel, definition  317
Batch Processing  202
Beats

analysis  209
button  116
marker  212
marker view  117
parameters  213
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C

per bar changes  214
shifting right or left  213
synchronizing  222
tempo granularity  214

Bias, tube effect  266
Bit Depth  321

setting in Cubase LE  321
Bit Reduction  190
Body Size, filter  145
BPM

envelopes  134
function generator  141
LFOs  137

Brownian, function generator mode  142
Buffer Latency Setting, Cubase LE  321
Buffer Size  24
Buffers, sample  23
Build Preset Options  297
Bypass Effects  240

C
Capture MIDI Controllers  82
Catalog Disks  66
Category

preset  43,  71
CC Window

keyboard  109
link  126

Channel Lag Processors  85
Channel Ramp Processor  86
Channel Swap  189
Channel Sync, function generator  141
Chicken Systems, Translator  319
Chorus

effect  246
voice  130

Chromatic, sample placement  295
Classic Response, volume  154
Clear Clip Indicators After 10 Seconds  29
Clear Library  66
Clipping

headroom  24
preventing  74

Clipping, Proteus VX  324
Clock

divisors  305
external MIDI  134,  137
master  74
modulation  304

Coarse Tune/Transpose Differences  129
Coarse Tuning, voice  129
Codec, to audition  65,  171
Comb Filter  146,  256
Combine Voices  120
Complete, envelope generator mode  134,  302
Compression

sample time  190
tube effect  266

Conserving Polyphony  165
using envelope complete mode  134,  302

Constant Time, pitch change  192
Context Sensitive Menus  278
Continuous Controller  314

changing loops using  219
cross-switch between voices  108

Control Panel, E-MU  321
Controller Knobs, MIDI keyboard  324
Controllers

#7  27
initial values  81
MIDI  314
MIDI #7  314
MIDI real-time  314
MIDI setup  28
modify the sound using  45
modulate FX using  242
modulation source  301
sensitivity  27

Convert
24-bit to 16-bit  190
other files to Emulator X format  319
other files to Proteus X format  319
sample rate  195
stereo to mono  194

Convolution  193
Copy and Paste, multiple samples &presets  276
Copy Section  180
Cords  306

amount chart  158
lore  161
modulation  301
preset  87
voice modulation  156

Cords, connecting  63
CPU Cap  24
CPU Meter  77
Crossfade

positional  101
random  304
random cycle group  113
using cycle groups  113
xtractor setting  198

Crossfade Looping  204
how to use  208

Cubase LE
project window  320
setting up  320

Current Channel Indicator  77
Current Preset, changing  45
Curve

glide  131
velocity  27
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D

Cut Section  180
Cut/Copy/Paste  274

multiple samples  184
sample  179
synth settings  274
voices  274

Cycle Groups  111

D
Damping, high frequency  243
DC Filter, sample  188
DC Offset  157

example  144,  308
Decay Time, reverb  243
Delay

LFO  136
voice  131

Delete
folder  242
multisetup  79
region  286
sample  179
sample zone  121
unused samples  206
voices  120

Destinations, Modulation  306
Details Page  119
Devices Menu, Cubase LE  320
Diffusion, reverb  243
Diode, modulation processor  307
Direction  97

function generator  142
region loop  97

DirectSound  23
Distortion

tube effect  266
twin effect  267

Divisors, clock  305
Drag & Drop  270

operations list  328
Duplicate, sample zone  121
Dynamic Range Adjust  24

E
Early Reflections Reverb, effect  244
Early Reflections, description  243
Early Reflections, effect  254
Echo, creating  250
Edit Menu, keyboard shortcuts  327
Effect Types

1-band para EQ  254
4-band EQ  255
chorus  246
compressor  248
early reflections  254

early reflections reverb  244
flanger  256
growl  258
limiter  259
mono delays  250
phase shifter  260
pitch shifter  261
reverb  244
reverb lite  245
ring modulator  262
SP12-ulator  263
tremulator bpm  264
tube  266
twin  267

Effects
block diagram  235
bypass  240
creating robot voice  250
descriptions  243
enable/disable  237
list of  243
post FX sends  241
preset, adding  233
selecting preset  73
sends  75
typical usage  236
voice controlled amount  239

EIII/EIV, converting files to Emulator X  319
Eliminate Audio from a Mix  196
Embedded Info  295
Emulator IV banks, loading  41,  319
End Step, function generator  141
Envelope Follower, ring modulator  262
Envelope Generators  301

description  132,  302
mode

complete  134
repeating  133

rates, scaling time of  134,  159
retriggering  302

Envelope, ADSR programming  133
Envelope, reverberation  243
EOS, banks loaded from floppy disk  319
Equal Power Mix, paste sample  182
Equal Power, crossfade loop  204
Equal Temperment Tuning  83
Expand Tree Items When Selected  29
Expand Voice  121
Export

bank  328,  329
multisetup as new bank  78
sample  57,  171
sample, batch process  202
tempo map  171,  172

Expression, MIDI  157
External Audio Editor  30
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F

External MIDI Clock  27,  74
External Tempo Source  27,  74
Extractor  196

F
Fade

bars in voices and zones windows  100
sample  186

Figure Eight, reverb pattern  244,  245
File Menu, keyboard shortcuts  327
Filter  310

bandpass  146,  310
comb  146
cost on voice count  23
descriptions  145
FX

1-band para eq  254
4-band eq  255

global type  77
morph designer  149
notch  310
parametric  312
poles  311
swept EQ  312
types  310
xtractor  197
Z-plane  313

Find, files using the librarian  67
Fine Tuning  130

linked preset  125
Fingered Glide  166
First Key, modulation  86
Fixed Pitch Mode  130
Flanger  256
Flip-Flop  307
Floating Keyboard  270
Floppy disk, loading EOS banks from  319
Focus Width, xtractor  197
Footswitch  301
Forward, function generator mode  142
Forward, region play mode  97
Freerun, function generator  141
Frequency Range of Common Instruments Chart  333
Frequency, LFO  136
Function Generator  139,  301,  305
FX Edit Screen  242
FX Insert Chains  242

G
Gain Adjust

sample edit tool  187
using xtractor tool  198

Gain Fade, sample  186
Gain, filter  145
Gain, xtractor  197

Gamelan Tuning  83
Gate, modulation source  300
Gate/Chop Controls  284
Gating, samples  284
Generator

envelope  301,  302
noise  301

GigaStudio, converting files to Emulator X  319
Glide  131

controlling with function generator  143
modulation source  300
rate  131

Global Controls  74
Gosset-Smith Tuning  192
Grid, function generator  139
Groove Loops  205
Group  93

make new from selected voices  93
Group N  93
Growl, effect  258,  259

H
HALion, converting files to Emulator X  319
Hard Drive Requirements  340
Hass-Effect Panning  130
Headroom/Boost Control  24
Hi Morph Gain  151
High Frequency Damping, stereo reverb  243
High Hat Simulation  164
High-Pass Filter  310
Hold, gate/chop control  284

I
IDE Disk Drive Tips  340
Implementation Chart, MIDI  334
Import Sample  171

audio file in Windows  328
Emulator X bank samples  328
WAVE, AIFF, REX2, MP3  270

Importing, tempo track to a sequencer  173
Impulse Response, using transform multiply  193
Independent, reverb pattern  244,  245
Initital Controllers A-P  81
Input Source, sampling  283
Inputs, adding to Cubase LE  321
IntelliEdit  26,  273

MIDI audition  185
Intensity, transform multiply  194
Inter-Aural Time Delay  130
Inverting, modulation sources  303
Isolate, specific instrument from a mix  196
ITD  130
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J
Just C Tuning  83

description  84
Just Intonation  84

K
Key

CC Win  85,  109
glide, modulation source  300
ranges & fades, adjusting  272
transpose  129
transpose, voice  128
velocity, modulation source  300

Key CC Win, changing loop with  222
Key CC Window  157
Key Sync

function generator  141
LFO  137

Key Timer, poly  86
Key Window

link  125
overview  99

Key/Velocity Windows, exploring  50
Keyboard

CC window  109
display, in voices & zones  94
key, modulation source  300
mini, floating  270
modes  166
pressure modulation source  300
ranges  99
tuning tables  83

Keyboard CC Window  109
Keyboard Range

setting  61
Keyboard Shortcuts  327
Keyboard, placing samples on  60
Kirnberger Tuning  83
Knob Tracking  29

L
Lag Amount, preset lag  85
Lag Processors

preset  85
voice  138,  307

Large Icons  276
Latch Mode  167
Latch, floating keyboard  270
Layering

presets, using links  124
voices & samples  101

Length Modulation, function generator  143
Level, gate/chop control  285

LFO  301
delay  136
flanger  256,  257
sync  304
tips & tricks  138
variation  136
waveforms  136,  303

LFO, connecting to the filter  63
Librarian  66
Librarian, using  58
Limiter  74
Limiting Polyphony  165
Linear Mix, paste sample  182
Linear, crossfade loop  204
Links  123

new  123,  124
preset  123
subsume  124
utilities  124

List of Presets & Samples  276
List View  41,  276
Lo Morph Gain  151
Load

preset  64
samples  58

Load Emulator 4 bank  41
Load Last Bank at Startup  29
Lock Loop  205
Lock Oscillators To Tempo  222
Lock Region  286
Loop  203

autocorrelation  178
backward  97
button  205
compression  204
crossfade  204
envelopes  133
forward  97
how to loop a sample  207
length, locking  205
marker view  117
modulation  161
processing  203
select  205
settings  205
switching  222

Loop (n) Knob  217
Loop in Release  205
Loop Select (Continuous)  220
Loop Select (Jump)  221
Loops

and multisampled voices  223
changing using a continuous controller  219
creating from analyzed sample  215
default behavior  217
different for each voice  226
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M

playing back  217
synchronizing  222
tips for making  216

Low Frequency Oscillator  136,  301,  303
Low Pass Filter  310

M
Main Output Routing  237
Marker  212

snap to  205
Mash Up Processing  199
Master Clock  74
Master Transpose  74
Master Tune  74
Master Volume Control  74
Matrix, reverb pattern  244,  245
Melody (last)  166
Merge, library object into the bank  67
Meter, beat analysis  211
Meters

main output  74
sample input  283

MIDI
audition  185
bank select commands  317
cc cross-switch voices  108
cc#7 curve  27
channel in multisetup  72
channel, current  44,  45,  71,  72
clock, using external  134,  137
continuous controller  314
continuous controller setup  28
controller #7  27
controllers

global page  77
initial settings  81

controlling effects with  242
file generated from region xplode  117
implementation chart  334
master volume sysex  334
modes, definition  317
multi mode  317
note-on  131
omni mode  317
poly mode  317
preferences  26
program change enable/disable  27
program changes  317
real-time controllers  314
selecting input ports  26
velocity curve  27

MIDI Connection, Cubase LE  322
MIDI Response  27
MIDI Track

recording in Cubase LE  325

Mini Keyboard  324
MiniMoog, solo mode  166
Mix Analysis, extractor  200
Mix/Tune Tab  99
Mod Wheel

floating keyboard  270
modulation source  300

Mode
fixed pitch  130
mono  339
multi  339
omni  339
poly  339
solo  166

Modulation  299
cords  301
description  299
destinations  306
of effects  242
of loop  161
processors  307
source, random  304
sources  300

adding  161
Monitor Input, sampling  283
Mono Aftertouch  300
Mono A-I  164
Mono Delays  250
Mono Mode  339
Mono to Stereo Conversion  194
Morph Designer  149
Morphing Filters  149,  313
MP3, import  171
Multi Mode  317,  339
Multi-core Processors  25
Multiple Samples, processing  202
Multiple Trigger  166
Multisample Voices

description  37
viewing & editing  92

Multisetup
basic operations  78
description  34
export as new bank  78
intro  42
MIDI channel  72
output assignment  72
saving  78
selecting  69
selecting presets  72

Mute Voice(s)  96
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N

N
Name

key  94
labels for continuous controllers  28
multisetup  78
preset  43
region  285
sample  162
show preset  331
sort presets by  49
sort samples by  93
template  279,  280

Network, searching with librarian  66
New

preset  327
sample zone  121
sample, pasting as  183
voice  120

New Features  17
No Snap  205
Noise Generator  301
None, in preset select field  45
Normalize

sample  187
xtractor  197

Normalize, sample  187
Not Set

filter override  77
twistaloop override  73

Notch Filter  310
Note Division, BPM envelopes  135,  137
Note Marker  212
Note Onset, marker view  117
Nudge Sample Rate  192
Nudge Tempo  224
Number of Samples Playing  77
Numeric Values, entering  271

O
Offset Sample Start  131
Omni Mode  317,  339
One-shot

function generator mode  142
loop mode  97

Open Sample  120
Open Voices  120
Optimizing your Computer  20
Original Key  60,  99

setting in region list  286
Overview Section, voices & zones  95

P
Pan

amplifer  154
in multisetup  72
linked preset  125
selecting audio based on  196

Parametric Filter  312
1-band para eq  254
4-band eq  255

Paste Section  181
as new sample  183

PatchCord
amount  314
amounts when routing to pitch  158
description  301
sources & destinations  156
tutorial  52

PatchMix DSP, setting up for sampling  282
Pedal, modulation source  300
Pendulum, function generator mode  142
Phase Shifter, effect  260
Phase Shifter, filter  146
Phattening, using chorus  246
Ping Pong  252,  253
Pink Noise  308
Pitch Amount Chart  158
Pitch Change

sample edit tool  192
using xtractor tool  197

Pitch Detect, sample  295
Pitch Shifter

effect  261
xtractor  197

Pitch Wheel  300
bend range  129
control assignment  28
floating keyboard  270

Play Button, sampling  283
Polarity, modulation source  160
Poly 16 A-B, assign group  164,  165
Poly All, assign group  164,  165
Poly Key Assign Groups  165
Poly Key Timer  86
Poly Mode, MIDI  317,  339
Poly Normal, keyboard mode  166
Poly Release Trigger  167
Polyphony, optimizing  23,  165
Positional Crossfade  101
Post FX Send Amounts  241
Pre/Post, gate/chop controls  284
Pre-Delay  243,  244,  245
Preferences  21
Pre-Filter  258
Pre-Roll  22

RAM indicator  77
Presence  266,  267
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Preset
about  34
auditioning  45
changing  43,  45,  70
cords  87
creating from samples  58
description  34
editing  80,  299
links  123
opening  49
selecting from the tree  45

Preset Effects
adding  233
enable/disable  73
modulation  242
selecting  73,  241
voice controlled  239

Preset Global Page  80
Preset Modulators  85
Processor

channel lag  85
channel ramp  86
modulation  307

lag  308
quantizer  308

Program Change Commands  317
Program Change, Cubase LE  325
Project Window, Cubase LE  320
Proteus X Composer FX Template  237
Pulse Width Modulation  161

Q
Q  147,  311
Quad-core Processors  25
Quantizer

effect  263
modulation processor  307

example  308

R
Ramp, channel  86
Random

crossfade  304
using cycle groups  113

crosswitch between voices  106,  108
function generator mode  142
generator  301
modulation  304
voice assignment  111

Range, keyboard  99
Rate

lag processor  138
LFO (frequency)  136
modulation, function generator  143
step rate, function generator  141

Realtime Controller, tutorial  314
Realtime Window  105
Receive Program Changes  27
Record Button, sampling  283
Recording a MIDI Track, Cubase LE  322
Recording Audio  282
Recording Directory  30
Reducing Bits

effect  263
of a sample  190

Region(s)  226
list  285
page  115
window  115
xplode  117

Release Velocity, modulation source  300
Re-order Voices & Samples  274
Repeat, envelope generator mode  133
Resampling  293
Resonance

controlling in realtime  159
definition  311
filter  147

Response, amplifier  154
Rest, creating with function generator  144
Restore, multisetup  78
Retrigger

envelope  302
function generator  143
LFO  305

Reverb Lite, effect  245
Reverb, effect  244
Reverb, envelope  243
Reverberation, description  243
Reverse

function generator mode  142
sample  189

REX 2, import  171
Right Click Shortcuts  328
Ring Modulator, effect  262
Robot Voice Effects, creating  247
Rotational Voice Assignment  111

S
Sample

audition from disk  65
batch processing  202
buffers  23
calculator  195
change pitch of  192
cut, copy, paste multiple  184
DC filter  188
definition  35,  38
deleting unused  206
editing tools  185
editor  169
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fade  186
layering  101
loading one into the bank  58
locating  58
normalize  187
open  120
output of Emulator X  293
pasting as new  183
placing on the keyboard  60
pool  57
retrigger  159
reverse  189
select all  205
selecting multiple  58
start offset  131
truncation  186

Sample Edit Menu, keyboard shortcuts  327
Sample Rate

convert, sample  195,  196
nudge  192
setting  24

Sample Zone
delete  121
duplicate  121
new  121

Save  32,  57
controller settings  46
definition  32
FX & multiseups  78
template  279

Save As  32,  57
Save Text Listing  276
Scarlatti Tuning  83
Scribble Strip  77
Section, morph designer  151
Select All, sample  205
Select Loop  205
Select on Current Channel  72
Select Preset on Active Channel  29
Selecting Voices, using MIDI keyboard  273
Send Aux 1-3  159
Send Main  159
Sensitivity, beat  116,  212
Sensitivity, MIDI controller #7  27
Sequencer, using function generator as  140
Set Keys

sample acquire  286
sample placement  295

Set Names
region  287
sample acquire  286

Set Original Key, sample placement  295
Shape

LFO  136
morph designer  151

Shifting Beats  213

Shortcuts, keyboard  327
Show All Button, function generator  140
Show Bank & Program Numbers  277
Show/Hide Object Numbers  277
Signal Path, simplified  127
Single Cycle Loop  195
Small Icons  276
Smooth, function generator  141
Snap

off  205
settings and markers  117
to marker  205
to zero crossings  205,  206

Software Activation  19
Software Installation  18
Solo Release Trig  167
Solo Voice(s)  96
Solo, keyboard modes  166
Sort

voices  93,  121
voices and zones  121
zones  121

SoundFont, converting files to Emulator X  319
Sources, Modulation  300
SP12-ulator, effect  263,  264
Start At Loop Button  217
Step Rate, function generator  141
Stereo to Mono Conversion  194
Stereo Width, voice chorus  130
Stop Button, sampling  283
Streaming, description  22
Subsume Links  124
Summing Amps  307

using lag processors  138
Summing Nodes  161
Swap FXA & FXB  242
Swap L-R Channels  189
Sweep Control, xtractor  198
Swept EQ Filter  312
Switch, modulation processor  307
Switching Voices

by cycling  111
by keyboard key  109
by velocity  103
randomly  108
using a realtime controller  105

Sync
function generator  141
LFO  137

to clock  304
Synth Solo Mode  166
Synthesizer Controls  127
SynthSwipe  290

parameters  292
setting up  290

System Exclusive, master volume  74
System Requirements  18
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T
T’switch  157
T’switch FF  157
Tempered Tuning  84
Templates  87,  128,  279

creating and recalling  279
organizing  280

Tempo
control  74

enable/disable  27
via preset  82

external control  27
fitting a sample to  190
granularity  214
nudging  224
range (bpm)  210
variation  210

Tempo Map, export  171
Text Listing of Presets & Samples  276
Time Compression, sample  190
Toolbars  269

viewing & hiding  270
Transform Multiply  193
Translator Application  319
Transport Menu, keyboard shortcuts  327
Transport/Loop Controls  177
Transpose

floating keyboard  270
key  129
linked preset  125
master  74
non-transpose mode  130
preset global  81

Tree
exploring  41
navigation using keyboard shortcuts  327
view  277

Trigger, multiple keyboard mode  166
Triggering Envelopes, from modulation sources  302
Triplet Button  212
Truncate

after loop  204
sample  186

Tube, effect  266
Tuning

coarse  129
keyboard  83
to other instruments  74
voice fine  130

Tuning Tables  83
Tutorials

Adding an aux effect  232
Adding an effect to a preset  233
Advanced application guide  65,  299
Building a preset from the ground up  58
Change loops with a controller  220,  221
Conserving polyphony  165

Control FX parameters via MIDI  242
Control the effect amount from the voice  239
Create a custom bank  47
Creating ADSR envelopes  133
Crossfade between two loops  227
Cycle groups for more realistic instruments  112
Examine a voice  52
Examine the samples  54
Function generator as an arpeggiator  140
Importing a tempo track to a sequencer  173
Layering presets  124
Looping a sample  207
Morph designer  150
Opening a preset  49
Process a vocal and return it to the mix  199
Program change commands  317
Proteus VX with Cubase LE  322
Pulse-width modulation  161
Sampling  282
Setting up your controller knobs  314
SynthSwipe  290
Using DSP  55

Twin, effect  267
TwistaLoop  209

bar numbering changes  214
override  73
troubleshooting  228

U
Ultra-High Precision Interpolation  24
Undo & Redo  32,  179
Unused Samples, delete  206
Update Library  58,  66
Use Multiple Processors  25
Use Optimal Buffer Size  24
Utilities, link  124

V
V2, what’s new?  17
Vallotti Tuning  83
Variation, LFO  136
Velocity Curve, MIDI  27
Velocity Window  103

link  125
View Menu  275
Vista, audition sample under  65
Vocal Elimination  196
Voice  51

& sample zones  89
add to preset  51
assign group  164
coarse tuning  129
combine  120
continuous controller cross-switch  108
control of FX amounts  239
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create new voices from regions  117
crossfading by realtime controller  105
crossfading by velocity  103
delay  131
delete  120
description  34,  36
expand  121
fine tuning  130
fixed pitch mode  130
key transpose  129
keyboard range  99
lag processors  138
layering  101
new  120
open  120
place into a group  93
processing, basics  62
random crosswitch  106
realtime crossfade  105
realtime window  90,  105
select all  93
select group  93
selecting multiple  127
selection  91
sorting  93
switching by key position  100
switching by realtime controller  105,  108
switching by velocity  103
utilities  120
velocity range  90,  103

Voice & Sample Zone Utilities  120
Voice Editor, overview  128
Voice Effect Sends  155
Volume

changing relative  95
in multisetup  72
increasing overall  24
linked preset  125
preset global  81

Volume Control, master  74
Volume Curve  27
Volume Sensitivity  27
VST Connections, Cubase LE  321
VST Instrument, Cubase LE  323
VSTi

& multisetup  78
Cubase LE checklist  326
launching  320

VU Meter  74
recording  282

W
WAVE, import  171
Waveforms, LFO  303
Wavetable Scanning Synthesis  161
Werkmeister Tuning  83
Wet/Dry Mix, effects  240,  241
Wheels, Pitch & Mod.  28,  300
White Keys  295
White Noise  304

X
X2, what’s new?  17
X3, new features  17
Xplode, voices from regions  117
Xtractor  196

Z
Zero Crossing  206,  208

snap to  206
Zero Crossing Threshold, setting  206
Zoom, keyboard shortcuts  327
Z-plane Filter  149,  313
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